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Preface

Preface

Thank you for purchasing your Topcon receiver, survey product or
accessory (the “Product”). The materials available in this manual (the
“Manual”) have been prepared by Topcon Positioning Systems, Inc.
(“TPS”) for owners of Topcon products. This Manual is designed to
assist owners with the use of software (the “Software”) to be used
with the Product and its use is subject to these terms and conditions
(the “Terms and Conditions”).

@ Please read these Terms and Conditions carefully.

Terms and Conditions

USE This product is designed to be used by a professional. The user
should have a good knowledge of the safe use of the product and
implement the types of safety procedures recommended by the local
government protection agency for both private use and commercial
job sites.

COPYRIGHT All information contained in this Manual is the
intellectual property of, and copyrighted material of TPS. All rights
are reserved. You may not use, access, copy, store, display, create
derivative works of, sell, modify, publish, distribute, or allow any
third party access to, any graphics, content, information or data in this
Manual without TPS’ express written consent and may only use such
information for the care and operation of your Product. The
information and data in this Manual are a valuable asset of TPS and
are developed by the expenditure of considerable work, time and
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money, and are the result of original selection, coordination and
arrangement by TPS.

TRADEMARKS Topcon®, HiPer®, TopSURV™, Topcon Link™,
Topcon Tools™, and Topcon Positioning Systems™ are trademarks
or registered trademarks of TPS. Windows® is a registered trademark
of Microsoft Corporation. Bluetooth® is a registered trademark
owned by Bluetooth SIG, Inc. and is used by Topcon Positioning
Systems, Inc. under license. Sokkia Corporation and the names of
Sokkia Corporation products referenced herein are either trademarks
or registered trademarks of Sokkia Corporation. Satel is a trademark
of Satel, Oy. Other product and company names mentioned herein
may be trademarks of their respective owners.

DISCLAIMER OF WARRANTY EXCEPT FOR ANY
WARRANTIES IN AN APPENDIX OR A WARRANTY CARD
ACCOMPANYING THE PRODUCT, THIS MANUAL, THE
PRODUCT, AND ANY ACCOMPANYING SOFTWARE ARE
PROVIDED “AS-IS.” THERE ARE NO OTHER WARRANTIES.
TPS DISCLAIMS ANY IMPLIED WARRANTY OF
MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR
USE OR PURPOSE. TPS AND ITS DISTRIBUTORS SHALL NOT
BE LIABLE FOR TECHNICAL OR EDITORIAL ERRORS OR
OMISSIONS CONTAINED HEREIN; NOR FOR INCIDENTAL OR
CONSEQUENTIAL DAMAGES RESULTING FROM THE
FURNISHING, PERFORMANCE OR USE OF THIS MATERIAL,
THE SOFTWARE, OR THE PRODUCT. SUCH DISCLAIMED
DAMAGES INCLUDE, BUT ARE NOT LIMITED TO, LOSS OF
TIME, LOSS OR DESTRUCTION OF DATA, LOSS OF PROFIT,
SAVINGS OR REVENUE, OR LOSS OF THE PRODUCT’S USE.
IN ADDITION, TPS IS NOT RESPONSIBLE OR LIABLE FOR
DAMAGES OR COSTS INCURRED IN CONNECTION WITH
OBTAINING SUBSTITUTE PRODUCTS OR SOFTWARE,
CLAIMS BY OTHERS, INCONVENIENCE, OR ANY OTHER
COSTS. IN ANY EVENT, TPS SHALL HAVE NO LIABILITY
FOR DAMAGES OR OTHERWISE TO YOU OR ANY OTHER
PERSON OR ENTITY IN EXCESS OF THE PURCHASE PRICE
FOR THE PORDUCT.
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Terms and Conditions

LICENSE AGREEMENT Use of the Software and any other computer
programs or software supplied by TPS or downloaded from a TPS
website (the “Software”) to be used with a Topcon Product constitutes
acceptance of these Terms and Conditions in this Manual and an
agreement to abide by these Terms and Conditions. The user is
granted a personal, non-exclusive, non-transferable license to use
such Software under the terms stated herein and in any case only with
a single Product or single computer. You may make one (1) backup
copy of the Software. Otherwise, the Software may not be copied or
reproduced. You may not assign or transfer the Software or this
license without the express written consent of TPS. This license is
effective until terminated. You may terminate the license at any time
by destroying the Software and Manual. TPS may terminate the
license if you fail to comply with any of the Terms or Conditions. You
agree to destroy the Software and manual upon termination of your
use of the Product. All ownership, copyright and other intellectual
property rights in and to the Software belong to TPS. If these license
terms are not acceptable, return any unused Software and the Manual.

CONFIDENTIALITY This Manual, its contents and the Software
(collectively, the “Confidential Information”) are the confidential and
proprietary information of TPS. You agree to treat TPS’ Confidential
Information with a degree of care no less stringent than the degree of
care you would use in safeguarding your own most valuable trade
secrets. Nothing in this paragraph shall restrict you from disclosing
Confidential Information to your employees as may be necessary or
appropriate to operate or care for the Product. Such employees must
also keep the Confidentiality Information confidential. In the event you
become legally compelled to disclose any of the Confidential
Information, you shall give TPS immediate notice so that it may seek a
protective order or other appropriate remedy.

WEBSITE; OTHER STATEMENTS No statement contained at the
TPS website (or any other website) or in any other advertisements or
TPS literature or made by an employee or independent contractor of
TPS modifies these Terms and Conditions (including the Software
License Agreement, Disclaimer of Warranty and limitation of
liability).
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SAFETY Improper use of a Topcon Product can lead to injury to
persons or property and/or malfunction of the Product. The Product
should only be repaired by authorized TPS warranty service centers.
Users should review and heed the safety warnings in the manual
accompanying the Product.

MISCELLANEQUS The above Terms and Conditions may be
amended, modified, superseded, or canceled, at any time by TPS. The
above Terms and Conditions will be governed by, and construed in
accordance with, the laws of the State of California, without reference
to conflict of laws.

Manual Conventions

This manual uses the following conventions:

Example Explanation

File » Exit tap the File menu and tap Exit.

Enter Indicates the button or key labeled Enter.

Notes Indicates a field on a dialog box or screen, or a tab
within a dialog box or screen.

Topo Indicates the name of a dialog box or screen.

Supplementary information that can help you
configure, maintain, or set up a system.

Supplementary information that can have an affect
on system operation, system performance,
measurements, personal safety
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What's New

What's New with

TopSURV

This chapter briefly describes new features and functions for version

6.11 of TopSURV.

Updates on Road Design
Sections of roads are now available for

!l@]amad [My Conventional] % E @
Joh View Survey Stake Cogo Hip

Sections of road can be selected
separately from data types for import/
export from/to a file.

For details on import/export
functionality, see “From File” on page 2-
94 and “To File” on page 2-112.

separate editing. Boints
e ! - 6 Codes
For details on the road design, see “Road Paint Lists
o
Design” on page 3-24. e
X-Sect Templates
Roads
i Horiz &lign
Linewark Wert Algn
Raw Data X-Sect Set
Layers from Global Data Dictionary -
E. -Cancel
Besides the codes, the layers from a ; ; i
.. . | Use Bold Font
Global Data Dictionary file can be used )
X f ["]Enable Job History
in the current job. ]
Auto Linework
For details on global settings for the job, Type [code-string v
see “Global” on page 2-70. Control Code Delimite ISpaCE v
Code File uthwest xm]
New Import/Export Functionality
me File

Data Horizontal Alignments v
Horizontal ments |
'vertical Alignments
A-Section Sets
Roads

X-Section Templates
Localization

Scanning Data

Surfaces (TINs) M

Format
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Chapter 1

Introduction

TopSURY is Topcon’s survey software available for hand-held
controllers. When installed on a hand-held controller that runs the
Windows® CE operating system, such as Topcon’s FC-100, FC-2000,
FC-200 and the integrated controller of GMS-2, TopSURY is used
for:

* field data collection
¢ stakeout and control work
¢ data conversions

¢ advanced COGO

Security

Upon initial startup, a Security screen displays.

TopSURY requires an access code to start. Contact a Topcon
representative to acquire the necessary codes.

* Key Value: the device’s number; given to a Topcon representative
to receive activation IDs.

* Activation IDs: the fields in which to enter the security codes
received from a Topcon representative to activate purchased
modes: TS, Contractor, Robotic, GPS+, GIS (RT DGPS and PP
DGPS), Roads, and mmGPS.
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Key Walue IW
Activation IDs

TS I

Contractor

Robotic

GRS+ I

GIS I

Roads

mmGPS

Figure 1-1. Security

To run a demo version of TopSURYV, tap OK or Cancel; a
confirmation message displays. Tap OK to confirm using Demo
Mode.

Security not enabled for GPS Mode!
The confroller will run in Demo
Mode with limited functionality!

Figure 1-2. Run Demo Mode?

Open Job

Initially, TopSURYV will open a Default job created upon program
installation.

Open Job m

Job List

Created:
08082006
01:34
Modified:
08082006
01:42

\CF Card\TPS\TopSURVYJobs

[ean ] [ ow ] wowse ] ooen |

Figure 1-3. Open Job
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Main Screen

* Open: creates the Default job current and returns to the main
screen.

¢ New: opens the New Job screen to create a new job.

* Browse: displays the screen to browse directories for selecting a
job to open (Figure 1-4 on page 1-3). Highlight the file and press
OK.

o Exit: quits the program.

Type IJDb Files (*.ts¥)

\CF Card\TPS}

[ ITopSURV
# 1100.ts¥
F KRISHA. tsy

[ROAD. tsv)

Name [ROAD.tsv

Figure 1-4. Browse Job

Main Screen

The TopSURYV main screen consists of a title bar, a menu bar and a
work area.

I3 081 (My RTK] 5
Job Edit View Survey Stake Cogo Hip

Figure 1-5. TopSURV Main Screen
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upon the device being used. Most of the screen
shots in this manual were taken from an FC-2000
hand-held controller. A few shots were taken from
an FC-100.

; The appearance of the screen titles and text depend

Title Bar

When on the main screen, the title bar displays the instrument button
and the name of the job open (and the configuration name), the
Reconnect button, as well as connection and controller power status
icons.

Job Name (Configuration Name) Controller Power Status

B v
EEJ]Joh 1.4 [My Reflectorless] B &%

A

Instrument Reconnect Connection Status

Figure 1-6. Title Bar — Main Screen

If the controller has Bluetooth® wireless technology, the Reconnect
button appears to reflect the status of Bluetooth connection.

When within a menu option, the title bar displays the bitmap button,
the name of the screen, and any system buttons required for various
operations.

Bitmap  Name of Screen  System Buttons

v A4 \4
Selel:t Survey Config m

Figure 1-7. Title Bar — Menu Functions

The bitmap opens the pop-up menu containing the Help item to
access the help files and some options specific for a screen open.
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Main Screen

The menu bar has seven menus used to configure and manage a
survey job, and to control data.

|Job Edit View Survey Stake Cogo HIp |

Figure 1-8. Menu Bar

See the following chapters for a description of each menu and its
functions.
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The Job menu includes the following menu items:

P/N 7010-0492

Open
New
Delete
Config
Import
Export
Info
Mode
Exit

Chapter 2

Ielroso My RTK] R
EEZ Edit View Survey Stake Cogo Hip

=)
W
Delete
Config »
Imnport »
Expart »
Info
Mode

g0

Exit

Figure 2-1. Job Menu
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Open Job

To open a job, tap Job » Open.

The Open Job screen can be used to select a job.

Open Job

Current Job: Default

Created:
11/16{2006
00:33

Modified:
11/16{2006
00:33

\CF Card\TPS\TopSURVYJobs

[ rowse ][ aoen |

Figure 2-2. Open Job

The Job List field contains the names of all existing jobs created/

opened using TopSURYV and indicated by the icon ‘. Initially, the
Job List is empty.

When a job is selected in this list, the Created and Modified fields will
reflect when the job was created and last modified.

* The path below the Job List shows the directory where the
selected job was created.

* Open: creates the chosen job current and returns to the main
screen. Upon the opening of a job created in a previous TopSURV
version a confirmation message displays to upgrade the job file to
the current format.

\WCF

& Carch, TPS TopSURYY JobsiROAD, tay
should be upgraded to the current
format wersion.

Upgrade now?

Figure 2-3. Update Job
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* Browse: displays the screen to browse directories for selecting a
job to open. Highlight the file and press OK.

Open Job OK | Cancel

Type IJDb Files (*.ts¥) .

\CF Card\TPS\TopSURV{Jobs}

Name [1100.tsv

Figure 2-4. Browse Jobs

New Job

To open a new job, tap Job » New.

The New Job screen starts the new job creation process which is
performed with the help of a Wizard.

[ [conce

\CF Card\TPS\TopSURVYJobs}

Name |sitel

Created By |sunrey|:|r

Comments

Current Date  11f16/2006 0:54 AM

I Browse " Next == ]

Figure 2-5. New Job

* The path displays the directory where the job will be created. By
default, job files are stored in the Jobs folder in the directory

where the application has been installed. Press Browse to change
the directory.

* Name: the name of the new job.

* Created By: the name or some other identifier of the surveyor.

P/N 7010-0492 2-3



Job

* Comments: any additional information about the project, for
example, the conditions of survey.

Current Date: displays the current date and time.

Browse: changes the directory in which to look for a job.

Next: after setting all fields of the screen, pressing this button
opens the Select Survey Config screen.

* Finish: saves the information and returns to the main screen. The
new job becomes the current job and uses the settings from the
previously open job, unless changed.

Select Survey Configuration

The Select Survey Config screen is used to select a survey
configuration for the job.

Survey Configuration is a set of parameters that does not depend on
the job. One configuration can be used by several Jobs.

Select Survey Config

Select the Configuration for the Job or create a
MNew Configuration.

GPS+ Config

MNarme

TS Config

MName  |<Default> v E

I <« Back " Next >> ]

Figure 2-6. Select Survey Configuration

The description of how to work with configurations will be discussed
in “Configuration” on page 2-11. Initially, TopSURV contains
several pre-defined configurations: My RTK, My Network RTK, My
Network DGPS, My RT DGPS, My PP Static, My PP Kinematic and
My PP DGPS for GPS+ mode; My Conventional, My Reflectorless,
My Robotic and My Level for TS mode.

* GPS+ Config: shows the GPS+ configuration for the current job.
The drop-down list shows the configurations available for the
GPS+ mode.
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* TS Config: shows the total station configuration for the current
job. The drop-down list shows the configurations available for the
TS mode.

» [ : opens the Configurations screen to edit a configuration
(see “Configuration” on page 2-11 for details).

* Back: returns to the previous screen.
¢ Next: opens the Coordinate Systems screen.

* Finish: saves the settings, and returns to the main screen.

The job settings of a survey configuration will be

@ applied only after opening a TopSURYV screen
which enables performing and storing
measurements in the job file.

Coordinate System

The Coordinate System screen contains coordinate system
information for the new job.

Coordinate System

Projection | “none: - e

Use GridfGround

Daturn EEE v | ..
Genid Madel |<n0ne> v

I <« Back ”]

Figure 2-7. Coordinate System

* Projection: specifies the projection to be used. The E] button
opens the Projections screen.
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* Use Grid/Ground: when a grid projection is selected, this box

becomes available. If checked, the E] button is activated to
open the Grid to Ground Param screen.

* Datum: shows the datum for the selected projection. The drop-
down list of datums is available only when the current grid

projection allows datum selection. The E] button opens the
Custom Datum screen.

* Geoid Model: shows the geoid selected (if any). The [ ]
button opens the Geoids List screen.

* Back: returns to the previous screen.

* Next: opens the Units screen.

¢ Finish: saves the settings, and returns to the main screen.

See “Coordinate System” on page 2-71 for working with coordinate
systems.

Units

The Units screen displays the default units that will be used in the job.

Distance v

Angle |oms "
Temperature |Celsius () w
Pressure |mmHg v

Figure 2-8. Units

* Distance: units of linear measurements for the job. These can be
Meters; IFeet (International Feet, 1 Ifoot = 0.3048 Meters), US
Feet (1 USFt = 1200/3937 Meters); IFeet and Inches, or US Feet
and Inches (the latter two are calculated taking into account that 1
Foot = 12 Inches).
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If the selected units are USfeet, linear values can be
% . entered as meters, or International Feet by

appending “m” or “if” to the entered value.

If the selected units are in meters, then a linear

value in USFeet, or International Feet can be

entered by appending “f”, or “if”” to the end of the
entered value.

If the selected units are in International Feet, linear
values can be entered in meters or USfeet by
appending “m”, or “f” to the entered value. The
appended characters “m”, “f”, or “if”” are case
insensitive. In other words, enter “M”, “F”, or “IF”.

* Angle: units of angle measurements and parameters. These can be
DMS (degrees, minutes, seconds), Grads (Gons), Radians (for
Cogo use only), or Mils (for Cogo use only). (360 degrees = 400
grads = 2r radians = 6400 mils.)

T3 ENTEL)

separated by “-”, “,” or “;”. Certain angles can be
entered as three points separated by “-”, “,” or “;”.
For instance a value of 100-101 indicates the

Azimuth or Distance from Point 100 to Point 101.

Azimuth and distances can be entered as two points

» Temperature (only for TS mode): units of temperature, used only
for the raw measurements. These can be Celsius (C), or
Fahrenheit (F).

* Pressure (only for TS mode): units of atmosphere pressure, used
only for the raw measurements. These can be mmHg, hPa, inHg
or bbar.

* Back: returns to the previous screen.
* Next: opens the Display screen.

* Finish: saves the settings and returns to the main screen.

P/N 7010-0492 2-7



Job

Display

The Display screen customizes the software interface.

Coord Type v
Coord Order MNorthing,Easting, Elevation s
Azimuth Origin Marth v
Disp Dir As Aziruth w
Disp CL Pos As Station v
Full Station [iooooo o

Figure 2-9. Display
Coord Type: sets the coordinate type for the coordinate system
selected.

Coord Order: sets the Northing/Easting order and displays the
height type for the coordinate system selected.

» Azimuth Origin: the reference direction of azimuth.

Disp Dir As: select whether to display the direction as bearing or
azimuth.

Disp CL Pos As: select how to display the position on the center
line: as station or chainage.

Full Station: available if Station selected for Disp CL Pos As; sets
the measurement units used for the full station value and is
usually 100 units.

Back: returns to the previous screen.
Next: opens the Alarms screen.

Finish: saves the settings and returns to the main screen.
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Alarms

The Alarms screen sets sound alerts for situations of low power, low
memory, poor radio link, and loss of fixed/float solutions. These

alarms may happen while working with the controller, GPS+ receiver,
or total station.

[ Jeoa]
[ e

Instrument Controller GP5+ TS
Power Alarm
Mernory Alarm

Radio Link

FixjFloat

Figure 2-10. Alarms

* Audible Alarm: select this field to enable audible alarms. The
alert will sound automatically when an alert situation occurs.

e Alarms: select the alarms to sound for various instruments and
situations.

* Back: returns to the previous screen.

¢ Finish: saves the settings and returns to the main screen.
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Delete

To delete a job, tap Job » Delete. The Delete Job screen deletes jobs.
Once deleted from the Job List, the file containing the job chosen is
deleted from the controller.

Delete Job

Current Job: Default

Created:
11/16{2006
00:33
Modified:
11/16{2006
00:51

\CF Card\TPS\TopSURVYJobs

[ Browse || Delete |

Figure 2-11. Delete Job

When a job is selected in the list, the Created and Modified fields will
reflect when the job was created and last modified.

* The path under the Job List displays the directory where the
selected job was created.

* Browse: If a job is not listed in this list, browse through the
directories to select the job for deletion.

* Delete: deletes the job.

* Close: closes the screen without deleting job.
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Configuration

The Config submenu changes the parameters set during Job creation.

EE¥krisHa [My conventional] el
EEZ Edit View Survey Stake Cogo Hip

elete Survey
Global
Import » | Coord Sys
Expart » | Units

Info Temp/Press
Mode Display

- Alarms
Bt Menu Display

Figure 2-12. Config Submenu

In TS mode, the Configuration functionality is restricted for the
Contractor Module (for details on selecting this module, see “Mode”
on page 2-123).

[E§conTrACTOR [My Conventionall B @

EEZ Edit View Survey Stake Cogo Hip

Survey
Irnport » [ Units
Export » | Display

Info Menu Display

Figure 2-13. Config Submenu in the Contractor Module

The Contractor Module is designed for use by non-surveyors doing
construction stakeout with total stations.
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Survey

To configure a survey, tap Job » Config » Survey.

Select Survey Configuration

The Select Survey Configuration screen can also be reached using
the New Job Wizard (see “New Job” on page 2-3).

Select Survey Config m

Select the Configuration for the Job or
create a New Configuration.

GPS+ Config
Name My RTK v E
TS Config

Name |4Default> v E

Figure 2-14. Select Survey Configuration

* GPS+ Config: shows the GPS+ configuration for the current job.
The drop-down list shows configurations available for GPS+
mode: My RTK, My Network RTK, My Network DGPS, My RT
DGPS, My PP Static, My PP Kinematic and My PP DGPS.

* TS Config: shows the total station configuration for the current
job. The drop-down list shows configurations available for TS
mode: My Conventional, My Reflectorless, My Robotic and My
Level. In the Contractor Module, only My Conventional and My
Reflectorless are available.

. : opens the Configurations screen for editing parameters
for the configurations.

* OK: sets the selected configuration for the current job and returns
to the main screen.
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GPS+ Configuration

To configure a GPS+ survey, press the button in the GPS+
Config field of the Select Survey Configuration screen.

Configurations

The Configurations screen presents a list of available configurations.
Editing and adding of a configuration is accomplished with the help
of a Wizard.

Configurations m

Configuration Name

My Network RTK
My Network DGPS
My RT DGPS

My PP Static

My PP Kinematic
My PP DGPS

| pelete || Edt |[ Add

Figure 2-15. GPS+ Configurations

Delete: deletes the highlighted configuration.

* Edit: opens the Config: Survey screen for changing configuration
settings.

Add: opens the Config: Survey screen for adding a new
configuration.

OK: returns to the Select Survey Configuration screen.
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Config: Survey

The Config: Survey screen contains general settings for the
configuration.

Econo ey [

Name y Network RTK]
Type INetwurk RTK kv
Corrections IVRS -

[]Enable PP Survey

Figure 2-16. Config: Survey

* Name: the name of the configuration that will be displayed in the
Configurations screen.

* Type: the type of the configuration; either RTK, Network RTK,
Network DGPS, Real Time DGPS, PP Static, PP Kinematic, or
PP DGPS. (“PP” means Post-Processing.)

— RTK (Real Time Kinematic) implies, first, a pair of receivers
operating simultaneously and, second, a radio link
established between the two receivers. From a functional
point of view, the two receivers will differ from each other.
One of the receivers (usually referred to as the Base Receiver)
is located at a fixed point with known coordinates. The base
receiver collects carrier measurements, generates RTK
corrections, and sends this data to the other receiver (usually
referred to as the Rover Receiver) via a radio link. To
establish proper connection between the two receivers,
specify necessary communication parameters first. The Rover
processes this transmitted data with its own carrier phase
observations to compute its relative position with a
centimeter accuracy.

A mmGPS aided RTK survey uses the usual RTK GPS+
survey system, but with a wireless PZS-1 sensor at the rover
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to pick up the signal from the PZL-1 transmitter for accurate
(millimeter) elevations.

— Network RTK (Network Real Time Kinematic) implies that
the Rover uses RTK correction data received from operating
reference station networks to compute its position.

— Real Time DGPS (Real Time Differential GPS) implies that
the rover uses differential pseudorange correction data
transmitted from DGPS services.

— Network DGPS (Network Differential GPS) implies the
usage of pseudorange corrections received from operating
differential GPS reference station networks.

— PP Static (Static Post Processing) implies two receivers that
collect data at stationary locations during a long period of
time. Then in the office, the software operator processes the
GPS data collected in the field and calculates the relative
position of the receivers. Usually it is “differential
processing”, when data from two or more receivers are
processed together in order to compute these receivers'
relative positions. If the coordinates of one receiver are
known, then the coordinates of the other can be calculated.

— PP Kinematic (Kinematic Post Processing) also implies two
receivers. One is fixed, the other is moving along some
trajectory. The processing of the collected data is performed
later, as for the PP Static type.

— PP DGPS (Post Processing Differential GPS) implies that the
raw observations made by the rover and the base receiver
would have to be written to files for further processing.

* Enable PP Survey: when the box is checked, additional screens
become available for post processing options in RTK, Network
RTK, RT DGPS, and Network DGPS surveys (see Figure 2-18
on page 2-17; Figure 2-32 on page 2-27; Figure 2-52 on page 2-
45).

* Corrections: available only in a Network RTK, Network DGPS,
or Real Time DGPS configuration; also selects the service to
receive differential correction data.
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For the Network RTK configuration it can be VRS, FKP, Single
Base or External Config. For RT and Network DGPS, the
correction data can be received from a User Base, Beacon,
CDGPS, WAAS, EGNOS, OmniSTAR-VBS, or OmniSTAR-HP
differential services.

For RTK and Real Time DGPS survey types, the bitmap on the upper-
left corner displays a pop-up menu containing two items:

* MultiPort: enables the MultiPort functionality (Figure 2-17).

* Help: accesses the Help files.
Cunﬁg: Survey

Name IMy RTK

Type RTK v
Num Ports |2 -

[]Enable PP Survey

Figure 2-17. Config: Survey — MultiPort

* Num Ports: sets the number of ports to configure the Base/Rover
to transmit/receive data from different ports.

* Next: opens the Config: Base Receiver screen. For Network
RTK, Network DGPS and Real Time DGPS (except User Based
mode) without post processing option, the Config: Rover
Receiver screen displays. For PP enabled surveys, the Config:
Base PP Setup or the Config: Rover PP Setup screen will
display. If PP Static survey type is selected, the Config: Static
Receiver screen will open.
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Config: Base PP Setup

The Config: Base PP Setup screen sets raw data logging parameters
for the base in case of PP enabled RTK and User Based mode in Real
Time DGPS surveys (Figure 2-18).

Cunﬁg: Base PP Setup

Raw Data Logging

File Name Default v
Log To |Receiver v
Logging Rate |5-UU secs

I <« Back " Next >> ]

Figure 2-18. Config: Base PP Setup

* Raw Data Logging: the set of logging parameters; log to the
receiver, set the logging rate and select if the name of the receiver
file is automatically set or user-defined. In the latter case, the
corresponding dialog box will be displayed at the logging start.

* Back: returns to the previous screen.

* Next: opens the Config: Base Receiver screen.

Config: Base (Static) Receiver
For RTK survey type

The Config: Base Receiver screen contains settings for configuring
an RTK Base receiver.

Cunﬁg: Base Receiver

RTK Format cMR+ %

Elevation Mask |1lII deg

I <« Back " Next >> ]

Figure 2-19. Config: Base Receiver

P/N 7010-0492



Job

¢ RTK Format: the format of the base receiver differential
corrections transmitted to the rover; CMR, CMR+ (default),
RTCM 2.1, 2.2, 2.3, 3.0.

e Elevation mask: data from satellites below this elevation will not
be used.

* Back: returns to the previous screen.

* Next: opens the Config: Base Radio screen (Figure 2-22 on
page 2-20).

* Finish: saves the changes and returns to the Select Survey Config
screen.

The bitmap on the upper-left corner displays the pop-up menu
containing two items:

* Receiver Setting: enables turning charger mode off.

* Help: accesses the Help files.
For Real Time DGPS survey type (with a User Base)

The Config: Base Receiver screen contains the settings for
configuring an RT DGPS Base receiver.

Cunﬁg: Base Receiver

DGPS Format Full {RTCM 1,31,3) %
Elevation Mask Ill:l— deg

I <« Back " Next >> ]

Figure 2-20. Config: Base Receiver — For Real Time DGPS

e DGPS Format: the format of the base receiver differential
corrections transmitted to the rover; either Full (RTCM 1, 31, 3)
or Partial (RTCM 9, 34, 3).

e Elevation Mask: data from satellites below this elevation will not
be used.

* Back: returns to the previous screen.
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¢ Next: opens the Config: Base Radio screen (Figure 2-22 on
page 2-20).

* Finish: saves the changes and returns to the Select Survey Config
screen.

The bitmap on the upper-left corner displays the pop-up menu
containing two items:

* Receiver Setting: enables turning charger mode off.

* Help: accesses the Help files.
For PP Static, PP Kinematic, or PP DGPS survey types
The Config: Static (Base) Receiver screen has the same fields of

parameters as for RTK and PP survey type except the RTK Format
field.

Cunﬁg: Static Receiver

Elevation Mask I deg

Raw Data Logging

Log To |Receiver -
Logging Rate |15.IIIIII 5ecs
File Name |Default v

I <« Back " Next >> ]

Figure 2-21. Config: Static Receiver — For PP Static Survey Type
* Back: returns to the previous screen.
» Next: opens the Static (Base) Antenna screen.

* Finish: saves the changes and returns to the Select Survey Config
screen.

The bitmap on the upper-left corner displays the pop-up menu
containing two items:

* Receiver Setting: enables turning charger mode off.

* Help: accesses the Help files.
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Config: Base Radio

The Config: Base Radio screen contains the settings for configuring
the radio modem connected to the Base receiver.

Cunﬁg: Base Radio

LEL LN LG Wiinternal HiPer Lite v

Receiver Port Connected to Radio

Port |C Baud [38400 v

Parity |NU"9 ~ | Stop |1

Data |3 v Defaults

I <« Back " Next >> ]

Figure 2-22. Config: Base Radio

* Radio Modem: the type of the modem. The list of pre-defined
modem types changes its contents depending upon the job
configuration chosen.

* Receiver Port Connected to Radio: contains the parameters for
the connection port, and are specific for the connected modem.
For example, Siemens cell phones need a 19200 baud rate.

Internal GR-3 FH915+, Internal HiPer Lite, and Internal HiPer
Lite+ FH915+ modems require a 57600 baud rate.

¢ Defaults: returns all the values in the Receiver Port Connected to
Radio fields to defaults.

» Next: opens the Config: Base Radio Param screen to set
parameters for the chosen modem (for details see “Config: Base
Radio Parameters” on page 2-21). Opens the Base Antenna
screen if the selected modem type does not require additional
settings (Figure 2-31 on page 2-26).

AirLink GPRS, AirLink CDMA, AirLink CDPD!, CDMA2000,
Generic, Sierra Wireless MP200 CDPD, and Internal HiPer Pro
modem types do not require additional settings.

1. CDPD stands for “Cellular Digital Packet Data”. CDPD is an open
packet data service, defined as an autonomous overlay network,
specified for the cellular TDMA network.
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* Finish: saves the changes and returns to the Select Survey Config
screen. All settings will be transmitted only when using the
configuration.

In Multi-Port mode (see page 2-16 for details), several Config: Base
Radio Out screens display to configure the radio for data output.

Cunﬁg: Base Radiol Out

Radio Modem |[RET=]i{=e{=t3 8 v

Receiver Port Connected to Radio

Port |C v Baud [38400 v

Parity |NU"9 ~ | Stop |1

w
Data |3 v Defaults

I <« Back " Next >> ]

Figure 2-23. Config: Base Radio Output

Config: Base Radio Parameters

For Cell Phone Modems: Internal HiPerXT (GSM), Internal
HiPer (GSM), Internal GR-3(GSM), Motorola V60 Cell Phone,
Motorola V710 Cell Phone, MultiTech GSM/GPRS Modem,
Siemens TC35 Modem, Siemens M20 Modem, Nextel i58sr Cell
Phone, Wavecom Fastrack GSM

The Config: Base Radio Param screen contains a field for Base PIN
input.

Cunﬁg: Base Radio Param

Base PIN [1aaq]

I <« Back " Next >> ]

Figure 2-24. Base Cell Phone Parameters
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For UHF Modems: Internal HiPerXT (UHF)

The Config: Base Radio Param screen contains the parameters for
UHF modem in the receiver.

Cunﬁg: Base Radio Param

Protocol IPDL v
Channel IIII v
Power 2W -

I <« Back " Next >> ]

Figure 2-25. UHF Modem
* Protocol: sets the protocol for data transmission:

— TPS: uses Topcon’s FCS mode to scan for the best channel to
communicate on.

— PDL: communicates with the rover PDL radio.
* Channel: sets the dedicated channel for the PDL protocol.

* Power: sets the level of power for RF transmissions: either IW or
2W.

For FH915 Modem: Internal HiPer Lite

The Config: Base Radio Param screen selects the operating channel
from the preset ones for the HiPer Lite internal modem.

Cunﬁg: Base Radio Param

Channel [T ~

I <« Back " Next >> ]

Figure 2-26. Internal Hiper Lite FH915 Modem
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For FH 915+ Modem: Internal HiPer Lite+ and GR-3 FH915+

The Config: Base Radio Param screen selects the parameters for
FH915+ internal modem:

* Location: selects the territory (specifically for Australia) to
adjust the frequency range and RF power level for the modem.

* Protocol: sets the operation protocol:

— FH915+: recommended if all receivers on the jobsite are
equipped with FH915+ radios only

— FH915: recommended if there is a mixture of receivers
with FHI915 and FH915+ radios on the jobsite

* Channel: selects the operating channel.

Cunﬁg: Base Radio Param

R (Ol fior h America |
Protocol IFHQ 15 v
Channel I 1 v

I <« Back " Next >> ]

Figure 2-27. Parameters for FH915+ Modem
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For Pacific Crest and Internal HiPer (Pac Crest) Radio Modem

The Config: Base Radio Param screen sets the channel number and
the sensitivity of the Radio Modem.

Cunﬁg: Base Radio Param

Channel IR

Sensitivity Low v

I <« Back " Next >> ]

Figure 2-28. Pacific Crest Radio Parameters
* Channel: sets the operating channel to the radio modem.

* Sensitivity: selects the sensitivity level for the radio modem;
either low, moderate, high, or off.

For Satel modems

The Config: Base Radio Param screen sets the model of the Satel
radio, the channel number and the frequency of the radio.

Cunﬁg: Base Radio Param

Model  [TEZEINN v

Channel IB v
Frequency I469.5l:ll:ll:l MHz

I <« Back " Next >> ]

Figure 2-29. Satel Radio Parameters
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For AirLink CDMA (Multicast UDP)

The Config: Base Radio Param screen sets IP addresses for
communication between the base and several rovers using the UDP
protocol.

Cunﬁg: Base Radio Param

Address to Add I225.l:l.l]55

IP Addresses list
225.0.055

I <« Back " Next >> ]

Figure 2-30. Base Multicast Parameters
* Address to add: the field for IP address input
* [P addresses list: displays all IP addresses available
* Delete: deletes the highlighted IP address

* Add: adds a new address specified in the Address to add field to
the list of IP addresses

* Back: returns to the previous screen

» Next: opens the Base Antenna screen
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Config: Base (Static) Antenna

The Config: Base Antenna (Config: Static Antenna for PP Static
survey) screen contains settings for the antenna at the Base.

Cunﬁg: Base Antenna

Ant Type 3
Ant Ht IU.UUU m
Meas Type ISIant v 5

I <« Back " Next >> ]

Figure 2-31. Config: Base Antenna

» Ant Type: the type of the Topcon antenna; either CR-3, CR-3 with
Cone, CR-4, CR-4 with Cone, GR-3, HiPer GD, HiPer GGD,
HiPer Lite/Lite+, HiPer Pro, HiPerXT, HiPer+, Legant 2,
Legant3 with UHF, Legant E, Legant L1, MapAnt B, MG-Al,
MG-A2, MG-AS, Odyssey, PG-Al, PG-Al with ground plane,
PG-A1 with ground plane with Cone, PG-A2, PG-A5, Regant-
DD, Regant-SD, Regency-DD, Regency-SD, or Unknown.

» Ant Ht: the height of the antenna.

* Meas Type: the type of antenna height measurement; either
Vertical (measuring to ARP, antenna reference point) or Slant
(measuring to edge of antenna). The screen also illustrates the
measurement type.

* Back: returns to the previous screen.

¢ Next: opens the Config: Rover Receiver screen (Figure 2-33 on
page 2-28). For PP enabled surveys, first the Config: Rover PP
Setup screen will display (Figure 2-32 on page 2-27).
In the PP Static case, the Config: Occupation Times screen is
opened (Figure 2-52 on page 2-45).

« Finish: saves the changes and returns to the Select Survey Config
screen. All the settings will be transmitted only when the
configuration is used.
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Config: Rover PP Setup

The Config: Rover PP Setup screen sets raw data logging parameters
for the rover in case of PP enabled surveys.

Cunﬁg: Rover PP Setup

Raw Data Logging

File Name v
Log To |Receiver v
Logging Rate |5-UU secs
Start Log |Manual w

I <« Back " Next >> ]

Figure 2-32. Config: Rover PP Setup

Raw Data Logging: the set of logging parameters; log to the
receiver, set the logging rate, and select if the name of the receiver
file is automatically set or user-defined. In the latter case, the
corresponding dialog box will be displayed at the logging start.

The Start Log option selects whether to start logging manually or
automatically as data are being collected.

* Back: returns to the previous screen.
* Next: opens the Config: Rover Receiver screen.

* Finish: saves the changes and returns to the Select Survey Config
screen.

Config: Rover Receiver
For RTK survey type

The Config: Rover Receiver screen contains Rover settings
(Figure 2-33 on page 2-28):

e RTK Format: the format of the rover receiver differential
corrections received from the base; either CMR, CMR+, RTCM
2.1, RTCM 2.2, RTCM 2.3, RTCM 3.0.
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Elevation mask: only data from satellites with elevation angles
below this value will be used.

Cunﬁg: Rover Receiver

RTK Format MR+ %
Elevation Mask |1lII deg

I <« Back " Next >> ]

Figure 2-33. Config: Rover Receiver
Back: returns to the previous screen.
Next: opens the Config: Rover Radio screen.

Finish: saves the changes and returns to the Select Survey Config
screen. All the settings will be transmitted only when the
configuration is used.

For RTK survey types, the bitmap on the upper-left corner displays
the pop-up menu containing four items:

Output Ports: adds the Num Out Ports field to the Config: Rover
Receiver screen to set the number of ports available to output
NMEA messages (Figure 2-34 on page 2-29).

Laser Config: when selected, the Laser Connect field will appear
on the Config: Rover Receiver screen to set the device the laser is
connected to: either Receiver or Controller. The Next button
opens the Laser Config screen to configure the laser device
(Figure 2-38 on page 2-32).

RTK Protocol: adds the option to select the protocol to receive
RTK corrections (Figure 2-34 on page 2-29):

— CSD Data: through a cellular phone used as modem.
Help: accesses the Help files.
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Cunﬁg: Rover Receiver

RTK Format CMR.+ v
Elevation Mask |1lII deg

Num Out Ports |1 v
Laser Connect |Receiver v
Protocol |CSD Data v

I <« Back " Next >> ]

Figure 2-34. Config: Rover Receiver Options
For Network RTK and Network DGPS survey types

The Config: Rover Receiver screen contains Rover settings for the
survey.

Cunﬁg: Rover Receiver

Elevation Mask I deg

Protocol |NTRIP v

I <« Back " Next >> ]

Figure 2-35. Config: Rover Receiver — For Network RTK

e FElevation mask: only data from satellites with elevation angles
above this value will be used.

* Protocol: selects the protocol to receive the corrections
— NTRIP: from a NTRIP Caster
— TCP/IP: through the Internet
— CSD Data: through a cellular phone used as modem
* Back: returns to the previous screen.

¢ Next: opens the Config: Modem Connect screen.
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* Finish: saves the changes and returns to the Select Survey Config

screen. All the settings will be transmitted only when the
configuration is used.

configuring a Network RTK survey type using the

‘i ; / Refer to the TopSURV User’s Manual for details on
NTRIP protocol.

For Real Time DGPS survey type

The Config: Rover Receiver screen has the following parameters.

iER 4 Config: Rover Receiver

DGPS Format

Elevation Mask IlD deg

| << Back || Next >> |

Figure 2-36. Config: Rover Receiver — For Real Time DGPS

e DGPS Format: the format of the differential corrections received

either from the user base (RTCM 2.1, RTCM 2.2, or RTCM 2.3)
or from a beacon station (in addition RTCM 3.0 can be selected).

The field disappears when any other differential service is chosen

on the Config: Survey screen.

e Elevation mask: only data from satellites with elevation angles
below this value will be used.

* Back: returns to the previous screen.

* Next: opens either the Config: Rover Radio, the Config: Beacon,
Config: WAAS, CDGPS Radio, Config: EGNOS, or Config:
OmniSTAR screen, depending on the differential service selected
on the Config: Survey screen.
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* Finish: saves the changes and returns to the Select Survey Config
screen. All the settings will be transmitted only when the
configuration is used.

For RT DGPS survey types, the bitmap menu on the upper-left corner
contains the three items.

* Qutput Ports: adds the Num Out Ports field to the Config: Rover
Receiver screen to set the number of ports available to output
NMEA messages (Figure 2-34 on page 2-29).

* Laser Config: when selected, the Laser Connect field will appear
on the Config: Rover Receiver screen to set the device which the
laser is connected to: either Receiver or Controller. The Next
button opens the Laser Config screen to configure the laser
device (Figure 2-34 on page 2-29).

* Help: accesses the Help files.

For PP Kinematic or PP DGPS survey types

The Config: Rover Receiver screen sets the elevation mask for
satellites to be used and logging parameters (log to the receiver, set
the logging rate and select if the name of the receiver file is
automatically set or user-defined). In the latter case, the
corresponding dialog box will be displayed at the logging start.

Cunﬁg: Rover Receiver

Elevation Mask I deg

Raw Data Logging

Log To |Receiver -
Logging Rate |5.IIIIII 5ecs
File Name |Default v

I <« Back " Next >> ]

Figure 2-37. Config: Rover Receiver — For PP Kinematic and PP DGPS

* Back: returns to the previous screen.
¢ Next: opens the Config: Rover Antenna screen.

* Finish: saves the changes and returns to the Select Survey Config
screen. All the settings will be transmitted only when the
configuration is used.
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Laser Config

The Laser Config screen contains typical laser parameters and

settings.

Laser Config

[ [conce

Manufacturer v
v

Model |LaserA|:e 300

Laser Port Setting

Type |Range Finder Only w

Port |C v Baud |9600 v

Data IB hd

Parity [None | stop |1

I <« Back " Next >> ]

Figure 2-38. Laser Configuration

* Manufacturer: selects the manufacturer of laser devices.

¢ Model: the model of laser device.

* Type: the type of laser measurement system.

* Laser Port Settings: the settings (port, parity, data, baud rate, the
number of stop bits) for the laser device’s connection port to
output raw and calculated data to the peripheral device.

Table 2-2 gives supported manufacturers and models of laser devices.

Table 2-1. Laser Device

Manufacturer and Model

Manufacturer Model Type of Laser measurement
system
MDL LaserAce 300 Range Finder Only

Range Finder with Encoder

Laser Technology, Inc Impulse 200

Impels Only
Impels with Compass

* Back: returns to the previous screen.

* Next: opens the Config: Rover Radio screen.

* Finish: saves the changes and returns to the Select Survey Config
screen. All the settings will be transmitted only when the
configuration is used.
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Config: Modem Connect

The Config: Modem Connect screen displays for the rover receiver
configuration in the Network RTK or Network DGPS surveys.

Cunﬁg: Modem Connect

Modern Connect Receiver

I <« Back " Next >> ]

Figure 2-39. Config: Modem Connect

e Modem Connect: selects the device to connect the modem: either
Receiver or Controller.

* Back: returns to the previous screen.

¢ Next: opens the Config: Rover Radio screen if the modem is
connected to the receiver’s radio port. If the modem is connected
directly to the controller, the button opens the Config: Modem
Internet Info screen.

* Finish: saves the changes and returns to the Select Survey Config
screen. All the settings will be transmitted only when the
configuration is used.
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Config: Rover Radio

The Config: Rover Radio screen contains parameters for the radio
modem connected to the Rover receiver.

Cunﬁg: Rover Radio

LEL LN LG Wiinternal HiPer Lite v

Receiver Port Connected to Radio

Port |C Baud [38400 v

Parity |NU"9 ~ | Stop |1

w
Data |3 v Defaults

I <« Back " Next >> ]

Figure 2-40. Config: Rover Radio

* Radio Modem: the type of modem.

Receiver Port Connected to Radio: contains the parameters of the
connection port which are specific for the connected modem.

¢ Defaults: returns all the values to defaults in the Receiver Port
connected to radio fields.

* Back: returns to the previous screen.

* Next: displays the parameters for the chosen modem. Opens the
Rover Antenna screen if the selected modem type does not
require additional settings.

« Finish: saves the changes and returns to the Select Survey Config
screen. All the settings will be transmitted only when the
configuration is used.
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Modem parameters are the same as for the base receiver (for details,
see “Config: Base Radio Parameters” on page 2-21) except as
provided for cell phones.

Cunﬁg: Rover Radio Param

Rover PIN |1234
Base Phone Number IBIIIS.III.III.215

Phone number list:
805.0.0.215

I <« Back " Next >> ]

Figure 2-41. Rover Cell Phone Parameters
* Rover PIN: a personal identification number for the rover.
* Base Phone Number: the phone number for the base.
Add: adds it to the Phone Number List.

* Back: returns to the previous screen.
* Next: opens the Base Antenna screen.

« Finish: saves the changes and returns to the Select Survey Config
screen. All the settings will be transmitted only when the
configuration is used.

In Multi-Port mode (see page 2-16) depending on the number of ports
selected, there can be two Config: Rover Radio screens to configure
radios for data input.

Cunﬁg: Rover Radiol In

Radio Modem HiPer)(T GSM v

Receiver Port Connected to Radio

Port |C v Baud [38400 v

Parity |NU"9 ~ | Stop |1

w
Data |3 v Defaults

I <« Back " Next >> ]

Figure 2-42. Config: Rover Radio Input
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% Use only one radio to receive corrections from the
base.

In Output-Port mode, depending on the number of output ports
selected, there can be several Config: Output Radio screens to
configure radios for NMEA data output.

Config: Output Radio

The Config: Output Radio screen contains parameters for the radio
modem connected to the rover.

Cunﬁg: Output Radio2

GEL LN ALLEY WAIrLink CDMA v

Receiver Port Connected to Radio

Port A v Baud [38400 v

Parity |NU"9 ~ | Stop |1

Data |3 v Defaults

I <« Back " Next >> ]

Figure 2-43. Config: Output Radio
For details, see “Config: Rover Radio” on page 2-34.

* Next: opens the Config: Output NMEA screen. If needed the
Config: Rover Radio Param screen displays first.
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Config: Output NMEA

The Config: Output NMEA screen contains a list of NMEA messages,
Select the types of messages to issue via the specified receiver port at
the interval set in seconds.

ERd config: output nmear [ [Ee

NMEA M... | ~
v|GSA

GLL

VTG

GRS

DA

GST <

Interval |1 Sec

I <« Back " Next >> ]

Figure 2-44. Config: Output NMEA
* GGA - outputs data on time, position and positioning

* GLL - outputs data on the current latitude/longitude and
positioning state

* GNS - outputs data on time, position, and positioning of
GPS+GLONASS (GNSS)

* GRS - outputs the residual error of distance, is used to support
RAIM

* GSA - outputs the operation mode of the GNSS
receiver, the satellite used for positioning, and DOP
* GST - outputs the statistics of position errors

* GSV-—outputs the number of satellites, satellite number, elevation
angle, azimuthal angle, and SNR

e HDT - outputs the direction (heading)

* RMC - outputs time, date, position, course and speed
data provided by a GNSS navigation receiver

* VTG — outputs the traveling direction and velocity

e ZDA - outputs UTC, day, month, year, and local time zone
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Config: Beacon

The Config: Beacon screen contains settings for a radio-beacon
source of differential GPS corrections.

Cunﬁg: Beacon

Country |USA v

Station |ACUSHNET, MA v

[

Figure 2-45. Config: Beacon

| Hext == ]

* Country: the country where the radio-beacon differential service
is located.

* Station: the station that provides broadcasting differential
corrections for the rover.

* Back: returns to the previous screen.
* Next: opens the Config: Rover Antenna screen.

* Finish: saves the changes and returns to the Select Survey Config
screen. All the settings will be transmitted only when the
configuration is used.
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Configuration

The Config: WAAS screen contains settings for the WAAS source of

differential correction data.

P/N 7010-0492

Channel 1
waAS PRN# [TLCNNNN v

GPS PRN# 12 v

Tono Corr |Use sat only if avail v

Channel 2
WAAS PRN# INl:lnE e

GPS PRN# 12 v
Iono Corr

|Use sat only if avail w

I <« Back " Next >> ]

Figure 2-46. Config: WAAS

Channel I and Channel 2: two receiver channels that can be
allocated to WAAS satellites.

WAAS PRN #: the WAAS satellite’s PRN number.

GPS PRN #: the GPS satellite’s PRN number, which is associated
with the WAAS PRN number.

lono corr: enable/disable the use of ionospheric corrections from
the WAAS satellite when computing positions:

— None: ionospheric corrections are not used
— Apply if avail: use ionospheric corrections if available

— Use sat only if avail: use only the satellites for which
ionospheric corrections are available.

Back: returns to the previous screen.
Next: opens the Config: Rover Antenna screen.

Finish: saves the changes and returns to the Select Survey Config
screen. All the settings will be transmitted only when the
configuration is used.
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CDGPS Radio

The CDGPS Radio screen contains settings for the CDGPS Radio to
receive differential correction data.

e

Radio Modem |CDGPS

Receiver Port Connected to Radio

Parity |NU"9

Port |W +| Baud |334uu v
w

~ | Stop |1

Data |3

v

Defaults

I <« Back " Next >> ]

Figure 2-47. CDGPS Radio

* Receiver Port Connected to Radio: contains parameters for the
connection port: port, parity, number of data bits, baud rate, and

the number of stop bits.

* Back: returns to the previous screen.

* Next: opens the Rover Antenna screen.

* Finish: saves the changes and returns to the Select Survey Config
screen. All the settings will be transmitted only when the

configuration is used.
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Config: EGNOS

The Config: EGNOS screen contains settings for an EGNOS source
of differential correction data.

Econo conos [ )

Channel 1

EGNOS Fone %

GPS PRN# 12 v

Tono Corr |Use sat only if avail v
Channel 2

EGNOS INl:lnE v

GPS PRN# 12 v

Iono Corr |Use sat only if avail v

I <« Back " Next >> ]

Figure 2-48. Config: EGNOS

* Channel 1 and Channel 2: up to two receiver channels can be
allocated to an EGNOS satellite.

e EGNOS PRN #: the EGNOS satellite’s PRN number.

e GPS PRN #: the GPS satellite’s PRN number, which is associated
with the EGNOS PRN number.

* Jono corr: enable/disable use of ionospheric corrections from the
EGNOS satellite when computing positions:

— None: ionospheric corrections are not used
— Apply if avail: use ionospheric corrections if available

— Use sat only if avail: use only the satellites for which
ionospheric corrections are available.
* Back: returns to the previous screen.
¢ Next: opens the Config: Rover Antenna screen.
« Finish: saves the changes and returns to the Select Survey Config

screen. All the settings will be transmitted only when the
configuration is used.
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Config: OmniSTAR

The Config: OmniSTAR screen contains settings for an OmniSTAR

source of differential correction data.

[EB4 config: omnisTaR

Satellite |EA_SAT Lon 25E

AM_SAT;AP_SAT Lon 97W; J
OPTUS Lon 160E

User Defined

I <« Back " Next >> ]

Figure 2-49. Config: OmniSTAR

Satellite: the satellite that delivers differential GPS corrections.
Back: returns to the previous screen.

Next: opens the Config: Rover Antenna screen.
Finish: saves the changes and returns to the Select Survey Config

screen. All the settings will be transmitted only when the
configuration is used.

Config: Rover Antenna

The Config: Rover Antenna screen contains settings for the antenna

connected to the Rover.

Cunﬁg: Rover Antenna

Ant Type v
ARP

Ant Ht |2.IIIIIII] m

Meas Type I\."ertil:al v H

I <« Back " Next >> ]

Figure 2-50. Config: Rover Antenna

» Ant Type: the type of the Topcon antenna.
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* Ant Ht: the height of the antenna.

* Meas Type: the type of the antenna height measurement; either
Vertical (measure to ARP, antenna reference point) or Slant
(measure to edge of antenna). The screen also illustrates the
measurement type.

* Back: returns to the previous screen.

* Next: proceeds to the Survey Parms screen. For RTK, Real Time
DGPS, and Network RTK surveys with enabled post processing,
and PP Kinematic surveys, the Config: Init Times screen is the
same as the Config: Occupation Times screen for PP Static
survey. For RTK configurations with enabled mmGPS+ (refer to
“Config: Survey” on page 2-14), the Config: mmGPS+ Parms
screen opens.

¢ Finish: saves the changes and returns to the Select Survey Config
screen. All the settings will be transmitted only when the
configuration is used.

Config: mmGPS+ Parameters

For mmGPS aided RTK survey types, the configuration screens are
the same as for the standard RTK survey types. A mmGPS survey
(RTK or Network RTK) uses the usual RTK GPS+ survey system, but
with a wireless PZS-1 sensor at the rover to pick up the Lazer Zone
signal from the PZL-1 transmitter for accurate (millimeter)
elevations.

include the height of the PZS-1 sensor with 5/8 inch

‘i ; i When measuring the height of the rover antenna,
plug.

The Config: mmGPS+ Parms screen adds a millimeter GPS+
selection to the RTK survey being configured (see Figure 2-51 on
page 2-44):

* Receiver port: selects the port used for communication between
the receiver and PZS-1 sensor (typically port D).
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* Sensor Gain: select Auto to automatically control the mmGPS
receiver's detection level of the transmitter's signal.

* Height Difference Limit: sets the threshold for the difference
between GPS and mmGPS+ height measurements.

e

onfig: mmGPS+ Parms

Receiver Port ID v
Sensor Gain IAutl:l -

Height Difference Limit IIII.BIIIIII m
[]Init Time Improvement

[ ] weighted Height

I <« Back " Next >> ]

Figure 2-51. mmGPS+ Parameters

Init Time Improvement: select to use the mmGPS signal to assist
in initializing the GPS receiver. This option is useful to decrease
the initialization time when satellite visibility is limited (for
example, tracking only four or five satellites).

* Weighted Height: select to combine mmGPS elevations and GPS
elevations. This option will force the receiver/sensor to always
consider the angle and distance when determining the elevation,
then combine the two elevations accordingly. This option works
well at large (300m) distances and steep angles.

* Back: returns to the previous screen.

* Next: proceeds to the Survey Parms screen. For RTK, Real Time
DGPS and Network RTK surveys with enabled post processing,
and PP Kinematic surveys, the Config: Init Times screen is the
same as the Config: Occupation Times screen for PP Static
survey.

¢ Finish: saves the changes and returns to the Select Survey Config
screen. All the settings will be transmitted only when the
configuration is used.
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Config: Initialization (Occupation) Times

The Config: Init (Occupation) Times screen contains timing settings
for the receiver loggings, used in automatic mode during a PP Static

Survey, and depends upon the number of satellites available and the
number of frequencies used.

Cl:lnfig: Init Times Cancel

Initialization tirme in minutes: CDﬂfigi Occupation Times
Mum Ss Single Freq Dual Freq Occupation times in minutes:

4 Iﬂ— |2D— Murm Shs Single Freq Dual Freq
5 o1 [p5 ] 4 m | B

<< Back | Next >>

| << Back || Next >> |

Figure 2-52. Config: Initialization/Occupation Times

e [nitialization (Occupation) Time in minutes: these are time
values, depending upon numbers of satellites and frequencies. For
example, the default for six GPS/GLONASS (6+) dual frequency
satellites is ten minutes. This means that for PP enabled RTK and
PP Kinematic surveys, the complete rover file should be at least
this long. Individual occupations can be different. For Static
surveys this means each station (Occupation) should be occupied
for at least ten minutes.

* Back: returns to the previous screen.

* Next: proceeds to the next screen (PP Static: Config: Stakeout
Parms; PP enabled RTK and PP Kinematic: Config: Survey
Parms).

* Finish: saves the changes and returns to the Select Survey Config
screen. All the settings will be transmitted only when the
configuration is used.
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Config: Survey Parameters

The Config: Survey Parms screen sets the parameters used by default
during the survey. These parameters can be changed with the help of
the Settings button from any Survey screen in GPS+ mode.

Cunﬁg: Survey Parms

Solution Type Fixony 2

Auto Accept

Hum Meas to Avg |3

[ Precision (m) Hz  [0.015 vert [0.030

Auto Topo

Method IBy Hz Dist + | Interval |15.0 m

I <« Back " Next >> ]

Figure 2-53. Config: Survey Parameters

* Solution Type: sets the solution type for each epoch. Depending
on the survey type chosen, it can be selected from “Fix
mmGPS+”, “Fix Only”, “Fix and Float mmGPS+", “Fix and
Float”, “Fix, Float, DGPS”, “DGPS”, “DGPS, Auto”, or “All”.

— Fix mmGPS+: positions were computed by the RTK engine

using the carrier phase measurements from the base receiver
and mmGPS aided rover receiver. Integer ambiguities were

— Fix: positions were computed by the RTK engine using the

carrier phase measurements from base and rover receivers.
Integer ambiguities were fixed.

— Float: positions were computed by the RTK engine using the

carrier phase measurements from base and rover receivers.
Integer ambiguities, however, were NOT fixed (their float
estimates were used instead).

— DGPS: positions were determined using only the pseudo-

range measurements or carrier-phase pseudo-ranges.

— All: positions were computed using all epochs accepted,
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— Auto: autonomous positions when differential corrections are
not available.

* The Auto Accept field sets parameters for automatic acceptance
during a stationary survey. These are:

— Num Meas to Avg: sets the number of measurements used for
averaging, as needed.

— Precision: sets Horizontal and Vertical precision values, if to
be taken into account. If both Precision and Num Meas To
Avg are checked, both these conditions must be satisfied
before the coordinates are accepted.

* The Auto Topo field sets parameters for kinematic surveys. These
are:

— Method: defines the method for measuring the interval
between the received epochs; by time, by horizontal distance,
or by slope distance.

— Interval: sets the value of this interval.
* The bitmap menu on the upper-left corner contains two items:

— Point Code: opens the Point Code screen to select an option
to enter feature codes when surveying points.

— Help: accesses the Help files.

Point Code

The Point Code screen enables a prompt to appear to set feature codes
attributes for the points being surveyed.

Feature Code m

|:| Prompt for Feature Codes:

Figure 2-54. Point Code
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For PP Kinematic or PP DGPS, the Config: Survey Parms screen
displays the following parameters.

Cunﬁg: Survey Parms

Topo

Number of Epochs |§|

Auto Topo

Method IB‘Jr Time |« Interval [5.00 sec

I <« Back " Next >> ]

Figure 2-55. Config: Survey Parameters
* Topo: enter the number of epochs to log on each location.

* Auto Topo: sets the time interval between locations. Only this
method is currently available.

* Back: returns to the previous screen.
» Next: opens the Config: Stakeout Parms screen.

* Finish: saves the changes and returns to the Select Survey Config
screen. All the settings will be transmitted only when the
configuration is used.

Config: Stakeout Parameters

The Config: Stakeout Parms screen sets the parameters that will be
used by job during a stakeout (Figure 2-56 on page 2-49). These
parameters can be changed with the help of the Settings button from
any Stakeout screen in GPS+ mode.

* Hz Dist Tolerance: sets when the graph will switch to a bull’s eye
in Stakeout.

* Reference Direction: sets the reference direction for stakeout. The
reference direction can be North, moving direction, moving
direction + North, the direction to the reference point, or a
reference azimuth. Moving Direction +North is similar to the
Moving Direction option, but displays the North direction when
the user is within 3 meters of the design point.
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Cunﬁg: Stakeout Parms

Hz Dist Tolerance

Store Staked Point As

D.0500 m
Reference Direction IMmring Direction

Configuration

Solution Type

Point  |Design Pt Suffix v
Note IDesign Point v

IFix Only w

|_stk

I <« Back " Next >> ]

Figure 2-56. Config: Stakeo

points:

ut Parameters

* The Store Staked Point As field sets the rule for naming staked

— Point: sets the rule for defining names for the staked-out

points; either design point name,

next point name, design

point with a pre-defined prefix (that is, stk_01, where “stk_”
is the prefix), or design point with a pre-defined suffix.

The choice of the prefix or suffix appears only when the
corresponding item is chosen from the drop-down menu.

Also, a specified numerical cons

tant can be added

automatically to generate the staked point name.

Store Staked Point As

Cl:lnfig: Stakeout Parms
Hz Dist Tolerance ID.DSDD m
Reference Direction

IMoving Directiaon :I

Point

Design PH+Constant El
MNote tation & Offset

|1000

B

Solution Type

IFix Only :I

| << Back || Next >> |

Figure 2-57. Design Point Name + Constant

For instance, if the constant spec
point is 100, the staked point wo

ified is 1000, and the design
uld be named 1100 (that is,

100+1000). If the design point is alphanumeric, the constant
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will be appended to the name. For example, for the design
point ALPHA, the corresponding staked out point will be
named ALPHA1000.

— Note: sets the rule for setting Notes for the staked out points;
either design point name, design point with a prefix, or design
point with a suffix.

Also, it can be Station & Offset information.

If the Station & Offset option is activated, an edit box for
entering alphanumeric prefix will appear. For the US, this
prefix is “Sta”, for the international markets is “Cha”, and for
the Korean/Japanese markets is “No.”. With this option
activated, depending on the choice for the prefix, TopSURV
will automatically generate one note for each stakeout point
as: Sta5+5.5R5.0 or Cha505.5R5.0 or No.5+5.5R5.0

* Solution Type (for real time surveys only): defines the type of
position solutions that should be used for the stakeout: Fix Only;
Fix and Float;, Fix, Float, DGPS; DGPS; DGPS, Auto; or All.

* Back: returns to the previous screen.
* Next: opens the Config: Advanced screen.

* Finish: saves the changes and returns to the Select Survey Config
screen.

* The bitmap menu on the upper-left corner contains two items:

— Display: opens the Staked Point Icon screen to set an icon for
the staked point.

— Help: accesses the Help files.
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Staked Point Icon

The Staked Point Icon screen selects options to display the icon for
the staked point on the map.

Staked Point Icon m

Use icon for staked point

Staked point
Icon |UUELENEED] w

Color [ ... | P

Figure 2-58. Staked Point Icon

* Use icon for staked point: enables display of the staked point on
the map.

* Staked point: specifies and displays a colored icon for the staked
point.

* OK: saves the changes and returns to the Config: Stakeout
Parms screen.

Config: Advanced

The Config: Advanced screen sets several additional parameters for
the GPS+ mode.

Cunﬁg: Advanced

[]Co-Op Tracking

Satellite System IGP5+GL0NASS v
RTK Position IExtrapuIatiun w

Figure 2-59. Config: Advanced

P/N 7010-0492 2-51



Job

The Multipath reduction is used when a signal received includes
multiple reflections from nearby objects. Check the Multipath
Reduction field to use this mode during the survey.

Co-Op tracking: involves additional resources for acquisition of
the signal, phase-lock, and delay-lock loops.

Satellite system: defines the system of satellites to use.

RTK Position (only for real time surveys): selects the method of
RTK corrections definition; either Extrapolation or Matched
Epoch (sometimes described as asynchronous or synchronous,
respectively).

Back: returns to the previous screen.

Finish: saves the changes and returns to the Select Survey Config
screen. All the settings will be transmitted only when the
configuration is used.
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Total Station Configuration

To configure a total station survey, press the button in the 7'S Config
field of the Select Survey Config screen.

Configurations

For TS configurations, the Configurations screen presents a list of
available configurations for Total Stations.

Configurations m

Configuration Name |
My Conventional

My Reflectorless

My Robotic

My Level

| pelete || Edt || add

Figure 2-60. TS Configurations

Delete: deletes the configuration.

» Edit: changes the configuration settings.

Add: adds a new Configuration.
¢ OK: returns to the Select Survey Configurations screen.

If the Contractor Module is selected in the TS mode (see “Mode” on
page 2-123), only Conventional and Reflectorless configurations are
available for use by non-surveyors doing construction stakeout with
total stations.
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Config: Survey

The Config: Survey screen contains general settings for the
configuration.

Name My Conventional

Type ICunventiunaI v

Figure 2-61. Config: Survey

* Name: the name of the configuration that will be displayed in the
Configurations screen.

* Type: the type of the Configuration; either Conventional,
Reflectorless, Robotic, or Level.

* Next: opens the Config: Instrument screen.

* Finish: saves the changes and returns to the Select Survey Config
screen. All the settings will be transmitted only when the
configuration is used.

Config: Instrument

The Config: Instrument screen (Figure 2-62 on page 2-55) contains
typical total station parameters and communication settings.

* Manufacturer: defines if a Topcon instrument is used. For
Conventional and Reflectorless surveys also Sokkia, Nikon and
Leica instruments can be defined. For survey emulation, Manual
Mode can be used.
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* Model: sets the model of the instrument, taking into account the
type of the configuration. For Robotic types, only motorized
models will be displayed in the drop-down menu.

Manufacturer

Cl:lnfig: Instrument

R~ |

Model

|GTs-B004 /5104

[-]

| << Back || Next >> |

Figure 2-62. Config: Instrument

Table 2-2 gives Topcon instrument models and their available

functionality.

Table 2-2. Instrument Model and Available Functionality

Topcon instrument models are:

GTS Series — Conventional

GTS-220 — Conventional

GTS-230/230W — Conventional
(Bluetooth)

GTS-600 — Conventional

GTS-720/720W — Conventional

GTS-800/810 — Conventional

GTS-800A/810A — Conventional and
Robotic

GTS-820A — Conventional and Robotic

GTS-900A — Robotic

AP-L1A — Conventional and Robotic

AP-L1 — Conventional and Robotic

GMT100 — Conventional

GTS 1/GTS 3 — Conventional

GRT 2000 — Conventional and Robotic

GPT 1000 — Reflectorless

GPT 2000 — Reflectorless

GPT 6000 — Reflectorless

GPT 3000/3000W/3000L — Reflectorless

GPT 7000/7000W/7000L — Reflectorless

GPT 8000 — Reflectorless

GPT 8200 — Reflectorless

GPT 9000 — Reflectorless

GPT 8000A/8200A/9000A —
Reflectorless and Robotic

DL-101 — Level

DL-102/102C - Level

Sokkia instrument models are:

SET3, SET4, SET5, SET300, SET400, or SET500

Nikon instrument model are:
DTM (SET)

Leica instrument models are:
TCR400 or TCR700

* Back: returns to the previous screen.
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* Next: opens the Config: Conn Mode screen for Total Stations
and Config: Cable screen for Levels.

* Finish: saves the changes and returns to the Select Survey Config
screen. All the settings will be transmitted only when the
configuration is used.

In Robotic mode, the bitmap on the upper-left corner of the screen
displays the Monitor item, in addition to the usual Help item.

Monitor Options

Selecting the Monitor item opens the Monitor Options screen to set
the parameters for a Monitor survey.

Ml:lnitl:lr Options m
Log To v [ER4 vonitor options | ox_|
Output Type |Raw Data v Log To |c0M2 v

Output Format IFc_ﬁ,lGTs_jr v Output Type IRaw Data w
File Name Iiles\OUTPUT.gts? E Output Format | FeEfTe) 5] v

Comm Settings

Baud |1152IZIIII ~ | Parity |N|:|ne v

Data |8 v Stop |1 v

Figure 2-63. Monitor Options

* Log To: sets whether the data will be output to a File, COM1 port,
COM2 port, Bluetooth, or None.

* Qutput Type: currently sets only the Raw data to output.

* Output Format: sets in which format to output the data: FC-5,
FC-6/GTS-7 or GTS-6.

Available options vary depending on whether File or a COM port is
selected.

e File Name: sets the file name.

[ browses for the destination of the file and sets the default
file extension.

* Comm Settings: sets the communication parameters for the port.
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¢ OK: saves the settings made and returns to the Config:
Instrument screen.
Config: Connection Mode

The Config: Conn Mode screen selects the connection mode to
manage communication between the total station and data controller.

Cunﬁg: Conn Mode

Initial TS Connection

[EEE———
Optical
|N|:|ne -

Note: The connection mode can be
changed in any of the measurement
screens.

I <« Back " Next >> ]

Figure 2-64. Config: Conn Mode

e [Initial TS Connection: selects a communication course between
the total station and the data controller according to the optional
device used. Depending upon the type of the instrument, it can be
the following:

— Cable: for connection using the RS-232 cable
— Radios: for radio communication

— RC2 Only: for optical communication using the remote
controller RC-2

— RC3 Only: for optical communication using the remote
controller RC-3

— Bluetooth TS: for establishing a Bluetooth connection

* Optical: selects the connection course between the field
controller and the remote controller RC-2/RC-3 in case carrying
out optical communication with the total station. It can be RC2/
RC3 Cable, RC2/RC3 Bluetooth, or None.

* Back: returns to the previous screen.

¢ Next: opens the Config: Cable screen.
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* Finish: saves the changes and returns to the Select Survey Config
screen. All the settings will be transmitted only when the
configuration is used.

Config: Cable

The Config: Cable screen contains the parameters of the cable
connection.

* Cable Comm Settings: the parameters for the cable connection:
Baud (baud rate), Parity, Data (number of the data bits), and Stop
(number of the stop bits).

e

Cable Comm Settings

Baud v
Parity IEven v
Data I? -
Stop |1 v
I Default ] I <« Back " Next >> ]

Figure 2-65. Config: Cable

* Default: restore settings to default values if they have been
modified.

* Back: returns to the previous screen.

* Next: opens the Config: Radio screen (for Robotic surveys),
Config: Mode (for motorized Conventional or Reflectorless
surveys), or Config: Survey Parms (for Conventional,
Reflectorless, or Level surveys).

* Finish: saves the changes and returns to the Select Survey Config
screen. All the settings will be transmitted only when the
configuration is used.
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Config: Radio

The Config: Radio screen sets the parameters of the modem
connected to the total station.

Cl:lnfig: Radio

Tyoe [EE |

Radio Comm Settings

Baud I%DD :I
Parity INone :I
Data IEI :I
Stop |1 :I
| Configure Radio | | << Back || Next >> |

Figure 2-66. Config: TS Radio
* Type: the type of modem; either Satel, Pacific Crest or Generic.

* Radio Comm Settings: sets radio communication parameters:
parity, number of data bits, baud rate, and the number of stop bits.

* Configure Radio: opens the Config: Radio Parms screen for a
Satel or Pacific Crest radio (see Figure 2-28 on page 2-24 and
Figure 2-29 on page 2-24).

* Back: returns to the previous screen.

¢ Next: opens the Config: Search/Track screen (refer to “Config:
Search/Track” on page 2-61).

« Finish: saves the changes and returns to the Select Survey Config
screen. All the settings will be transmitted only when the
configuration is used.
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Config: Mode

The Config: Mode screen contains the parameter defining the turning
ability of conventional total stations. This mode is available only for
motorized instruments in Conventional and Reflectorless modes of
operation.

Auto Tracking
|Aut3 Tracking [~

| << Back || Next >> |

Figure 2-67. Config: Mode

Motorized total stations can support Auto Tracking and Auto Aiming
mode.

Table 2-3. Motorized Total Stations

GTS-800/810/900 — Motorized AP-L1 — Motorized and Auto Tracking
GTS-800A/810A/820A/900A — AP-L1A — Motorized and Auto Tracking

Motorized and Auto Tracking/Aiming | GRT-2000 — Motorized and Auto
GPT-8000 — Motorized Tracking

GPT-8000A/8200A — Motorized and GMT-100 — Motorized
Auto Tracking/Aiming

e Enable Motor Turning: sets the motor to active mode.

* Auto Tracking: if motor turning is enabled, sets the motorized
total station into remote control, or a fully automatic mode of
operation.

— The Auto Tracking mode causes the total station to track the
reflector as the surveyor moves from point to point.

— The Auto Tracking/Auto Aiming mode causes the instrument
to find the prism in the pre-defined region.

— The No Aiming/No Tracking mode disables the total station
operation program.
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* Back: returns to the previous screen.
* Next: opens the Config: Search/Track screen.

* Finish: saves the changes and returns to the Select Survey Config
screen. All the settings will be transmitted only when the
configuration is used.

Config: Search/Track

The Config: Search/Track screen contains parameters for signal
tracking for motorized total stations. Parameter values and
accessibility depend on the selected total station model.

Cl:lnfig: SearchjTrack

Turning Speed Iw :I rm
Start Search After |5 :I sec
Pattern IF‘attern 1 :I

Range {dms)
Trk Speed |Survey El Hz |5 El
Sensitivity |High [=] [vert |5 E—‘
Track Light ~ [Off ]

Scan Range IWide : I

| << Back || Next >> |

Figure 2-68. Config: Search/Track

* Turning Speed: sets the turn speed of a total station in revolutions
per minute.

o Start Search After: sets the delay between the loss of the signal
and the start of searching.

* Pattern: sets the program for tracking and searching.

— Normal (for AP-L1A and GRT-2000) or Pattern I mode
searches for the prism at the point where the prism was lost.
The instrument gradually searches in up and down directions,
and will continue until the prism is found.

— High (for AP-L1A and GRT-2000) or Pattern 2 mode
searches for the prism for a set amount of time. The
instrument searches from up to down and continues until the
prism is found, or after a maximum of six attempts.
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Auto tracking mode changes to manual mode when the prism
cannot be found within six attempts, and returns to the point

where the prism was lost.!

Trk Speed: sets the speed for tracking; either slow, medium, or
fast. For TS models with Auto Tracking, sets the speed mode
according to the purpose of measurement: Survey - for fixed point
observation, or Machine Control 1, 2 - for controlling of
construction machinery or real time surveying of various
travelling objects.

Sensitivity: sets the detection sensitivity of the accepted signal;
either low, medium, or high.

Track Light: sets the light on the line of sight to be enabled or
disabled.

Scan Range: sets the width of the tracking signal; either narrow,
middle, or wide. Available only in the AP-L1A and GRT-2000
total stations.

Range: sets the range of searching or tracking, in degrees, for the
vertical and horizontal planes.

Back: returns to the previous screen.
Next: opens the Config: Survey Parms screen.

Finish: saves the changes and returns to the Select Survey Config
screen. All the settings will be transmitted only when the
configuration is used.

1. For details, refer to the “Automatic Tracking Total Stations. GTS-800A
Series” Instruction Manual.
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Config: Survey Parameters

The Config: Survey Parms screen contains the default parameters
that will be used during the survey. They can be changed with the help
of the Settings button from any Survey screen.

Cl:lnfig: Survey Parms

Meas Method finigle/Dist Sets-Dir/Rev
Angle Sequence |EISIFS Plunge FS/BS [~
Murn Sets |1 :I Tolerances

Hz IS.D SBC
Distance Averaging

ist, ID.DDE\

|:| Measure Reverse Dist D5 m
[ 2uto Advance Set VA IS.D sec

[ 2uto Accept Meas

| << Back || Next >> |

Figure 2-69. Config: Survey Parameters — First Screen

e Meas Method: sets the mode of side-shot measurements; either
Sideshot-Direct, Sideshot Direct/Reverse, or Angle/Dist Sets-Dir/

Rev. See “Observations” on page 6-8 for a description of these
methods.

In the Contractor Module, the only measurement supported is
Sideshot-Direct (Figure 2-70).

Cunﬁg: Survey Parms

Meas Method jSideshot-Direct v
Tolerances
Hz |5.III sec
Dist. Il:l 006 m
VA |5.III sec

I <« Back " Next >> ]

Figure 2-70. Config: Survey Parameters in the Contractor Module

» Angle Sequence: sets the sequence of measured angles. (Available
in the Angle/Dist Sets-Dir/Rev mode.) Here, FS is foresight point
(the next occupation point), BS is backsight point (the previous
occupation point), and Plunge term stands for flipping and
rotating the total station telescope by 180 degrees. These are used
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for the reduction of the angle errors. Possible sequences are BS/
FS Plunge BS/FS; BS/FS Plunge FS/BS; FS/BS Plunge BS/FS;
FS/BS Plunge FS/BS; BS Plunge BS/FS Plunge FS; or FS Plunge
FS/BS Plunge BS.

Num Sets: the number of measurement sets participating in the
average. Here the Num Sets defaults to 1 and cannot be changed
if Sideshot-Direct or Sideshot Direct/Reverse is selected in the
Meas Method field. Selecting Angle/Dist Sets-Dir/Rev in the
Meas Method field allows for NumSets to be greater than 1.

Tolerances: the admissible deviation values of the horizontal and
zenith angles and the distance.

Distance Averaging: defines if the distance used is measured
using one signal or the average of several signals.

Measure Reverse Dist: enables reverse distance measurements.
These are used for the reduction of the distance measurement
errors.

Auto Advance Set: sets the Automatic Repetition of the
measurements to active mode, the survey automatically advances
to the next set. This field can be enabled only for motorized
surveys and only if a Meas Method of Angle/Dist Sets-Dir/Rev is
selected.

Auto Accept Meas: activates the review of automatic repetition
needed to accept each measurement. This field can be enabled
only for Robotic, non-RC2 surveys and only when a Meas
Method of Angle/Dist Sets-Dir/Rev is selected

Next: opens the next Config: Survey Parms screen.

Finish: saves the changes and returns to Select Survey Config.
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The next Config: Survey Parms screen contains the additional survey
parameters.

Cunﬁg: Survey Parms

Meas Type Im
EDM Mode [Fine 1mm <]
Prism Constant IU mm
Point Guide brism 3

Auto Topo
Method |B‘1r Time « | Interval |1.IIIIII sec

I <« Back " Next >> ]

Figure 2-71. Config: Survey Parameters — Second Screen

* Meas Type: sets the order and the type of the measurements in

one set.
— HA: horizontal angle — HD: horizontal distance
— VA: vertical angle — VD: vertical distance

— SD: slope distance

* EDM mode: sets distance measuring mode, coarse or fine, that
determines the sensitivity to use for the distance measurements.
Fine is a normal mode, coarse mode measures in a shorter time

* Prism Constant: the parameter of the prism, characterizing the
difference between the reflection plane and the center of the
prism.

* Point Guide: check if it is desired to operate the tracking lights.
* Non-Prism: check to enable the non-prism mode.

* AutoTopo (only for robotic total stations): the parameters of the
automatic survey.

* Back: returns to the previous screen.
¢ Next: opens the Config: Stakeout Parms screen.

* Finish: saves the changes and returns to the Select Survey Config
screen. All the settings will be transmitted only when the
configuration is used.
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Config: Stakeout Parameters

The Config: Stakeout Parms screen sets the default stakeout
parameters. These parameters can be changed using the Settings
button from any Stakeout screen in TS mode.

Cl:lnfig: Stakeout Parms

Hz Dist Talerance IMI mm
Reference Direction IInstrument Reference :I

Store Staked Point As
Point  [Desion Ptoufic || [ st

Mote IDesign Point :I
Turn TS to Design Pt IHA only :I

[ Search After Turn

| << Back || Next >> |

Figure 2-72. Config: Stakeout Parameters

* Hz Dist Tolerance: sets when the graph will switch to a bull’s eye
in Stakeout.

* Reference Direction: sets the direction assumed to be the
referenced one during the stakeout. For now, it can be Instrument
Reference only.

* Store Staked Point As field: sets the rules for staked points
naming. This is the only field needed for a Level survey.

— Point: sets the rule for defining names for the staked-out
points; either design point name, next point name, design
point with a pre-defined prefix (that is, stk_01, where “stk_"
is prefix), design point with a pre-defined suffix, or design
point with a specified numerical constant added
automatically (for details on staked point name generation,
see page 2-49).

— Note: sets the rule for defining Notes for the staked-out
points; either Design Point, Design PT Prefix, Design PT
Suffix, or Station & Offset (for details, see page 2-49).

* Turn TS to Design Pt controls the way the total station turns
toward the design point.
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* Search After Turn: causes the instrument (only for motorized
surveys) to search for the prism after turning to the design point.

Back: returns to the previous screen.

Next: opens the Config: Miscellaneous screen.

Finish: saves the changes and returns to the Select Survey Config
screen. All the settings will be transmitted only when the
configuration is used.

The bitmap menu on the upper-left corner contains two items:

— Display: opens the Staked Point Icon screen to set an icon for
the staked point like in GPS configurations (“Staked Point
Icon” on page 2-51).

— Help: accesses the Help files.

Config: Miscellaneous

The Config: Miscellaneous screen is used to customize the user
interface:

Cunﬁg: Miscellaneous
¥|Stakeout Sound ~
Manual Stakeout Update {Robotic Only)
v Beep on Storing Points
VA Zero at Level
Use Horizontal Angle Left
v| Automatically display BS Setup screen
4| Hold Offset Measurement
v|BS Is Always Required

< 4

Figure 2-73. Config: Miscellaneous

* Display Coordinates after Measurement: when checked,
computed coordinates are displayed automatically after a total
station measurement is performed and before the point
coordinates are stored into the database.

» Apply Earth Curvature and Refraction: corrects the computed
heights for Earth Curvature (Vertical Distance) and slope
distances and vertical angles for atmospheric refraction.
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Prompt for Rod Height: when checked, prompts for a height of a
Rod (Target) before a point is stored.

Prompt for BS Check: when checked, will bring up the Backsight
Check screen when the Backsight Setup screen is exited.

Prompt for Feature Code: when checked, a dialog will appear to
specify the control code and attribute before a surveyed point is
stored.

Stakeout Sound: makes a sound each time a point is staked-out.

Manual Stakeout Update (Robotic Only): when checked, the
Meas button in a Stakeout screen must be pressed to make a
measurement to the Robotic Total Station. When not checked the
measurements are recorded continuously. This applies to the
Stakeout screens only.

Beep on Storing Points: beeps each time a point is stored.

VA Zero at Level: if checked, vertical angle measurements are
oriented to be zero at the Horizontal (“Level”) direction. If this
option is unchecked, vertical angle measurements are oriented to
be zero at the vertical (“Zenith”) direction (default). Only certain
Total Stations allow TopSURYV to set this value. For this reason,
ensure that this option is set to the same value in the total station
as is set in TopSURV.

Use Horizontal Angle Left: if checked, the horizontal angle
measurements are shown in a counter-clockwise (“Left”)
direction. If this option is unchecked, the horizontal angle
measurements are shown in a clockwise (“Right”) direction
(default). TopSURYV will automatically set the Total Station to
“HR” or “HL” depending on the selection.

o Automatically display BS Setup screen: if checked, the Backsight

Setup screen displays automatically when attempting to access
any of the screens involving total station observations.

Hold Offset Measurement: if checked, the screen to measure an
offset point with the help of the selected offset tool displays
automatically after each measurement.
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* BS Is Always Required: if checked, a warning to set Backsight
always displays when attempting to access any of the screens
involving total station and level observations.

* Back: returns to the previous screen.

* Finish: saves the changes and returns to the Select Survey Config
screen. All the settings will be transmitted only when the
configuration is used.

For the Level survey type, the Config: Miscellaneous screen contains
some specific user interface parameters.

Cunﬁg: Miscellaneous Finish | Cancel

Display Coordinates after Measurement
Apply Earth Curvature and Refraction
Prompt for Feature Codes

¥|Stakeout Sound

v Beep on Storing Points

v Hold vertical Offset

Figure 2-74. Config: Miscellaneous — Level

e Prompt for Feature Codes: when checked, the Code-Attributes
dialog will appear to specify the code and attributes before a
surveyed point is stored.

* Hold Vertical Offset. available only for the digital level; if
checked, the vertical offset is added automatically to each
measurement.
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Global

To set general settings in TopSURYV, tap Job » Config » Global. The
Global screen sets the mode for performing linework.

Use Bold Font
Enable Job History

Auto Linework

Type ICude—CuntmI Cod
Control Code Delimite I_ v
Code File Is\GLOBl.me

Figure 2-75. Global sCREEN

e Use Bold Font: if checked, uses the bold font on the controller
display to see more clearly.

* Enable Job History: if checked, saves every surveyor’s operation
on the job in a history file.

* Auto Linework: selects the type of linework to form open and
closed polylines:

— Code-String: all points with the same unique combination of
Code and Strings are connected to form a line. This line is
named as “~~~Code&String”.

— Point/Line/Area: all points are selected to be a part of either
points or named lines or areas (GIS mode). Areas in this
mode are simply closed lines. Strings and control codes are
not supported in this mode.

— Code-Control Code: the control codes /BEG and /END are
indicated along with codes to start and end lines. All points
with the same code between and indicating the points with
the /BEG and /END control codes are then connected in the
measurement order to form a line. This line is named as
“~mnrCode& XXX XXXXX”, where the XXXXXXXX is an
automatically generated number which increments for each
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additional line created. Strings cannot be entered in this mode

* If the selected mode is either Code-String or Code-Control Code
mode, then the Control Code Delimiter option selects a delimiter
for entering control codes along with codes in a single field,
separated by this delimiter.

* Code File: sets a Global Data Dictionary file to use the file’s
codes and layers with the currently selected job. Tap the Browse
button to select the necessary file.

* OK: saves the changes and returns to the main screen.

Coordinate System

Job » Config » Coord Sys opens the Coordinate System screen. The
Coordinate System screen contains coordinate system information for

the job.

Coordinate System

Projection | <nane= L .

Use GridfGround

Daturn EEE v | ..
Genid Madel |<n0ne> v

I <« Back ”]

Figure 2-76. Coordinate System

* Projection: specifies the projection used. The E] button opens

the Projections screen where active projections can be

manipulated (added from a list of pre-defined projections,

deleted).

» Use Grid/Ground: when a grid projection is selected, this box

becomes available. If checked, the E button is activated to

open the Grid to/from Ground Param screen where
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transformation parameters are set to place grid coordinates to a
near ground reference surface and vice versa.

* Datum: shows the datum for the selected projection. The
drop-down list of datums is available only when the current grid
projection allows appropriate datum selection.

Note, that the NAD83 datum has three independent realizations in
TopSURYV with respect to the WGS84 datum:
- NADS3: sets the following seven transformation parameters

DX=-0.9956 m, DY=1.9013m, DZ=0.5215m

RX=-0.025915", RY=-0.009426", RZ=-0.011599"
IScale=0.00062

- NAD83(ITRF96): provides the following set of
transformation parameters

DX=-0.991 m, DY=1.9072m, DZ=05129 m
RX=-0.02579", RY=-0.00965", RZ=-001166"
Scale=0.0

- NAD83_NO_TRANS: uses zero transformation parameters
to equal WGS84 with NADS3 as realized in 1986

The E] button opens the Custom Datums screen to add/edit
user-defined datums.

* Geoid Model: shows the geoid selected (if any). The E]
button opens the Geoids List screen where geoids can be added,
deleted, or their properties viewed.

* Back: returns to the previous screen.
* Next: opens the Units screen.

* Finish: saves the settings, and returns to the main screen.
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The Projections screen contains a list of cataloged projections, that

can be chosen for use in the job.

Projections

Pre—Deﬁned E Active

Global

- ELrope

iddle East

- South America
B-LSA

<

>

UTMMorth-Zone_37

Figure 2-77. Projections

* Pre-Defined: contains the tree of available projections divided by

regions.

¢ Custom: opens the Custom projections screen to add/edit user-
defined projections.

* Active: contains the list of chosen projections (corresponds to the
drop-down list in the Projections field of the Coordinate System
screen). The first time the screen is opened, it is empty.

. : selects the chosen projection in the Pre-Defined panel and

inserts it into the Active panel.

: deletes the highlighted projection from the Active panel.

* OK: saves the changes and returns to the Coordinate System

screen.
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Custom Projections

The Custom Projections screen contains a list of custom projections
(grid systems). Initially, this list is empty.

Custom Projections

Projection

< >
| pelete || edat || add |

Figure 2-78. Custom Projections

* Add: opens the Custom Projection screen to enter parameters of
the new custom grid system.

* Edit: opens the Custom Projection screen to edit parameters of
the selected custom grid system.

* Delete: deletes the selected custom grid systems.

Custom Projection

The Custom Projection screen sets parameters for the new custom
grid system.

Custom Projection

Narne

Type |Transverse Mercator v
Daturm IW E
Region |Ohi0

MNote (Chio TM projection

Figure 2-79. Custom Projection

* Name: sets the name of the new projection.

* Type: selects a sample projection from the list of available types:
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— Albers Equal Area (orthembadic) conic projection.

— Cassini-Soldner cylindrical projection.

— Double Stereographic conformal azimuthal projection.

— Lambert conformal conic projection.

— Oblique Mercator conformal cylindrical projection.

— Stereographic conformal azimuthal projection.

— Transverse Mercator conformal cylindrical projection.
e Datum: selects the datum for the projection from the list of

available types.

o E] : opens the Custom Datums screen to add/edit user-

defined datums.
* Region: displays the region.
* Note: any additional information about the projection.

* Finish: saves the changes, closes the screen and returns to the
Custom Projection screen.

» Next: opens another Custom Projection screen to enter the new
projection specifications depending on the sample projection
selected.

If the Transverse Mercator projection is selected as the sample, the
Custom Projection screen displays the following fields:

Custom Projection

Central Meridian |EEERENNN 0000}

Scale Il.DDDD 150

LatD 40.070000000
EastO 10000.000 m
Morthd IlDDDD.DDD m

Figure 2-80. Custom Projection Parameters
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Central Meridian: longitude of the central meridian of a zone.
Scale: scale factor on the central meridian.

Lat0: latitude of the origin of the projection.

East0: false Easting of the origin of the projection.

NorthQ: false Northing of the origin of the projection.

The Latitudes are entered as a positive number in
the Northern Hemisphere, and as a negative number
in the Southern one. The Longitudes are positive for
Eastern directions and negative for Western
directions relative to the GMT line.

Grid to/from Ground Parameters

A ground projection is a grid mapping projection re-scaled to convert
point coordinates to another reference surface (up to average project

elevation) to produce near ground values. The ground system can be

rotated and shifted relative to the grid system. The ground coordinates
can be converted back to the grid projection.

The Grid to/from Ground Params screen contains the parameters of
the Grid to Ground and Ground to Grid coordinate transformation.

Grid toffrom

Parameters

Ground Param m

j5cale Factor v

Direction |

Scale Factor

Az Rotation
Origin {

East
Height

0.000

m
North |0.000

Grid to Ground v

|1 .00000000

0.00000000 dms

Offsets (m)

MNorth IIII.IZIIIIIJ
East Il:l.l:ll:ll:l

0.000

La *

2-76

Grid to Ground Params m
Parameters Avg Job Ht v
Avg Job Ht IIII.IZIIIIIII m
Map Scale |1.IIIIIIIIIIIIIIIIIIIZIIII
Az Rotation 0.00000000 dms
Origin {m Offsets (m)

North [0.000 North [0.000
East  |o.000 East [0.000
Height |0.000

Figure 2-81. Grid to/from Ground Parameters
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* Parameters: selects the set of parameters to perform Grid/Ground
coordinate transformation: Scale Factor, Avg Job Ht or Origin Pt.
The available options on the screen vary depending on the set of
parameters selected.

* Direction: selects coordinate transformation type, either from
Grid to Ground or from Ground to Grid.

e Scale Factor: sets the combined scale factor.

* Az Rotation: sets the angle between the axes of the grid and
ground coordinate systems. This angle defines the reference
direction for ground azimuths.

* Avg Job Hrt: sets average job height to compute the elevation
scale.

* Map Scale: sets the value of the zone scale factor

* Offsets: sets the offsets of the origin along the North and East
axes to reduce ground coordinates to manageable values.

If the Origin Pt is selected for the coordinate transformation, the Grid
to Ground Params screen displays the parameters to set the origin of

the ground coordinates.

Grid to Ground Params m

Parameters [T
Direction |Gri|:| to Ground

Scale Factor I

Az Rotation  [0.00000000 dms | -

Origin (m Ground Pt {m)
North [0.000 North [0.000

East 0.000 East IIJ.IIIIIIIII

Height |0.000

Figure 2-82. Grid to Ground Params

o E] : opens the Compute Rotation screen to compute the Az
Rotation value.

* Origin: sets the grid point for the ground origin. Can be selected
from map, list or entered manually.

* Ground Pt: sets the ground coordinates for the origin.
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* OK: saves the settings and returns to the Coordinate System
screen.

Compute Rotation

The Compute Rotation screen computes azimuth rotation using
ground and grid azimuths.

Cumpute Rotation m
Azimuth (dms)

Ground  |52.00000

Rotation I dms

Figure 2-83. Compute Rotation
* Azimuth: sets the azimuths in the ground and grid systems.

* Compute: opens the Compute Azimuth screen to compute
azimuths in the ground and grid systems respectively.

¢ Rotation: shows the azimuth rotation when this field is selected.

¢ OK: saves the results and returns to the Grid to Ground Params
screen.
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Compute Azimuth

The Compute Azimuth screen computes the azimuth of the direction
using two points.

Compute Azimuth m

From |1
To [12
Add to 3.00000| dms

Azimuth I dms

Figure 2-84. Compute Azimuth
» From: sets the start point for the direction.
* To: sets the end point for the direction.
* Add to: an additional value to add to the azimuth.

* OK: saves the results and returns to the Compute Rotation
screen.
Custom Datums

The Custom Datums screen contains a list of custom datums.
Initially, the list is empty.

Custum Datums ..

Datum
< >
[ Delete H Edit H Add ]

Figure 2-85. Custom Datums

* Add: opens the Custom Datum screen to enter parameters of a
new custom datum.
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 Edit: opens the Custom Datum screen to edit parameters of the
selected custom datum.

¢ Delete: deletes the selected custom datums.

Custom Datum

The Custom Datum screen sets parameters of the new custom datum.

Custom Datum
Name |
Ellipsoid ARy v
Note

Figure 2-86. Custom Datum Name

¢ Name: sets the name of the new datum.

Ellipsoid: selects the ellipsoid for the datum from the list of
available types.

Note: any additional information about the datum.

Next: opens the next Custom Datum screen to set offsets,
rotations and scale for the new datum.

Custum Datum
Offsets{m) Rotations (secs)
dx IIII.IZIIIIIZI rx IIII.IIIIII
dy Illl]l]l] ry Illl:ll]
dz IIII.IZIIIIIZI rZ IIII.IIIIII

Scale IIII.IIIIIIIIIIIIIIIIZI ppm

Figure 2-87. Custom Datum Parameters
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Geoid List

Geoid is a physical reference surface. Its shape reflects the
distribution of mass inside the earth. Geoid undulations are important
for converting GPS-derived ellipsoidal height differences to
orthometric height differences.

The Geoids List screen contains a list of active Geoids available for
selection.

F=hd Geoids List | ok |

INarme Full Path

dutchGeoid Storage Card' TRS, TopSURY Genidsy

<] | [

| Remove | Edit | Add

Figure 2-88. Geoid List

* Add: opens the Add Geoid screen to add a geoid file to the list.
Install the geoid file on the controller prior to adding it to the list.
Some geoid files can be installed on the controller during
TopSURY installation. They are provided to the user with the
TopSURY installation program as '.gff" files.

* Remove: deletes the geoid from the list.
» Edit: opens the Add Geoid screen to change the geoid.

* OK: the job will refer to the selected geoid file when performing
calculations.
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Add Geoid

From the Add Geoid screen, select a Geoid file from the controller
and see the boundaries of the geoid application.

EOET - -]

Genid format; |Geoid File Farmat [~

I\Smrage Carch, TPS) TopSURWY Geoids!dutchGeoid. gf

T_ Lat |53°4D'30.D"N Lon I 3°12'29.9"E

Geoid Boundary

L oLat |50°31'29.9"N Lon | 7o27'29.9"E

Figure 2-89. Geoid Parameters

* Geoid Format: the format of the geoid: Geoid 99/2003,
Australian, Canadian 2000, Canadian 95, Geoid File Format,
Mexico 97, Sweden, Denmark, Dutch2004 Files, and Norwegian
Files.

. : displays the directory where the geoid file is stored in the

controller. Usually, the geoid files are stored in the Geoids folder
in the directory where the application has been installed.

* Browse: opens the browse screen for choosing the geoid file from
models previously downloaded to the controller. After the geoid
is chosen and the OK button is pressed, the Geoid Boundary
fields in the lower part of the Add Geoid screen display the
coordinates of the north-west and south-east points of the geoid.

* Geoid Boundary: displays the boundary of the geoid application.

T_ : the longitude and latitude of the point that sets the

north-west boundary of the geoid.

_l : the longitude and latitude of the point that sets the
south-east boundary of the geoid.

* OK: confirms the geoid selection and returns to the Geoid List
screen.
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After being chosen, the geoid file appears in the Geoids List screen.

Units

Job » Config » Units opens the Units screen. For details, see “Units”
on page 2-6.

Temperature/Pressure

This option is available only for Total Stations surveys.

Job » Config » Temp/Press opens the Temperature/Pressure screen
to set the temperature and air pressure surrounding the total station.

iER 4 Temperature/Pressure m Cancel

Temperature Im oC
Pressure I?EuD.D mmHg

Figure 2-90. Temperature/Pressure

are for reference only, and do not effect the

@ The values entered for Temperature and Pressure
measured slope distance.

Display
Job » Config » Display opens the Display screen. For details on this
screen, see “Display” on page 2-8.

In the Contractor Module, the Display screen does not contain the
Coordinate Type field because this module works only with ground
coordinates.

P/N 7010-0492 2-83



Job

Alarms

Job » Config » Alarms opens the Alarms screen. For details, see
“Alarms” on page 2-9.

Menu Display

With the Config submenu, the appearance of the menus can also be
modified. Some rarely used functions are not displayed, but can be
enabled through the Config » Menu Display submenu and the
Config Menus screen.

Config Menus

The Config Menus screen displays the list of menus and submenus
for each special submenu for the current job configuration.

R |

Menu Sub Menu to Display |
Resection

Stk Elewation

Cago Missing Line

Figure 2-91. Config Menus
e Menu: the list of available menus.

* Sub Menu to Display: the list of the selected menu items available
for display. Place a check mark near the item to display in the
menu.

* Use Icons: check this box to display the menu items on the main
screen as icons.
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Import

To import data, tap Job » Import (Figure 2-92).

23 081 [My PP Static] 5
EEZ Edit View Survey S5take Cogo Hip

Open
[enw
Delete
Config »

From Job
Export » | From Eile
Infa From Contraller
Mode

Exit

Figure 2-92. Import Submenu

The Import function is used to add points, codes and attributes, Code
Libraries, Roads, Cross Section Templates, Point Lists and
Localization from another job, file, or controller.

The bitmap in the upper-left corner of the screen displays the floating
menu of the Help item.

Import From Job
To import from a job, tap Job » Import » From Job.

Select Job

The Select Job screen (Figure 2-93 on page 2-86) selects the job for
import. Select launches a wizard-based import process. The wizard
will guide the steps through the import process by means of the Next
button. When at the final stage, the Next button becomes unavailable,
and the Finish button will be active.
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Select Job

Current Job: JOBF

Created:
02082005
03:06

Modified:
02f09/2005
03:36

\Storage Card\ TP5\TopSURVYJobs

| Browse || Select |

Figure 2-93. Select Job

If there is no desired job in the Job List, press the Browse button to
select a job from the controller. The second Select Job screen will be
opened to browse directories on the controller for a job.

ERdsstect 10b [ ok |
Type  [Job Files (*.ts0) :I

5! \Storage Card\ TP5\ TopSURV Jobs}
f3Default.

MNarme |Defau|t.lsv

Figure 2-94. Select Job
* Name: the name of the imported file.

* OK: approves the selection and opens the Import screen.
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Import From Job

The Import From Job screen selects the data to import and, if
necessary, filters the imported points.

Impl:lrt from Default

Points |41l Points [~

[] Code Library
[] Localization
=
[ Roads

Figure 2-95. Import From Job

* Points: select the points for import, from the drop-down menu:

— All Points — By Type, Range and
— By Type Code
— By Range and Code — None

* The following data can be imported along with points:

— Code Library — Point Lists

— Localization — Roads

* Back: returns to the previous screen.

¢ Next: depending on selections, opens either the Select Point
List(s) to Import screen, or Select Point Type(s) to Import screen,
or Select Roads to Import screen if only Roads is checked and All
points is selected.

* Finish: starts the import process if only Code Library and/or
Localization items are chosen and All Points is selected.
Otherwise, the button is not available.
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Select Point Type(s) to Import

The Select Point Type(s) to Import screen is used to select the types
of points to be imported if Code Library, Localization or Roads are
checked (if points filter by type has been enabled in the Import From
Job screen). This can be done by placing check marks in the list, next
to the desired types of points.

bEL dSelect Po pe D PO Cancel
Point Types -
|| Design Paints
[_|Control Foints
| _|Cogo Points L |
[_|Base Station
4 Topo Paints
| Offzet Topo Paints
|| Auto Topo Points
|| Sideshat
1 |
| Check ||in:hel:k| | << Back | | Next >> |

Figure 2-96. Select Point Type(s) to Import

* Point Types: the list of the point types. The following types are
available for import:

Design Points Control Points Cogo Points

Base Station Topo Points Offset Topo Points
Auto Topo Points Sideshot Offset

Remote Reflectorless BackSight

Stake Points Stake Line Check Points

Manually Typed Tape Dimension

* Check and Uncheck: toggles the highlighted item(s) on or off,
depending on the button being pressed. Press Ctrl while selecting
to select more than one item.

* Back: returns to the previous screen.

» Next: opens Points to Import screen (if points filter by type, code
and range has been enabled in the Import From Job screen).
Otherwise, the button is not available.
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Points to Import

The Points to Import screen filters the imported points.

PuinE to Import
Poirts with Codes
<haft, pool

[] Range of Paints

Figure 2-97. Points to Import

* Points with Codes: if checked, all points with the selected codes
will be imported.

* Select: opens the Code screen for code selection.

* Range of Points: select the points to import. These can be set by

range (-7, “;” or “,” can be used as a range separator) or by
enumeration.

* Back: returns to the previous screen.

» Next: opens the Select Road(s) to Import screen (if Roads was
checked in the Import From Job screen). Otherwise, the button is
not available, and the Finish button appears to open the Import
Status screen.
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Code

The Code screen contains a list of available codes. All points with
codes selected here will be imported.

Select Codes |

[ |bord

shaft
poal

e

[ fount

|Un|:he|:k| | Check |

Figure 2-98. Code
* Uncheck: removes the mark from the highlighted code.
* Check: marks the highlighted entries.

* OK: returns to the previous screen with the codes selected.

Select Road(s) to Import

The Select Road(s) to Import screen selects the roads to import along
with the data. Select from the Roads list for import by placing check

marks next to them.

k=R 4 Select Road(s) to Import

Roadls
[w]72

| Check ||in:hel:k| | << Back | | Next »> |

Figure 2-99. Select Road(s) to Import
* Roads: the list of available roads in the selected job.

* Check and Uncheck: toggles the highlighted item(s) on or off,
depending on the button being pressed.
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* Back: returns to the previous screen.

* Finish: starts the import process.

Select Point List(s) to Import

The Select Point List(s) to Import screen is used to select the point
lists (if available) to import along with the data. Place the check
marks to select the lists to import.

v alect Po 0 4 Finish | Cancel

Point Lists
~oeesbiord&l

| Check ||in:hel:k| | << Back | | Next »> |

Figure 2-100. Select Point List(s) to Import

* Point Lists: the list of available point lists in the selected job.

Check and Uncheck: toggles the highlighted item(s) on or off,
depending upon the button being pressed.

* Back: returns to the previous screen.
* Next: is not available.

* Finish: starts the import process.

Import Status

The Import Status screen reflects the import process and contains a
progress bar and a comments window. The progress bar displays the
percentage of the data being imported (Figure 2-101 on page 2-92).

Press the Close button to return to the main screen.
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Import Status
Irnporting Points. ..

2 codes imported.

Import Status

2 codes imported.

62 paints imparted.

1 ¥-section ternplate imported.
1 road imported.

Import In Progress.

Import Successfully Finished.

Figure 2-101. Import Status

Duplicate Objects

If the existing job contains points, roads, or point lists with the same
names as the imported job, the Duplicate Objects screen appears.

Duplil:ate Points
Warning: Point already exists!
Marme: 1
dN: 55,723
dE: 37.651

¢ 157.135

() Rename? Start Paint; I

O Prefix? |
() suffix?
[ ves |[[ves Toan|[ skip || skip an |

Figure 2-102. Duplicate Objects

The Duplicate Objects screen is a warning that prevents the loss of
points, roads or point lists when names of these imported objects
coincide with existing ones.

* Overwrite: the imported object will overwrite the existing one. If
the object represents a control point, a confirmation displays that
the point is deleting (Figure 2-103 on page 2-93).
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P1 is a Confrol Paint. Are you sure
you want to delete it?

Yes

Figure 2-103. Delete Message

* Rename: the imported object will be renamed. The new name
should be noted in the corresponding field.

* Prefix/Suffix: the imported object will differ from the existing
object by prefix or suffix. The prefix/suffix should be noted in the
corresponding field.

* Yes: press the button to accept the decision.

* Yes To All: press the button to accept the same decision for all
similar cases.

 SKkip: press the button to skip the object without importing.

 Skip All: press the button to skip all the objects with names that
coincide with the names of existing objects, without importing.

* Close: disables the import process and opens the Import Status
screen to remove all the objects already imported.

Import Status

Imported Objects Were Successfully Removed!

Figure 2-104. Import Status of Removing Objects

The import process cannot skip duplicate templates.
These objects must be renamed.
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Import From File

To import data from a file, tap Job » Import » From File.

From File

The From File screen imports points, roads, cross section templates,
and localization from files with either pre-defined or custom formats.
For a description of these formats, see Appendix A.

k=R dFrom File
Data [Multinie =]
AN XML

Farmat

Figure 2-105. Import From File

* Data Type: select the data type to import from the file: Points,
Lines, Point Lists, Code Library, Roads, X-Sect Templates,
Localization, Scanning Data, Surfaces (TINs), Layer States, or
Multiple.

» Format: select the type of the file being imported:

— For Points and Point Lists data types: FC-4, FC-5, GTS-6,
FC-6/GTS-7, GTS-7 with strings, GT, GT-FIN, MMH360,
MMH360_7000, DXF, KOF, DWG, SHP, ISFF/DGN, CMM,
LandXML, CRS5, MOSS GENIO, NEZ, NEZ with strings,
Custom Format with QC info, and Text (Custom Format).

— For Lines data type: DWG, SHP, DXF, LandXML, ISFF/
DGN, MX GENIO, and Text (Custom Format).

The TopSURYV linework consists of the lines and points
whereas the imported linework contains no points, it includes
positions only (names will start with the question mark)
(Figure 2-106 on page 2-95).
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[ERdeait Line (o |
Points in Line |Sty|e |

Lineswark Marme IEI
[#] [ st ot paints @')1

d #027000051

? #027000082

7 #027000083
7 #027000084

2] K1 . E|E| =200m [»]

Figure 2-106. Edit Imported Linework
— For Code Library data type: TDD, XML, DBF.

Code Library is a set of codes with attributes used in the job.
Once created, it can be saved as a file with *.tdd, *.xml, or
*.dbf extensions.

— For Horizontal and Vertical Alignments data types: SSS Road,
TopSURYV Road, CLIP, or ISPOL.

— For X-Section Sets data types: SSS Road, TopSURYV Road,
CLIP, ISPOL or Custom X-Sections Format.

— For Roads data type: SSS Road, TDS Road, MC Road,
LandXML, TopSURYV Road, CLIP, ISPOL, VGP, or MX
GENIO.

X-Sections are stored as Zones in LandXML files.

The header of the TopSURYV Road format contains the
starting azimuth if the Road is not a straight line.

—For X-Sect Template data type: SSS Template, TDS X-Section
Template or TopSURV Template

— For Localization data type: GC3 and TDS Raw Data.
Control Points are imported together with Localization data.
— For Scanning Data data type: DI-3000.

Only Camera Calibration Parameters are imported from the
whole set of Scanning Data.

— For Surfaces (TINs) data type: DXF, DWG, LandXML.
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— For Layer States data type: LAS (AutoCAD Layer Format).

— For Multiple data type: DXF, DWG, SHP, LandXML, ISFF/
DGN, and Text (Custom Format).

TopSURYV imports layers from DWG/DXEF files along with the
appropriate data types.

b=R 4 Import Status |

Importing Lines...

10 layers imported.

Import In Progress...

Cancel

Figure 2-107. Import Layers from DWG/DXF Files

When importing data from DWG/DXEF files, select the check Import
block base points box to import central points in blocks as points.

k=R 4 From File
Data |Lines v
Format  [ETCARM

|:| Import block base points

Figure 2-108. Import Block Base Points

TopSURYV only imports AutoCAD 2000 format
DWG files.
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For Points and Point Lists data types the From File screen displays
additional settings.

From File
Format |Text (Custorn Farmat) El
Point Type  |Design Points =]

ASCII File Properties
Lse Type for Atributes
Lse Quotes for Text Walues

Figure 2-109. Import From Text File

* Point Type: the type of the imported points.
— Design Points: points used as targets for stakeout.

— Control Points: the points with coordinates, known from the
catalog; used for localization.

— Topo Points: the points collected during a stationary survey.
— Auto Topo Points: the points collected during a kinematic
survey.

* ASCII File Properties: define the conditions of the imported file
interpretation. These conditions use the same type for the
attributes, and quotes for the text values. The ASCII Flle
Properties field appears for a .txt imported files.

* Next: opens the Import From Format screen for the format being
chosen in the File Type field.
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Import From Format

The Import From Format screen browses directories from which to
select the file to import data from.

Type  [Text Files (*.5ct) :[

] \Storage Card\TP5\TopSURV\IEFiles)

Marne |p|:|int.txt

Figure 2-110. Import From Format
* Type: specifies the extension for the filename.
* Name: the name of the imported file.

* OK: approves the selection and opens the Coordinate System
screen. For text file types, the Text File Format screen opens.

For Surfaces (TINs) data type, OK opens the Import Status
screen and starts the import process to save results into TN3 files.

When Multiple Types data type is chosen, OK opens the Import
Status screen. Then the Import from LandXML screen displays.

Text File Format

The Text File Format screen imports a file of arbitrary text format.

Text File Format

Delimit
[OSpace @ Comma (O Tabs () Other II_E ‘

[ Header in First Rowr

Select File Format

“armne, MiLat), E{Lon),Elev, Codes

| Add Format | | Eqit Format |

Figure 2-111. Text File Format
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* Delimiter: sets the separator symbol between data in the import
file; either a space, a comma, tabs or other (select from the list).

e Header in First Row: check if the text file has a header.
e Select File Format: sets the order of fields in the selected file.

* Add Format: creates a new file format with the help of the
Custom Style screen.

» Edit Format: changes the selected file format with the help of the
same Custom Style screen.

* Back: returns to the previous screen.
* Next: opens the Coordinate System screen.

* Finish: opens the Import Status screen and starts the import
process.

Custom Style

Using the arrows, move the necessary items from the left side of the
screen (the Available column) to the right side (the Order column) in
the desired order.

Custum Style ..
Available | Order |
Ell ht Name
Notes NiLat)
Codes&5trings E(Lon)
Codes&Attributes Elev
FullCodes Codes

Figure 2-112. Custom Style

* Save: saves the File Style and returns to the Text File Format
screen. A new string appears in the Select File Format drop-down
menu.

* Close: returns to the previous screen.
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Coordinate System

The Coordinate System screen is similar to that described in the
section “Coordinate System” on page 2-5.

This screen contains information about the coordinate system for the
imported job (Figure 2-113 on page 2-100).

The differences are:

* The Coordinate Type for the imported file and be set; either
WGS84, Datum, Grid, or Ground.

¢ The distance units used in the file can be recalculated to Meters,
IFeet, or USFeet.

Coordinate System

Projection

[ Use Grid/Ground

|UTMNarth, Zone# 37

=] - iER 4 Coordinate System

Projection

= I0NE =

Datum e

-] |: & Use Grid/Ground

Geoid Model | <none:

[ ]
L]

EI |: Daturn

Coord Type |Grid

DistUnits  [Meters

[wasa4 ]

EI Geoid Model |<n0ne> El \_l
= Coord Type  [WGSB4 (LatyLongHt) [~
DistUnits  [Meters =]

<< Back || Next >> |

Figure 2-113. Coordinate System

* Back: returns to the previous screen.

» Next: with the type of ellipsoid coordinates chosen, opens the
Lat/Lon Record Format screen.

* Finish: opens the Import Status screen and starts import process.
(See “Import Status” on page 2-91.)
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Latitude/Longitude Record Format

From the Format (Lat/Lon) drop-down menu in the La#/Lon Record
Format screen, select the desired format to represent data being
imported from the file.

iEA 4L at/Lon Record Forma Finish | Cancel

Format {LatfLon}

cidd mm ss.55555
cddmmss, 55555
ddd. {decimal

Figure 2-114. Latitude/Longitude Record Format

* Back: returns to the previous screen.

* Finish: opens the Import Status screen and starts import process
(see “Import Status” on page 2-91.).

Import Multiple Data

For Multiple Types data type (see Figure 2-105 on page 2-94 for and
example this data type) select the specific data group from the file to
be imported. For the LandXML example: Point Lists, Parcels,
Surfaces, and Alignments (Figure 2-115).

B
File Contents:

05 T i b ]
[ atignments: [T | [ #-Sections: [0 |
[ Parcels: ]
[ Surfaces: 2]

Figure 2-115. Import Multiple Data

» Next: becomes active after selection of a data group from the file
contents, and opens the Select Data For Import screen.
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Select Data For Import

The Select Data For Import screen is used to choose objects for
importing from the file.

k=R 4 Select Data For Import

Parcels

VIt

| Check ||in:hel:k| | < ﬁackl

Figure 2-116. Select Data For Import
* Objects: the list of available objects in the selected file.

* Check and Uncheck: toggles the highlighted item(s) on or off,
depending on the button being pressed.

* Back: returns to the previous screen.

* Finish: opens the Import Status screen and starts the import
process.
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Import From Controller
To import a job (or any other file) from a controller device, tap

Job » Import » From Controller.

Import/Export Settings

The Import/Export Settings screen is used to set the Import/Export
options for file interchange with another controller.

Import{Export Settings

Com Port

Figure 2-117. Import/Export Settings

* Com Port: selects the Communication port. These can be COM 1,
COM?2, IR Port, or Ethernet. Also there can be communication
via Bluetooth.

* Next: opens the File Import Directory screen.

File Import Directory

The File Import Directory screen selects the destination directory for
data import.

File Import Directory

Select current dir to import into..

- antennas

E-Beacons -
- CustomDevices

.. DT

[l FileSettings

- Geaids

- Haln E

\Storage Card\ TP5\TopSURY

Figure 2-118. File Import Directory
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* Back: returns to the previous screen.
* Close: returns to the main screen.

* Finish: opens the Import File screen reflecting status of
importing the file to the chosen directory.

Import file

File name:  MDT.TN3

File size: 72592 bytes

Loading...

Figure 2-119. Import File

A successful completion of the file import returns to the main screen.
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Export
To export data, tap Job » Export (Figure 2-120).

23 081 [My PP Static] 5
EEZ Edit View Survey S5take Cogo Hip

Open
[enw
Delete
Config »
Imnport »

To Job

Infa To Eile

Mode To Controller
Sessions

Exit
Figure 2-120. Export Submenu

The Export function is used to export points, codes and attributes,
Code Libraries, Roads, Cross Section Templates, Point Lists,
Localization, Road Survey and Raw Data from the current job to
another job, file, controller, or session settings to the receiver.

Export to Job
To export data to a job, tap Job » Export » To Job.

Select Job

The Select Job screen selects the destination job to export to. If there
is no desired job in the Job List, press the Browse button to select a
job from the disk.

Select Job

Current Job: JOBF
Job List

- Created:

Dafawlt 02/08/2005

? 1100 03:06

BT Madified:

F 002 H 02/09/2005
03:36

\Storage Card\ TP5\TopSURVYJobs

Browse || Select

Figure 2-121. Select Job

P/N 7010-0492 2-105



Job

* Select: starts the export process wizard. Follow the wizard’s Next
button until the Finish button is available.

Export To Job

The Export To Job screen is used to select the code library,
localization parameters, roads, and/or point lists that should be
exported along with the point data.

[ERdExport to 902_F

Points |41l Points

[-]

3 Localization
[ Paint Lists

[ Roads

Figure 2-122. Export To Job

* Points: select the points for export, from the drop-down menu:

— All Points
— By Type
— By Range and Code

— By Type, Range and
Code

— None

* The following data can be exported along with points:

— Code Library

— Localization

— Roads

— Point Lists

* Back: returns to the previous screen.

¢ Next: depending on selections, opens either one of the Select
Point List(s) to Export screens, or Select Point Type(s) to Export
screen, or Select Roads to Export screen if only Roads is checked

and All points is selected.

* Finish: starts the export process if only Code Library and/or
Localization items are chosen and All Points is selected.
Otherwise the button is not available.
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Select Point Type(s) to Export

The Select Point Type(s) to Export screen selects the types of points
to export if Code Library, Localization or Roads are checked (if
points filter by type has been enabled in the Export screen). Place
check marks near the desired types.

mll

b dSelect Po pe D PO Cancel

Paint Types e
[ |Design Paints

Control Points
Cogo Paints
Ease Station —
Topo Paints

Offzet Topo Paints

Auto Topo Paints

Sideshot
|

| Check ||in:hel:k| | << Back | |§uext 33 |

LI IC OIS

Figure 2-123. Select Point Type(s) to Export

* Point Types: the list of point types. The following types are
available for exporting:

Design Points Control Points Cogo Points

Base Station Topo Points Offset Topo Points
Auto Topo Points Sideshot Offset

Remote Reflectorless BackSight

Stake Points Stake Line Check Points

Manually Typed Tape Dimension

* Check and Uncheck: toggles the highlighted item(s) on or off,
depending on the button being pressed. Press Ctrl while selecting
to select more than one item.

* Back: returns to the previous screen.

* Next: opens Points to Export screen (if points filter by code and
range has been enabled in the Export To Job screen).
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Points to Export

The Points to Export screen filters the exported points.

v Po 0 po Cancel

[ Paints with Codes

1

Rarige of Poirts
p1-p1

Figure 2-124. Points to Export

* Points with Codes: export all points with the selected codes.
* Select: opens the Code screen.
* Range of Points: selects the points to export. These can be set by

(T3REENTN L] (13}

range (-7, “;” or “,” can be used as range separators) or by
enumeration.

* Back: returns to the previous screen.

* Next: opens the Select Road(s) to Export screen (if Roads was
checked in the Export To Job screen). Otherwise, the button is
not available, and the Finish button appears to open the Export
Status screen.
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Code

The Code screen contains a list of available codes. All the points with
the codes chosen here will be imported.

Select Codes |

[ |bord

shaft
poal

e

[ fount

|Un|:he|:k| | Check |

Figure 2-125. Code
* Uncheck: removes the mark from the highlighted code.

* Check: marks the highlighted entries.
* OK: returns to the previous screen with the codes selected.

Select Road(s) to Export

The Select Road(s) to Export screen selects the roads to export along
with the data. Place the check marks to select the exported roads.

k=R 4 Select Road(s) to Export

Roadls
[w] &

| Check ||in:hel:k| | << Back | | Next »> |

Figure 2-126. Select Road(s) to Export
* Roads: the list of available roads in the job.

* Check and Uncheck: toggles the highlighted item(s) on or off,
depending upon the button being pressed.

* Back: returns to the previous screen.
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¢ Next: is not available.

* Finish: opens the Export Status screen and starts the export
process.

Select Point List(s) to Export

The Select Point List(s) to Export screen selects the Point Lists (if
available) to export along with the data. Place check marks near the
exported point lists.

fERd Select Point List(s) to Expc|[Fnd

Point Lists o
(] il
ceronaiB2
ceroniiBil
~eroniiBe3
ceronaPRL
ceronabiBed
rarsrapoleil

e ONCES
|

| Check ||in:hel:k| | << Back | | Next »> |

< OO s

Figure 2-127. Select Point List(s) to Export

* Point Lists: the list of available point lists in the selected job.

Check and Uncheck: toggles the highlighted item(s) on or off,
depending upon the button being pressed.

* Back: returns to the previous screen.
* Next: is not available.

¢ Finish: opens the Export Status screen and starts the export
process.
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Export Status

The Export Status screen reflects the export process and contains a
progress bar and a comments window. The progress bar displays the
percentage of the data being exported.

Export Status

Exporting Points... —
b=h dExport Status
INRREEEER
pemEE INNEEENERRRNREREEEENI

3 codes exparted.
25 points exported.
1 road exported,

Export In Progress...

Cancel

Export Successfully Finished.

Figure 2-128. Export Status

Press the Close button to return to the main screen.

Duplicate Objects

If the existing job contains points, roads or point lists with the same
names as the job that these are exported to, the Duplicate Objects
screen displays.

Duplil:ate Points
Warning: Point already exists!
Marme: 1
di: 55,723
dE: 37.651
dH: 157,135
() Rename? Start Paint; I
O Prefix? |
() suffix?
[ ves |[[ves Toan|[ skip || skip an |

Figure 2-129. Duplicate Objects

This screen is the same as the Duplicate Objects screen for the import
process (for details, see “Duplicate Objects” on page 2-92).
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Export to File

To export data to a file, tap Job » Export » To File.

To File

The To File screen exports points, codes, roads, cross section
templates, localization, roads survey and raw data to files with either
pre-defined or custom formats. For a description of these formats, see
Appendix A.

e To File
Data Type TR
Format |Text (Custorn Farmat) El

["] Select Types Of The Points

[ Use Filters

[ Stored stakeout points
ASCII File Properties

Lse Type for Atributes

Lse Quotes for Text Walues

Figure 2-130. To File

* Data Type: select the data type to export: Points, Lines, Point
Lists, Code Library, Roads, X-Sect Templates, Localization,
Scanning Data, Roads Survey, Raw Data, Job History, Surfaces
(TINs), Layer States, or Multiple.

» Format: select the file type to export data to.

— For Points and Point Lists data type: FC-4, FC-5, GTS-6,
FC-6/GTS-7, GTS-7 with strings, GT, GT-FIN, MMH360,
MMH360_7000, DXF, KOF, DWG, SHP, ISFF/DGN, Cut
Sheet Standard, Cut Sheet User Defined, Check Sheet, PTL
Sheet, CMM, LandXML, CR5, MOSS GENIO, NEZ, NEZ
with strings, Text (custom format), or Custom Format with
QC info.

— For Lines data type: DWG, SHP, DXF, LandXML, ISFF/
DGN, MX GENIO, or Text (custom format).

— For Code Library data type: TDD, XML, DBF.
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Code Library is a set of codes with attributes used in the job.
Once created, it can be saved as a file with *.tdd, *.xml, or
*.dbf extensions.

— For Horizontal and Vertical Alignments data types: SSS Road,
TopSURYV Road, CLIP, or ISPOL.

— For X-Section Sets data types: SSS Road, TopSURYV Road,
CLIP, ISPOL, or Custom X-Sections Format.

— For Roads data type: SSS Road, TDS Road, MC Road, Land
XML, TopSURYV Road, CLIP, ISPOL, VGP, or MX GENIO.
X-Sections are stored as Zones in LandXML.

The header of the TopSURYV Road format contains the
starting azimuth if the Road is not a straight line.

— For X-Sect Templates data type: SSS Template, TDS
X-Section Template, or TopSURV Template.

— For Localization: GC3, and TDS Raw Data for GPS.
Control Points are exported together with Localization data.

— For Scanning Data type: all scanning data are exported for
DI-3000.

— For Roads Survey: X-Section Surveys or Find Station Report.

— For Raw Data: FC-5, FC-6/GTS-7, LandXML, TDS Raw
Data, MOSS Survey, Field Book, KOF, Berlin GNSS-
Messprotocol or Berlin GNSS- Mittelwerte. Field Book files
are text files that contain the observed point data. If choosing
LandXML or TDS Raw Data, select the type of raw data to
export: Export TS Raw Data and/or Export GPS Raw Data.
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g TO : Cancel

Data Type | RalEl]
Format  [LandiL [~

Export TS Raw Data
Expart GPS Raw Data

Figure 2-131. Export Raw Data To LandXML

— For Job History data type: CSV and Report.
The Job History file is formed if the Enable Job History
check box is selected on the Select Survey Config screen (see
“Select Survey Configuration” on page 2-12).

— For Surfaces (TINs) data type: DXF, DWG, LandXML.
— For Layer States data type: LAS (AutoCAD Layer Format).

— For Multiple data type: DXF, DWG, SHP, LandXML, ISFF/
DGN, and Text (Custom Format).

TopSURYV exports layers to DWG/DXF files, along with the
appropriate data types.

TopSURYV only exports AutoCAD 2000 format
DWG files.

o Select Types of the Points (for Points and Point Lists data types):
check this field if not all types of points should be exported.

 Use Filters (for Points and Point Lists data types): check this field
if filters (by code and by range) should be used for exported
points.

* Stored Stakeout Points (for Points and Point Lists data types):
check to export stored points saved by stakeout process.

* ASCII File Properties (for Points and Point Lists data types):
define the conditions of the exported file interpretation. These are
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the use of the same type for the attributes or not, and the use of
quotes for the text values. This field appears only for the text
format of the exported file.

* Next: opens the following screen:

— the Select Point Type(s) to Export screen if Select Types of
The Points is checked.

— the Points to Export screen if Use Filters is checked.
—the Select TN3 screen if Surfaces (TINs) data type is chosen.

— the Export To File screen in all other cases for the format
chosen in the File Type field.

Select Point Type(s) to Export

The Select Point Type(s) to Export screen is similar to that described
in the section “Select Point Type(s) to Export” on page 2-107, except
for the behavior of the Next button. Here, Next opens the Points to
Export screen (if Points data type was selected and Use Filters was
checked in the To File screen) or the Export To Format screen.

Points to Export

The Points to Export screen is similar to that described in the section
“Points to Export” on page 2-108, except for the behavior of the Next
button. Here, Next opens the Export To Format screen.
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Select TN3

The Select TN3 screen is used to select a TN3 file to export data to
DXF, or DWG, or LandXML files.

[ERd setect T3 File [ ok |
Type  [THG Files (. TH3) 7]

\Storage Card\ TP5\ TopSURV\IEFiles
[ DEMO. THE

Mame [MDT.TN3

Figure 2-132. Select TN3 File
* Type: specifies the extension for the files being searched.
* Name: the name of the file whose data will be exported.
* OK: approves the selection and opens the Export To Format

screen.

Export To Format

The Export To Format screen selects a destination directory and the
name of the created file.

Type  [Text Files (*.5ct) :[

\Storage Card\ TP5\ TopSURV\IEFiles
=] point. txt

Marne |pr|:|je|:t.txt

Figure 2-133. Export to Format
* Type: specifies the file extension.

e Name: the name of the created file.
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* OK: approves the selection and opens the Coordinate System
screen. See “Coordinate System” on page 2-100. For text file
types, OK opens the Text File Format screen.

Text File Format

The Text File Format screen exports a file of arbitrary text format.

Text File Format

Delimit
[OSpace @ Comma (O Tabs () Other II_E ‘

[ Header in First Rowr

Select File Format

“armne, MiLat), E{Lon),Elev, Codes

| Add Format | | Eqit Format |

Figure 2-134. Text File Format

* Delimiter: selects the delimiting symbol between the data in the
exported file; either space, comma, tab or other.

* Header in First Row: select to output a header in the file.
* Select File Format: sets the order of fields in the exported file.

* Add Format: creates a new file format with the help of the
Custom Style screen.

» Edit Format: changes an existing file format with the help of the
same Custom Style screen.

* Back: returns to the previous screen.

* Next: opens the Coordinate System screen. See “Coordinate
System” on page 2-100.

* Press Finish to start the export process.

Custom Style

Using the arrows, move items from the Available column to the Order
column and arrange in the desired order. If exporting GPS points to
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Custom Format with QC info, the information on Quality Control is

available.

[« (31

Save

<

Custum Style

Available | Order JER Custom Style

Ell ht Hame Available N

Notes NiLat) PDOP

Codes&Strings E{Lon) HDOP

Codes&Attributes Elev vDOP

liCod d i

FullCodes Codes Solution Type
Num. of GPS
Num. of GLONAS: W

>

Figure 2-135. Custom Style

 Save: saves the File Style. A new entry appears in the Select File
Style drop-down menu.

* Close: returns to the previous screen.

<

Selecting elevations (Elev) in the exported format
prompts you to use a geoid model in the job. If it is
not necessary to use the geoid, select ellipsoidal
heights (Ell ht) to avoid the prompt message in the
process of export.
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Export Multiple Data

For Multiple data type there is ability to choose specific data group in
the job available to export. For the LandXML example: Points,
Alignments, TS and GPS Raw Objects, Surfaces (Figure 2-136).

Data selection
Available data
£9 [ codes: o

[] alignments; [2 [ *-Sections:  [3
[ TS Raw Objects: 7
[] GPS Raw Objects:  [20

[ Surfaces:

Figure 2-136. Export Multiple Data

» Next: depending on the data selected for export, opens the Points
Selection screen, or the Select Road(s) to Export screen (see
“Select Road(s) to Export” on page 2-109), or the Export to
Format screen (see “Export To Format” on page 2-116).

Points Selection

The Points to Export screen filters the exported Points.

§EAA PO electio Cancel

Points

By Type
By F.ange and Code

By Type, Range and Code
MNone

Figure 2-137. Points Selection
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Export to Controller

To export a file to a controller, tap Job » Export » To Controller.

Import/Export Settings

The Import/Export Settings screen sets import/export options for
data transfer with another controller.

Import{Export Settings

E_OR1

Com Port

Figure 2-138. Import/Export Settings

* Com Port: selects the Communication port. These can be COM 1,
COM?2, IR Port, Ethernet or Bluetooth.

¢ Next: opens the Files To Export screen.

Files To Export

The Files To Export screen browses directories for selecting the file
to export.

[ERgFes to Export
Browse Directory info here.. and select f
= Johs E‘

- 1100ty
12 F toy

~902_H.tsv

- Default. tsy

- JOB3. tsv

-~ JOBF. tsv

Lo ten E

1...A\TPS5\TopSURVJobs\002_F.tsv

Figure 2-139. Files to Export

* Back: returns to the previous screen.
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¢ Close: returns to the main screen.

¢ Finish: opens the Export File screen reflecting status of
exporting the file chosen (Figure 2-140).

Export file

File name:  902_F.tsv

File size: 1376256 bytes

Uploading...

Figure 2-140. Export File

A successful completion of file export returns to the main screen.

Sessions

To export a session to the receiver, tap Job » Export » Sessions.

In the Sessions screen, the left panel contains a tree of the available
receivers and their session plans. The right panel contains a list of
sessions to export.

Sessions Close
Receivers E Active Sessions

j(n} Type  Stal

Site_1 Static Sur

K1 L]

v |w| Goto sleep mode

Figure 2-141. Job Sessions

. ﬂ : selects the session to export.

: deletes the session from the export list.

* Goto sleep mode: if checked, the receiver will go into sleep mode.
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* Refresh: refreshes the export list.
* Export: starts the connection with the receiver.
* Close: closes the screen without performing export.

The bitmap in the upper left corner of the screen consists of two
items:

 Edit Session: opens the Sessions screen to edit the sessions. For
details see “Sessions” on page 3-59.

* Help: accesses the Help files.

Information

To get job information, tap Job » Info.

Job Information

The Job Info screen contains information about the current job.

Job name ROAD -
Number of Points 62
Points
Order by Name Point Name:
First 1
Last P110_RO
Job size on disk 1408 kB
Job created 02f09/2005 El
ns.-s

Figure 2-142. Job Information
* Job name: the name of the job open.
* Number of Points: the amount of the points stored in the job.

* Points: the names of the first point and the last one from the list of
the points ordered by name.

* Job size on disk: the space that the job takes up on the disk.
* Job created: the time and date of job creation.

* Job modified: the time and date of job modification.
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* OAF expire on: the date of OAF expiration for the given GPS
receiver. Tap CIk to expand under the date to display the Current,
Purchased and Leased status for all OAF options (Figure 2-143
on page 2-123).

e Firmware version: the number and build date of the firmware
loaded to the GPS receiver.

Name Date C P L A
_GPS 70506 1 0 1
_GLO 70506 1 0 1
L1 70506 1 0 1
L2 70506 1 0 1
CIND 70506 1 0 1
_POS 70506 20 O 20
RAW 70506 20 O 20
CDDB 70506 1 0 1 w

Figure 2-143. Job Info — OAF

Mode

To set the instrument mode, tap Job » Mode or the instrument icon in
the upper left corner of the main screen (Figure 2-144).

Observation Mode

The Observation Mode screen selects the instrument type and
wireless control options.

El Obsenratiun Mode m
Select Instrument Type

(O) Total Station

[]Bluetooth

Figure 2-144. GPS+ Observation Mode
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*» Select Instrument Type: sets the operation mode for surveying;
either GPS+ or Total Station.

* Bluetooth: the option for remote (wireless) control on short
distances. Only available if a Bluetooth device is available.

If Total Station mode is selected, it becomes possible to choose
Contractor mode, a scaled down version of the existing Total Station
mode.

— Obsenratiun Mode m
Select Instrument Type
() GPS+

Total Station

Bluetooth

Figure 2-145. Total Station Observation Mode

The bitmap in the upper-left corner of the screen displays the Help
menu.

When using TopSURYV on the GMS-2 integrated controller, the
Observation Mode screen contains settings for selecting an external
receiver for surveying.

Select Instrument Type

GPS+

() Total Station Cantractar

Bluetooth ISD Card

[W¥]External Receiver: |F‘0rt & v

Figure 2-146. Observation Mode for GMS-2
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Chapter 3
Edit

Edit menu includes the following menu items:
* Points
* Codes
* Point Lists
* Layers
* X-Sect Templates (when Roads are activated)
* Roads Design (when Roads are activated)
* Linework
e Raw Data

* Sessions (for GPS+ post processing modes only)

Il 3r0ad [my RTK] 8@

Job View Survey Stake Cogo Hip

Points
Codes
Point Lists

Layers
X-Sect Templates
Road Design 3

Linewark

Raw Data

Figure 3-1. Edit Menu

< ~ To edit object properties, double-tap on the object
or select the object and tap the Edit button.
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Points

To edit points, tap Edit » Points.

The Points screen contains the list of stored points with coordinates
and codes, and a set of tools for database operation (Figure 3-2).

In the Point column, an icon displays the point type:

47 — GPS stationary (topo)

477+ — offset point

#3 — GPS kinematic (auto topo)
T - RTK base

#+ — TS observed

4 — control

«$~ — design or imported
@' — staked out

— TS scanned point
— cogo

P — manually entered

Point:

| code | morthim)

| Eastimy  [<]

749
APl
A2
#7100
4101

2

3982.576
4090.906
4067.917
4074.558
4067.917

il

9365897
9145416 —
9248.298
9219.108

9248.2%@

Find by Code | | Find by point || Find next |

Delete

|| Eait

e

Figure 3-2. Points

* Find by Code: opens the Find by Code screen to enter a code for
searching for a point.

* Find by Point: opens the Find by Point screen to enter a point
name (or a part of the name) for searching.

* Find Next: finds next point that satisfies the same conditions as
the previous found point.

* Delete: deletes the point from the list.
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 Edit: opens the Edit Point screen to edit point parameters: name,
code, coordinates and/or other parameters stored with the point.

¢ Add: creates a new point through the Add Point screen.

* The bitmap on the upper-left corner displays the following pop-
up menu:

PTL Mode: switches on the PTL (Point-To-Line) Mode. (The screen
changes its appearance on Points (PTL).) For details, see “PTL
Mode” on page 6-12.

— String: switches on the strings displaying function along with
the codes.

— Show Scan Points: switches on the scan points displaying
function.

— Show AutoTopo Points: switches on the AutoTopo points
displaying function.

— Help: accesses the Help files.

* Settings: opens the Display screen.

Display

The Display screen is used to customize the interface.

Coord Type v
Coord Order MNorthing,Easting, Elevation s
Azimuth Origin Marth v
Disp Dir As Aziruth w
Disp CL Pos As Station v
Full Station [iooooo o

Figure 3-3. Display
* OK: saves the settings and returns to the Points screen.

For details on the screen settings, see “Display” on page 2-8.
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Find by Point

The Find by Point screen contains settings for searching for a point
by its name.

[EE&Find by Paint
Point ]

@ Match entire name

(O Match partial name

Figure 3-4. Find by Point
* Point: the name of a point or a part of the name.

e Match entire name: set if the whole name was entered in the Point
Name field.

* Match partial name: set if a part of the searched name was
entered in the Point Name field.

» Search: starts the search process and returns to the Points screen,
highlighting the point found.
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Find by Code

The Find by Code screen contains a form of searching for a point by
its code.

[EEZFind by code

Code

Figure 3-5. Find by Code
* Code: the name of the code selected from the drop-down list.

* Search: starts the search process and returns to the Points screen,
highlighting the first point with the code selected.

Add (Edit) Point
The Add (Edit) Point screen displays the form of the point properties.

[ o]
Point Info |Layer,‘5tyle ]Phutu Note ]
[@] Point o128 1
@ Code Iﬁ
Local{m) Note

HNorth |2III.IJIJIII
East ISD.DDD
Eley |15 .000

[] Control Point

Figure 3-6. Add/Edit Point
The Point Info tab contains the following fields (Figure 3-6):
* Point: sets the name of the point.

* Code: sets the code for the point. Can be entered manually or
chosen from the drop-down list.
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«¥E| : the Artributes List bitmap, opens the Code-Attributes
screen to set values for attributes available for the code chosen
(Figure 3-14 on page 3-10).

The fields for the coordinates of the point in the current
coordinate system (the field name changes with the display type).
Control Point: check this field to use the point as the Control.
Note: the short note for the point.

The bitmap next to the Attributes List bitmap displays the
following list:

— String: toggles on the String field. Also, the sign appears.

— Layer: opens the Select Layer screen (see “Select Layer” on
page 3-8).
— Note: opens the Note screen. For details, see “Topo” on
page 5-24.
OK: saves the changes and returns to the Points screen. Points

which have no codes, or have codes but no strings associated with
the codes, are simply stored as points.

The Layer/Style tab contains the following fields (Figure 3-7):

§EA4 Add Point

Point Info | LayerfStyle
Layer I{By Code> v

Point Style

o] |Cin:le + | | Color

Figure 3-7. Add/Edit Point — Layer/Style Tab

Layer: selects the layer to locate the point.
Point Style: sets and shows the style to designate the point on the
map:

— The drop down list contains the point symbols to select.
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— Color: opens the Select Color screen (see “Select Color” on
page 3-9).

* OK: saves the point settings and returns to the Points screen.

The Photo tab displays a photo note—a picture of the situation at the
point—if a picture has been taken and added (using the Add button).

[EEZEdit point ok |cancel

[Cut Sheet ]Check Points | Photo Note II':

s mneeas © 0 omoeD o ere oooneTn

rora e

belete| [Edit | | add |

Figure 3-8. Add/Edit Point — Photo Note Tab
* Add/Edit: opens the Select Image File screen to browse for the
picture.
* Delete: erases the picture for the point.
If the point has some duplicate points and the weighted average is

used, the Edit Point screen will contain the Check Points and
Weighted Average tabs.

The Check Points tab displays the coordinates of check points and the
deviations from the coordinates of the original point.

[Puint Info ]Layer,‘style | Check Points
Name |dN | dE | dH
45 0.000 0.000 0.000
< >

Figure 3-9. Edit Point — Check Points
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The Weighted Average tab displays coordinate residuals of the check
point.

[Puint Info ]Layer,‘style ]Check Points | WA l_

Name |N Resid | E Resid | H Resid | wa Con
t10 0.020 0.056 -0.250 used
Bltio 3960 0553 -2.384 unused

< 4

Figure 3-10. Edit Point — WA

* Use In WA: uses the station as a weighted average.

Select Layer

The Select Layer screen selects the layer in which to locate the point.
o Jcmeal
Laver  [EERCTCENN v -

Figure 3-11. Select Layer

The [ -] button opens the Layers screen to edit layers. (For details
on editing layers, refer to “Layers” on page 3-18.)
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Select Color

The Select Color screen sets the color of the point mark to show on
the map.

Select Color

Hue 116 Red

Sat Iﬁ IE Greer

Lo |1‘JI'I |1TT Blic
Figure 3-12. Select Color

Tap in the area of the desired color and move the slider to select the
level brightness. If needed, check the color’s values.

If the PTL Mode is on, the Add Point screen has the PTL tab with the
following parameters.

[Puint Info ]Layer,‘style | PTL .

Start Ref Pt l—

|

PTL Offsets(m)

Line Il].l]l]l]
Offset Il].l]l]l]
Eley |3.156

Figure 3-13. Add Point (PTL)
o Start Ref Pt, End Ref Pt: the reference points. Can be selected
from map, from list or entered manually.

* PTL Offsets: the offsets from the reference line formed by the
reference points:

— Line: the distance from start reference point along the
reference line, where the perpendicular to this line passes
though the target.
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— Offset: the horizontal distance from the target.
* Ell ht: the height of the target.

* OK: saves the point settings and returns to the Points screen.

Code-Attributes
The Code-Attributes screen sets attribute values for the selected code.
v ode-Atiribute 0K Cancel
Code |de El
Cirl Codes I :I
%, tree
12 pillar H

Attrib ﬁangel Multiple Codes |

Figure 3-14. Code-Attributes

¢ Code: shows the code selected.

* Ctrl Code: shows the control code list. The Control Code is a
special type of code that can be used by the graphic tool for the
interpretation of survey results.

The supported control codes (/AS, /AE, /C, /R) control line
behavior when creating arcs, closure of lines, and rectangles
respectively. The /AS control code indicates the start of an arc,
and the /AE control code indicates the end of the arc. Arc
parameters are determined using additional points in the line.

* The lower field shows the available attributes and provides a field
to enter its value.

* OK: saves the changes and returns to the Add (Edit) Point screen.
The program prompts if the value is not within the range
specified.

» Attrib Range: opens the Attribute Ranges screen to view the
ranges for the attributes. Attributes can only be added using the
Codes - Attributes screen.
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e Multiple Codes: opens the Multiple Code-Attributes screen.
Multiple codes and strings associated with a point make the point
a part of numerous lines.

Multiple Code - Attributes

The Multiple Code-Attributes screen is used to edit multiple codes
and strings.

Multiple Code-Attributes m
Codes |Strings |Attributes |
cp tree=
ij
< >
| pelete |[  Edit || Add

Figure 3-15. Multiple Code-Attributes

Delete: deletes the code from the list.

Edit: opens the Code-Attributes screen to edit the code.

Add: creates a new code through the Code-Afttributes screen.

OK: saves the settings and returns to the Add Point screen.

The bitmap on the upper-left corner displays the following pop-
up menu:

— String: switches on the strings display along with the codes.

— Show Second Ctrl Code: switches on the field to enter another
code.

— Help: accesses the Help files.

P/N 7010-0492 3-11



Edit

Codes and Attributes

To edit codes and attributes, tap Edit » Codes.

Codes - Attributes

The Codes - Attributes screen contains a list of codes used for the
survey, the list of attributes for each code, and a set of tools for editing
the codes and attributes. Codes already in use cannot be edited or
deleted.

iER 4 Codes - Attributes

Attributes

Del pel | | Edit | add

Figure 3-16. Codes — Attributes

¢ Codes: contains a list of codes.
e Attributes: contains a list of attributes for the selected code.
* Del: deletes the highlighted entry.

* Edit: opens the applicable Code or the Attribute screen with the
properties of the highlighted entry.

* Add: opens the applicable blank Code or the Attribute screen. A
new attribute can be added if at least one code exists and is
highlighted.

The bitmap at the upper-left corner displays a pop-up menu:

* Export To File: opens the To File screen to export code library to
the file format selected.

* Help: accesses the Help files.
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Code

The Code screen contains the parameters of a code.

b dCode

Code Mame

EiLaver [roaD v

Line Style

|<Ely Layer= v

Width 1Pt »

Point Style

. |<Ely Layer= v

Figure 3-17. Code

* Code Name: the name of the code.
* Layer: the name of the layer in which the code resides.

* Line Style and Point Style: selects the line and point plotting
attributes for the linework. The Color button opens the Color
screen (see “Select Color” on page 3-9).

* OK: saves the changes, closes the screen, and returns to the
Codes - Attributes screen.

* The bitmap menu in the upper right corner of the screen contains
two items:

— Edit Layers: opens the Layers screen to edit layers. For
details, see “Layers” on page 3-18.

— Help: accesses the Help files.
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Attributes

The Attributes screen contains the parameters of an attribute.

Atribute Mame  [type

Type —— .

® tier B R~ trivutes [ oK |
() Text

O Irteger Atribute Mame  [type

() Real Mumber

MNurn Characters |32
ERdAttioutes ok

Atribute Mame e

() Real Mumber

O Menu Min al |5
O Text Max Wal |25

@ Integer
() Real Mumber

Figure 3-18. Attributes — Menu, Text, and Integer Examples
e Artribute Name: the name of the code attribute.
* Type: sets the type of the code attribute:

— Menu: the attribute value can only be selected from a list of
available values. The Add button adds admissible values

entered in the Add entry field. The button deletes the
selected entry from the menu.

— Text: the attribute value is an alpha-numeric string. Enter the
number of characters available for the text value.

— Integer: the attribute value is an integer. Enter the minimum
and maximum values of the attribute.

— Real Number: the attribute value is a real number. Enter the
minimum and maximum values of the attribute.

* OK: saves the changes, closes the screen and returns to the Code
- Attributes screen.
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Point Lists

The Point List is a group of points that can be simultaneously
processed. Point list is tightly intergrated throughout TopSURV.
Depending on the context, the points may or may not be connected
with a line. A Point List with its points connected forms a polyline.

To use the Point Lists, select Edit » Point Lists.

List of Point Lists

The List of Point Lists screen contains a list of existing Point Lists on
the left part of the screen, and the two windows on the right part, that
present the general view of the selected list in the horizontal and
vertical planes. To view the current selected point list in a larger map,
double-tap one of the map plots.

§ER dList of Point Lists

List of Paint: Lists '%

PointListl .—:
PointLjst2

(4 | Dot

| petete | | copy | | Eait | [ aca |

Figure 3-19. List of Point Lists

* Delete: press to delete the Point List from the list.
» Copy: press to create a copy of the selected List.

» Edit: opens the Edit Point List screen. Press to edit the properties
of the selected List.

* Add: opens the Add Point List screen. Press to create a new List.

* The bitmap on the upper-left corner displays the following pop-
up menu:

— Edit Points: displays the Points screen. For details, see
“Points” on page 3-2.

— Help: accesses the Help files.
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Add/Edit Point List

The Point List tab displays general properties of the Point List.

fERd Add Point List | oKk |
Point List | Properties

Point List Mame: IPointList4

[+]

oS0 Usft ]
Point Info Select Points [§w

Figure 3-20. Add Point List — Point List Tab

e Point List Name: the name of the Point List.

e List of Points: the list of currently selected points. Adding the
point to the list can be performed in two ways.

— Through the map: tap the plot on the right. The large Map
screen opens (for details on the screen icons, see Chapter 4).
Select the points by tapping them on the map; the two
sequentially tapped points will be connected with a line.
Press Close to return to the Add/Edit Point List screen.

— Through the Select Points button: pressing the button displays
the floating menu of five items: By Range, By Code, By
CodeString, By Radius, From Map, and From List. Select the
desired way of adding points and enter in this way: set the
range, check the codes, set the center point and the radius of
the area, select the points from the map or using the list.

* Point Info: shows the point information of a current selected
single point.

e The up and down arrows to the left of List of Points move the
highlighted point up or down in the order of the points.

. : switches on/off the keyboard arrow keys that duplicate the
arrows on the screen.
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. : deletes the highlighted point from the list.

. E : closes the plot of the point list. Only the list of points table
will be available.

* The bitmap on the upper-left corner displays the following pop-
up menu:

— Edit Points: displays the Points screen. For details see
“Points” on page 3-2.

— Help: accesses the Help files.

The Properties tab shows only the Name field, that duplicates the
Point List Name on the Point List tab.

fERd Add Point List | oKk |
Point List | Properties

Figure 3-21. Add Point List — Properties Tab
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Layers

To edit layers, tap Edit » Layers.

The Layers screen displays the list of all layers existing in the current
job and layer status.

pl:ll:ll Empty
m road Has Objects

(oot (et [1ns ] e

Figure 3-22. Layers

* Layer Name: contains a list of Layers.Each layer has an icon to

show whether it is visible () or hidden (\). To turn on/off the

visibility of the selected Layer, tap on the Layer Name column
header.

* Status: shows if the layer is empty or has objects.
* Del: deletes the highlighted layer.

» Edit: opens the applicable Edit Layer screen with the properties
of the highlighted layer.

* Add: opens the Add Layer screen to add a new layer.

* Ins: opens the Add Layer screen to insert a new layer below the
selected layer.

: moves the highlighted layer up or down in the order of
the layers.

The bitmap at the upper-left corner displays a pop-up menu Of the
Help item.
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Add Layer

The Add Layer screen sets properties for a new layer. The Layer tab
contains general settings.

* Layer Name: sets the name of the layer.
* Visible: hides or shows the layer objects on the map.
* Note: any additional information on the layer.

* OK: saves the settings and returns to the Layers screen.

Layer | Style

Layer Mame

Wisible

MNote

Figure 3-23. Add Layer Name

The Style tab sets plotting parameters for lines and points on the layer.

Line Style
v
1Pt v
Point Type
Dot v

Layer Color E

Figure 3-24. Add Layer Style

* Line Style: selects the shape and width of the line.
* Point Type: selects the shape of the point.

* Layer Color: the browse button opens the Select Color screen to
set the color for the layer (see Figure 3-12 on page 3-9).
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Edit Layer

To edit the selected layer, tap the Edit button on the Layers screen.
The layer properties can be changed in the Layer and Style tabs (see
Figure 3-23 and Figure 3-24 on page 3-19).

If the layer has objects, the Edit Layer screen contains the Objects tab
that displays points and other objects of the given layer.

Layer | Style | Ohjects

El
1000
Lines
Alignrments

Figure 3-25. Edit Layer Objects

Edit Multiple Layers

To turn on/off the visibility of multiple layers at a time, select desired
layers using the Ctrl or Shift buttons on the controller’s keyboard and
tap on the Layer Name column header.

Layers Close

(oot (et [1ns ] e

Figure 3-26. Edit Multiple Layers
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X-Sect Templates

A cross section template is a template for the creation of a complex
cross-section view of the road. The cross section template consists of
several sets of segments, cut slope and fill slope.

The X-Sect Templates screen displays a list of the existing templates
in the upper part of the screen and a plot of the highlighted template
in the lower part.

)(—Sect Templates ..
Name Num Segs Cut Slope | Fill Slope
1 4 0.000 0.000
2 2 0.000 0.000
< >
L
——————5m v

Figure 3-27. X-Sect Templates

The list contains four columns: Name (the name of the template),
Num Segs (the number of segments), Cut Slope, and Fill Slope values.

* Delete: deletes the template from the list.

 Edit: opens the properties of the selected template in the X-Sect
Templates screen.

¢ Add: opens the blank X-Sect Templates screen to enter the
properties for a new template.

. IEI : hides and shows the plot of the highlighted template.

* Close: saves the changes and returns to the main screen.
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The X-Sect Templates screen opened for editing contains parameters

of the highlighted template.

)( Sect Templates

Cance

Name
Slope 1: n

ID 0oo

Fill l:l 0oo

Cude Hz

8.000 D

3.000

Ve

———————om

‘\h\‘__”,ﬂ'

Igelete ] [ Edit l Insert HATE

Figure 3-28. Edit X-Sect Template

* Name: the name of the template.

* Slope: the cut and fill parameter values (run values for cut and fill
for a unit rise). These values represent the horizontal increment of
the slope for a unit vertical increment. The cut slope is used when
the road surface is below the terrain, and the fill slope is used
when the road surface is above the terrain.

. IEI : hides and shows the scaled plot of the highlighted template.

* Also the screen contains a list of segments comprising the
template and a plot of the template. A list of segments consists of
three columns: Code (the code of the segment), Hz (the horizontal
offset), Vert (the vertical offset).

— Delete: deletes the segment from the template.

— Edit: opens the Segment screen with the parameters of the

highlighted segment.

— Insert: opens the blank Segment screen. The added segment
is inserted in the list above the currently highlighted segment.

— Add: opens the blank Segment screen. The added segment
will be attached after the last segment in the list.

* OK: saves the changes and returns to the previous X-Sect

Templates screen.
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X-Section Segment

The Segment screen contains the parameters of the highlighted
segment.

T - [
@ Code I b : I

Offset
Horizontal IlD.DDD m
& |Down | [o.500 m

Figure 3-29. Segment

* Code: the code of the segment. Select the code from the drop-
down list or type a new code.

* Offset: the horizontal and vertical offsets. Press the Down/Up/
Grade button to select the type and value of the vertical offset.
Being input as Grade (in %), the vertical offset will be
recalculated to meters (or other selected units) after the OK
button is pressed.

~ The “hand” symbol means the function is
selectable.

* OK: saves the changes being made and closes the screen.
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Road Design

The road as an object can be described through the horizontal and
vertical projections of the center line, called alignments, and the line
describing the surface of the road and lying in the plane perpendicular
to the center line, called a cross section.

The alignment can be divided into sections, each described with the
help of algebraic functions. The horizontal alignment can be
described through lines, spirals, arcs and intersection points.
Intersection point is defined as the intersection of the two lines
tangential to the 'incoming’ and 'exiting' spirals, or to the central curve
at the PC and PT points, if spirals are not specified. The vertical
alignment can be described through vertical grades and parabolas, or
long sections.

The cross section can be described using templates (see “X-Sect
Templates” on page 3-21 for details).

The Road Design submenu contains four items to select for editing a
road as a whole and for each single component of the road:

1. Roads

2. Horiz Align
3. Vert Align
4. X-Sect Set

Illoertault My RTK] 8@

Job View Survey Stake Cogo Hip

Points
Codes
Point Lists

Layers
X-Sect Templates

Roads
] Horiz Align
% Wert Align
Raw Data X-Sect Set

Figure 3-30. Road Design
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Roads

The Roads screen displays a list of the created roads, and plots of the
horizontal and vertical alignments for each road.

bEA dRoads
MName
T
M
=200 m
®7
< > |=som
[ Delete ] [ Edit ] [ Add ]

Figure 3-31. Roads

The left part of the screen displays the list of created roads. The right
part shows the corresponding plots of alignments.

* Delete: deletes the road from the job.

» Edit: opens the Edit Road screen, displaying the parameters of
the selected road.

* Add: opens the Add Road screen with blank parameter fields to
set a new road.
Tap the bitmap at the upper-left corner to display a pop-up
menu of the following items:

* Import Road(s) From Job: starts the import of roads from the job
selected (“Import From Job” on page 2-85).

* Import Road(s) From File: starts the import of roads from the file
of the selected format (“From File” on page 2-94).

* Export Road(s) To Job: starts the export of roads to the job
selected (“Export to Job” on page 2-105).

* Export Road(s) To File: starts the export of roads to the file of the
selected format (“To File” on page 2-112).

* Help: accesses the Help files.
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Edit Road
The Edit Road screen displays the general properties of the road.

Hw

Name lmﬂl—

Layer |III v u
Hz Alnt [H1 9 .. ]

IV]_ T [ ]
x-Sect Set  [x1 v i ..
Start 5tn Il:l+l]l].l]l]l] m
Stn Interval |100.000 m

Figure 3-32. Edit Road

¢ Name: enter a name for the road.

* Layer: selects the layer on which the road is located. The (. ]
button opens the Layers screen to edit layers (for details refer to
“Layers” on page 3-18).

* Hz Alnt: selects a pre-defined horizontal alignment to use in

designing the road. The [ .- ] button opens the Hz Alnt screen to
edit horizontal alignments (for details refer to “Horizontal
Alignment” on page 3-27).

* Vt Alnt: selects a pre-defined vertical alignment from to use in
designing the road. The [ -] button opens the V¢ Alnt screen to

edit vertical alignments (for details refer to “Vertical Alignment”
on page 3-37).

* X-Sect Set: selects a set of cross section templates to use in
designing the road. The (-] button opens the X-sect Set screen

to edit cross sections sets (for details refer to “Cross Section Set”
on page 3-46).

o Start Stn/ Start Chn: the starting station number with distance to
the station, or the starting chain distance, depending on a
selection made in the Display screen (for details refer to
“Display” on page 2-8).
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* Stn Interval/Chain Interv: the interval between the points where
the road related computations are made.

After the Road is created, calculate the road points. The bitmap
displays the menu of the following items:

* Calculate Road Points: opens the Calculate Road Points screen
(“Calculate Road Points” on page 3-48).

* Help: accesses the Help files.

Horizontal Alignment

The Hz Alnt screen displays a list of the created horizontal
alignments, and the map area to show the plot of the highlighted
horizontal alignment.

=S Hz Alnt [ close |
MName
< ¥ |—=100m

[ Delete ] [ Edit ] [ Add ]

Figure 3-33. Horizontal Alignment
* Delete: deletes the horizontal alignment from the job.

 Edit: opens the Edit Hz Alnt screen, displaying the parameters of
the selected horizontal alignment.

* Add: opens the Add Hz Alnt screen with empty parameter fields
to set a new horizontal alignment.

The bitmap at the upper left corner displays a pop-up menu Of
the Help item.
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Edit Horizontal Alignment

The Edit Hz Alnt screen contains the features of the horizontal

alignment.

The Start Pt tab displays the parameters of the point starting the

horizontal alignment.

Start Pt |Hz

Alnt Name

@ Code
MNorth
East
Start Sta

 E—
FH start pt [100

pi]
i7esatoer

415390.619
0+00.000

|
m
m
m

Figure 3-34. Edit Horizontal Alignment

¢ Alnt Name: the horizontal alignment name.

e Start Pt: the start point name. Can be entered manually (if a new
point name is entered, the point will be created with the
coordinates entered in the North/East fields), chosen from the

map , or selected from the list . The button
opens the Add Photo Notes screen to enter a photo note for the

point.

Code: the point code. Can be entered manually or selected from

the drop-down list. The code of an existing point cannot be

edited. The Attributes List bitmap opens the Code-
Attributes screen to set the values for the attributes available for

the code chosen.

* The bitmap next to the Attributes List bitmap displays the

following list:

— String: toggles the String field. Also, the sign appears.

— Layer: opens the Select Layer screen to select the layer in
which to locate the point (see “Select Layer” on page 3-8).
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— Note: opens the Note screen. For details, see “Topo” on
page 5-24.

* North, East: the local coordinates of the point.

o Start Sta/ Start Chn: the starting station number with distance to
the station, or the starting chain distance, depending on a

selection made in the Display screen (for details refer to
“Display” on page 2-8).

The bitmap at the upper left corner of the screen displays the
menu of the following items:

 Edit Points: opens the Points screen to edit points (see “Points”
on page 3-2).

* Help: accesses the Help files.
The Hz tab displays a list of horizontal alignment elements, the

horizontal alignment plot, and the ending station (or chainage) of

each element. The selected horizontal alignment element is
highlighted in the plot

ERZEdit He AInt ok | cancel
Start pt | Hz
Element Length
£~ Curve 200.000
= Line 100.000
S’ Curve 200.000 ¥
< > =100 m
End Sta 1+00.000
[Qelete] [ Edit ] Ilnsertl v| [ Add ] v|

Figure 3-35. Edit Horizontal Alignment Elements

The element list has the following columns:

* Element: the icon and the name of the element: line, spiral, curve,
or intersection point.

* Length: the length of the element.

» Azimuth: the azimuth at the beginning of the element.
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Radius: the radius of the curve, spiral, or intersection point (the
radius of the spiral is the radius at the end of the 'incoming' spiral
or at the beginning of the 'exiting' spiral; the radius of the
intersection point is the radius of the corresponding curve).

Delete: deletes the element from the road.
Edit: opens a screen with properties of the selected element.

Insert: inserts elements selected from a floating menu (Line,
Curve, Spiral, or Intersection Point) at the selected location in the

list. The bitmap displays the floating menu only after
selecting a location.

Add: adds elements selected from the floating menu to the end of
the list:

— Line: for details see “Line” on page 3-32.
— Curve: for details see “Curve” on page 3-33.
— Spiral: for details see “Spiral” on page 3-34.

— Intersection Point): for details see “Intersection Point” on
page 3-36.

Select a horizontal alignment element, then tap the Station
information under the element list to display brief information on the
start and end stations (or chainages) for the selected alignment
element.

ERZEdit He AInt

Start Pt | Hz

Element Length
100.000

== Line 100.000

S A riarun 200 gog ¥
Start Sta 1+00.000 >
End Sta 3+00.000

[Qelete] [ Edit ] [1nsert]v| [Add ]v|

=100 m

Figure 3-36. Alignment Element Information
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Also the graphics interface can display information on the start and
final positions of the selected element. Double-tap in the plot area to
open the greater Map screen for horizontal alignments.

——200m

Figure 3-37. Alignment Map

Select the alignment element, then double-tap to display information
on the start and end stations (or chainages) for the selected horizontal
alignment element from the map.

Alignment Element Info ..

Start Sta 1+00.000
End Sta 3+00.000
Start North 6178591.778
Start East 415461.330
End North 6178555.938
End East 415625.763

Figure 3-38. Alignment Element Information
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Line

To add a line, press the Insert or Add buttons in the Hz tab of the Add
Road screen and select the Line item from the floating menu. The
Line screen will open.

Length [100.000 m
Azimuth [45.0m00 drms

Figure 3-39. Line
The plot at the bottom-left corner will show the element’s appearance.
» Length: the length of the line element.

* Azimuth: by default, the azimuth is set tangent to the previous
element. This field is editable only for the starting element of the
road. To change the azimuth of all other elements, the check mark
from the Tangent to Previous Item menu on the bitmap in the
upper-left corner of the screen should be removed.

azimuth, since road elements are usually tangential

@ Caution should be exercised when setting the
to each other.

¢ OK: saves the element to the Road and returns to the Add Road
screen.
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Curve

To add a curve, press the Insert or Add buttons in the Hz tab of the
Add Road screen and select the Curve item from the floating menu.
The Curve screen will open.

| J50.000 m
& [Length | [50.000 m
Azimuth [45-0m00 dms
Tun [Rgnt ]
=20

Figure 3-40. Curve

The plot in the bottom-left corner will show the element’s
appearance.

* Radius/ Deg Chord/ Deg Curve: the radius of the curve, or one of

the two parameters unambiguously defining the radius: degree of
chord, or degree of curve.

Using the degree of chord (DCH) or degree of curve (DCV)
parameters, the radius can be calculated as follows:

50 100x180 1
R = . R = X
. (DCH I1 I DCV
Sin 2 X 18

* Length/Chord/Tangent/Mid Ord/External/Delta: the length of the
curve element, or one of five parameters unambiguously defining
the curve length: chord, tangent, middle ordinate (the distance
from the midpoint of a chord to the midpoint of the corresponding
curve), external (the distance from the midpoint of the curve to
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the tangent), or delta (the angle between the radii corresponding
to the curve).

* Azimuth: by default, the azimuth is set tangent to the previous
element. This field is editable only for the starting element of the
road. To change the azimuth of all other elements, the check mark
from the Tangent to Previous Item menu on the bitmap in the
upper-left corner of the screen should be removed.

azimuth, since road elements are usually tangential

@ Caution should be exercised when setting the
to each other.

 Turn: the direction of turn. The Right value stands for clockwise
direction, the Left value for counter-clockwise direction.

¢ OK: saves the element to the road and returns to the Add Road
screen.

Spiral

To add a spiral, press the Insert or Add buttons in the Hz tab of the
Add Road screen and select the Spiral item from the floating menu.
The Spiral screen will open.

a 3| |100.000 m
& |Length |100.000 m
Azimuth [10271745 dms
Turn |Right El

®\O or [ETesc [+]

—=50

Figure 3-41. Spiral

The plot in the bottom-left corner displays the element’s appearance.

* Radius/ Deg Chord/ Deg Curve: the radius of the curve, or one
of two parameters unambiguously defining the radius: degree of
chord, or degree of curve (as shown in “Curve” on page 3-33).
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* Length/Sp Const: the parameter is the square root of the product
of the length and the radius of the spiral, as defined above.
Consequently, the spiral constant has the units of length.

* Azimuth: by default, the azimuth is set tangent to the previous
element. This field is editable only for the starting element of the
road. To change the azimuth of all other elements, the check mark
from the Tangent to Previous Item menu on the bitmap in the
upper-left corner of the screen should be removed.

Caution should be exercised when setting the
@ azimuth, since road elements are usually tangential
to each other.

e Turn: the direction of turn. The Right value stands for clockwise
direction, the Left value for counter-clockwise direction.

* Dir: the direction of movement along the spiral, TS to SC
(entering the turn), or CS to ST (exiting the turn)l.

¢ OK: saves the element to the road and returns to the Add Road
screen.

1. The traverse points on the turn have the following markers: TS -
traverse-spiral; SC - spiral-circle; CS - circle-spiral; and ST - spiral
traverse.
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Intersection Point

To add an intersection point, press the Insert or Add buttons in the Hz

tab of the Add Road screen and select the Intersection Point item
from the floating menu. The Intersection Point screen will open.

Intersel:til:ln Point m

H point [primc
MNorth W m
East IW m
@“ W drms

Figure 3-42. Intersection Point

* Point: the name of the intersection point. Either enter the name
manually (with the coordinates specified in the North and East
fields and a height of zero), or select it from the map or the list.

* North, East: the local coordinates of the intersection point; cannot
be changed for an existing point.

Radius/ Deg Chord/ Deg Curve: the radius of the corresponding
curve, or the parameter, unambiguously defining the radius,
degree of chord, or degree of curve as shown in “Curve” on
page 3-33.

Length1/Sp Const 1, Length2/Sp Const 2: the length of the
corresponding spiral elements, or the spirals constants. The spiral
constants are defined as shown in “Spiral” on page 3-34.

OK: saves the element to the road and returns to the Add Road
screen.
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Vertical Alignment

The Vt Alnt screen displays a list of the created vertical alignments,
and the map area to show the plot of the highlighted vertical
alignment.

=R vt Alnt [ close |
MName
< ¥ |—=—=s0m

[ Delete ] [ Edit ] [ Add ]

Figure 3-43. Vertical Alignment
* Delete: deletes the vertical alignment from the job.

 Edit: opens the Edit Vit Alnt screen, displaying the name of the
selected vertical alignment.

* Add: opens the Add V¢t Alnt screen to add a new vertical
alignment.

The bitmap at the upper left corner displays a pop-up menu Of
the Help item.
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Add Vertical Alignment

The first Add Hz Alnt screen sets the name of the new vertical
alignment and selects a way of creating this alignment.

[EEZ add vt AInt

Name

VAL Type

!Lung Section w

Figure 3-44.

Add Vertical Alignment

There are two ways of creating vertical alignments.

* Long Section: select to create the vertical alignment by sections.
The vertical alignment is presented as a set of sections between
the stations where the heights are known (usually these are the
extremes of the vertical alignment line), and the interval around
the station where the vertical alignment line has a parabolic

shape.

e Elements: select to create

the vertical alignment element by

element, starting and finishing wherever desired and starting

again.

* OK: opens the second Add V¢t Alnt screen

The second Add Vt Alnt screen sets the parameters of the vertical

alignment.

For Element vertical alignment types, the Start Pt tab sets the
parameters of the point starting the vertical alignment (Figure 3-45 on

page 3-39).
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EEZAdd vt aint [ ok Jcancel]
| start Pt | vert |
Alnt Name I@—
Hsartet [ [S58)
@ Code I—v
Ell ht [o-000 -

Start Sta IIII+IIIIII.IIIIIIIII m

Figure 3-45. Add Vertical Alignment
» Alnt Name: the vertical alignment name.

e Start Pt: the start point name. Can be entered manually (if a new
point name is entered, the point will be created with the height
entered in the height field), chosen from the map [=%], or selected

from the list [fE]]. The button opens the Add Photo Notes
screen to enter a photo note for the point.

* Code: the point code. Can be entered manually or chosen from
the drop-down list. The code of an existing point cannot be

edited. The Attributes List bitmap opens the Code-Attributes
screen to set the values for the attributes available for the code
chosen.

* Ell ht: the point height.

» The bitmap next to the Attributes List bitmap displays the
following list:

— String: toggles the String field. Also, the sign appears.

— Layer: opens the Select Layer screen to select the layer in
which to locate the point (see “Select Layer” on page 3-8).

— Note: opens the Note screen. For details, see “Topo” on
page 5-24.
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* Start Sta/ Start Chn: the starting station number with distance to
the station, or the starting chain distance, depending on a
selection made in the Display screen (for details refer to
“Display” on page 2-8).

The Vert tab displays a list of vertical alignment elements, the vertical
alignment plot and the ending station (or chainage) of each element.

Start Pt | Vert
Element Length

[Avertical ... 200.000

. Parabola 300.000

< *| | =100m
End Sta 5+00.000

[Qelete] [ Edit ] [1nsert]v| [Add ]v|

Figure 3-46. Add Vertical Alignment Elements

The element list has the following columns:

* Element: the icon and name of the element: vertical grade,
parabola, or arc.

» Length/Arc Radius: depending upon selection: the length of the
element / the radius of circular arc.

* Start Grade, End Grade: the grades of the element, in percentage,
at the starting and ending points. For a Vertical grade element,
values are the same.

* Insert: inserts elements selected from a floating menu (Vertical

Grade and Curve) at the selected location in the list. The
bitmap displays the floating menu after selecting a location.

* Add: displays a menu of two elements (Vertical Grade and
Curve) to select.

The bitmap at the upper left corner of the screen displays the
menu of the two items:

* FEdit Points: opens the Points screen to edit points (see “Points”
on page 3-2).

* Help: accesses the Help files.
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For Long Sections vertical alignment types, the Start Pt tab displays
only the vertical alignment name.

Start Pt |vert
Alnt Name |m

Figure 3-47. Edit Vertical Alignment

The Vert tab shows the list of vertical long sections, the vertical
alignment plot, and the ending station (or chainage) at each element.

Start Pt | Vert

LongSection | Station

Long Sec... 0+00.000

Long Sec... 3+00.000 |

< ¥ |l =50m
End Sta 0+00.000

[Detete | [ Edit | [ msert | [ add |

Figure 3-48. Edit Vertical Alignment Long Sections
The element list has the following columns:
* Long Section: the name of the element.
e Station: the station distance.
e Elevation: the elevation value on the station.

* VC Length: the vertical curve length is the length of the interval
near the station, where the alignment has a parabolic shape.

Delete: deletes the element from the road.

» Edit: opens a screen with properties of the selected element.
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* Insert: opens a blank Long Section screen in which to insert an
element at the selected location in the list (Figure 3-53 on
page 3-45).

* Add: opens a blank Long Section screen for adding an element to
the end of the list (Figure 3-53 on page 3-45).

Select a vertical alignment element, then tap the Station information
under the element list to display brief information on the start and end
stations (or chainages) for the selected alignment element.

ERZEdit vt aint

Start Pt | Vert

Element Length
200.000
300.000

Vertical ...
Parabola

Start Sta 7+00.000
End Sta 10+00.000

2| =10m

[Qelete] [ Edit ] [1nsert]v| [Add ]v|

Figure 3-49. Alignment Element Information

Also, the graphics interface can display the start and final positions of
the selected element. Double-tap in the plot area to open the greater
Map screen for vertical alignments.

——=100m

Figure 3-50. Alignment Map

For vertical curves, the Map screen will display the PVC point where
the curve begins, the PVI point of intersection of two tangents, and
the PVT point where the curve ends.
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Vertical Grade

To add a vertical grade, press the Insert or Add buttons in the Vert tab
of the Add Road screen and select the Vertical Grade item from the
floating menu. The Vertical Grade screen will open.

b=R 4 Vertical Grade m

Length  [EENENH] m
Gradle [e0.00000 %

e

==100

Figure 3-51. Add Vertical Grade

The plot in the bottom-left corner will show the element's appearance.
. Length: the length of the vertical grade element.

. m Grade: the grade of the element, in percents. If the grade is
falling, the value should be set negative.

¢ OK: saves the element to the road and returns to the Add Road
screen.
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Curve

To add a curve, press the Insert or Add buttons in the Vert tab of the
Add Road screen and select the Curve item from the floating menu.
The Curve screen will open.

[ ox_Jconcel
Curve Type v
Length |25.uuu m

Start Grade [15.00000 %
End Grade [-3.00000 %

—

——=10m

Figure 3-52. Add Vertical Curve
* Curve Type: selects the type of the curve to add, either Circular
Arc or Parabola.

The plot in the bottom-left corner will show the element
appearance.

* Arc Radius or Length: the radius of the arc or the length of the
parabola element depending on the type of the curve selected.

* Start Grade, End Grade: the starting and ending grades of the
element, in percents. If the grade is falling, use a negative value.

¢ OK: saves the element to the road and returns to the Add Road
screen.
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Long Section

The Long Section screen contains parameters of the section.

Station [2+0.000 m
Elevation |193.471 m

Curve Type v
¥C Length |3|:|_|:||:||:| m

—=20m

Figure 3-53. Long Section

* Station: the station distance from the beginning of the road.

* Elevation: the height at the station.

* Curve Type: selects the type of the curve to add, either Parabola
or Circular Arc.

The plot in the bottom-left corner will show the element
appearance.

* VC Length or Arc Radius: the length of the parabola at the station
(with the assumption that the station is located in the middle of
the interval), or the radius of the arc depending on the type of the
curve selected.

¢ OK: saves the element to the road and returns to the Add Road
screen.

P/N 7010-0492 3-45



Edit

Cross Section Set

The X-Sect Set screen contains a list of cross section sets and a
general scaled view of the highlighted cross section set.

X-Sect Set

Close

Name

< 4

—=100m

| Delete |

l Edit l

(o |

Figure 3-54. X-Section Set

* Delete: deletes the cross section set from the list.
» Edit: opens the Edit X-Sect Set screen, displaying properties of

the selected cross section set.

* Add: opens a blank Add X-Sect Set screen to create a new set of

Cross sections.

Edit Cross Section Set

The Edit X-Sect Set screen contains a list of stations where cross
sections are applied, and a scaled plot of a cross section at the

highlighted station.
[EBZEdit x-sect set
X-Sect Set Name [x1
Station Left X-Sect... | Right X-Se. ~
0+00.000 1 1
3+00.000 1 2
A+NN.NNN Pl pJ he
< >
P a P
[ petete | [ Edit |[ ada |[¥]

Figure 3-55. Edit X-section Set
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* X-Sect Set Name: the name of the cross section set.
* The list of stations contains the following columns:
— Station: the station where the cross section is applied.

— Left X Section, Right X Section: the names of the cross section
templates for the left and right parts of the road cross section
relative to the center line. The left and right cross sections can
be different.

intermediate cross sections are calculated using

% If two or more cross sections are defined, the
interpolation.

— Delete: deletes the station with the road cross section from
the list.

— Edit: opens the X-Section screen displaying properties of the
selected road cross section.

— Add: opens a blank X-Section screen.

Cross Section

The X-section screen contains parameters of the road cross section at
a given distance and a plot of this cross section.

Station m

X-Sections IButh v
Left X-Section |1 v
Right X-Section |1 v
P L P
———————10m \/

Figure 3-56. X-Section

* Station/Chainage: the station where the cross section is applied,
or the distance to this station.
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* X-Sections: selects whether the cross section is created for both
parts of the road or only for the left or right side of the road. The
screen display changes depending on the selection.

* Left X-Section, Right X-Section: the cross section templates for
the left and right side of the road cross section. These can be
chosen only from the existing cross section templates.

¢ OK: saves the X-section in the list and returns to the Add Road
screen.

The bitmap at the upper left corner of the screen displays the
menu of the two items:

o Edit X-Sect Templates: opens the X-Sect Templates screen to edit
cross section templates (see “X-Sect Templates™ on page 3-21).

* Help: accesses the Help files.

Calculate Road Points

The Calculate Road Points screen generates points along, to the right
and to the left of the center line of the road, along all its entire length.

Call:ulate Road Points ..
Points to Generate
:

Points Right of Centerline
Points Left of CenterLine
Include Transition Points

PrefixfSuffix INune v

Station Interval |100.000 m

Figure 3-57. Calculate Road Points

* Points to Generate: defines the points to generate - center line
points, the points to the right of the center line, and/or the points
to the left of the center line. Also, if it is desired along with the
line points to include the transition points, place the check mark
in the corresponding fields, and select a prefix/suffix for them, if
necessary, in the appearing field below.
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e Station Interval / Chainage Interv: sets the interval between the
generated points. By default it is the Station (or Chain) Interval
set in the Srart Pt tab on the Roads screen.

» Next: opens the appropriate screen, depending on the selection
made in the Points to Generate group. The last screen contains
the Calc button to calculate the road points along the desired line.

Centerline Points Parameters

The Centerline Points Params screen displays the parameters of
points to be computed along the center line (Figure 3-58).

Centerline Points Params Cancel

First Point [FEi

E¥ code I v
PrefixfSuffix INDne w

[]save Points To Point List

I <« Back ] Iuext 53 ]

Figure 3-58. Centerline Points Parameters
» First Point: the name of the first point. The button opens the
Add Photo Notes screen to enter a photo note for the point.

* Code: the code of the points being generated; enter manually or

select from the drop-down list. The Attributes List bitmap
accesses the attributes of the chosen code and opens the
Code-Attributes screen (see “Code-Attributes” on page 3-10).

* The bitmap next to the Attributes List bitmap displays the
following list:

— String: toggles on the String field. Also, the sign appears.

— Layer: opens the Select Layer screen to select the layer in
which to locate the point (see “Select Layer” on page 3-8).

— Note: opens the Note screen. For details, see “Topo” on
page 5-24.
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Prefix/Suffix: when selected, sets the prefix or suffix to be added
to the generated point name.

* Save points to Point List: check if it is necessary to save the
generated points to a separate points list. When checked, a field
appears where the name for the list can be set.

Back: returns to the previous screen.

Next: opens the Right Offset Points Params screen.

Right Offset Points Parameters

The Right Offset Points Params screen displays the parameters of
points to be computed to the right of the center line.

Right Offset Points Params

First Point [FEi
@ Code I v
PrefixfSuffix INDne w

[]save Points To Point List
Offsets

Type ISurfal:e Offset  +

Right jp.oo0 & [Up  |[p.ooo m

I <« Back ] Iuext 53 ]

Figure 3-59. Right Offset Points Parameters

e First Point: the name of the first point. The button opens the
Add Photo Notes screen to enter a photo note for the point.
* Code: the code of the points being generated; enter manually or

select from the drop-down list. The Attributes List bitmap
accesses the attributes of the chosen code and opens the
Code-Attributes screen (see “Code-Attributes” on page 3-10).

» The bitmap next to the Attributes List bitmap displays the
following list:

— String: toggles on the String field. Also, the sign appears.

— Layer: opens the Select Layer screen to select the layer in
which to locate the point (see “Select Layer” on page 3-8).
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— Note: opens the Note screen. For details, see “Topo” on
page 5-24.
* Prefix/Suffix: when selected, sets the prefix or suffix to be added
to the generated point name.

* Save points to Point List: check if it is necessary to save the
generated points to a separate points list. When checked, a field
appears where the name for the list can be set.

* Offsets: set the offset of the point from the center line along two
dimensions: horizontal (the Right field) and vertical (the Up/
Down field) relative to the surface (Surface Offset type) or to the
horizontal line (Flat Offset type).

* Back: returns to the previous screen.

¢ Next: opens the Left Offset Points Params screen.

Left Offset Point Parameters

The Left Offset Point Params screen is similar to the Right Offset
Points Params screen, except for the direction of the offset.

Left Offset Points Params
First Point [Ty
E¥ code I v

PrefixfSuffix INDne w

[]save Points To Point List
Offsets

Type ISurfal:e Offset  +

Left jo.ooo & (Up  |[p.ooo m

Figure 3-60. Left Offset Points Parameters

* Calc: calculates the points and stores them to the data set.
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Linework

The Linework is a group of points connected with a line. Points
defined by the same code string automatically form a linework.

To edit a linework, tap Edit » Linework.

The Linework screen contains a list of existing Lineworks on the left
side of the screen, and the two windows on the right side, that present
the view of the selected linework in the horizontal and vertical planes.

b dlLinework Close

List of Lineworks '%

T

~ e noline-53000004
=200 m
T

< ?| |=100m

Figure 3-61. Linework

To view the current selected linework in a larger map, double-tap one
of the map plots.
* Delete: press to delete the Linework from the list.
¢ Edit: opens the applicable Edit Line screen.
¢ Add: opens a blank Add Line screen to create a new linework.
The Linework can be created in four ways: by selecting the points

with the desired codes or code strings, by tapping the points on
the map, or by selecting the points from the list.

The bitmap at the upper-left corner displays the following
pop-up menu:
* Edit Points: displays the Points screen. For details, see “Points”
on page 3-2.
* Help: accesses the Help files.
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Edit Line

The Point in Line tab of the Edit Line screen displays a list of existing
points in the selected Linework on the left part of the screen, and the
general view of the linework on the right part. The hand symbol on
the plot indicates the point highlighted in the list of points. To view
the current selected linework in a large map, tap on the map plot.

EEA 4 Edit Line
Points in Line |LayerfStyle
Linework Name ine-53000004]

[#][ List of points | codet 'ﬁ
& 100 a
& 101 b

# 106 e

®l¢ *|| e=z00m >

Point Info Select Points [Fw

Figure 3-62. Edit Line — Points in Line

e Linework Name: the name of the Linework.

e List of Points: points and their codes (if any) in the selected
linework.

* The up and down arrows to the left of List of Points move the
highlighted point up or down in the order of the points in the
linework.

. : toggles on/off the keyboard arrow keys that duplicate the
arrows on the screen.

. : deletes the highlighted point from the linework.

. E: closes the plot of the point list. Only the list of points table
will be available.

* Point Info: displays information on the selected point.

¢ Select Points : displays a floating menu of four items to
select the method of adding points to the beginning of the line:
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— By Code: select the codes with which the points will be added
to the line.

— By Code String: select the codes and strings with which the
points will be added to the line.

— From Map: select the points by tapping them on the map; the
two sequentially tapped points will be connected with a line.

— From List: select the points using the list of points.
The bitmap on the upper-left corner displays the following
pop-up menu:

* Edit Points: displays the Points screen. For details see “Points” on
page 3-2.

* Help: accesses the Help files.

The Layer/Style tab of the Edit Line screen sets a type and color to
display the line in the selected Linework on the map.

iR 4 Edit Line ok | cancel
Laver/style

Layer By Code> w

Line Style

|4By Code> +| | Color
Width I{By Code>

Figure 3-63. Edit Line

* Layer: selects the layer for the line from the drop down list.

* Line Style: selects the form and width of the line from the drop
down lists and shows the result.

¢ Color: opens the Select Color screen to choose the color for the
line (see “Select Color” on page 3-9).
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To edit raw data, tap Edit » Raw Data.

This screen has the following columns and buttons.

Raw Data

Name Type
#Base2  ph. ...
FTA Topo
#7182 Topa Name Type | Codes HI ~
F1B3 Topo HV _ _ _
9 HV Name | Type | HI Mid Wire | D~
! WT :VSA CC 1Wire 1.313 1.3130
= == =2 raaz 1wire 1313 15150 1
Find by Point || Find b | ¢ 1 1wire 0994 1.1960 1
E bez  1wire 0497 07740 1
= bz 1wire 1027 13040 1
Find by Point || Find < >
[ st || rast ][ Eait

[Find by Point ”Find by Code ] Find Next

Figure 3-64. Raw Data - GPS, TS and DL, respectively
* Name: point name and the icon displaying the type of the point
* Type: the type of measurement
* Codes: codes for the point

* HI: for TS mode, the height of the instrument; for a Level survey,
the elevation of the line of sight of the levelled instrument above
the datum.

* Ant Ht: for GPS+ mode, the antenna height.
* Coordinates: the coordinates of the point (TS and GPS+ modes).
* Mid Wire: the reading on the middle wire for Level survey.

e Distance: the horizontal distance between the Level and the rod
for Level survey.

* Ctrl Code: control code for the point.
* Notes: additional information on the point.

* Local Time: the local time when the point is collected.
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* First and Last: moves the cursor to the first or last point.

 Edit: opens the Edit Raw Data screen to edit user-entered raw
data.

* Recompute: recomputes the point coordinates after editing the
point’s raw data.

* Find by Point: finds a point by its name or a part of its name.
* Find by Code: finds a point by its code or by a part of the code.

* Find Next: finds the next point that satisfies the same conditions
as the previous found point.

¢ Close: closes the screen.

The button in the upper-left corner of the screen enables the menu of
three items:

* Job Info: displays the Job Info screen.

* Show Raw GPS+/TS: toggles between displaying GPS+ raw data
and TS raw data.

* String: displays strings for points among raw data.

* Help: accesses the Help files.
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The Edit Raw Data screen is used to edit the name and code of the
surveyed point, and the antenna/instrument height at this point. The
title of the first tab is the survey type for the point being edited.

Raw Data

[oc Jconce]
Topo |Data —
[iEA4Edit Raw Dat
@] point  [B2 =8 3] a
ide Shot | Data
@ Code IP w
& pont [T |
ant Ht  [1fo00 m  [vert J B code | v
Ant Type ICR—3 v
Note (% HR [1-636 m
Note

Figure 3-65. Edit Raw Data - GPS and TS measurements

The Data tab displays information on the point’s measurements.

[ERdEdit Raw Data [ ok |

Topo | Data

iER 4 Ed

X
dy
dZ
Local Time

Data OK Cancel

Side Shot | Data |

2004:11:04::00:34:40

Local Time

HOWD

35.0000

0.262 m

14,998 m
2004:11:23::00:24:08

Figure 3-66. Edit Raw Data — Data Tab
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In addition to these two tabs, the Edit Raw Data screen for DL
measurements contains a Meas tab to adjust rod readings, distances,
and vertical offsets.

[ERZEdit Raw Data [ ok | cancel

| side Shot | Meas |Data |

Mid Wire [1.515] m

Distance |1III.IIIIIIIII m
V. Offset Il:l.l:ll:ll:ll:l m

Figure 3-67. Edit DL Raw Data — Meas Tab

For the base station, the Edit button opens the PC Coords screen to
display the base coordinates available for editing.

WGS84(m)
Lat ;
Lon |7.290288802
Ell ht |158.684

Figure 3-68. Base Station Coordinates

Northern Hemisphere and negative in the Southern
one. The Longitudes are positive for the Eastern
direction and negative for the Western direction,
relative to the GMT line.

; The Latitudes are considered to be positive in the
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Sessions

To create or edit sessions of the automatic survey for post-processing,

select Edit » Sessions.

Sessions

Sessions

o Jconcel
E Receivers

1D Type
Site_1  Static

Stz [ =-
Sul

>

Figure 3-69. Sessions

¢ Sessions: a list of the available sessions. The table contains the
following columns: ID, Type, Start Day, Start Time, End Day,

End Time, and End Date.

» Receivers: the list of the available receivers and their session
plans. To hide/display the session plans of the receiver, tap on the
“-/+” sign located near the receiver name.

» Edit: press to edit the existing session. The Session Setup screen

opens.

* Add: (left) press to create a new session. The Session Setup

screen opens.

* Add: (right) press to add a receiver. Enter the receiver name in
the Receiver Name screen being opened.

. : use to put the session to the session plan of the receiver. In
the Sessions screen highlight the desired session in the left panel
and the necessary receiver in the right and press this button.

. : use to delete the session from the sessions list or receiver.

* OK: saves the changes and close the screen.
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Session Setup

The Session Setup screen contains the parameters of the session.

Sessiun Setup m
Site Name lw Type Im
Start Time m |u_% |u_%
End Time |Sunday v |III ﬁ |III Ilfll
Interval [3p sec Min SVs |4—

ant Type |Legant 2 v

Ant Ht IIII.IZIIIIIII m |Verti|:al w

Figure 3-70. Session Setup
* Site Name: the name of the occupation point.
» Type: the type of the session survey, static or kinematic.
o Start Time, End Time: the time and date of the start and end
e [nterval: the interval between measurements,
* Min SVs: the minimum satellites available for the survey
* Ant Type: the type of the antenna.
» Ant Ht: the value and type of the antenna height.

* OK: saves the changes and returns to the Sessions screen.

display in the receiver file. But the antenna height
recorded in the file includes offsets for the specified
antenna type.

@ The antenna type specified in this screen will not
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Chapter 4

View

The View menu contains the following menu items:

Enable

Zoom In

Zoom Out

Zoom Window
Zoom All

Zoom To Point
Toolbar
Background Images

Properties

I roAD [My RTK] g &
Job Edit B Survey Stake Cogo Hip

'% v Enable

Zoom In
Zoom Out
Zoom Window
Zoom All +
Zoom To Paint

Toolbar
Background Images
———2000 | Properties

Figure 4-1. View Menu
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Enable

To display the job map on the main screen, tap View » Enable.

Ielroso My RTK] R
Job Edit View Survey Stake Cogo Hip

4

FsllROAD [My RTK] =P}
Job Edit View Survey Stake Cogo Hip

(0.000

Road Stakeout
Real-time Road Stakeout
Slope Stakeout

ooy =y ol I

Edit
Delete

Stakeout Wertices

T =FT A

Add To Layer

Edit
Delete

Add To Layer

Figure 4-2. Main Map
The Main Map allows:

* Selecting/deselecting objects on the map. To do this, tap on the
desired object (point, line, road).

* Selecting objects with a window. Click the : button and draw
a frame from right to left to highlight the desired objects.

* Access to the stakeout from the Main Map. Select the object to be
staked, press Alt on the controller’s keyboard and tap the object,
or hold the stylus on the selected object for a while. A pop-up
menu displays the options available for the selected object
(Figure 4-2).

» Editing a single selected object (point, line, road). Select Edit
from the pop-up menu.

* Deleting selected objects. Select Delete from the pop-up menu.

* Adding selected objects to Layers. Select the Add to Layer option
from the pop-up menu.
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Zoom In/Out/Window

Zoom In/Out/Window

For display customizing, tap View » Zoom In, or View » Zoom Out,
or View » Zoom Window to zoom the plot inwards, or outwards, or
scales the plot to fit it the screen, respectively.

Zoom All

To return the map to the initial view, tap View » Zoom All.

Zoom To Point

To select a point for centering, tap View » Zoom To Point and choose
the point in the Select point screen.

[ERdsetect Point [ ok |

t 6. Lo
52 Lat:55.42139... Lom:37.c
1 Lat:55.42140... Lom:37.c
2 Lat:55.42140... Lom:37.c
3 Lat:55.42141... Lomi37.c
11 Lat:55.42139... Lom:37.l
12 Lat:55.42141... Lomi37.c
21 Lat:55.42139... Lom:37.l
22 Lat:55.42141... Lom:37.c

pOO01 Lat;55.42118... Lon:?ﬁz
1] |

Figure 4-3. Select Point
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Toolbar

To display the bar of control buttons of viewing options, tap
View » Toolbar.

I3 1100 [My RTK]
Job Edit View Survey Stake Cogo

I
&

i
=

I% 1 133 g
é%s%“ = 5 %
2. s ol
B2 2&?%
. %

———50m

Figure 4-4. Toolbar

1 zooms in

&
« 18] : z00ms out
a8

: selects a frame of objects for zoom-in display; when
drawn from right to left, selects the desired objects

. : displays all points in the job

. & : opens the Points screen

2 .
» | 1| : opens the Map Properties screen

The Main Map maintains the scale and displays the scale bar after
changing the status of the main map.
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Background Images

Any raster images in TIF, JPG, and BMP formats are supported to be
read. To be positioned correctly under all observed data on the map
screen, the images need to have geo-referenced data. GeoTIFF
images already include geo-referenced data, while the others use a
separate file that references the geographic location of the image.
This file is called World file. The World file contains information
about the size of the corresponding image and the coordinates of the
geo-reference point (the upper left corner of the image) in the
coordinate system of the job. The World file must have the filename
extension associated with the image format (TFW, JGW or BPW) and
should be located in the same directory as the image file.

To load an image, tap View » Background Images. The Background
Images screen displays a list of available image files. Initially, the list
is empty.

Background Images m
Format |Filename |Units |
v|Geo... TESTGEOTIFF m
IEmperties] I Delete ” Add l

Figure 4-5. Image List

* Properties: opens the Properties screen for the highlighted file.

Delete: deletes the currently selected file from the list.

* Add: opens the Add Image screen to browse the controller’s
directories for the desired file.

» Cancel: exits out of the screen without changes.

* Up/Down arrows: moves the selected images up or down in the
list.
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* OK: opens the selected file (Figure 4-8 on page 4-7). If no world
file exists for the background image file selected, a warning
displays, and the Background Images screen will appear again to
select another file.

Multiple background images can be selected, but is limited by the
amount of free space in the controller memory.
Add Image

The Add Image screen selects an image file to add to the Background
Images list.

Type [GeoTIFF (*.tif;* v

\CF Card\TP5\TopSURV\Images}

[EF]

(1108
TESTGEOTIFF. tif
lcc-datum. tif

Name ITESTGEOTIFF.tif

Figure 4-6. Add Image

* Type: selects the type of the image to be added, either GeoTIFF,
TIFF, JPEG or BITMAP.

* Name: displays the name of the selected file.

* OK: opens the Properties screen for the selected file.
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Properties

If the selected image uses a World File, select the projection in which
the coordinates in the World File are given: either Current job
projection or UTM.

Pmperties . 0K I Cancel |
File Name: IMG_0007
File Path: \CF Card\IMG_0007.IPG
File Type: IPEG
Projection: ICurrent W
Ui v
Use World File

Figure 4-7. Properties of Background Image

* OK: returns to the Background Images screen with the file
added to the list. To use a file once it is added, make sure the file
is checked in the list.

Default <Defauli>

Job Edit View Survey Stake Cogo Hip

®

&
£V
a

i

e |
i

Figure 4-8. Background Image (on Main Map)

To map a Background Image correctly, the image
= . (it’s geo-reference point) should be in the job’s
current coordinate system or at least in a very
similar one (e.g., in a corresponding UTM zone).
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Properties

The Map Properties screen customizes the map view by adding
properties to the points (names, codes, heights, etc.), displays the
Auto Topo points, or sets the application to adjust the scale
automatically (the Autoscale field).

Autoscaling works to display 30 most recent points of a survey on the
map screen.

Map Properties m

Show Roads
Names [ station
[ ] Icons [ ] Templates
[] Auto Topo
[ ] Codes Show Lines
[ ]Heights
[] Autoscale

[ ] Current Position

Figure 4-9. Map Properties

To enable the points displaying, place a check mark in the Show
Points field. Along with the points, their names, codes, icons, heights,
and/or auto topo points can be displayed.

In addition, you can display roads, turn on the linework on the map,
perform autoscaling, and start each time from the current position.
Checking the Current Position field also means that if the current
position moves off the edge of the map, it will automatically snap
back to the center.

Most TopSURYV functions can be performed with the help of the Map
view (for example, see Figure 4-10 on page 4-9 for a Topo survey).
Depending upon the task, the appearance of the view changes. Mostly
it duplicates the controls located on the main task page. But it also
contains some controls that do not depend on the function being
performed. These controls correspond to the viewing options and
display customizing.
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[ 41 Topo ]Data| Map |0ffsets]

Eotongs] cove

QJf
Q)
Q)
| 130

%I —==50m .

Rl e s

Figure 4-10. Topo — Map

Properties

Points can be selected from the Map when the point selection is
needed (for instance, to stake out).

P/N 7010-0492
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Figure 4-11. Map



View

Notes:
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Chapter 5

GPS Survey

The Survey menu appearance depends upon the survey type selected
and can include the following menu items:

* Status

 Start Base

¢ Init mmGPS+ (only for mmGPS+ RTK)
* Topo

* Auto Topo

* Known Point Init

* X-Section

* Find Station

» Tape Dimension

* Static Occupation (only for PP Static)
* Localization

I3 1100 [My RTK] R
Job Edit View m Stake Cogo Hip

Status
Start Base

Topo

Auto Topo
Known Paint Init
*-Section

Eind Station
Tape Dimension

Localization

Figure 5-1. RTK Survey Menu
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GPS Survey

Status

To check the status of a GPS+ survey, tap Survey » Status.

The Status screen contains information about the position of the
receiver, RTK status, and the satellite constellation.

The bitmap in the upper-left corner of the screen displays a menu that
varies depending on the configuration type used:

* Rover Antenna Setup: opens the Antenna Setup Screen (see
“Config: Rover Antenna” on page 2-42).

* Config OmniSTAR: opens the OmniSTAR screen to view the
status for OmniSTAR service (see “OmniSTAR” on page 5-9).

* Config Beacon: opens the Beacon screen to view the status for
Beacon service (see “Beacon” on page 5-10).

¢ Config Radio: opens the Configure Radio screen (see “Config:
Rover Radio” on page 2-34).

* Reset RTK or Reset DGPS: reinitializes the receiver.
* mmGPS+ Options: opens the mmGPS+ Options screen.
* Help: accesses the Help files.

The Position tab displays the following information:

[ status
Position |System | ScatterPlots | SVs |

&1 & 10 UTC  [08:11:13
Fixed
WGS84(m)
Lat 55 :43: 2008621 N
Lon 37 :39: 2.86618 E

Ell ht 166.978

'_":: PDOP 1.8 H 0.011 V 0.012 m

Base Dist 2.100 m

Figure 5-2. Status — Position

* Total number of available satellites. The lock icon signifies the
number of the satellites tracked, the star icon shows the number
of satellites used in position determination.

5-2 TopSURYV Reference Manual



Status

When using a mmGPS system, the Position tab displays a

mmGPS icon || This icon displays when the receiver

calculates mmGPS heights.
UTC: the current UTC time.

The type of the position calculation method: Autonomous, Fixed,
Float, Code Differential.

WGS84: the coordinates of the antenna in the selected coordinate
system; this field changes its name based on the chosen value in
the Coordinate System screen (see “Coordinate System” on
page 2-5), Display screen (see “Display” on page 2-8), and the
chosen distance units (see “Units” on page 2-6).

* PDOP: the PDOP value; a factor depending solely on satellite
geometry describing how the uncertainty in the coordinates will
depend on the measurement errors. PDOP is proportional to the
estimated position uncertainty.

e H and V: stand for HRMS and VRMS, the RMS! values of the
horizontal and vertical coordinates, respectively.

* Base Dist: slope distance to base antenna. The field is empty if no
differential corrections are received.

The System tab displays information about the current state of RTK
measurements.

ERZstus

| Position | System | ScatterPlots | Svs |

m Position Type Fixed
ﬂ Common Sats 11
& Initialized Sats 10
?"'Radio Link 100%
Rtk-Age{sec) 1
Receiver Memory(KB) 31328.7
Receiver Power (%) 100
Controller Memory(KB) 42910.0
Controller Power(%) 100

Figure 5-3. Status — System

1. RMS means Root Mean Square — a factor that characterizes the
precision of the collected coordinates.
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* Position Type: the type of the position calculation method:
Autonomous, Fixed, Float, Code Differential.

e Common Sats: the number of satellites common to the base and
rover used in RTK solution.

* [nitialized Sats: the number of satellites contributing to the
solution.

* Radio Link: a checksum reading from the radio as the base
generates packets. 100% means all packets have been received.

* RTK Age: how much delay is seen between the marker of the last
RTK message received from the base and the epoch being solved
at the rover.

* Receiver Memory: the remaining memory of the receiver.

* Receiver Power: the current receiver power value.

» Controller Memory: the available memory in the controller.
» Controller Power: the current controller power value.

* Settings: opens the Elevation Mask screen.

Elevation Mask

The Elevation mask screen sets the value for the minimum threshold;
data from satellites below this elevation angle will not be used.

iER 4 Elevatio 3 Cancel
Elevation Mask for IRover :I
Elevation Mask L] deg

Figure 5-4. Elevation Mask
e Elevation Mask for: sets the device of elevation mask application.

e Elevation Mask: the value of the elevation mask.
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¢ Set: sends the current elevation mask to the base or rover receiver
as chosen above.

If the rover receives CMR+ corrections from more than one base, an
additional tab called Multi Base will appear in the Status screen at the
rover side. Muti Base mode is set in the Start Base screen (see
Figure 5-17 on page 5-14).

The Multi Base tab displays a list of the base stations with their
parameters (age, link quality, type, etc.).

3 1 100 Fixed 1054,
] 4 - 1 100 - 4466.
] 5 1 100 - 1709.
< >

Figure 5-5. Status — Multi Base Tab

 Use: selects/deselects the desired base for RTK processing.

Currently, TopSURYV supports processing RTK
baselines from one base at a time.

The Scatter Plots tab displays the current receiver position
(Figure 5-6 on page 5-6).

. I&% : zooms the plot inwards.

. E& : zooms the plot outwards.

= : switches the vertical scatter plot to the horizontal one.

. E : switches the horizontal scatter plot to the vertical one.
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b4 Status Se 5
Multi Base | ScatterPlots I:'I

166,889 m {

Vertical scatter plot

[Sottngs | Gioee |

ScattorPiots [svs | [ 1[>

MP.00m

166,879 m 30secy

SR

Horizontal scatter plot

Figure 5-6. Status — Scatter Plots

T
. ﬂf}g : opens the Properties screen from which to set graphical
features for the scatter plots (Figure 5-7).

Time Window (secs) |ﬁ|

. Vertical scatter plot

Properties m Cancel

Show Grid

Horizontal scatter plot

Figure 5-7. Properties (Scatter Plot)
— Time Window: duration in seconds for the time axis.
— Show Grid: if selected, displays the local coordinate axes

— Auto Zoom: if selected, automatically scales the horizontal
scatter plot to fit into the screen.
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The SVs tab of the Status screen displays the graphical position of the
satellites on the sky.

ERgsts:

[Position | System | ScatterPints | Svs |

N\

;
Figure 5-8. Status — SVs Plot
* Show GPS: shows/hides the GPS satellites images.

* Show GLNS: shows/hides the GLONASS satellite images.
GLONASS satellites are marked with a “+” sign.

* SNR: toggles the appearance of the screen to a table displaying
the signal-to-noise ratio of each of the satellites (Figure 5-9).

E -] |
[Position | System | ScatterPints | Svs |
SNR L1|L2 (dB*Hz)

6
£ [ show ars

48 @ [V Show GLNS
Lz

|16

1724253036 0

Figure 5-9. Status — SVs SNR

* List: toggles the appearance of the screen to the table displaying
the table of the satellites parameters (Figure 5-10 on page 5-8).

— PRN: shows the number of the satellite.
— H/U: shows whether healthy or unhealthy.
— EL: shows the elevation angle of the satellite.

— AZ: shows the azimuth of the satellite.
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— SNRI: L1 signal to noise ratio.
— SNR2: 1.2 signal to noise ratio.

ERZstus

[Position | System | ScatterPints | Svs |

HESRERE S

prn & | Ul EL

&1 H 10 298 37
& a H 222 47 42
&= H 55 148 52
&e H 43+ 254 47
@ 10 H 9 126 29
&1 H 57+ 13 =0

15
25 L
41
36
21

o

£ show GLNS

Figure 5-10. Status — SVs List

* Back: toggles between this screen and the sky plot view.

¢ Close: closes the screen.

means that for some reason, the signal from this

@ The absence of “wings” on the satellite image

satellite is not used in the positioning (for example,
below elevation cutoff).
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OmniSTAR

The OmniSTAR screen starts the OmniSTAR service for DGPS
survey type. To open this screen, select the Config OmniSTAR item
from the bitmap menu in the upper left corner of the Status screen.

The same item is accessible from the Topo and Auto Topo screens.

EEICI G EA SAT Lon 25E v

OmniSTAR SN NfA
Subscription NfA

Status

Figure 5-11. OmniSTAR
o Satellite: selects the satellite that the receiver is subscribed to.

¢ The lower field shows the OmniSTAR serial number and
subscription.

* Status: opens the OmniSTAR screen to view information on
OmniSTAR link and the receiver OmniStar board (Figure 5-12).

OmnISTAR
Satellite SAT LOM 208

| [«]
OmNiSTAR SM 200230 ==
Subscription 2001¥12M31023h59. .
Wersion 1.51
Freguency 1535.2 MHz
g |

Set Satellite

Figure 5-12. OmniSTAR Status

* Set Satellite: connects to the selected satellite and begins logging
data from this satellite.
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Beacon

The Beacon screen starts the Beacon service for DGPS survey type.
To open this screen, select the Config Beacon item from the bitmap
menu in the upper left corner of the Status screen.

The same item is accessible from the Topo and Auto Topo screens.

Beacon OK | Cancel
Countny v
Station |ACUSHNET, MA v

Figure 5-13. Beacon

* Country: the country where the radio-beacon differential service
is located.

* Station: the station that provides broadcasting differential
corrections for the rover.

* Status: opens the Beacon Status screen to view information on
beacon link and the receiver beacon board (Figure 5-14).

Beacon Status ..

Station ACUSHNET, MA

Version NfA
Frequency NfA
Signal Quality  NjA

Figure 5-14. Beacon Status
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mmGPS+ Options

The mmGPS+ Options screen displays the status of mmGPS+ in
RTK survey type. To open this screen, select the mmGPS+ Options
item from the bitmap menu in the upper left corner of the Status
screen.

mmGPS+ Options m

mmGP5+ is DISABLED

Turn mmGPS+ ON -

|:| Use weighted height computations

Height Difference Limit IIII.BIIIIII m

Figure 5-15. mmGPS+ Options

¢ Select “Turn mmGPS+ ON” to enable the use of mmGPS+ in
height computation.

» Use weighted height computations: select to combine mmGPS
elevations and GPS elevations. When selected, this option will
force the receiver/sensor to always consider the angle and
distance when determining the elevation, then combine the two
elevations accordingly. This option works well at large (300m)
distances and steep angles.

* Height Difference Limit: sets the threshold for the difference
between GPS and mmGPS+ height measurements.
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Start Base

To start a Base, tap Survey » Start Base.

The Start Base screen contains information about the Base receiver
and can be used for the Base Receiver setting in a PP enabled RTK
survey.

D il Flaat

Foe
Point  [STAT1

Code v

Ant Ht |1.000 m I\."ertil:al w
WGSB84(m)

Lat 40.060582481

Lon -82.591200350

Elht  [247.233 Auto Pos
Duration 0:00:00 Start Base

Figure 5-16. Start Base

* Point: selects the name of the point of the Base receiver location
from a map or list, or entered manually. The button opens
the Add Photo Notes screen to enter a photo note for the point.

* Code: the code of the point. Can be selected from the list, or
entered manually. Also the attributes can be selected with the help
of the Attributes List bitmap. The bitmap next to the Attributes
List bitmap displays the list of additional features: String, Layer
and Note. For details, see “Topo” on page 5-24.

* WGS84: (for RTK mode) the coordinates of the antenna in the
selected coordinate system. Changes its name based on the
chosen value in the Coordinate System screen; that is, WGS84 or
Local (see “Coordinate System’ on page 2-5), the Display screen
(see “Display” on page 2-8), and the chosen distance units (see
“Units” on page 2-6).

* Auto Pos (for RTK mode): measures the position of the current
point. Once pressed, the button becomes a Stop button; press it to
stop position averaging. The average of the coordinates displays
and the Pos field appears with the number of measurements used
for averaging.
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» Ant Ht: the antenna height and type of measurement (vertical or
slant).

* Duration and Remaining Time (for PP Kinematic mode): displays
the time passed and remained since the beginning of the survey.

» Start Base: sets the receiver as a Base transmitting data.

The bitmap on the upper-left corner displays the pop-up menu which
can display the following items depending on the survey type chosen:

e Status: opens the Status screen (see “Status” on page 5-2).

 String: toggles on the String field to enter a string for the code.
Also, the sign appears.

* Base Antenna Setup: opens the Antenna Setup Screen (see
“Config: Rover Antenna” on page 2-42).

¢ Config Radio (for RTK mode): opens the Configure Radio
screen. For details, see “Config: Rover Radio” on page 2-34.

* Multi Base (for RTK survey type): opens the Multi Base screen to
set the multi base mode. This mode allows the base stations to use
a single frequency for transmitting data. Setting a transmission
delay for each station prevents signals from colliding.

Multi Base

The Multi Base function in TopSURYV is implemented using Time
Division Multiple Access (TDMA) mode of transmission. This means
that one Base can transmit at the beginning of the second and another
Base can transmit a half second later on the same frequency. The
Rover can recognize the two separate data streams.

to transmit at the same frequency and must transmit

@ All transmitters (Base receivers) must be configured
CMR+ format corrections.

The Rover receiver must be configured to receive
only CMR+ messages.
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The Multi Base screen sets parameters for base stations.

* Base Station ID: the ID of the current base station. Choose any ID
from 0 to 30 (31 is the default ID for Trimble transmitters.)

» Transmit Delay: sets a signal transmission delay for the current
base.

* Use Multi Base: when checked, enables multi base mode for
surveying. In the Status screen at the rover side, the Multi-Base
tab will appear where to select the desired base.

Base Station ID | ~

Transmit Delay |3|:| + | msec

Use Multi Base

Figure 5-17. Multi Base

Init mMmmGPS+

To setup mmGPS+ system for RTK surveying, tap Survey » Init
mmGPS+.

The Init mmGPS+ screen contains information about the calibration
of the laser transmitter and initialization of the sensor.

The Trans Data tab (Figure 5-18 on page 5-15) calibrates the
transmitter with the correct channel and communication port:

e Name: the name of the transmitter.

ID: the ID that corresponds to the channel of the transmitter.
* Data: the status of calibration data.
* Add: opens the Transmitter screen to get the transmitter data.

» Edit: opens the Transmitter screen to change the information on
the transmitter.
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¢ Delete: removes the transmitter from the list.

ok P OK J§ Cancel
Trans Data |Trans Pos ISensor |
INarme jinj Data
2
3
4
| Add | | Edit | | Delete |

Figure 5-18. Initialize mmGPS - Data Tab

The bitmap in the upper-left corner of the screen displays a floating
menu of the following items:

e Field Calibration: opens the Calibration screen to set the
transmitter to calibrate (that is, to fix errors in incline in the self-
leveling mechanism of the transmitter).

* Known Point Offset. opens the Known Point screen.

* Help: accesses the Help files.

Transmitter

The Transmitter screen sets the transmitter parameters.

Transmitter m Cancel

MNarme |12

Com Port ICOM2 :I
D 3

Calibration Data Ok

Clear Data Get Data

Figure 5-19. Transmitter

¢ Name: the name of the transmitter.

* Com Port: the communication port of the transmitter.
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¢ [D: the channel of the transmitter.

e Calibration Data: the status of calibration data.

* Clear Data: clears the ID and Calibration Data fields.
¢ Get Data: retrieves the transmitter’s data.

¢ OK: returns to the Init mmGPS+ screen with the calibration data
shown.

The Trans Pos tab allows setting up the transmitter’s height and
location at the jobsite.

il P OK J§ Cancel

Trans Data | Trans Pos |Sensor |

| Resect | | Edit | | Delete |

Figure 5-20. Initialize mmGPS — Position Tab

¢ Name: the name of the transmitter.

ID: the channel of the transmitter.
* Point: the point over which the transmitter is setup.

* Resect: opens the Resect mmGPS+ screen to perform a resection
for an unknown transmitter location.

 Edit: opens the Known Point screen to select the point over
which the transmitter is setup.

¢ Delete: removes the transmitter from the list.
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The Sensor tab uploads transmitter calibration information to the
sensor and sets up the sensor for receiving the transmitter’s laser
beam.

-Inlt mmGP5+
Receiver Port I
Transmitter ID I v
Sensor Gain Auto -
Firmware Version NfA

Init Sensor

Figure 5-21. Initialize mmGPS — Sensor Tab

* Receiver Port: the receiver port that connects the receiver and
Sensor.

e Transmitter ID: the transmitter’s channel. The ANY selection will
allow the sensor to independently select the transmitter with the
smallest error rate.

» Sensor Gain: sets the sensitivity of the sensor to the transmitter’s
laser beam.

e [nit Time Improvement: check this box to improve the RTK fix
time for the receiver.

* Init Sensor: starts the initialization process.
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Resection

The Resect mmGPS+ screen is used to measure an unknown
transmitter location using the rover and three or more points
(Figure 5-22).

Sensor

The Sensor tab is identical with the title tab on the Init mmGPS+
screen and used to set up the sensor.

Resect mmGP5+ m
Sensar |Resect| Datal

Receiver Port

Transmitter ID

Sensor Gain

[] Init Time Improvernent
[ Known Trans Harz Pas

g

Init Sensor

Figure 5-22. Resection — Sensor Tab

* Receiver Port: sets the receiver port that connects the receiver and
Sensor.

* Transmitter ID: displays the channel of the transmitter.

* Sensor Gain: select Auto to automatically control the mmGPS
receiver's detection level of the transmitter's signal.

¢ Init Sensor: starts the initialization of the sensor.

e [nit Time Improvement: select to use the mmGPS signal to assist
in initializing the GPS receiver. This option is useful to decrease
the initialization time when satellite visibility is limited (for
example, tracking only four or five satellites).

* Known Trans Horz Pos: if selected, then after pressing the Init
Sensor button, the Known Point screen displays. Select the point
over which the transmitter is setup.
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Known Point

The Known Point screen is used to select the known point over which
the transmitter is setup and enter the transmitter height.

Knuwn Point m Cancel

Point [
Transmitter

MNarme 12

D 3

Ht |1.303 mo [sent  [+]
["] 2m Fixed Tripad

Figure 5-23. Known Point

* Point: the point the transmitter is installed over; selected using the
map or list buttons.

» Transmitter:
— Name: displays the name of the transmitter.
— ID: displays the transmitter’s channel.

— Ht and m: sets the height of the transmitter from the ground to
the mark on the transmitter’s side and the method of height
measurement.

— 2m Fixed Tripod: this box can be checked if using a 2 meter
fixed tripod.

* OK: uploads the transmitter calibration information to the sensor.
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Resect

The Resect tab is used to perform the resection calculation from the
rover point to the point over which the transmitter is installed.

Rese Settingsl OK lCanceI]

[ Sensor | Resect | Data ]

i il Feed HO W g
2 s 0021 0021 74

Meas 1

[ ]Known Point
|

AntHt 2170 m  [vertic

Figure 5-24. Resection — Resect Tab

The upper-right corner of the screen displays information about the
current state of measurement:

: the mmGPS icon displays the sensor receives the
transmitter’s beam.

. {Iull{l, : the quality of the radio link.

Fixed .. .
o L :the type of the position calculation method.

H V ) )
. : the RMS errors for horizontal and vertical

coordinates, respectively.

gl

e |7+o| : the number of the satellites tracked and used in position
calculation, respectively.

e Meas: the number of measurement.

* Known Point: enable this when occupying a known point, and
select a point to occupy using the map and list buttons.
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* Ht and m: the antenna’s height and method of height
measurement.

* Start: starts the measurement process. After pressing, the button
changes its name to Stop, and the counter of the epochs collected

appears.

* Logging: displays the number of GPS epochs used in the
resection calculation during the measurement.

Data

The Data tab is used to view the results of resection measurements.
Data will display only after three or more points have been measured.

Rese Settingsl OK ICanceI]

Sensor IResect| Data ]

.. |HRM... |VRM... |Lat

M
M..
M... 0.539 0.012 37.4.

< >

Figure 5-25. Resection — Data Tab

* Re-Meas: clears all data and restarts the resection process.

* Accept: opens the Add Point screen to view the point information
for the transmitter.
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Add Point

The Add Point screen is used to view and save the transmitter
location.

ST ok |cancel|

Point Info

[®] Point ITransmitter21
@ Code I v
[
Note |Transmitter
WGS84(m)

Lat I37.41l]5 13599
Lon I— 121.533006595
Ell ht IBI].463

[] Control Point

Figure 5-26. Add Point

Calibration

The Calibration screen selects the transmitter for field calibration.

Calibration

Set Transmitter to Field Calibration mode,

Transmitter MName I 12 : I

Figure 5-27. Calibration
e Transmitter Name: the name of the transmitter to calibrate

» Next: starts the process of auto-leveling.
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Adjust the height of the Sensor if required.

T MoveUp -3.1913 dms

Close

Init MMGPS+

b4 Calibration

Adjust the height of the Sensor if required.

W Angle is OK 0.3608 dms

Figure 5-28. Check Angle of Sensor

» Next: opens the Calibrate screen with instructions to follow.

Calibration

complete,

Face front {%1) of Transmitter towards
Sensor and wait for auto-leveling to

Close

Figure 5-29. Calibrate

After the auto-leveling process completes, pressing the Calibrate

button collects calibration data.
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Topo
To set up a survey with topo points, tap Survey » Topo.

The Topo screen records stop and go survey.

Settings
47 Topo |Data | Map | Offsets
¢ EHE H v g
1863 2536 g+¢5

[®] point  [FTRETE
oe [ v 26 5]
Ant Ht |2.IZIIIIIII m I\."ertil:a v

Epoch Count O

|

Figure 5-30. Topo

The Topo tab contains the initial data for the survey and displays the
progress of the survey. The upper-right corner of the screen displays
the status of information on the Status screen. For details, see
“Status” on page 5-2.

* The bitmap on the upper-left corner displays the following pop-
up menu that varies depending on survey mode used:

— Status: opens the Status screen (see “Status” on page 5-2).

— Rover Antenna Setup: opens the Antenna Setup screen (see
“Config: Rover Antenna” on page 2-42).

— Config Radio: opens the Configure Radio screen. For details,
see “Config: Rover Radio” on page 2-34.

— Config OmniSTAR: opens the OmniSTAR screen to start the
OmniSTAR service. For details, see “OmniSTAR” on
page 5-9.

— Reset RTK: resets the ambiguities and sets the receiver in the

Rover RTK mode. The settings being used are based on the
selections in the survey configuration.

— Reset DGPS: sets the receiver in the Rover DGPS mode. The
settings being used are based on the selections in the survey
configuration.
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— Notes: opens the Notes screen (see below).
— Edit Points: opens the Points screen.

— Inverse: opens the Two-Point Inverse COGO task screen. For
details see “Inverse” on page 9-2.

— PTL Mode: switches on the PTL (Point-To-Line) Mode. (The
screen changes its appearance to Topo (PTL).) For details see
“PTL Mode” on page 6-12.

— Grid Setup: opens the Grid Setup screen to set a grid to be
displayed with the Map (see “Grid Setup” on page 5-39).

— Help: accesses the Help files.
* Point: displays the current point name. The button opens
the Add Photo Notes screen to enter a photo note for the point.
* Code: displays the current point code. Can be entered manually
or selected from the drop-down list.
. : tap on this icon to open the Code-Attributes screen to set
the attributes for the selected code.

The Code-Attributes screen sets attributes for the selected code.

[ERd Code-attributes | oKk |

Code | de El
Cirl Codes I : I

%, tree

12 pillar H

Attrib ﬁangel Multiple Codes |

Figure 5-31. Code — Attributes

¢ Code: shows the code selected.

* Ctrl Code: shows all the control codes used. The Control Code is
a special type of code that can be used by the graphic tool for the
interpretation of the survey results.
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¢ The field below shows the available attributes with a field to enter
its value.

¢ Attrib Range: opens the Attribute Ranges screen.

Attributes Ranges
Code: road
Attribute | Range |

Figure 5-32. Attributes Ranges

e Multiple Codes: opens the Multiple Code-Attributes screen.

To add several codes, attributes and control codes to an object,
use the Multiple Codes tool.

EE2muttipie code-atiributes [N

Codes Strings | Atfributes Ctil

4] | 0]
Delete | | Edit I Add

Figure 5-33. Multiple Code — Attributes

— Add/Edit: opens the Code-Attributes screen to add/edit a
code string to the table.

— Delete: removes the code string from the table.
— OK: saves the changes and returns to the Topo screen.

The String and Ctrl Code fields appear only if the String and
Show Second Ctrl Code options have been enabled,

respectively, in the pop-up menu opened by the bitmap in the
upper-left corner of the screen.
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* The bitmap next to the Attributes List bitmap displays the
following list:

— String: toggles on the String field on the Topo tab. Also, the

sign appears.

¢ EE H

v g
1830 2552 g+ 4

[@] Point  [A10 stk1 [3]]
@ Code I v
Ant Ht |2.IZIIIIIII m I\."ertil:al v

Epoch Count O

Figure 5-34. Topo — String

— Layer: opens the Select Layer screen to select the layer in
which to locate the point (see “Select Layer” on page 3-8).

— Note: opens the Note screen (Figure 5-35). The Note screen is
used for additional information. When exporting raw data
(for example, to a TDS Raw Data file), this information will
be set in the Point Description field. The text should be typed
in the Note field. Press OK to store the Note.

MNote

Figure 5-35. Note
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* Ant Ht: sets the antenna height and its type (slant or vertical).

antenna includes the height of the PZS-1 sensor

i ; i When using mmGPS+, the height of the rover
with 5/8 inch plug.

» Epoch count: shows the number of accepted epochs.

* Rem Time: shows remaining time to stop logging when in PP
Kinematic or PP DGPS mode.

* String is a specifying parameter for a code for grouping of objects
with one code according to some specified attribute. For example,
the code “tree” also has “Jones” string. When processing the
points, only trees with the Jones string will be taken into
consideration, not any other trees.

* Start: starts the survey process. After pressing, the button
changes it name on Accept and a new button Cancel appears
along with the counter of the epochs collected (Figure 5-36).

iERd Topo Settings I close |
47 Topo |Data | Map | Offsets

¢ EHE H

v g
1335 1774 g4 4

[@] Point  [A10_stk1 [3]]
¥ code I
Ant Ht |2.IZIIIIIII m I\."ertil:al

Epoch Count 2

Figure 5-36. Topo — Start

* A mmGPS icon | -i7q displays on the Topo screen when the

receiver calculates mmGPS heights.

* Settings: opens the Survey Parameters screen. See “Config:
Survey Parameters” on page 2-46.

» Start Log (for RTK&PP, PP Kinematic, and PP DGPS): starts
logging file in the receiver. When pressed, the button changes its
appearance to Stop Log.
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In the PP Kinematic mode, instead of an icon displaying the RTK
status, the symbol displays, showing the status of the log file.

If the file is opened, it changes its appearance to .

When file logging is started, the Status screen also displays the
Log History tab (Figure 5-37 on page 5-29).

[Rdstotus

oL

7:43:59 8:13:59

¥

GPS 28 EI
GPS 29
GPS 08
GPS 26
GPS 27

GPS 31

o >

Figure 5-37. Status — Log History Tab

The Log History tab graphically displays the usage of satellites over
time. The field is divided to 5-minute portions along dotted lines with
the starting time and each next hour marked.

If the base is started in autonomous mode, and an observed Topo
point has known coordinates stored in the job, the Duplicate Points
screen displays additional options to correct the base coordinates.

45 Already Exists!

Offsets{m)
dN -0.001
dE 0.000
dH -0.008

() Overwrite?

(@) Rename? |1|:|4
() store As Check Point?
Use in Weighted Average

[ ] Correct Base

Figure 5-38. Duplicate Point

* Overwrite: overwrites the existing point.
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* Rename: the point will be renamed. The new name is noted in the
field and will be the point with observed coordinates.

e Store As Check Point?: if selected, the observed point will be
stored as check point of the existing point.

* Use in Weighted Average: available if the Store As Check Point
radio button is selected. The OK button opens the Weighted
Average screen (see “Weighted Average” on page 5-33 for
details).

* Correct Base: if selected, the existing coordinates of the observed
point will not be replaced by the coordinates of the observed
point. Instead the known coordinates of this point will be used to
correct the Base coordinates. After either closing the Topo screen
or moving to another tab, recomputations are performed and the
coordinates of all points are updated using the new Base
coordinates.

The Data tab shows the results of the survey.

41 Topo | Data |Map I 0ffsels|

.

Point ID i1

Code tree

Lat 55.415624993

Lon 37.335772349

Ht 208.860

< | ]

Figure 5-39. Topo — Data
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The Map tab shows the stored point graphically and performs the

same actions as the 7opo tab. For a detailed description of the Map
view see “Properties” on page 4-8.

e .
130
%l ==S50m

| BT B v =T
Figure 5-40. Topo — Map
The icons displayed stand for the following fields:

. |§| : the name of a point.
. : the code of a point.

. ?ﬂ : attributes for the code.

. E‘ : toggles between the Start button and status icons on
the right part of the screen. When pressed, changes its appearance

toE.
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The Offsets tab sets the offset point for the measurement.
iEAA Topo

#1 Topo | Data | Map | Offsets
B Settings | Close
# Topo | Data | Map | Offsets

- Caeosto |

P | azpist nt
-

Figure 5-41. Topo — Offsets

* Line: opens the Line screen to define a point, set by the offset
from a line.

» Az Dis Ht: opens the Azimuth-Distance-Height screen to define
a point specified by the offset from a point.

* Laser: only available when a laser distance meter has been added
in the Config Survey, opens either the Config Laser screen (see
“Config Laser” on page 5-36) or the Laser BS Meas screen to
define a point specified through a backsight (see “Laser BS
Meas” on page 5-37).

 Settings: opens the Survey Parameters screen. See “Config:
Survey Parameters” on page 2-46.
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Weighted Average

The Weighted Average screen displays coordinate residuals of the
check point.

Weighted Average m
WA
|mame |NResid |EResid  |H Resid
[E4s5 o0.000 0.000 0.000
< >

Figure 5-42. Weighted Average

* Use In WA: uses the check points in weighted averaging
positions.

Line

The Line screen is used to enter the parameters defining a point that
are not available physically relative to some reference line.

Reference Line

Start Pt 101
End Pt 106

Ottset Point
@] [107 [3]]
E3 b v

Offsets From End Pt (m)
A [ Forward ] |2.000

v [ Right | [o.300

T up Iﬁm Store

Figure 5-43. Line

* Reference Line: a line is specified by two known or measured
points. They can be selected from the map, from the list or
measured directly.

* Meas: starts measuring the current location point.
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* Offset point: sets the parameters of the offset point:
— the name of a point

— the code of a point (can be typed manually or chosen from the
drop-down list)

— the attributes of the code (can be entered through the
Attributes List bitmap, see “Code-Attributes” on page 3-10
for details)

* The bitmap next to the Attributes List bitmap displays the
following list:

— String: toggles the String field. Also, the sign appears.

— Layer: opens the Select Layer screen to select the layer in
which to locate the point (see “Select Layer” on page 3-8).

— Note: opens the Note screen. For details, see “Topo” on
page 5-24.

* Offsets: the offset values:

— Forward/Backward: the distance from Point 2 to the
projection of the target point along the Line of Sight.

— Right/Left: the distance from the target point to the line of
sight, either to the left or right of the line.

— Up/Down: the height difference from the target point.

* Store: calculates the coordinates of the offset point and saves the
point to the database.

* The bitmap on the upper-left corner displays the following pop-
up menu:

— Antenna Setup: opens the Antenna Setup screen (see
“Config: Base (Static) Antenna” on page 2-26)

— Help: accesses the Help files

* Settings: opens the Survey Parameters screen. See “Config:
Survey Parameters” on page 2-46.
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Azimuth-Distance-Height

The Azimuth-Distance-Height screen defines an offset point using
the current point as a reference.

Azimuth—Distance—Height Settings

¢ EHE H

v g
2447 3380 1042

[@] start Pt NfA

[@] point  [107 EJa|

@ Code I v

[azmuth | [60.0000  dms

&|zenith Angle| [90.0000  dms
Horizontal Dist ISDJT m

Figure 5-44. Azimuth-Distance-Height

* Start Pt: the starting point of the offset measurement.

* Point: the name of the new point.

* Code: the code of the new point. Can be entered manually or
selected from the drop-down list. The button opens the Add
Photo Notes screen to enter a photo note for the point.

. : the Attributes List bitmap opens the Code-Attributes
screen (see “Code-Attributes” on page 3-10).

* The bitmap next to the Attributes List bitmap displays the
following list:

— String: toggles on the String field. Also, the sign appears.

— Layer: opens the Select Layer screen to select the layer in
which to locate the point (see “Select Layer” on page 3-8).

— Note: opens the Note screen. For details, see “Topo” on
page 5-24.

¢ Azimuth/Az to Pt: sets the azimuth to the target point by value or
by point.

* Zenith Angle/Elev Ang/Vert Dist: sets the zenith angle (zenith
distance) to the target point, or vertical distance.
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e Horizontal Dist: sets the horizontal distance between the current
and the target point.

* Store: calculates and stores the point. The next screen shows the
parameters of the current point, the PDOP value, the Sigma
values, and the epochs logged counter.

* The bitmap on the upper-left corner displays the following pop-
up menu:

— Antenna Setup: opens the Antenna Setup screen (see
“Config: Rover Antenna” on page 2-42).

— Help: accesses the Help files.

* Settings: opens the Survey Parameters screen (see “Config:
Survey Parameters” on page 2-46).

Config Laser

When the selected laser does not have an Encoder, the Config Laser
screen defines an occupation point and backsight azimuth or point, as
well as defines the laser height and point information.

Config Laser

|§| Occ Point |1l:|1—

o o oA
Laser HI IU-UUU m

@] Point  [107 =8| 3]

@ Code IE .

Press the Fire Button on the Laser to
measure

Figure 5-45. Config Laser

* Occ Point: enter an occupation or select an occupation using the
map or list buttons.

¢ BS Azimuth / BS Point: enter either a BS azimuth value or select
a BS point using the map or list buttons.

* Laser HI: enter the height of the device above the occupation
point.
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* Point: enter the name of the point being measured. The
button opens the Add Photo Notes screen to enter a photo note for
the point.

* Code: displays the current point code. Can be entered manually
or chosen from the drop-down list.

o [E2E: the Asrributes List bitmap opens the Code-Attributes screen
(see “Code-Attributes” on page 3-10).

* The bitmap next to the Attributes List bitmap displays the
following list:
— String: toggles on the String field. Also, the sign appears.
— Layer: opens the Select Layer screen to select the layer in
which to locate the point (see “Select Layer” on page 3-8).
— Note: opens the Note screen. For details, see “Topo” on
page 5-24.

* OK: saves the settings and returns to the Topo screen.

Laser BS Meas

When the selected laser has an Encoder, the Laser BS Meas screen
defines an occupation point and backsight azimuth or point.

[®] occ Point [101
oo v A

Press the Fire Button on the Laser to
measure

Figure 5-46. Laser BS Meas

* Occ Point: enter an occupation or select an occupation using the
map or list buttons.

P/N 7010-0492 5-37



GPS Survey

* BS Azimuth / BS Point: enter either a BS azimuth value or select
a BS point using the map or list buttons.

¢ OK: saves the settings and opens the Config Laser screen for
lasers with an Encoder (see “Config Laser” on page 5-38).
Config Laser

For lasers with an Encoder, the Config Laser screen defines the laser
height and point information.

Config Laser

[®] Occ Point 101
BS Point 103
Laser HI lﬁ m
[@®] Point j107 (E3] (3] ]
@ Code Ie w

Press the Fire Button on the Laser to
measure.

Figure 5-47. Config Laser

* Occ Point: enter an occupation or select an occupation using the
map or list buttons.

* BS Azimuth / BS Point: enter either a BS azimuth value or select
a BS point using the map or list buttons.

* Laser HI: enter the height of the device above the occupation
point.

* Point: enter the name of the point being measured. The
button opens the Add Photo Notes screen to enter a photo note for

the point. Also, the field appears to enter a string.

* Code: displays the current point code. Can be entered manually
or chosen from the drop-down list.

* BS Setup: returns to the Laser BS Meas screen to set up a new
BS.

* OK: saves the settings and returns to the Topo screen.
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Grid Setup

Select the Grid Setup option from the top left menu in the Topo screen
to open the Grid Setup screen. The Grid Setup screen is used to setup
a grid to be displayed with the Map to help while collecting data.

Grid Setup
Display Grid
origin Point 2
5| Azimuth J60.0000 dms
Spacing {m)
¥ (North) W

x (East) |5|.uuu

Figure 5-48. Grid Setup

* Display Grid: when this box is checked, a grid will be displayed
in the Map page.

* Origin Point: specifies the origin point for the grid.

Azimuth(Bearing)/Azimuth(Bearing) To Point: sets the
corresponding value to the direction of the grid lines.

Spacing: specifies the intervals between the grid lines along the
y(North) and x(East) axes.

OK: displays the grid in the Map page with the specified settings.

|k BV e

Figure 5-49. Grid in Map
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Auto Topo Survey

To set up a survey with automatic topo points, tap Survey » Auto
Topo.

The Auto Topo initiates a kinematic survey.

#1 Auto Topo |Data | Map

¢ EHE H

v
2100 2969 g+ 3

[®] Point [S000 2]
¥ code IE v
Ant Ht |2.IZIIIIIII m I\."ertil:al v

Figure 5-50. Auto Topo

The Auto Topo tab contains the initial data for the survey and displays
the progress of the survey (Figure 5-50). The upper-right corner of
the screen displays the status of information on the Status screen. For
details see “Status” on page 5-2.

* The bitmap on the upper-left corner displays the following pop-
up menu:

— Status: opens the Status screen (see “Status” on page 5-2).

— Topo: opens the Topo screen (see “Topo” on page 5-24).

— Rover Antenna Setup: opens the Antenna Setup Screen (see
“Config: Rover Antenna” on page 2-42).

— Config Radio: opens the Configure Radio screen (see
“Config: Rover Radio” on page 2-34).

— Config OmniSTAR: opens the OmniSTAR screen to start the
OmniSTAR service (see “OmniSTAR” on page 5-9).

— Reset RTK: resets the ambiguities and sets the receiver in the
rover RTK mode. The settings being used are based on
selections in the survey configuration.
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— Reset DGPS: sets the receiver in the Rover DGPS mode. The
settings being used are based on the selections in the survey
configuration.

— Note: opens the Notes screen (see “Note” on page 5-27).

— Edit Points: opens the Points screen (see “Points” on
page 3-2).

To have auto topo points in the list of points, make

@ sure that the Show Auto Topo Point option is
selected in the bitmap menu in the upper left corner
of the Points screen.

— PTL Mode: switches on the PTL (Point-To-Line) Mode. (The
screen changes its appearance to Auto Topo (PTL).) For
details see “PTL Mode” on page 6-12.

* Point: displays the current point name. The button opens the
Add Photo Notes screen to enter a photo note for the point.

* Code: displays the current point code. Can be entered manually
or selected from the drop-down list.

. : the Attributes List bitmap, opens the Code-Attributes
screen (for details see “Code-Attributes” on page 3-10).

* The bitmap next to the Attributes List bitmap displays the
following list:

— String: toggles on the String field. Also, the sign appears.

— Layer: opens the Select Layer screen to select the layer in
which to locate the point (see “Select Layer” on page 3-8).

— Note: opens the Note screen. For details, see “Topo” on
page 5-24.

» Ant Ht: sets the antenna height and its type (slant or vertical).

antenna includes the height of the PZS-1 sensor

i ; / When using mmGPS+, the height of the rover
N,
with 5/8 inch plug.
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* Log Now: immediately stores the current position of the receiver
antenna.

» Pause: interrupts the survey. After pressing, the button changes
its name to Resume.

 Start: starts the survey process. After pressing, the button
changes to Stop and the Pause button becomes available.

#1 Auto Topo |Data | Map

- BEE H v
Logging Pt ¢ 2132 2425 ‘?t+2

[@] Point  [S000 2]
¥ code I
Ant Ht |2.IZIIIIIII m I\."ertil:al

[[eouse | 5tor |

Figure 5-51. Auto Topo — Start

* A mmGPS icon | -1 displays on the Auto Topo screen when

the receiver calculates mmGPS heights.

* Settings: opens the Survey Parameters screen. See “Config:
Survey Parameters” on page 2-46.

The Data tab shows the properties of the last stored point: the Point
name and its coordinates.

F7 Auto Topo | Data |Map|
m
Point Auto2
Code road
Lat 55.415632130
Lon 37.335769858
Ht 212.671
< | ]

Figure 5-52. Auto Topo — Data
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The Map tab shows the stored points graphically. All survey
processes can be done through this page, as well as from the Auro
Topo tab, as all the controls are duplicated.

F7 Auto Topo I Data | Map |

q Start

£

Pause

Log

—0.5m

1| (@100 | R

Figure 5-53. Auto Topo — Map

AP

Bt

B

The icons displayed stand for the following fields:
. |§| : the name of a point.

. : the code of a point.

* |&®[g| : the Artributes List bitmap, opens the Code-Attributes
screen (for details, see “Code-Attributes” on page 3-10).
. E’ : toggles between the buttons and status icons on the
right part of the screen. When pressed, changes its appearance to
=1
For a detailed description of the Map view, see “Properties” on
page 4-8.
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Known Point Init

To set up a survey with known points, tap Survey » Known Point
Init.

The Known Point Init screen initializes the receiver using known
coordinates for the Rover station. This screen is used with single
frequency receivers, and for quality control on dual frequency
receivers.

Knuwn Point Init
Point IRmrerl
WG584{m})

Lat I55.415624393
Lon I37.335766770

Ht |2IIIB.926
AntHt  [2.000 m  |vertical [+]

Figure 5-54. Known Point Rover

* Point: sets the name of the point, and can be selected from a list or
from a map.

* WGS84: the coordinates of the point in the current coordinate
system. (Use the Job » Config » Coord Sys menu selection to
change the system and the name of the field, its contents will also
change.)

* Ant Ht: the height of the antenna reference point (ARP) above the
mark, and the type of the height measurement (vertical or slant).

¢ Initialize: sends the information to the rover receiver.

* The bitmap on the upper-left corner displays the following pop-
up menu:

— Status: opens the Status screen (see “Status” on page 5-2).

— Rover Antenna Setup: opens the Antenna Setup Screen (see
“Config: Rover Antenna” on page 2-42).

— Config Radio: opens the Configure Radio screen (see
“Config: Rover Radio” on page 2-34).
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— Help: accesses the Help files.

X-Section

The X-Section function is similar to that of the Total Station mode,
except for the measurement screens, which are the corresponding
GPS+ measurement screens. For details, see “Cross-Section” on
page 6-32 and “Topo” on page 5-24.

Find Station

The Find Station function is similar to that of the Total Station mode,
except for the measurement screens, which are the corresponding
GPS+ measurement screens. For details, see “Find Station” on

page 6-34 and “Topo” on page 5-24.

Tape Dimension

The function is similar to that of the Total Station mode, except for
the measurement screens, which are the corresponding GPS+
measurement screens. For details, see “Tape Dimension” on

page 6-36 and “Topo” on page 5-24.
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Static Occupation

In the PP Static mode of GPS survey, the Survey menu contains only
two items: Status and Static Occupation. The Status screen is
discussed in “Status” on page 5-2.

To open the Static Occupation screen, choose the PP Static
configuration in the Select Survey Config screen (Job » Config »
Survey) and select Survey » Static Occupation.

Statil: Occupation
0O 2.??4 2.¥54 ‘5{,?
Code I v
(8]]

AntHt  [0.000 m [Slant v

Duration 0:00:00
Remaining Time 0:00:00

Start Occ

Figure 5-55. Static Occupation

* The bitmap on the upper-left corner displays a floating menu of
the following items:

— Status: opens the Status screen (see “Status’ on page 5-2).

— Static Antenna Setup: opens the Antenna Setup Screen (see
“Config: Rover Antenna” on page 2-42).

— Help: accesses the Help files.
* Point: displays the current point name, which can be entered

manually or chosen from the map or point list. The button
opens the Add Photo Notes screen to enter a photo note for the
point.

* Code: displays the current point code, which can be entered
manually or chosen from the drop-down list.

. : the Artributes List bitmap, opens the Code-Attributes
screen (for details, see “Code-Attributes” on page 3-10).
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* The bitmap next to the Attributes List bitmap displays the
following list:

— String: toggles on the String field. Also, the sign appears.

— Layer: opens the Select Layer screen to select the layer in
which to locate the point (see “Select Layer” on page 3-8).

— Note: opens the Note screen. For details, see “Topo” on
page 5-24.

* Ant Ht: sets the antenna height and its type (slant or vertical).
* Duration: displays the time passed from the beginning of survey.

» Settings: opens the Static Receiver screen. (For details, see
“Config: Base (Static) Receiver” on page 2-17.)

* Start Occ: starts the survey in the static occupation mode. When
pressed, changes to Stop Occ. The icon displays the status of

the log file. If the file is opened, the icon changes to .

Localization

To set up a survey with localization, tap Survey » Localization.

Localization is used for transforming coordinates between a local
system and a WGS84 system. The basic approach of calculating the
mathematical conversion is to provide pairs of coordinates for each
point used for localization in the job.

The Localization screen contains a list of points used for localization,
called control points (Figure 5-56 on page 5-48). Their coordinates
are known in both systems: Local and WGS84. Each point has a level
of reliability specified with the values of the residuals along the
horizontal and the vertical axes and the Control parameters, that
shows the status of the point. The horizontal and vertical use of any of
the control points can be changed by selecting the line and then taping
on the header of the H Control or V Control. This will toggle the
display between “used” and “not used”.
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k=R L ocalization
Name H Resid V¥ Resid H Control
DO1 0.000 0.000 used

] | D]
[] Keep scale 1.000

| Details | | Remove | | Edit | | Add |

Figure 5-56. Localization

For localization to work properly, enter or import
@ the local coordinates with Projection set to <none>

in the Coord System screen and Coord Type set to
Ground in the Display screen.

* The bitmap on the upper-left corner displays a floating menu of
the following items:

— Config Radio: opens the Configure Radio screen. (For details,
see “Config: Rover Radio” on page 1-28).

— Help: accesses the Help files.

» Keep scale 1.000: preserves localization from scale
transformation.

* Details: opens the Localization Results screen.
* Remove: removes the highlighted points.

» Edit: creates localization parameters, using the localization
points.

* Add: opens the Add Localization Point screen to add a point to
use in localization.

* Settings: opens the Survey parameters screen. For details, see
“Config: Survey Parameters” on page 2-46.

5-48 TopSURYV Reference Manual



Localization

The more localization points used, the more precise

@ the localization will be. The localization is updated
(recomputed) every time a new point (local and
WGS84 coordinates) is added to the localization list
of points. The new parameters of the localization
are available through the Details button.

Add Localization Point

The Add Localization Point screen contains the coordinates of the
control points.

Add Localization Point m

il Fieed H o W g
1003 0062 0059 742
Local Point
Use Horizontal Use Vertical
WG584 Point

Point IBase

Code |L|:||: v
Epoch Count: 0O

Figure 5-57. Add Localization Point

¢ The Local Point field contains the name and coordinates of the
point in the local coordinate system.

— Point: sets the name of the control point. Select a point from
the map, or from the list, or enter a new point name.

— Use Horizontal: specifies that a point should be used for the
horizontal localization.

— Use Vertical: set if the point should be used for the vertical
localization.

* The WGS84 Point field contains the name and global coordinates
of the control points.

— Point: sets the name of the control point. Enter a new point
name, select a point from the map or from the list.
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— Code: sets the code of the control point. Can be entered
manually or chosen from the drop-down list.

. : the Attributes List bitmap, opens the Code-Attributes

screen to set the values for the attributes available for the code
chosen (Figure 3-14 on page 3-10).

* The bitmap next to the Attributes List bitmap displays the
following list:

— String: toggles on the String field. Also, the sign appears.

— Layer: opens the Select Layer screen to select the layer in
which to locate the point (see “Select Layer” on page 3-8).

— Note: opens the Note screen. For details, see “Topo” on
page 5-24.

 Start Meas: sets the control point to the current location. The
Epoch Count field shows the number of the accepted epochs. The
parameters of the logging are set through the Survey Parameters
screen. If a point with such a name already exists, the application
will open the Point Check notification screen. Overwrite, rename,
or store the point as a check point.

* OK: saves the point and opens the Localization screen with a
newly added point being displayed.

Localization Details

The Localization Details screen contains the Results and Map tabs.
The Results tab displays calculated parameters of the localization:
global coordinates, corresponding local coordinates, scale parameter,
the azimuth, and plane slope angles (deflections) corresponding to
north and east directions (see Figure 5-58 on page 5-51).



Localization

LDCaliZatiDn details
Results | Map
Projection Name None
Geodetic Origin ~
Lat N 55.432105957 dms
Lon E 37.390407428 dms
Ht 161.825 m
Local Origin
MNorth 1000.000 m
East 1000.000 m )
< B >

Figure 5-58. Localization Results

The Map tab displays the job graphically with the localization points
marked by blue triangles.

Localization details

Results | Map

A100

1008

—=500 m

FPBPEE

Figure 5-59. Localization Map
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Notes:
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Chapter 6

Total Station Survey

The Survey menu includes the following menu items for Total Station
surveys:

* Occ/BS Setup

* Observations

* Resection

* Elevation

* X-Section

* Find Station

» Tape Dimension

* Missing Line (optional)

* Auto Topo (for Robotic mode)
* Scanning (for Robotic mode)
¢ Monitor (for Robotic mode)

¢ Remote Control (for Robotic mode)

EEq 1100 (My Robotic] 5D

Job Edit View Stake Cogo HIp

Occ/BS Setup
Observations

Resection
Elevation

Miszing Line *-Section
Auto Topo Eind Station
Scanning Tape Dimension

Monitar
Remote Control

Figure 6-1. TS Survey Menu
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Occupations and Backsight
Survey Setup

To set up a survey with localization, tap Survey » Occ/BS Setup.

Backsight Survey

The Backsight Survey screen contains Backsight station parameters.

The BS Setup tab contains following parameters.

' B5 Setup |Data | Map |

Gl occpoint [z
B oH frson |m @er fpoon  m
& [BS Point | o=

85 ES Circle [o.000d
[ Measure distance to BS [ 1unToEs

[ Fixed HR at BS e 8
[ checkps | [ HCset | | meases |

Figure 6-2. Backsight Survey
* Occ. Point: the name of the point where the total station is
located.

. : opens the map for choosing the occupation point.

* The bitmap next to the Map icon in the Occ. Point field opens a
floating menu of four items:

— From List: opens the list from which to choose the occupation
point.

— Resection: opens the Resection screen from which to
determine the occupation point coordinates by solving the
resection task, using the known point’s coordinates (For
details, refer to “Resection” on page 6-27.)

— Elevation: opens the Elevation screen (For details, refer to
“Elevation” on page 6-30).
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— Properties: opens the Add/Edit Point screen that displays the
properties of the current point, or can create a new point if no
point is chosen yet.

* HI: sets the height of the instrument above or below the mark (the
HR value can be negative so points above the prism, such as those
on a bridge, can be measured from below).

* HR: sets the height of the target above the mark.

* BS Point (BS Azimuth): sets the backsight point location, or the
direction to it.

* The bitmap next to the Map icon in the BS Point field displays the
following list:

— From List: opens the list of points.

— Multiple BS: opens the Multi-Point BS screen, to involve
several Backsight points for performing survey (see “Multi-
Point Backsight” on page 6-5).

— Properties: opens the Add/Edit Point screen that displays the
properties of the current point, or suggests to create a new
point if no point is chosen yet.

* BS Circle: displays the horizontal circle reading corresponding to
the backsight point.

* The bitmap next to the BS Circle field displays the floating menu
that suggests to set the BS Circle value to zero, azimuth, or to
change the value by +/- 90 or 180 degrees.

* Measure distance to BS: set if the distance to backsight point
should be measured.

* Fixed HR at BS: set if the height of the backsight point is fixed for
the whole set of measurements. When checked, an additional HR
box appears. This is useful when one target is mounted at the BS
for the duration of an occupation and another is used for the
sideshots.

e g : shows the battery and memory status for the controller.

* g :shows the battery status for the total station.
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* (@ :shows the status of communication between the controller
and total station.

* Check BS: opens the Check Backsight screen to check the
Backsight point (see “Check Backsight” on page 6-8).

¢ HC Set: sets the horizontal circle as defined in the BS Circle
field.

* Meas BS: measures the Backsight point.

* Settings: opens the Mode screen (identical to the screen “Config:
Survey Parameters” on page 2-46).

* The bitmap on the upper-left corner displays the following pop-
up menu:

— Edit Points: opens the Points list (see “Points” on page 3-2).

— Edit Raw: opens the Raw Data screen (see “Raw Data” on
page 3-55).

— Remote Control (for Robotic mode only): opens the Remote
Control screen (see “Remote Control” on page 6-56).

— Config Link (only for the Robotic mode): opens the
Configure Link screen (see “Configure Link” on page 8-8).

— Inverse: opens the Inverse COGO screen (see “Inverse” on
page 9-2).

— Intersection: opens the Intersection COGO screen (see
“Intersection” on page 9-7).

— Help: accesses the Help files.
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The Data tab displays the available values of the backsight point
parameters.

iER 4 Backsight Survey
BS Setup | Data |Map|

[, Hi 10000 [2. 2z 225.00000ms
HR

1.000 m
HA 55.0000 dms
VA 90.0000 dms
SD
i | b]

Figure 6-3. Backsight — Data
* HR (Height of Rod/target) and HA (Horizontal Angle)
* VA (Vertical Angle) and SD (Slope Distance)

There are two fields in the top of the page that display the height of
the instrument and the azimuth.

The Map tab shows all points in a graphic mode. For details on map
properties and customizing, see ‘“Properties” on page 4-8.

iER 4 Backsight Survey
BS Setup | Data | Map |

l% 2

APl

Base2

———=10000 m E

Figure 6-4. Backsight — Map

+
Nh'
by

Multi-Point Backsight

To access the Multi-Point BS screen, tap Survey » Occ/BS Setup,
press the bitmap next to the Map icon in the BS Point field and select
the Multiple BS item.
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Multiple backsight points can generate more precise measurements.

# Measurement |Data | Map | Meas Setl

[®] Point [po1
@ Code tree
[f] HR [Zooo | m

Measure Foresight Direct

Figure 6-5. Multi-Point BS

* Point: the known point name. Can be selected from the map or
from the list.

Code: the known point code.

HR: the height of the rod (target).

Meas: takes the sideshot to the point.

Settings: opens the Mode screen (see “Config: Survey
Parameters” on page 2-63.

The bitmap on the upper-left corner displays the following
pop-up menu:

— Edit Points: opens the Points list (see “Points” on page 3-2).

— Inverse: opens the Inverse COGO screen (see “Inverse” on
page 9-2).

— Notes: opens the Notes screen.

— PTL Mode: opens the PTL Mode screen (see “PTL Mode” on
page 6-12).

— Display Coord: if chosen, the coordinates of the previous
point measured will display below the HR data
(see Figure 6-9 on page 6-10).

— Help: accesses the Help files.

The Data tab shows the results of the current measurement and the
scale factor and standard deviations of the coordinates.
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The Map tab shows all points in graphic mode. For details on map
properties and customizing, see ‘“Properties” on page 4-8.

The Meas Set tab displays the result of the sideshots being done
during one set.

EEdMutti-point BS Settings | Close
[} Measurementl Data | Map | Meas Set

point | ResHA|  HR| HA
BSN 0.0000 0.000 0.0001  90.0
BSS 0.0001 0.000 179.5957  90.0
BSW  -0.0002 0.000 269.5957  90.(

<] | L]

| Remove | | Re-Meas | | Accept |

Figure 6-6. Multi Point BS — Meas Set Tab

The table represents the result list of the measurements being made:
the residuals of the horizontal angles, the measured and initial
parameters (HR, HA, etc.)

» Use Ctrl: toggles through specific measurements in the resection;
for example the horizontal angle, but not the vertical, or vice
versa.

* Re-Meas: replaces the current measurement with a new
measurement.

¢ Accept: stores the new coordinates in the database.
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Check Backsight

The Check Backsight screen contains information about the
backsight point errors. Note, that HD and VD will not appear if only
an azimuth (direction) has been entered for the backsight.

[EBd check Backsight
[52, A 0.000m [BSN, az 0.0003
HD Error 0.002 m -
VD Error -0.001 m
HA Error -0.0002 dms
BS Azimuth 0.0003 dms
HA 359.5958 dms
vA 90.0003 dms EIE
| |

[ Turn To BS %9 [0.0000

Check Distance | Check I | HC Set |

Figure 6-7. Check Backsight

There are two fields in the top of the page for the height of the
instrument and the azimuth.

e Turn To BS (available only for the Robotic mode): check to turn
the total station to Backsight Point.

* Check distance to BS: set if necessary to check the distance to
backsight point along with the angle measurement (when
pressing the Check button).

Check: checks the errors in angle and distance measurements and
displays them on the screen.

HC Set: sets the horizontal circle to the selected value.

Observations

Toggling between the sideshot modes is performed from the
Measurement Method field in the two Mode screens opened by the
Settings button in the Sideshot-Dir (Sideshot -Dir/Rev, or Ang/Dist
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Sets-Dir/Rev) screen (for a description of other parameters on this
screen, see “Config: Survey Parameters” on page 2-46):

Meas Method [Sideshot-Direct v

Angle Sequence |BS,‘FS Plunge FS/BS

Num Sets I 1 Tolerances

Hz

Distance Averaging i

|:| Measure Reverse Dist Di=tg)0.006 [

Auto Advance Set VA
Auto Accept Meas

Defaults Next >>

Figure 6-8. Mode

s5ec

?J3

s5ec

* Sideshot-Dir: defines that the measurement to a single point is
taken using the Direct position of the Total Station.

* Sideshot -Dir/Rev: defines that the measurement to a single point
is taken using the Direct Position and the Reverse Position of the
Total Station (i.e., Plunge - Flip and Rotate the Total station by
180 degrees to get the reverse measurement). This measurement
method is known as Multiple, in which case the Meas Set tab
appears in the SS-Dir/Rev screen. One set consists of one direct
and one reverse measurement. These measurements are used to
eliminate the Vertical and Horizontal circle centering errors.

* Ang/Dist Sets-Dir/Rev: defines that during the measurement, the
instrument will use the specified Angle sequence to perform
repeated measurements. In this case the Sets-Dir/Rev screen will
also have the Meas Set tab. The sequence of four measurements
constitutes one set. One measurement is the backsight in Direct
face or the Foresight in Reverse face in two positions of the Total
Station. These measurements are used to eliminate centering
errors in the horizontal and vertical circles.
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Sideshot - Direct

The Measurement tab of the SS-Dir screen contains the initial data for
performing single sideshots and displays this information during
survey.

# Measurement |Data | Map | Offsets

[® Point [108 |

EY code e v
[f HR  [o.000 m 108
N:1041.042,E:887.237,Ht:101.000 (m)

Measure Foresight Direct
[] Traverse Point

BS Setup Meas

Figure 6-9. Sideshot-Direct — Measurement Tab

* Point: sets the current point name. During the survey, the
numerical part of the name changes automatically by one. The

button opens the Add Photo Notes screen to enter a photo
note for the point.

* Code: sets the Code for the current point. Can be entered
manually or chosen from the drop-down list.

« |=®[E| : accesses the attributes of the chosen code, opens the
Code-Attributes screen (for details see “Code-Attributes” on
page 3-10).

* The bitmap next to the Attributes List bitmap displays the
following list:
— String: toggles on the String field. Also, the sign appears.
— Layer: opens the Select Layer screen (see “Select Layer” on
page 3-8).

— Note: opens the Note screen. For details, see “Topo” on
page 5-24.

* HR: sets the height of the target above the mark (rod height).
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e BS Setup: opens the Backsight Survey screen for setting the
backsight point. The information displayed is the same as has
been entered.

* The bitmap on the upper-left corner of the screen displays the
following pop-up menu:

— Adv: (Advance) opens the Backsight Survey screen for
setting the next traverse point as the next occupation point.
The current occupation point becomes the next backsight
point.

— Edit Points: opens the Points list
— Inverse: opens the Inverse COGO screen
— Notes: opens the Notes screen.

— PTL Mode: opens the PTL Mode screen (see “PTL Mode” on
page 6-12).

— Display Coord: if chosen, the coordinates of the previous
point measured will display below the HR data (see Figure 6-
9 on page 6-10).

— Help: accesses the Help files.

» Traverse Point: if checked, opens the screen to set the coordinates
of the point manually.

If more than two points have been tagged as

% . Traverse Points, the ADV button displays a list box
with all tagged Traverse points from which to select
the next occupation point. Upon selecting OK, the
Backsight screen displays and automatically
updates, as in the case when one TP point is
available.
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* Meas: takes the sideshot to the point. The result is given in the
information window.

¢ Settings: opens the Mode screen (for a description of parameters
on this screen, see “Config: Survey Parameters” on page 2-46).

PTL Mode

The Point-To-Line mode (PTL) is a method of interpretation of the
point coordinates. The coordinates are defined through the two
reference points. The line trace through these points is set as one axis
and its perpendicular as another.

Start Ref Point [101
End Ref Point |1|35|

PTL Mode On

Figure 6-10. PTL Mode

o Start Ref Point, End Ref Point: the names of the reference points.
Select these points from the map or select from the list of points.

e PTL Mode On: enables the PTL mode.

* OK: saves the changes and returns to the previous screen.
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The Data tab contains the results of the measurements along with the
initial data.

Settings
## Measurement | Data Map|0ffsets

[, Hr 1.000m| [az 100.0000dms

Point 110 ~
Code e

Note

HR 0.000 m

MNorth 735.463 m

East 048.022 m

Height 101.000 m

Angle Right 92.0000 dms -
< >

Figure 6-11. Sideshot-Direct — Data Tab

The Map tab performs sideshots in the graphic mode. The buttons on
the right duplicate the controls on the first page.

Eotings] cove

[ # Measurement ]Data | Map |0ffsets ]

'ﬂ 101 BS
& _

Q|
%l =200 m
1,2£||111 Ele ~ [2E

106

Figure 6-12. Sideshot-Direct — Map Tab

For details on map properties and customizing, see “Properties” on
page 4-8.

In the Sideshot Sets-Dir/Rev and Ang/dist Sets-Dir/Rev modes a new
Meas Set tab appears.

The page contains the data collected during the measurements,
grouped by sets: one set for Multiple mode contains two
measurements; one set of the Repeat mode contains four
measurements).
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bl [y Ta) gl BT =T 1 o Il Settings | Close
[} Measurementl Data | Map | Meas Set | Offsets
Point | ResHA| Resva|Ressp|  HR|
R53 -0.0001 -0.0002 0.001 0.000
RS3 0.0005 -0.0001 0.000
RS3 0.0001 0.0002 -0.001 0.000
R53 -0.0004 0.0000 0.000
] | D]
| Remove | | Re-Meas | | Accept |

Figure 6-13. Ang/dist Sets-Dir/Rev — Meas Set Tab
¢ The columns are:
— Point: the name of the point.

— Res HA: Difference of each HA measurement within the set
from the average of all the HA's in the set.

— Res VA: Difference of each VA measurement within the set
from the average of all the VA's in the set.

— Res SD: Difference of each SD measurement within the set
from the average of all the SD's in the set.

— HR: the height of the rod (target).

—HA: Horizontal Angle measurement within the corresponding
set.

— VA: Vertical Angle measurement within the corresponding
set.

— SD: Slope Distance measurement within the corresponding
set.
* Remove: deletes all measurements from the set.

* Re-Meas: displays the sideshot page to measure a new set of
angles.

* Accept: saves the measured point.

* Settings: opens the Mode screen (see “Config: Survey
Parameters” on page 2-46).
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Offsets

The Offsets tab contains a set of tools for defining the offsets.

# Measurement | Data | Map | Offsets

Figure 6-14. Offsets

* Hz Angle: defines a point using the horizontal angle from one
point and the distance to another.

* Hz-Vt Angle: defines a point using the horizontal and vertical
angles.

* Dist. Offset: defines a point giving the ability to add or subtract
distances, horizontally and vertically.

2 Line ISection: determines a point by the intersection of the two
lines. Each line is defined by two points or two measurements.

* Line & Corner: determines a point on the corner using one line
defined by two points and horizontal angle measurement.

* Line & Offset: determines a point distant from a line defined by
two points.

* Plane & Corner: determines a point (Corner) by a plane defined
by three points and horizontal and vertical angle measurements.
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Horizontal Angle Offset

The Measurement tab of the Horizontal Angle Offset screen contains
data for definition of a point using the horizontal angle from one point
and the distance to another.

Erommor  ETTAEZE
| # Measurement |Data | Map | Offsets |

[@®] Paint [

@ Code Ie v
W poo —m o jO8S

Take measurements in any order

Side Center

Figure 6-15. Horizontal Angle Offset — Measurement Tab

Point: name for the offset point to be stored. The button
opens the Add Photo Notes screen to enter a photo note for the
point.

Code: code for the offset point to be stored. Can be entered
manually or chosen from the drop-down list.

: the Attributes List bitmap, opens the list of available
attributes (for details see “Code-Attributes” on page 3-10).

The bitmap next to the Attributes List bitmap displays the
following list:

— String: toggles on the String field. Also, the sign appears.

— Layer: opens the Select Layer screen (see “Select Layer” on
page 3-8).

— Note: opens the Note screen. For details, see “Topo” on
page 5-24.

HR: sets the target height above the mark (rod height).
Settings: opens the Mode screen for setting the sideshot mode.

Side and Center: take measurements to Center and obtain
vertical angle and horizontal angle measurements, then a Side
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measurement provides VA, HA, and distance measurements.
With these two sets of measurements, the computation can be
made for point at center of a tree; for example, when taking
measurements, a comment will appear on the screen.

* The bitmap on the upper-left corner of the screen displays the
following pop-up menu:

— Adv (Advance): opens the Backsight Survey screen for
setting the next traverse point as the next occupation point.
The current occupation point becomes the next backsight
point.

— Edit Points: opens the Points list.

— Edit Raw: opens the Raw TS screen (see “Raw Data” on
page 3-55).

— Inverse: opens the Inverse COGO screen (see “Inverse” on
page 9-2).

— Intersection: opens the Intersection COGO screen (see
“Intersection” on page 9-7).

— Note: opens the Notes screen. (See “Note” on page 5-27.)

— PTL Mode: opens the PTL Mode screen (see “PTL Mode” on
page 6-12).

— Display Coord: if chosen, the coordinates of the previous
point measured will display below the HR data (see Figure 6-
9 on page 6-10).

— Help: accesses the Help files.
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The following three tabs are similar to the Offset tasks:

* The Data tab contains the data collected during the offset
measurement.

Hurizuntal Angle Offset
## Measurement | Data |Map | Offselsl

[po1, HI 0.000m [po1, az 0.0000d

Point ID T53 e
Code well
Attributes
HR
North 1.000 m
East 1.000 m
Height 2.000 m
Side
HA n_nnon_d
] | IIIEI

Figure 6-16. Horizontal Angle Offset — Data Tab

* The Map tab contains the graphic view and duplicated controls
from the Measurement tab. For the details on viewing properties
customizing, see ‘“Properties” on page 4-8.

Hurizuntal Angle Offset
[} Measurementl Data | Map |0ffsels|
g >
&

Side

Cntr

AEELe

——lm
1, |[@][Tso004 | E3[EER

Figure 6-17. Horizontal Angle Offset — Map Tab

Bt

E

* The Offsets tab switches to another offset task.
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Horizontal/Vertical Angle

The Measurement tab in the Horizontal/Vertical Angle mode contains
data for definition of a point using the horizontal and vertical angles.

EEvvweos  ETTAEEE
| # Measurement |Data | Map | Offsets |
[@] Point
@ Code IP v
W oo m o o8

Measure To Prism

Prism HAJVA

Figure 6-18. Horizontal/Vertical Angle — Measurement Tab

Point: name for the offset point to be stored. The button
opens the Add Photo Notes screen to enter a photo note for the
point.

Code: code for the offset point to be stored, which can be entered
manually or chosen from the drop-down list.

: the Attributes List bitmap, lists available attributes (see
“Code-Attributes” on page 3-10).

The bitmaps next to the Attributes List bitmap and on the upper-
left corner of the screen display the same lists as for the
Horizontal Angle Offset screen.

HR: sets the target height (Rod Height).

Prism: stores horizontal distance and horizontal angle
measurements (to prism).

HA/VA: combines horizontal angle and zenith angle
measurements with horizontal distance logged in Prism step to
determine point location.

Settings: opens the Mode screen for setting the sideshot mode.

The Data, Map and Offsets tabs are similar to that of the Horizontal
Angle Offset measurement.
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Distance Offset

The Measurement tab of the Distance Offset screen contains the data
for definition of a point giving the ability to add or subtract distances,
horizontally and vertically.

Settings
# Measurement |Data | Map | Offsets

[®] Point
@ Code I v
f HR 1000 m 108

Measure Foresight Direct

Meas

Figure 6-19. Distance Offset — Measurement Tab

* Point: name for the offset point to be stored. The button

opens the Add Photo Notes screen to enter a photo note for the
point.

* Code: code for the offset point to be stored. Can be entered
manually or chosen from the drop-down list.

* |s®[| : The Attributes List bitmap, opens the list of available
attributes.

* The bitmaps next to the Attributes List bitmap and on the upper-
left corner of the screen display the same lists as for the
Horizontal Angle Offset task.

* HR: sets the target height above the mark (rod height).
* @& : shows the battery and memory status for the controller.

After the sideshot is taken, the Enter Distance Offsets screen will be
displayed and contains the following three parameters for the offset:

» Forward/Backward: sets the distance between the current point
and the projection of the offset point on the line of sight.

* Up/Down: sets the height of the point relatively to the current
position.
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¢ Right/Left: sets the distance between the offset point and its
projection, taking into consideration its location relative to the
line of sight.

* Meas: performs the measurement.
* Settings: opens the Mode screen for setting the sideshot mode.

The Data, Map and Offsets tabs are similar to that of the Horizontal
Angle Offset measurement.

Hidden Point

The Measurement tab of the Hidden Point screen defines a point on
the ground surface, with a slanted rod touching the ground point. The
rod has two targets.

[®] Point
@ Code I v
W oo m o o8

Take measurements in any order

Rod Pt1 Rod Pt2

Figure 6-20. Hidden Point — Measurement Tab

* Point: name for the offset point to be stored. The button

opens the Add Photo Notes screen to enter a photo note for the
point.

* Code: code for the offset point to be stored. Can be entered
manually or chosen from the drop-down list.

. : the Artributes List bitmap, opens a list of available
attributes.

* The bitmaps next to the Artributes List bitmap and on the upper-
left corner of the screen display the same lists as for the
Horizontal Angle Offset screen.
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Single: toggles between the Single and Repeat sideshot modes.
Fine: toggles between the Fine and Coarse sideshot modes.
Rod Pt1: measures the first target on the rod.

Rod Pt2: measures the second target on the rod.

Settings: opens the Mode screen for setting the sideshot mode.

Two Line Intersection

The Measurement tab of the Two Line Intersection screen contains
data for determination of a point by the intersection of the two lines.
Each line is defined by two points or two measurements.

2Line Inters Settings | Close

[®] Point
Hode [ ¥
[ v [rooo  m 108%

Take measurements in any order

[Linel pt1 " Linel Pt2 " Line2 Pt1 " Line2 Ptg]

Figure 6-21. Two LIne Intersection — Measurement Tab

Point: name for the offset point to be stored. The button
opens the Add Photo Notes screen to enter a photo note for the
point.

Code: code for the offset point to be stored. Can be entered
manually or chosen from the drop-down list.

#¥ 5| : the Artributes List bitmap, opens the list of available

attributes.

The bitmaps next to the Attributes List bitmap and on the upper-
left corner of the screen display the same lists as for the
Horizontal Angle Offset task.

HR: sets the target height above the mark (rod height).
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¢ Line 1 Pt1 and Line 1 Pt2: obtains measurements to determine
the first and second points defining first line.

* Line 2 Pt 1 and Line 2 Pt 2: obtains measurements to determine
the first and second points defining second line.

* Settings: opens the Mode screen for setting the sideshot mode.

The Data, Map and Offsets tabs are similar to that of the Horizontal
Angle Offset measurement.

Line and Corner

The Measurement tab of the Line and Corner screen contains data for
determination of a point on the corner using one line defined by two
points.

Line&Cumer Settings | Close
[®] Point

@ Code l—v
B Jioo o jOES

Measure Line Points

[ Line Pt1 " Line Pt2 " Corner ]

Figure 6-22. Line and Corner — Measurement Tab

* Point: name for the offset point to be stored. The button

opens the Add Photo Notes screen to enter a photo note for the
point.

* Code: code for the offset point to be stored. Can be entered
manually or chosen from the drop-down list.

. : the Artributes List bitmap, opens a list of available
attributes.

* The bitmaps next to the Attributes List bitmap and on the upper-
left corner of the screen display the same lists as for the
Horizontal Angle Offset screen.
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* HR: sets the target height above the mark (rod height).

Line Pt1: obtain measurements to determine first point defining a
line.

Line Pt2: obtain measurements to determine first point defining a
line.

* Corner: obtain horizontal angle to locate point on line at corner.
* Settings: opens the Mode screen for setting the sideshot mode.
The Data, Map and Offsets tabs are similar to that of the Horizontal
Angle Offset measurement.
Line and Offset

The Measurement tab of the Line and Offset screen contains data for
determination of a point distant from a line defined by two points.

Settings | Close

# Measurement |Data | Map | Offsets

[®] Point
@ Code I v
f HR 1000 m 108

Take measurements in any order

Line Ptl || Line Pt2

Figure 6-23. Line and Offset — Measurement Tab

* Point: name for the offset point to be stored. The button
opens the Add Photo Notes screen to enter a photo note for the
point.

* Code: code for the offset point to be stored. Can be entered
manually or chosen from the drop-down list.

» |4 : the Astributes List bitmap, opens a list of available
attributes.

6-24 TopSURYV Reference Manual



Observations

* The bitmaps next to the Artributes List bitmap and on the upper-
left corner of the screen display the same lists as for the
Horizontal Angle Offset task.

* HR: sets the target height above the mark (rod height).

* Line Pt1: obtains measurements to first point on a line.

* Line Pt2: obtains measurements to second point on a line.

* Settings: opens the Mode screen for setting the sideshot mode.

After the lines are measured, the Enter Distance Offsets screen will
be displayed and contains the following three parameters for the
offset:

» Forward/Backward: sets the distance between the current point
and the projection of the offset point on the line of sight.

* Up/Down: sets the height of the point relatively to the current
position.

» Right/Left: sets the distance between the offset point and its
projection, taking into consideration its location relative to the
line of sight.

The Data, Map and Offsets tabs are similar to that of the Horizontal
Angle Offset measurement.
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Plane and Corner

The Measurement tab of the Plane and Corner screen helps
determine a point (Corner) using a plane defined with three points and
an angle measurement.

# Measurement |Data | Map | Offsets

[®] Point
@ Code I v
f HR 1000 m 108%

Measure Plane Points

[ Plane 1 |[ Plane 2 || Plane 3 || comer |

Figure 6-24. Plane and Corner — Measurement Tab

* Point: name for the offset point to be stored. The button
opens the Add Photo Notes screen to enter a photo note for the
point.

* Code: code for the offset point to be stored. Can be entered
manually or chosen from the drop-down list.

. : the Attributes List bitmap, opens a list of available
attributes for the chosen code.

* The bitmaps next to the Artributes List bitmap and on the upper-
left corner of the screen display the same lists as for the
Horizontal Angle Offset screen.

* HR: sets the target (rod) height above the mark.
* Plane 1: obtains measurements to determine first point in a plane.

* Plane 2: obtains measurements to determine second point in a
plane.

¢ Plane 3: obtains measurements to determine third point in a
plane.
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* Corner: obtains horizontal and vertical angle measurements to

determine corner point in a plane.

The three points defining a plane must be not be
colinear (all on the same line).

* Settings: opens the Mode screen for setting the sideshot mode.

The Data, Map and Offsets tabs are similar to that of the Horizontal
Angle Offset measurement.

Resection

To access the Resection screen, tap Survey » Resection.

Alternatively, tap Survey » Occ/BS Setup, then press the bitmap next
to the Map icon in the Occ. Point field and select the Resection item.

The method of resection computes the coordinates of a point using
measurements from two (or more) points with known coordinates.
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Settings
# Measurement |Data | Map | Meas Set

[#] Point [101
@ Code IE
[f] HR |u.uuu m 188

Measure Foresight Direct

Figure 6-25. Resection

Code: the known point code.
HR: the height of the rod (target).
Meas: takes the sideshot to the point.

Settings: opens the Mode screen (see “Config: Survey
Parameters” on page 2-46).

Point: the known point name. Can be selected from the map or
from the list.
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* The bitmap on the upper-left corner displays the following
pop-up menu:
— Edit Points: opens the Points list (see “Points” on page 3-2).
— Inverse: opens the Inverse COGO screen (see “Inverse” on
page 9-2).

— Notes: opens the Note screen for adding notes to the
measurement session.

— PTL Mode: switches on the PTL (Point-To-Line) Mode. (The
screen changes to Points (PTL).) For details, see “PTL
Mode” on page 6-12.

— Remote Settings (for Robotic mode only): opens the Search/
Track Parameters screen (see “Config: Stakeout Parameters”
on page 2-66).

— Config Link (only for the Robotic mode): opens the
Configure Link screen (see “Configure Link™ on page 8-8).

— Display Coord: if chosen, the coordinates of the previous
point measured will display below the HR data (see Figure 6-
9 on page 6-10).

— Options: opens the Resection Options screen (see “Resection
Options” on page 6-30).

— Help: accesses the Help files.

The Data tab shows the results of the current measurement and the
scale factor and standard deviations of the coordinates.

The Map tab shows all points in a graphic mode. For details on map
properties and customizing, see ‘“Properties” on page 4-8.

The Meas Set tab displays the result of the sideshots being done
during one set (Figure 6-6 on page 6-7).

6-28 TopSURYV Reference Manual



Resection

Resection Settings

Close

[} Measurementl Data | Map | Meas Set

Point

| resHA| Res va| Res sD|use

BSN -0.0002
BSE 0.0002
B55 -0.0001
BSW 0.0000

K1 I

-0.0003
-0.0002
0.0004
0.0002

-0.000
0.001
-0.001
0.000

HVSD
HVSD
HVSD
HVSD

D]

SdE [0.0025 | Sd N [0.0024

Sd H [0.0041

Ground to Grid ||:|_999972

| Use Cirl | | Re-Meas |

| Accept |

Figure 6-26. Resection — Meas Set Tab

and Height, respectively.

Sd N, Sd E, Sd H: displays Standard deviations for North, East

* Ground to Grid: displays the calculated scale factor.

 Use Ctrl: toggles through specific measurements in the resection,
for example the horizontal angle, but not the vertical, or vice
versa. The used measurements are listed in the Use column. For
example, HVSD indicates that the Horizontal angle, Vertical
angle and the Slope Distance were used.

* Re-Meas: replaces the current measurement with a new
measurement.

¢ Accept: stores the new coordinates in the database.
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Resection Options

The Resection Options screen calculates along the scale factor and
sets the resection type: whether to calculate the height (3-D) or just
the horizontal coordinates (2-D).

Resection Options m
Resection Type

Estimate Scale

|:| Use Calculated scale factor

Figure 6-27. Resection Options

Elevation

To access the Elevation screen, tap Survey » Elevation.
Alternatively, tap Survey » Occ/BS Setup, then press the bitmap next
to the Map icon in the Occ. Point field and select the Elevation item.

Computation or estimation of elevation (vertical coordinate) will
typically use measurements from two or more points with known
coordinates.

Eaelo]
| # Measurement |Data | Map | Meas Set |
[@] point o1
@ Code IE—
[lwe oo m 108

Measure Foresight Direct

Figure 6-28. Elevation

* Point: the known point name, which can be selected from the map
or from the list.
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* Code: the known point code.
* HR: the height of the rod (target).
* Meas: takes the sideshot to the point.

* Settings: opens the Mode screen (see “Config: Survey
Parameters” on page 2-63).

* The bitmap on the upper-left corner displays the same pop-up
menu except of the Options item, as for the Resection task.

The Data tab shows the results of the current measurement and the
scale factor and standard deviations of the coordinates.

The Map tab shows all points in a graphic mode. For details on map
properties and customizing, see “Properties” on page 4-8.

The Meas Set tab displays the results of the sideshots being done
during one set, the same as for the Resection task.

Elevation Settings | Close
[} Measurementl Data | Map | Meas Set
Point | Res vA| ResHt| HtDirf| HR
BSE 0.0002 0.001 -0.000 0.000
BSS -0.0004 -0.002 -0.000 0.000
BSW 0.0001 0.001 -0.000 0.000
q] | L]
| Remove | | Re-Meas | | Accept |

Figure 6-29. Elevation — Meas Set Tab

The table represents the result list of the measurements being made:
the residuals of the vertical and horizontal angles, the measured and
initial parameters (HR, HA, VA, etc.) The Ht Diff column represents
the difference between the calculated height and the height of that
measurement.

* Remove: deletes highlighted measurements in the elevation.

* Re-Meas: replaces the current measurement with a new
measurement.

¢ Accept: stores the new coordinates in the database.
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Cross-Section

The Cross-Section task surveys of the cross section. To start working,
select the Survey » X-Section.

The Cross Section screen contains station settings for a selected road,
where the cross section survey is to be performed.

Cmss Section m Cancel

T T——
Bace [ v
Station lm m
Interval IM m

Figure 6-30. Cross Section

Road: select the road from the Roads list.

ClI Code: the code of the center line points. Insert manually, or
select one from the drop-down list.

« |a® | : the Astributes List bitmap, opens the list of available
attributes (for details see “Code-Attributes” on page 3-10).

* The bitmap next to the Attributes List bitmap displays the
following list:

— String: switches on the String field (see “Topo” on
page 5-24).

* Station/Chainage: sets the station/distance where the cross
section is surveyed.

e Interval: the increment of distance towards the next station.

The Station/Chainage and Interval fields appear
only if the road is chosen.
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* The bitmap in the upper-left corner of the screen displays the
menu of two items:

— Edit Roads: enables the Roads screen. See “Road Design” on
page 3-24.
— Help: accesses the Help files.
* OK: saves the changes and opens a screen to perform sideshot
measurements. Toggling between the sideshot modes is
performed from the Measurement Method field in the two Mode

screens opened by the Settings button in the XSect-Dir
(XSect -Dir/Rev) screen.

XSection - Direct

The XSect-Dir screen performs the usual observation work relative to
the cross section.

Eotongs] cove

| # Measurement |Data | Map |

[®] pont [iox [58)

@ Code lﬁ
@] we  [looo  m 1088

Measure Foresight Direct
[] Traverse Point

BS Setup Cur Chn Meas

Figure 6-31. Cross Section - Direct

The survey is performed from one side of the road to another in a
plane perpendicular to the center line. If the road has not been set,
define the plane.

On the first station the survey is performed so that each next point has
a different code, for example A, B, C, cl, D, E, F. After the Close
button is pressed, the station number automatically changes. The
application will suggest that the survey on the next station using the
same codes in the opposite order: F, E, D, cl, C, B, A. The line will be
created along the points with “cl” code.
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For a detailed description of the survey process, see “Observations”
on page 6-8. The only difference lies in the presence of the Cur Stn/
Cur Chn button. Similar to the Meas button, it makes the
measurement, but does not store the point to the data set.

Find Station

To start working, select Survey » Find Station.

The Measurement tab of the Find Station screen is used for the
identification of the station by computing the distance from the
beginning of the road to the projection of the station to the road, and
the offset of the station from the center line of the road.

[EB4Find station
| # Measurement | Results | Map |
Road [R1
@] point 101
@ Code I v
B w  poo—m 508S

Measure Foresight Direct

[BsSetup || Ptstn | curstn || Meas |

Figure 6-32. Find Station — Measurement Tab
* Road: type the name for the road, or select it from the list.

* Point: the name of the point. Select the point from the map or
from the list.

* Code: the code. Can be entered manually or chosen from the
drop-down list.

«*E| : the Artributes List bitmap, opens a list of available
attributes (for details, see “Code-Attributes” on page 3-10).

» @ : shows the battery and memory status for the controller.
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* The bitmap next to the Attributes List bitmap displays the
following list:

— String: toggles on the String field. Also, the sign appears.

— Layer: opens the Select Layer screen (see “Select Layer” on
page 3-8).

— Note: opens the Note screen.
* HR: sets the target height above the mark (rod height).

* BS Setup: opens the Backsight Survey screen for setting the
backsight point. The information displayed is the same as has
been entered.

* Pt Stn: computes the result.

* Cur Stn: computes the result, takes the sideshot to the point, and
stores the point to the data set.

* Meas: computes the result and takes the sideshot to the point. The
result reflects in the Result tab.

* Settings: opens the Mode screen to set the sideshot mode.

* The bitmap in the upper-left corner of the screen displays the
following pop-up menu:

— Edit Points: opens the Points list.
— Inverse: opens the Inverse COGO screen.
— Notes: opens the Notes screen.

— PTL Mode: opens the PTL Mode screen (see “PTL Mode” on
page 6-12).

— Display Coord: if chosen, the coordinates of the previous
point measured will display below the HR data (see Figure 6-
9 on page 6-10).

— Help: accesses the Help files.
The Result tab shows the results of the computation.

The Map tab shows all points in a graphic mode and duplicates the
button controls from the first tab. For details on map properties and
customizing, see “Properties” on page 4-8.
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The Meas Set tab (if available) displays the result of the sideshots
being done during one set.

Tape Dimension

To start working, select Survey » Tape Dimension.

The Tape Dimension screen calculates the periphery of structures
such as buildings that have features perpendicular to each other. This
is done using tape measurements, relative to the two known points
that belong to one side of the structure (wall of the building), forming
the so called reference line.

The Ref Line tab contains information about the two points
comprising the reference line.

[Ref Line [Tape Dim | Data | Map
Start Pt
Start Point [DO1 o5
@ Code tape
End Pt
End Point D02 -
@ Code tape

Figure 6-33. Tape Dimension Ref Line Tab

* Start Pt: contains properties of the starting point: the name (can
be entered manually or chosen from the map or list) and code.
Also, the point can be measured by pressing the Meas button.

* End Pt: contains properties of the ending point: the name (can be
entered manually or chosen from the map or list) and code. Also,
the point can be measured by pressing the Meas button.
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The Tape Dim tab contains the settings for performing the survey.

Tape Dimension

[®] point 112

@ Code Ie v
o E
IS.DDD
=100 m 102 I Accept ] I Finish |v

Figure 6-34. Tape Dimension — Tape Dim Tab

* Point: the name of the next point in the survey. The button
opens the Add Photo Notes screen to enter a photo note for the
point.

* Code: the code of the point. Can be entered manually or chosen
from the drop-down list.

. : the Artributes List bitmap, opens the list of available
attributes (for details see “Code-Attributes” on page 3-10).

* The bitmap next to the Attributes List bitmap contains the String,
Layer, and Note items.

* Dist Left: toggles between Dist Left and Dist Right values. These
set the direction of the next movement, relative to the previous
direction. The field below sets the distance to move.

* Accept: applies the taped distance to the perimeter line.
* Finish: opens the floating menu of two items:

— Close Polygon: connects the first and the last two points with
a line.

— Calc Closure: calculates the difference between the last and
the first points.

* The bitmap in the lower-left corner of the screen shows the plot of
the already taped perimeter.
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The Data tab shows the initial data and current results of the
measurements.

The Map tab displays the plot of the already made measurements.

Missing Line
To start working, select Survey » Missing Line.

The Missing Line screen emulates the total station measurement from
one point to another and stores the result to the Raw Data database.

"Ref Line |Data | Map |
Start Pt
Start Point [DD4
@ Code I :I
End Pt
End Point D03
@ Code I :I

Figure 6-35. Missing Line — Ref Line Tab

* The Start and End points can be entered manually, chosen from
the map or from the list, or measured through the Meas button.

The Data tab displays the results of the measurements.

ERZmissing Line
Ref Line | Data || Map

[po1, HI 0.000m [az 0-0000dms

Start Point D04

End Point Do3

dHD 100.000 m

avD -20.000 m

dsp 101.980 m

| | [»]

Figure 6-36. Missing Line — Data Tab
The same results are reflected in the Raw Data screen.

The Map tab shows the relative position of the points and the
measured line.
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Auto Topo

This function is activated only with Robotic instruments, and collects
points by Time and Distance. To open the Auto Topo screen, select
Survey » Auto Topo in the Robotic mode.

¥ Measurement |pata | Map

[®] Point
EY code e v
[f HR  [o.000 m ﬂ@g

Log Now Start

Olock  [search || Lock || Tumn || stop |

Figure 6-37. Auto Topo

The bitmap on the upper-left corner displays the following pop-up
menu:

Edit Points: opens the Points list.
Inverse: opens the Inverse COGO screen.
Notes: opens the Notes screen.

PTL Mode: opens the PTL Mode screen (see “PTL Mode” on
page 6-12).

Remote settings: opens the Search/Track Parameters screen (see
“Config: Stakeout Parameters” on page 2-66).

Config Link: opens the Configure Link screen (see “Configure
Link” on page 8-8).

BS Setup: opens the Backsight Survey screen (see “Backsight
Survey” on page 6-2).

Display Coord: if chosen, the coordinates of the previous point
measured will display below the HR data (see Figure 6-9 on
page 6-10).

Help: accesses the Help files.

The Measurement tab contains the initial data for the survey:
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* Point: displays the current point name. The button opens the
Add Photo Notes screen to enter a photo note for the point.

* Code: displays the current point code. Can be entered manually
or chosen from the drop-down list.

o fﬁ : selects attributes for the indicated code.

* The bitmap next to the Attributes List bitmap displays the
following list:

— String: switches on the String field. (The sign also
appears.)

— Layer: opens the Select Layer screen (see “Select Layer” on
page 3-8).

— Note: opens the Notes screen (see “Note” on page 5-27).
* HR: the height of the rod (target).
* Log Now: immediately stores the current position.

* Start: starts the survey process. After pressing, the button
changes it name to Stop.

¢ Qlock: sends the “Quicklock” or “Turn Around” command which
will cause the Total Station to search for the RC-2!.

* Search: make the instrument search for the prism.
* Lock: lock onto the prism or “track” it.

* Turn: opens the Rotate screen which allows the Total station to
turn to various angles or points.

» Stop: makes the total station to stop tracking the prism and go
into “Standby” mode.

 Settings: opens the Mode screen. Press Next to access the Auto
Topo settings (Figure 6-38 on page 6-41):

1. RC-2 is the Remote Control System 2 for optical communications. For
instructions of how to operate the RC-2 device, consult the instruction
manual for RC-2.
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— Method: sets the method of data collection; either By Time,
By Horizontal Distance, or By Slope Distance.

— Interval: the time interval for the data collection.

* Press Finish to save the changes and return to the Auto Topo
screen.

Meas Type
EDM Mode IFine 1mm :I
Prism Constant IU— mm

& Point Guide [ Hon-Prism

Auto Topo
Method |B‘1r Time Ellntenral |1.IIIIII sec

| Defaults || <« Back |

Figure 6-38. Mode Screen — Auto Topo Settings
The Data tab displays the data being surveyed.

The Map tab shows the surveyed data graphically and duplicates the
controls from the Measurement tab to perform the survey to work in
the map mode.
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Scanning

This function is activated only with robotic/reflectorless and
motorized/reflectorless total stations. Make sure that the Show Scan
Point option is selected in the bitmap menu in the upper left corner of
the Points screen (refer to “Points” on page 3-2).

To open the Scanning screen, select Survey » Scanning in the
Robotic mode. In the Scanning screen select a desired scan type:
either Scan with Image or Scan w/o Image.

For Scanning without Image (Figure 6-39).

Scanning Close

|Scan wifo Image El

Orientation IVerticaI : I

Figure 6-39. Scan without Image

* Orientation: sets the type of scan orientation; either Vertical,
Horizontal, or Incline.

* Next: opens the Area screen (refer to “Area” on page 6-52).
For Scan with Image (Figure 6-40).

scan with Image

Figure 6-40. Scan with Image
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» Next: opens the screen to enter information on the scan session.

Session I 9 v
Image | 1MG_ooos v
Camera | CanonPowerShotS2

Yiew [ <« Back ][ Next >> ]

Figure 6-41. Enter Scan Session Information
e Session: sets a Session name.

* Image: sets an Image file. Select a previous Image or browse for a
new one (Images are stored as JPEG with the * jpg file
extension).

* Camera: sets the Camera information. If the Image exists in the
Job, the Camera information will be selected automatically.
Otherwise, select a previous Camera or browse for a new one
(Cameras are stored as a text file with the *.cmr extension).

* View: opens the View Scan screen.
* Back: returns to the previous screen.

» Next: once all fields are filled, clicking the button opens the
Orientation screen.
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View Scan

The View Scan screen displays the image along with orientation and
scanned points for completed scan sessions.

Cancel

Tap on Orientation Pt

| Meas IV | << Back || Next >>

Figure 6-42. View Scan

. : zooms in the image
. : zooms out
: displays the whole image

/ : enables/disables a pan drag control of the image.

When the Pan button is disabled, tap on the image to choose the
orientation point.
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Orientation

The Orientation screen associates a position on the image (X, y) with
known N, E, Z coordinates.

Tap on Orientation Pt

Meas IV | << Back || Next »>

Figure 6-43. Orientation

: zooms in the image

: zooms out

: displays the whole image

/ : enables/disables a pan drag control of the image.

When the Pan button is disabled, tap on the image to choose the
orientation point. The image will zoom to this point and show a
crosshair. The position of the crosshair can be adjusted.

Orientation Canl:el

_I-
o
x]

|T9|9 :I Select or meas Orient Pt
Mea IV | << Back || Next »> |

Figure 6-44. Select Orientation Point
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. / |§| : switches on/off the keypad arrow keys to adjust the

crosshair position. When the Arrow button is enabled, the arrow
keys on the keypad can move the crosshair up, down, left, or
right.

. El : attempts to move the crosshair to the center of a circular

object on the image. First tap somewhere inside the circular
object. The object should be a well-defined circle with high
contrast between the inside and outside of the circle.

* The drop-down list in the bottom left corner of the screen
contains two options to view the image (Figure 6-45):

— Tele (telescope): the default zoomed-in view of the crosshair.

— Wide View: zooms out and shows the area of the image which
contains the orientation point.

Select or meas Orient Pt

| Meas IV | << Back || Next »> |

Figure 6-45. Select Orientation Point — Wide View

* Meas: measures the orientation point. The bitmap menu options
(Meas, From Map, From List) are used to take a measurement or
to select an existing point from a map or list.
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. : opens the Orientation Results screen to delete the selected
orientation points (Figure 6-46).

Orientatiun Results m
Name |
v|oriol
ori2
v|orio3
orio4

Figure 6-46. Delete Orientation Points

* Next: when four or more orientation points have been established
click this button on the Orientation screen to display the
orientation results (Figure 6-45).

Cancel

Tap on Orientation Pt

| Meas IV | << Back || Next >> |

Figure 6-47. Calculate Image Orientation
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Orientation Results

The Orientation Results screen displays the results of the image
orientation. The results for each orientation point is displayed as dX
and dY in image pixels.

Orientatiun Results
Name | dX[pixel] | d¥[pixel] |
ori03 1.0 1.0 BAD
orio4  -1.2 0.3 GOOD
ori0l 1.0 -0.6 BAD
ori02 -0.8 -0.6 GOOD

MAX dX:1.2 d¥:1.0 GOOD
RMS dX:1.0 d¥:0.7 BAD
[ Delete ][ <« Back ][ Next >> ]

Figure 6-48. Orientation Results
* Back: continues to the Scan screen to select areas for scanning.

* Delete: removes the selected point to adjust the orientation
calculation. If four points still remain, the new results are
displayed. If there are less than four orientation points, then the
Orientation Results screen will close automatically to continue
the orientation procedure.

Scan Area, Selecting

Use one of the following methods to select one or more areas for
scanning:

Select Area Method 1.Draw a rectangle by pressing the stylus on
the screen for the start point and dragging to the end point.
When the stylus is lifted, the area is set (Figure 6-49 on page 6-
49, left image).

Select Area Method 2.Draw a polygon by pressing the stylus down
at each vertex. Lines will be drawn connecting each vertex to
the previous one. Press the stylus near the first vertex to close
the area (Figure 6-49 on page 6-49, right image).
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iEAASca Settings | Cancel

SlelLle

Draw Scan Area, then press Next

Clear || << Back

Draw Scan Area, then press Next

| Clear || << Back |

Figure 6-49. Select Scan Area

» Next: when the areas are set, pressing this button begins the scan,
first opens the Interval screen to set the scanning settings.

¢ Clear: erases all drawn areas.

* Settings: opens the Mode screen (for a description of parameters
on this screen, see “Config: Survey Parameters” on page 2-46).
This is the same screen as the Settings button opens in the
Observation and Occ/BS Setup screens. The main use is set the
instrument to “Non-Prism” mode which is required for scanning
and also to change the measurement mode (Fine, Coarse).
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Interval

The Interval screen sets the starting point and horizontal and vertical
intervals for scanning.

Interval . Cancel |

Start Pt [ECAN2348)

Scan Mode [Fine v Start Pt [SCAN2348

Meas Mode [Normal NP R Scan Mode [Fine v
Hormal NP

Interval |Angle v pepode I .

S 0.3000 dms GITT B Num Points 19

vA 0.3000 dms Num H [10

[ <« Back ][ Next »>> ] Num ¥ |1lII

[ <« Back ][ Next >>

Figure 6-50. Scanning Interval
* Start Pt: sets the starting name for the scanned points.
* Scan Mode: sets scanning mode to either Fine or Coarse.
* Meas Mode: sets measuring mode to:
— Normal NP: normal Non-Prism measurements.

— Long NP: long distance Non-Prism measurements (200-300
meters away); only available for GPT-8200 and GPT-7000
Total Stations.

— Normal/Long NP: attempts to take a normal NP
measurement. If unsuccessful, the instrument will
automatically switch to long NP mode for the measurement;
only available for GPT-8200 and GPT-7000 Total Stations.

e Interval: sets the scanning intervals either as Angle values or
Numbers of points.

e HA/Num H: sets the interval in the horizontal direction.
e VA/Num V: sets the interval in the vertical direction.

» Next: saves the settings and opens the Estimate Time screen.
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Time Estimate

Before scanning begins, the Estimate Time screen displays the
scanning information including the total number of points to be
scanned and an estimate of the time it will take to complete the scan.
If the estimated time is too long, click Cancel and enter larger
intervals.

Estimate Time

Start Pt 100
Scan Mode  Fine

Meas Mode  Mormal NP

H Interval 0.0148 dms

Y Interval 0.0148 dms

Areas 1

Points 1156

Time 072112

Figure 6-51. Estimate Time

* Finish: begins scanning points.

Scanning in Progress

As the total station measures points within the predefined area, each
point will be displayed on the image.

Scanning...

| Clear || << Back ||_§tup |

Figure 6-52. Scanning in Progress

* Stop: immediately stop the scan.
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Area

The Area screen selects the starting and ending points for the

scanning area.

o]
5 iER 4 Area "
Pl . . |
Pt1
P2 4Pt3
'd
* P2 4Pt3 "
Meas =] 4
[ << Back ][ Next >3 ]

Figure 6-53. Select Area

* Meas: measures the orientation point. The bitmap menu

options (Meas, From Map, From List) are used to take a
measurement or to select an existing point from a map or list.

* Next: displays the same Interval and Estimate Time screens as
for Scanning with Image mode (see “Interval” on page 6-50 and
“Time Estimate” on page 6-51).

Scan

As the total station measures points within the predefined area, each
point will be displayed on the screen.

Figure 6-54. Scanning in Progress
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¢ Clear: removes measured points from the screen and return to the
Area screen.

» Stop: immediately stop the scan and returns to the Area screen.

After scanning is completed, the screen returns to the Area screen to

set a new area for scanning. The icon denotes the scanned points
in the list of points.

Monitor

This function is activated only with robotic total stations. To enable
the monitor survey, select Survey » Monitor in the Robotic mode.
The Monitor Pointlist screen displays.

Monitor PointList

The points to be measured are added to a point list which is then
loaded using the Monitor Pointlist screen:

[EB4 MonitorPoint List
[2] Point List IPointLisﬂ -|

[#] [List of Points | Code(s) y

lo001
1002
u S
[*] |« | =0.05 m []

HR II].I]I]I] m

Figure 6-55. Monitor Point List

After the point list is selected, the Next button opens the Monitor
screen.
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Monitor

The Monitor function measures one or more prisms repeatedly and
uses the measurements to detect changes in the position of the prisms.
The measurements are recorded into the raw data file.

Optionally, the raw measurements or the computed points can be
output to a file or communication port in either the FC-6 or GTS-7
formats. The output format and destination is accessed from the
Monitor Options screen when configuring the total station (see

“Config: Instrument” on page 2-54).

The Monitor screen is used to control the monitor survey.

Ml:lnitl:lr Settings
¥ Remote |Data | Map

FO8S
[®] Point 103
Cycle Time |600 secs
Auto on v

HA 359.5951,VA 90.5407,5D
4.258 {dms,m)

© ® Press Start when ready

Start

Qlock lSean:hl lLDCk l lTum l lStup

Figure 6-56. Monitor

* Points: the point name.

» [nterval: interval listed as the Cycle Time. If a prism cannot be
found after a period of 15 seconds, the total station will rotate to

the next point in the sequence.

e Auto: If the Auto combobox is set to ON, the total station
automatically rotates to the next point in the sequence and records
a measurement. If it is set to OFF, the total station rotates to the
point, but allows the user to verify or correct the centering to the
prism prior to taking a measurement. The monitor function will
always complete the entire sequence, even if the measurements

take longer than cycle time.
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 Start: initiates the sequence of measurements which repeats at
the desired interval.

¢ Qlock: sends the “Quicklock’ or “Turn Around” command which
will cause the Total Station to search for the RC-2!.

* Search: make the instrument search for the prism.
* Lock: lock onto the prism or “track” it.

* Turn: opens the Rotate screen which allows the Total station to
turn to various angles or points.

* Stop: makes the total station to stop tracking the prism and go
into “Standby” mode.

The Data Indicator above the Qlock button shows the current state of
the robotic Total Station with one of the following icons:

Q -no data @ — turning

= — querying status I -receiving data
The Data tab lists the differences between the coordinates of the
reference point and the measured point.

The Map tab shows all points in graphic mode. For details, on map
properties and customizing, see ‘“Properties” on page 4-8.

1. RC-2 is the Remote Control System 2 for optical communications. For
instructions of how to operate the RC-2 device, consult the instruction
manual for RC-2.
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Remote Control

To set up a survey with remote control, tap Survey » Remote
Control.

If one person performs the survey process with a motorized
instrument, the remote control transmits commands from the
controller to the total station. The radio modems need to be set and
connected to the controller and the instrument.

Remote Control

The Remote Control tab controls the total station through the radio.

Reml:lte Control
# Remote Control |Data | Mapl

@ e

HA:33.2511,VA:91.0543,5D:19.070
|

|QI|:||:k ||Sea[|:h|| Lock || Turn || Stop |

Figure 6-57. Remote Control

The Remote Control tab shows the current values of the total station
measurements and provides a set of tools for control:

. : switches the keyboard control on and off, shows the

current status of the switch.

* g :shows the battery status for the total station.

e (@ :shows the status of communication between the controller

and total station.
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¢ Qlock: sends the “Quicklock” or “Turn Around” command which
will cause the Total Station to search for the RC-2!.

* Search: make the instrument search for the prism.
* Lock: lock onto the prism or “track” it.

* Turn: opens the Rotate screen which allows the Total station to
turn to various angles or points.

» Stop: makes the total station to stop tracking the prism and go
into “Standby” mode.

¢ The Data Indicator above the Qlock button shows the current
state of the Total Station. There are four types: no data, querying
status, turning, and receiving data.

¢ All the observations can be done in the remote mode as well if the
instrument chosen is robotic.

* The bitmap on the upper-left corner displays the following pop-
up menu:

— Edit Points: opens the Points list.
— Inverse: opens the Inverse COGO screen.
— Notes: opens the Notes screen (see “Note” on page 5-27).

— PTL Mode: opens the PTL Mode screen (see “PTL Mode” on
page 6-12).

— Remote Settings: opens the Search/Track screen.

— Config Link: opens the Configure Link screen (for details,
see “Configure Link” on page 8-8).

— Help: accesses the Help files.

The Map tab shows all points in a graphic mode. For details, on map
properties and customizing, see “Properties” on page 4-8.

1. RC-2 is the Remote Control System 2 for optical communications. For
instructions of how to operate the RC-2 device, consult the instruction
manual for RC-2.
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When the Robotic total station operates in the Remote Control Mode,
some of the screens change their appearance, the remote control tools
appear on the Measurement tab (Figure 6-58 on page 6-58).

# Measurement |Data IHI Measurement Setl
@ point 51|
@ Code o

[f HR [o:000 ] ush e

HA:33.2511,¥A:91.0543,5D:19.070
) Measure Foresight Direct

|QI|:||:k ||Sea[|:h|| Lock || Turn || Stop |

Figure 6-58. Sample Screen for Remote Control Mode

Rotate

The Rotate screen contains settings for the remote total station
rotation (Figure 6-59 on page 6-59).

* Rotation Angles: sets the values of the horizontal and vertical
rotation angles.

¢ Turn: sends the data to the total station.

* Rotate to Point: selects a point by typing its name, selecting it
from the map or a list, inserting the HR value (height of rod or
target), and pressing the Turn button.

* Plunge TS: press to plunge the instrument (rotate the telescope
and the body by 180 degrees).
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Rotate

Rotation Angles

Horizontal |245. 1622 dms
Vertical |91.l3657 dms

Rotate to Point

@] proint [po3
[ Hr [12507] m Tu

Pl |
7 Plunge TS

@

Figure 6-59. Rotate

Remote Control



Total Station Survey

Notes:
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Chapter 7

Level Survey

The Survey menu includes two items for Level survey:
* Level Run
* Two Peg Test
& Leveiing [My Leven g &

Job Edit View Cogo HIp
Level Run
Twio Peg Test

Figure 7-1. Level Survey Menu

Level Run

To set up a Level survey in running mode, tap Survey » Level Run.

The Level Run screen creates a new level run.

Name | 11 v
Note bm A road|

Figure 7-2. New Level Run

* Name: sets a name of the new level run.
* Note: adds optional information on the level run.

» Next: opens the screen to make leveling measurements.
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DL Level Run

The DL tab of the Level Run <run name> screen displays all leveling
data in progress and contains tools to conduct leveling.

[EEdLevel Run(rUN1) [ Close
DL |pata Level Run({RUN2) Close ]
DL |pat
Point | BS [ [Fs =
e+ CUR1 1.3130 1.313 Point | Accumulated Ht | BS ~
oLl 1519 |43 1.4500
FeCUR1  -0.066
< 9 aclusure v
SumBS-SumFs : 10.000 ¢ A

@1 @ |—v@ SumBS-SumFS : 0.000
[ 8BS |[ ss |[ &5 [@lfcory = =7 [FE] [ | v [zzE|
BS ES

55

Figure 7-3. DL Level Run

|§| : sets the point for rod reading; selected from the map or the

list of points.

. @ : sets the code for the measured point. The bitmap next to
the field opens the Code-Attributes screen to set a new code. For
details, see “Code-Attributes” on page 3-10.

* BS: usually sighting back along the leveling line, the Level takes
a rod reading on a point of known elevation.

* SS: the Level takes a sideshot to the point.

* FS: the Level takes a rod reading on a point of unknown
elevation.

* The fieldbook displays the following information:

— Pt Name: point name and icon displaying point type. Icons

can be:
|:| — backsight point |E| — sideshot point
[+#] — foresight point k] - closure

— Code: the code of the point.
— BS: arod reading taken on the backsight point.
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— HI: the height of the leveled instrument; the elevation of the
line of sight of the telescope above the datum.

— FS§: arod reading taken on the foresight point.
— Elev: elevation of the point.

— BS Dist: the horizontal distance from the level to the rod on a
backsight point.

— FS Dist: the horizontal distance from the level to the rod on a
foresight point.

— Sum BS Dist: the sum of backsight distances.
— Sum FS Dist: the sum of foresight distances.

— SumBS-SumFS: the difference between the sums of BS and
FS measurements.

— Accumulated Ht: the difference between the sum of the
backsights and the sum of the foresights.

— Notes: any additional information on the point.

~ All columns except PT Name can be selected to
display (see “Display Settings” on page 7-4).

* The bitmap in the upper-left corner of the screen displays the
following pop-up menu:

— Stake Point: opens the Stake Point screen to stake out a point.

— Stake Point List: opens the Stake Point List screen to stake
out points from the list (see “DL Stakeout” on page 8-21).

— Stake Elev: opens the Stake Elev screen to stake out at a rod
point (see “Stakeout Elevation” on page 8-22).

— Vertical Offset: opens the Vertical Offset screen to set the
vertical offset to apply at the point.

— Display Settings: opens the Settings screen to select the
columns and the order of the columns to display.

— Show SumBS-SumF'S: displays SumBS-SumFS measurement.
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— Inverse: opens the Two-Point Inverse COGO screen (see
“Inverse” on page 9-2).

— Help: accesses the Help files.

The Data tab of the Level Run <run name> screen displays
information related to the current measurement.

Level Run{11) ..
DL
I I 4
Point A3
Code sm
Ctrl Code 2
Eley 49,430
ES 1.5500
HI 51.550
ES Dist 25.000
Sum BS Dist 25.000
SumBS-5SumFS -5.000 a3
rlntac

Figure 7-4. Level Run - Data

Display Settings

The Settings screen selects the columns to display using. The Up/
Down arrows are used to change the order of the selected column.

Column to Display ~

v Elev
BS Dist
F5 Dist
Sum BS Dist
Sum FS Dist
v|SumBS-5umFS
¥| Accumulated Ht
Notes
v|Code v
< >

Figure 7-5. Display Settings
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Two Peg Test

The Two Peg Test is performed to check if the line of sight of the level
telescope is horizontal when the instrument is leveled.

To execute the Two Peg Test, tap Survey » Two Peg Test.

The Two Peg Test screen guides through a series of measurements to
help determine any error. First it prompts to take shots to the first
point assuming the level is fairly centered between the two points.
Then the instrument should be moved to one of the pegs and the shots
are taken again to Pegs 1 and 2.

e

dpl 4ol
Measure to Pegl(p1) pl: VD:1.500, HD:3.000
Locate Peg2 Measure to Peg2(p2)
Locate Peg2 l [ Meas l

Figure 7-6. Two Peg Test

* Locate Peg2: measures the horizontal distance to Peg2 and
compares it with the already taken measurement to Pegl. This
measurement is not used in the error computations.

* Meas: takes measurements for the displayed prompted Peg. The
results are displayed.
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Two Peg Test Results

The Two Peg Test Results screen displays the results of the test after
all measurements are taken.

kEA 4 Two Peg Test Results
Shot Data
pl vD 1.500
pl HD 3.000
p2 vD 1.800
p2 HD 33.000
pl° vD 1.600
pl" HD 3.000
p2°' vD 1.800
p2°" HD 33.000
Error = -2.778 mmjm

Figure 7-7. Two Peg Test Results
* The table displays all the shots taken.

* Error: computed error means inclination of the actual line of sight
from true horizontal. This error is proportional to the distance
from the level to the rod.
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Chapter 8

Stake

The Stake menu includes the following menu items:
* Points
* Point in Direction
* Point List
* Lines
» Offsets
* Roads
« DTM
* CodeStrings

Il 1100 [My RTK] 8@

Job Edit View Survey Cogo Hip

Y ED?”:S_ ot EEoL-102c-1 My Level] A ®
1123 nint in Direction - .
1% .2 ??.35.: Bl L Job Edit View Survey Cogo Hip
2 Lines Paints Ql
:g < % éﬁﬁ' Offsets H Point List
. Blz ) ngz’%é Roads ) Elev Ql
A DIM |
Code Strings (CUR1 Q
130 |
—a50m @%
+ﬂl‘2

——50m

Figure 8-1. Stake Menu

For stake out with digital levels, the Stake menu includes three
options: Points, Point List and Elevation.
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Points

To stakeout a point, tap Stake » Points.

Stakeout Point

The Stakeout Point screen contains initial data for the stakeout point.

iER 4 Stakeout Point

?"'“ Fixed H Y]
1009 0006 0010 2+2

‘q} Design Point IDIIIl
@ Code Iplace :I

Notes

Ant Ht |2.000 m  |vert[~]

Stakeout

Figure 8-2. Stakeout Point

» For GPS stakeouts, the bitmap in the upper-left corner displays
the following pop-up menu:

— Status: opens the Status screen (see “Status” on page 5-2).

— Rover Antenna Setup: opens the Antenna Setup screen (see
“Config: Rover Antenna” on page 2-42).

— Config Radio: opens the Configure Radio screen (see
“Config: Rover Radio” on page 2-34).

— Edit Points: opens the Points screen (see “Points” on
page 3-2).

— PTL Mode: switches on the PTL (Point-To-Line) Mode. (The
screen changes its appearance to Stakeout Point (PTL).) For
details, see “PTL Mode” on page 6-12.

» For Total Station stakeouts, the bitmap in the upper-left corner
displays the following pop-up menu:

— BS Setup: opens the BS Setup screen (see “Backsight Survey”
on page 6-2).
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— Config Link (for Robotic mode only): opens the Configure
Link screen.

— Remote Control (for Robotic mode only): opens the Remote
Control screen (see “Remote Control” on page 6-56).

— Edit Points: opens the Points screen (see “Points” on
page 3-2).

— PTL Mode: switches on the PTL (Point-To-Line) Mode. (The
screen changes its appearance to Stakeout Point (PTL).) For
details, see “PTL Mode” on page 6-12.

» Design Point: sets the identifier of the design point. Choose it
from a map, from the list, or add a new point.

» Antenna Ht (for GPS mode): sets the height of the antenna
reference point (ARP) above the mark. Also the measurement
type for the height needs to be specified: slant or vertical.

HR (for TS mode): the height of the rod (target).

Settings: opens the Stakeout Parameters screen (see “Config:
Stakeout Parameters” on page 2-48).

Stakeout: opens the Stakeout screen.

GPS+ Stakeout

The Stakeout screen assists in the stakeout process.

b dStakeout Close

. il Fived H W
Point  DO1 130% 0,005 0,010 gsf+2

ﬁ East
1.132 m

North
2.981 m
Cut
0.229 m
Height
202.675 m
Azimuth
275.6

Figure 8-3. Stakeout

Horz Dist
0.990 m

The graphic shows the north direction, the reference direction, and the
target point, if the distance to the target is less than horizontal
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distance tolerance. If the distance is greater than three meters, the
arrow will point to the target, showing the direction of movement.
When the target is closer than the Horizon Distance Tolerance value,
the graphic shows a bull’s-eye target point on the screen. The panel on
the right displays the parameters of the target.

 Store: saves the location. Check the parameters of the stored
point in the Store Point screen, if available.

* Next Pt: moves to the next point in the list.
¢ Close: closes the screen and returns to the Stakeout Point screen.

* The bitmap at the upper-left corner displays the following pop-up
menu:

— Status: opens the Status screen (see “Status” on page 5-2).

— Rover Antenna Setup: opens the Antenna Setup screen (see
“Config: Rover Antenna” on page 2-42).

— Config Radio: opens the Configure Radio screen (see
“Configure Radio” on page 8-5).

— mmGPS+ Options: available if mmGPS is used, opens the
mmGPS+ Options screen (see “mmGPS+ Options” on
page 5-11).

— Topo: opens the Topo screen (“Topo” on page 5-24).

— Auto Advance Pt. if checked, after storing a staked point
opens automatically the Stakeout screen for the next point.

— Store Design Pt/ Layer: opens the Design Pt /Layer screen to
select options to store the points (see “Design Pt/Layer” on
page 8-8).

— Design Offsets: opens the Design Elev screen to add elevation
offsets to the staked points.

— Display Coords: if checked, coordinates are displayed instead
of directions when storing the points.

— Help: accesses the Help files.
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Configure Radio
The Configure Radio screen contains parameters for the radio
modem (Figure 8-4 on page 8-5).

* Radio Connected to: selects the type of the receiver where the
radio is connected, Rover or Base.

* Type: shows the current modem type set for the current survey
configuration. To change the modem, use the
Job » Config » Survey menu.

* Radio Port, Channel, Sensitivity: parameters for the radio
connection.

Cunfigure Radio m

Radio Connected to m
Type Int. Hiper{Pac Crest)

Radio Port |C ~]
Channel IU :I

Sensitivity IHigh : I
Set Radio

Figure 8-4. Configure Radio

TS Stakeout

The Stakeout screen reflects the progress of the stakeout.

iER 4 Stakeout
1088
Hz Dist Left
0.970 m 0.000 m
Away From TS
0.970 m
(o] Fil
+ 5.490 m
Dsan HA., Turn Right
295.0000 dms [€]| 0.0000 dms
[ Next pt || store |G

Figure 8-5. Stakeout
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The Stakeout screen displays the current point name (in the upper-left
corner of the screen), the layout of the target and current position, the
direction, and the values of the distances to the target.

 [»]: opens the map of the layout of the target and current

position.
bl Stakeout
10T
q Left
0.000 m
Away From TS
$‘~ 0.970 m
, Fill
5.490 m
Turn Right
——50m 0.0000 dms
[ Next Pt ][ Store ][gur Pus]

Figure 8-6. Stakeout Map

« EDM: selects the distance measurement mode: Coarse, Fine, or
Coarse Tracking.

* Next Pt: switches to the next target.

* Store: opens the Store Point screen to store the current position as
a point (see “Store Point” on page 8-10).

* Cur Pos: causes a measurement to be made and displays the
result on the screen.

* Search: for robotic Total Stations, starts autotracking and
instructs the TS to search for the prism. This function is useful for
setting the stake and measuring the final position.

* Stop: for robotic Total Stations, stops autotracking. This function
is useful for moving the pole to set the stake in the ground.

¢ Close: closes the screen.

* The bitmap at the upper-left corner displays the following pop-up
menu:

— Rod Height: opens the Enter Rod Height screen to change the
rod height during a stakeout.
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— Remote Control (Robotic mode only): opens the Remote
Control screen (see “Remote Control” on page 6-56).

— Config Link (Robotic mode only): opens the Configure Link
screen.

— Auto Advance Pt: if checked, after storing a staked point,
automatically opens the Stakeout screen for the next point.

— Store Design Pt/ Layer: opens the Design Pt /Layer screen to
select options to store the points.

— Design Offsets: opens the Design Elev screen to add elevation
offsets to the staked points (“Design Elev” on page 8-9).

— Display Coords: if checked, coordinates are displayed instead
of directions.

Stakeuut
Point  S5001 C jeBEE
Hz Dist 7| North
0.015 m - 09,979
East
07.794
@ Eley
09,175
Dsan HA.
269.0440 dms
[][ Qlock ][ MNext Pt ][ Store ]

Figure 8-7. Display Coordinates

— Help: accesses the Help files.
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Configure Link

The Configure Link screen contains parameters for the radio modem.

k=R 4 Configure OK | Cancel

Conn Mode Radios Cnly
Type Satel
Radio Part |C0M1 ~]
Model |3ASU :I
Channel B :I
Frequency 469.5000 1MHz

| Disconnect || Set Radio |

Figure 8-8. Configure Link
e Conn Mode: the connection mode, Cable or Radios Only.

* Type: shows the current modem type set for the current survey
configuration. To change the modem, use the Job » Config »
Survey menu.

* Radio Port, Model, Channel, Frequency: parameters for the radio
connection.
Design Pt/Layer

The Design Pt /Layer screen selects parameters for storing staked
points.

Design Ptf Layer OK | Cancel

Display Store Pt Info

Layer IIII v E

Figure 8-9. Design Pt/Layer

* Display Store Pt Info: if checked, the Store Point screen will
appear before storing a staked point.
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* Layer: selects the layer from the drop down list.

o [ opens the Layers screen to edit layers (see “Layers” on
page 3-18).

Design Elev

The Design Elev screen sets an offset to add to the elevations of the
points when staking points, roads, or DTM’s.

[ o

Design Elev

D |1EI4.49IJ m
Road Offset
I m

DTM Offset

o

Figure 8-10. Design Elevation
Initially, the point height is shown.

To set the elevation offset, select the available check box to activate
the field for entering data and enter the desired offset. Click OK to
save the setting.

P/N 7010-0492 8-9



Stake

Store Point

The Store Point screen displays information on the staked point
before storing.

k=R Store Point m

Point Info |Layer,‘5tyle ]Stk Info ]Phutu Note ]
@ ront [EEE

E¥ code I v
Note
C3

Fill |1 487

Figure 8-11. Staked Point Information
The Point Info tab contains the following fields (Figure 8-11):
* Point: sets the name of the point.

* Code: sets the code for the point. Can be entered manually or
chosen from the drop-down list.

=« || : the Artributes List bitmap, opens the Code-Attributes

screen to set the values for the attributes available for the code
chosen (“Code-Attributes” on page 3-10).

Note: the name of the previous point.

Cut/Fill: shows cut and fill information if it is displayed before
getting stored.

* The bitmap next to the Attributes List bitmap displays the
following list:

— String: toggles on the String field. Also, the sign appears.
For details, see “Topo” on page 5-24.

— Layer: opens the Select Layer screen to put the point. For
details, see “Topo” on page 5-24.

— Note: opens the Note screen. For details, see “Topo” on
page 5-24.
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The Layer/Style tab contains the following fields.

_Pl:lint Info | Layer/Style | stk Info | Photo Note
ELaver [ v E

Point Style

T e ¥ [wowr)

Figure 8-12. Store Point — Layer/Style Tab
* Layer: selects the layer to locate the point.

* Point Style: sets and shows the style to designate the point on the
map.

— The drop down list contains the point symbols to select.
— Color: opens the Select Color screen.

The Stk Info tab displays results of staking.

Sture Point
[Puint Info ]Layer,‘style | Stk Info | photo Note

GG:UTMNorth-Zo...

North 1020.149
East 275.361
Elev 164.872
dN 29.851
dE 9.639

dH -4.872

Figure 8-13. Store Point — Stk Info
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The Photo Note tab adds a photo note to the stakeout point. Initially
the screen is empty.

Store Point OK lCanl:eI

[Puint Info ]Layer,‘style ]Stk Info | Photo Note

Figure 8-14. Store Point — Photo Note

* Add: opens the Select Image File dialog to browse for the
necessary file in the controller.

* Delete: erases the image from the screen.

DL stakeout

DL Stakeout of design points can be accessed from the main menu or
top left menu in the Level Run screen (for details, see page 7-3).

Stake Point

The Stake Point screen selects a design point to determine the
elevation and compute a cut/fill value.

Stake Point

BS Point |12
<+ Design Point [DES1

l BS H Stakeout l

Figure 8-15. DL Stake Point
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* BS Point: selects the backsight point for the stake measurement
(entered manually or selected from the map or list).

* Design Point: selects the point to stake (entered manually or
selected from the map or list).

* BS: if not already measured, takes a BS measurement before
staking.

 Stakeout: opens the level Stakeout screen.

Stakeout

The level Stakeout screen displays the design point, the BS point. For
every measurement taken, updates the Elevation and Cut/Fill values.

Stakeuut
< DES1 L2
HI 1.865
Eley 0.165
Cut 0.165
’ Store ] [ Meas ]

Figure 8-16. DL Stakeout

* Meas: measures the elevation and computes a cut/fill value.

* Store: opens the Code-Attributes screen to set a code for the
staked out point (see “Codes and Attributes” on page 3-12), and
then the Edit Point screen (see “Add (Edit) Point” on page 3-5).
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Staked points are not added to the Level Run, they are independent.
Staked out points are listed as observed points on the Points screen.

B crmem

Point | Code | Lat

oy 2 RL 55400639539
i 3 55.431800000
oy 4 55.200000000
3 stk 55.431800016
dyd_ste 55432000005
d ]

Find by Code | | Find by point || Find next |

| petete || Eat ||  Ada |

Figure 8-17. Points — Staked out

Point in Direction
To perform the Point and Direction stakeout, select Stake » Point in

Direction.

Point in Direction

The Point in Direction screen performs the stakeout of a point, using
known point, the azimuth, and the offsets from the azimuth line.

Pl:lirlt in Direction .

From Point |2 i[‘z‘llli I
& [azwopt | 1

Angle Offset [é_lil_lil_lil_lil_ dms
Hz Dist [foooo |m
VertDist  |-8.000 m

Store Pt B ]

Ant Ht |2.000 m  |Verti|~|
Stakeout |

Figure 8-18. Stakeout Point & Direction

* From Point: the starting point. Type the name manually or select
it from the list or from the map.
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» Azimuth/Az to Pt: the azimuth can be set by value, or as the
direction to another known point.

* Angle Offset: the angle offset from the azimuth line.
* Hz Dist: the distance offset along the angle offset line.
* Vert Dist: the height offset.

* Store Pt: check this field if it is desired to store the computed
point to the data set.

» Antenna Ht (for the GPS mode): sets the height of the antenna
reference point (ARP) above the mark. Also, specify the
measurement type: slant or vertical.

* HR (for the TS mode): the height of the rod (target).
* Stakeout: opens the Stakeout screen to perform the stakeout.

* Settings: opens the Stakeout Parameters screen. See
“Configuration” on page 2-11.

» For a GPS stakeout, the bitmap at the upper-left corner displays
the following pop-up menu:

— Status: opens the Status screen (see “Status” on page 5-2).

— Rover Antenna Setup: opens the Antenna Setup screen (see
“Config: Rover Antenna” on page 2-42).

— Config Radio: opens the Configure Radio screen (see
“Configure Radio” on page 8-5).

— Edit Points: opens the Points screen (see “Points” on
page 3-2).

— Help: accesses the Help files.

* For a Total Station stakeout, the bitmap on the upper-left corner
displays the following pop-up menu:

— BS Setup: opens the BS Setup screen (see “Backsight Survey”
on page 6-2).

— Config Link (for Robotic mode only): opens the Configure
Link screen.
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— Remote Control (for Robotic mode only): opens the Remote
Control screen (see “Remote Control” on page 6-56).

— Edit Points: opens the Points screen (see “Points” on
page 3-2).

— Help: accesses the Help files.

GPS+ Stakeout

The Stakeout screen reflects the progress of the stakeout, displaying
the current point name (in the upper-left corner of the screen), the
layout of the target and current position, the desired direction, and the
values of the distances to the target.

Stakel:lut
Point D01, 15.... ¢ auo H v
2E61 4084 740
Hz Dist ﬁ Left
23.464 m 6.681 m
Forward
24.572 m
Fill
15.456 m
Height
-530.443 m
Azimuth
4720 dms

Figure 8-19. Point in Direction — Stakeout

* Store: performs the measurement and opens the Store Point
screen.

* Close: saves the changes and closes the screen.

The bitmap at the upper-left corner displays the following pop-up
menu:

— Status: opens the Status screen (see “Status” on page 5-2).

— Rover Antenna Setup: opens the Antenna Setup screen (see
“Config: Rover Antenna” on page 2-42).

— Config Radio: opens the Configure Radio screen (see
“Configure Radio” on page 8-5).
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— mmGPS+ Options: available if mmGPS is used, opens the
mmGPS+ Options screen (see “mmGPS+ Options” on
page 5-11).

— Store Design Pt/ Layer: opens the Design Pt /Layer screen to
select options to store the points (see “Design Pt/Layer” on
page 8-8).

— Display Coords: if checked, coordinates are displayed instead
of directions.

— Help: accesses the Help files.

TS Stakeout

The Stakeout screen reflects the progress of the stakeout, displaying
the current point name (in the upper-left corner of the screen), the
layout of the target and current position, the necessary direction, and
the values of the distances to the target.

Point  100_stk1 ekt

Hz Dist Right
192.252 m 52.992 m
Towards TS
184.805 m
Fill
6.000 m
Dsan HA. Turn Right
298.0000 dms 148.0000 dms

Figure 8-20. Point in Direction — Stakeout

e EDM: selects distance measurement mode: Coarse, Fine. or
Coarse Tracking.

» [»]: toggles between the scheme and the map of the layout of the
target and current position.

* Store: opens the Store Point screen to store the current position
as a point (see “Store Point” on page 8-10).

* Cur Pos: causes a measurement to be made and displays the
result on the screen.
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* Close: saves the changes and closes the screen.

* The bitmap at the upper-left corner displays the following pop-up
menu:

— Auto Advance Pt: if checked, after storing a staked point
opens automatically the Stakeout screen for the next point.

— Store Design Pt/ Layer: opens the Design Pt /Layer screen to
select options to store points.

— Display Coords: if checked, coordinates are displayed instead
of directions.

— Help: accesses the Help files.

Point List

To stakeout points from a list, select Stake » Point List.

The stakeout of points from the list can be enabled from the Main
View (see Figure 4-2 on page 4-2). Press Alt on the controller’s
keyboard and tap the linework. Select the Stakeout Vertices item
from the pop-up menu appear to open the Stakeout Point List screen.

Stakeout Point List

The Stakeout Point List screen performs a stakeout of existing points,
creates a pointlist to stakeout, selects the starting stakeout point, and
stakeouts in direct or reverse order.

[ERd stakeout Point List

[ PointList  [DEXEES

[#] [ ist of Points | co[= ¥
Cogol co
? TS5 L
4 DO1 bc
? 154
L4 | IIIEI =sm [
Ant Ht |1.000 m |Verti|~]

[] Stakeout in Reverse Order Stakeout

Figure 8-21. Stakeout Point List
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e Point List: the preexisting points list. Can be chosen from the list
or entered manually.

e List of Points: the list of currently selected points.

* Up and down arrows moves the highlighted point up and down in
the order of the points.

: if activated, uses the up/down arrows on the keyboard to
move the highlighted point up and down.

: deletes the highlighted point from the list.

* [®]: closes the scheme of the polygon. Only the list of points will
be available.

Ant Ht (for GPS mode): sets the height of the antenna reference
point (ARP) above the mark. Also, specify the measurement type
for the height: slant or vertical.

HR (for the TS mode): the height of the rod (target).

* Stakeout in Reverse Order: check to perform stakeout starting
from the end of the Point List.

¢ Stakeout: opens the Stakeout screen.

For GPS stakeouts, the bitmap at the upper-left corner displays
the following pop-up menu:

— Status: opens the Status screen (see “Status” on page 5-2).

— Rover Antenna Setup: opens the Antenna Setup Screen (see
“Config: Rover Antenna” on page 2-42).

— Config Radio: opens the Configure Radio screen (see
“Config: Rover Radio” on page 2-34).

— Edit Point Lists: opens the Point Lists screen (see “Point
Lists” on page 3-15).

* For Total Station stakeouts, the bitmap on the upper-left corner
displays the following pop-up menu:

— BS Setup: opens the BS Setup screen (see “Backsight Survey”
on page 6-2).
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— Config Link (for Robotic mode only): opens the Configure
Link screen.

— Remote Control (for Robotic mode only): opens the Remote
Control screen (see “Remote Control” on page 6-56).

— Edit Point Lists: opens the Point Lists screen (see “Point
Lists” on page 3-15).

Stakeout (GPS and TS)

GPS and TS stakeouts are performed in the same way as described in
“Stakeout Point” on page 8-2. Here, points can be staked out in any
order by selecting the next stakeout point using an additional option
from the bitmap menu in the upper left corner:

e Select Stakeout Point: opens the Select Point screen to select a
stakeout point from the list.

Select Point

The Select Point screen displays the Point List being staked, from
which points can be randomly chosen to continue the stakeout.

The new starting point can be selected from the list, or by double-
taping a point on the map to the right of the list.

[ERdsetect Point [ ok |

Point List  PointListl

|Name |C|:||:Ie(s - '%
417 To...

I To...

To...
4 EIIZ' —=1lm E

Show Remaining Points
[] Show Staked Points
["] Reverse Order

Figure 8-22. Select Point

* Show Remaining Points: check to show all the points that have
not yet been staked out.

» Show Staked Points: check/uncheck to display the points in the
list that have already been staked out.
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* Reverse Order: check to stakeout the points from last point in the
list to first.

* OK: saves changes and closes the screen.

DL Stakeout

DL Stakeout of point lists can be accessed from the main menu or top
left menu in the Level Run screen (for details, see page 7-3).

The level Stake Point List screen selects a list of design points to
determine the elevation and compute a cut/fill value at every point of
the list.

* BS Point: selects the backsight point for the stake measurement
(entered manually or selected from the map or list).

 Point List: selects the point list point to stake (entered manually
or selected from the list). When selected, it will be displayed in
the tab and in the plot.

e Stk in Reverse Order: stakes in reverse order of the point list.

* BS: if not already measured, takes a BS measurement before
staking.

 Stakeout: opens the level Stakeout screen for every point of the
list (see Figure 8-16 on page 8-13).

[EBZstake Point List
BS Point  [L2
[&] Point List |

[#] [ List of points Cudel'\,1

El < ?||==50m |E|
[] Stk in Reverse Order

Figure 8-23. DL Stake Point List
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Elevation

DL Stakeout of elevations can be accessed from the main menu or top
left menu in the Level Run screen (for details, see page 7-3).

Stakeout Elevation

The Stakeout Elevation screen selects a backsight point and the
elevation to determine the elevation.

Stakeout Elev ..

BS Point |12
Elevation |1-39 m

l BS ” Stakeout l

Figure 8-24. Stakeout Elevation

* BS: if not already measured, takes a BS measurement before
staking.

» Stakeout: opens the level Stakeout screen for the desired
elevation. This screen is identical to that shown in Figure 8-16 on
page 8-13.
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Lines

To stakeout a line, select Stake » Lines.

Stakeout Line

The Stakeout Line screen contains the initial data for the line
stakeout.

* The bitmap on the upper-left corner displays the same pop-up
menu as for the Stakeout Points&Direction screen (see “Point in
Direction” on page 8-14).

®ilFved H WV g
100%: 0006 0010 g+ 2

Start Point |
End Point]| |
Htcomp  [Htof Start Pt [+]

Antenna Ht [2.000 m |vert|~]

Figure 8-25. Stakeout Line

* Start Point: sets the starting point of the reference line.

* End Point/Azimuth: sets the direction of the reference line
thorough another point, or azimuth.

* Ht Comp: the type of height computations for the stakeout point.
Currently, only Ht of Start Pt (height of starting point) is
available: the stakeout point will have the same height as the
starting point of the line.

» Antenna Ht (for GPS mode): sets the height of the antenna
reference point (ARP) above the mark. Also, specify the
measurement type for the height: slant or vertical.

* HR (for TS mode): the height of the rod (target).
¢ Stakeout: opens the second Stakeout Line screen.

* Settings: opens the Stakeout Parameters screen. For details, see
“Stakeout Point” on page 8-2.
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GPS+ Stakeout

The graphics on the Stakeout Line screen shows the north direction,
the reference direction, the movement direction, the target line. The
panel on the right displays the parameters of the target.

Stakel:lut Line
Point Topol-»>T... ¢ &ue H Vv gt
1366 2043 1040

.ﬁ Right of Line
2.456 m
Dist Along Line
5.893 m
_|_ Length of Line
2.828 m
Cut
34.316 m
Azimuth
337.3741 dms

Figure 8-26. Stakeout Line

* Store: saves the location. Check the parameters of the stored
point in the Add/Edit point screen.

¢ Close: closes the screen and returns to the Stakeout Line screen.

* The bitmap at the upper-left corner displays the following pop-up
menu:

— Status: opens the Status screen (see “Status” on page 5-2).

— Rover Antenna Setup: opens the Antenna Setup screen (see
“Config: Rover Antenna” on page 2-42).

— Config Radio: opens the Configure Radio screen (see
“Configure Radio” on page 8-5).

— mmGPS+ Options: available if mmGPS is used, opens the
mmGPS+ Options screen (see “mmGPS+ Options” on
page 5-11).

— Store Design Pt/ Layer: opens the Design Pt /Layer screen to
select options to store the points (see “Design Pt/Layer” on
page 8-8).

— Display Coords: if checked, coordinates are displayed instead
of directions.

— Help: accesses the Help files.
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TS Stakeout

The Stakeout screen displays the stakeout process, displaying the
current point name (in the upper-left corner of the screen), the layout
of the target and current position, the direction, and the values of the
distances to the target.

Stakeuut Line '.
Point 188
Right of Line
0.000 m
Dist Along Line
0.000 m
Away From TS
0.000 m
Dsan HA. Fill
5.0000 dms 1.000 m
Turn Right
E 0.0000 dms

Figure 8-27. Stakeout Line

 [®]: toggles between the scheme and the map of the layout of the
target and current position.

e EDM: selects distance measurement mode: Coarse, Fine, or
Coarse Tracking.

* Store: takes a measurement and opens the Store Point screen to
store the current position as a point (see “Store Point” on
page 8-10).

* Cur Pos: causes a measurement to be made and displays the
result on the screen.

¢ Close: returns to the line screen.

* The bitmap at the upper-left corner displays the following pop-up
menu:

— Rod Height: opens the Enter Rod Height screen to change the
rod height during stakeout.

— Remote Control (Robotic mode only): opens the Remote
Control screen (see “Remote Control” on page 6-56).

— Config Link (Robotic mode only): opens the Configure Link
screen.
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— Store Design Pt/ Layer: opens the Design Pt /Layer screen to
select options to store the points.

— Display Coords: if checked, coordinates are displayed instead
of directions (see Figure 8-7 on page 8-7).

— Help: accesses the Help files.

Offsets

The Offsets submenu contains four items:
* Line & Offsets
* Intersection & Offsets
* 3 Pt Curve & Offsets
* Curve & Offsets
* Spiral & Offsets

Line & Offset

To stakeout Line & Offset, select Stake » Offsets » Line & Offsets.

Stakeout Line & Offset

The Stakeout Line & Offset screen performs a stakeout of a line with
offsets in the Horizontal and Vertical directions.

f=bd Stakeout Line & Offset
Start Point  [Topo? [E=F
& [End Point | [Topo1 E2ED
Ht Comp m
StartSta  [0+0.000  |m
[] Hum Subs IIII—

:D/

Figure 8-28. Stakeout Line & Offset
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* Start Point: the starting point of the line. The line is defined, by its
azimuth, azimuth to another point, or the End point of the line.

* End Point/Azimuth: the direction of the line set through either
the azimuth of the line or the ending point of the line.

* Ht Comp: the type of height computations for the stakeout point.
Currently, only Ht of Start Pt (height of starting point) is
available: the stakeout point will have the same height as the
starting point of the line.

* Num Subs: designates the number of subdivisions if it is desired
to subdivide the line. For instance a value of 3, indicates that the
user wants to stakeout four points by subdividing the line in three
equal segments.

Start Stn: The starting station (chainage) of the line.
* Next: opens the Station & Offsets screen.

* Settings: opens the Stakeout Parameters screen. See
“Configuration” on page 2-11.

For GPS stakeouts, the bitmap at the upper-left corner displays
the following pop-up menu:

— Status: opens the Status screen (see “Status” on page 5-2).

— Rover Antenna Setup: opens the Antenna Setup screen (see
“Config: Rover Antenna” on page 2-42).

— Config Radio: opens the Configure Radio screen (see
“Config: Rover Radio” on page 2-34).

— Edit Points: opens the Points screen (see “Points” on
page 3-2).

— Help: accesses the Help files.

» For Total Station stakeouts, the bitmap on the upper-left corner
displays the following pop-up menu:

— BS Setup: opens the BS Setup screen (see “Backsight
Survey” on page 6-2).

— Config Link (for Robotic mode only): opens the Configure
Link screen.
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— Remote Control (for Robotic mode only): opens the Remote
Control screen (see “Remote Control” on page 6-56).

— Edit Points: opens the Points screen (see “Points” on
page 3-2).

— Help: accesses the Help files.

Station & Offsets

The Station & Offsets screen contains the settings for the stakeout
stations with offsets from the line.

[ERdstation & offsets [ settings | close |

Station [o+10.000 ==
Sta Interval IlU-UUU m
& [ight Offset [2.000 m
i Up jo.5po m

HR |1 000 m

Figure 8-29. Stakeout

Station: The station along the line being staked. The two arrows
to the right decrease or increase the station by the interval
specified in the Stn Interval shown in the next line.

: decreases / increases the distance by the station
staking interval.

: uses the right/left arrow keys of the keyboard to increase
or decrease the station.
Stn Interval: the station staking interval.

Right Offset/Left Offset: the right or left offset of the stakeout
point with respect to the line at the station shown on the Station
field.

Up/Down: the Up or Down Height offset with respect to the
height of the line at the station.
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» Antenna Ht (for GPS mode): sets the height of the antenna
reference point (ARP) above the mark. Also the measurement
type for the height needs to be specified: slant or vertical.

* HR (for TS mode): the height of the rod (target).
* Back: returns to the previous screen.

 Stakeout: opens the Initial Point Name screen.

Initial Point Name

The Initial Point Name screen specifies the starting name for the
points calculated for the stakeout task.

B al Po ame 0K J Cancel
Calculated Points

First Point [{Ta81
E¥ code I :I

Figure 8-30. Calc Point Names
* First Point: the name of the first point.

* Code: the code of the points; selected from the list or entered
manually.

?ﬁ : accesses the attributes of the chosen code, opens the
Code-Attributes screen (see “Code-Attributes” on page 3-10).

* The bitmap next to the Attributes List bitmap displays the
following list:

— String: toggles on the String field. Also, the sign appears.
For details, see “Topo” on page 5-24.

— Layer: opens the Select Layer screen to put the point. For
details, see “Topo” on page 5-24.
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— Note: opens the Notes screen. For details, see “Topo” on
page 5-24.

¢ OK: saves the changes and opens the Stakeout screen.

GPS+ Stakeout

The graphics on the Stakeout screen show the north direction, and the
relative position of the antenna and target. The panel on the right
displays the parameters of the target.

Stakeout

Sta 0+0.000,... ¢ auo H v
34 48T g0

East

1.441 m
South

0.7955 m
Cut

35.505 m
Height

0.417 m
Azimuth

117.4032 dms

Store |

Figure 8-31. Stakeout

Hz Dist
1.625 m

» NextSta: advances the station by the specified Station Interval for
staking out points at the Next station.

* Store: saves the location. Check the parameters of the stored
point in the Add/Edit point screen.

¢ Close: closes the screen and returns to the Stakeout Line screen.

* The bitmap at the upper-left corner displays the following pop-up
menu:

— Status: opens the Status screen (see “Status” on page 5-2).

— Rover Antenna Setup: opens the Antenna Setup screen (see
“Config: Rover Antenna” on page 2-42).

— Config Radio: opens the Configure Radio screen (see
“Configure Radio” on page 8-5).

— mmGPS+ Options: available if mmGPS is used, opens the
mmGPS+ Options screen (see “mmGPS+ Options” on
page 5-11).
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— Auto Advance Sta: if checked, after storing a staked point,
automatically opens the Stakeout screen for the next point.

— Design Offsets: opens the Design Ell ht screen, which allows
changing the design point elevation height, road and DTM
offsets (identical to “Design Elevation” on page 8-31).

— Store Design Pt/ Layer: opens the Design Pt /Layer screen to
select options to store the points (see “Design Pt/Layer” on
page 8-8).

— Display Coords: if checked, coordinates are displayed instead
of directions.

— Help: accesses the Help files.

Design Elevation

The Design Elev screen contains an option to change the elevation of
the design point.

Design Elev

Design Elev
0765

Road Offset
I m

DTM Offset

o

Figure 8-32. Design Elevation

* Design Elev: check this box to enable the entry field for editing
the elevation value manually.

* Road Offset: check this box to enable the entry field for editing
the road offset value manually.

* DTM Offset: check this box to enable the entry field for editing
the DTM offset value manually.
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TS Stakeout

The Stakeout screen reflects the progress of the stakeout, displaying
the current station (in the upper-left corner of the screen), the layout
of the target and current position, the necessary direction, and the
values of the distances to the target.

A Stakeout "
0+00.000... elr:
Hz Dist Left
1.000 m 0.086 m
Away From TS
0.996 m
@® Fil
+ 1.000 m
Turn Right
Dsan HA.
5.0000 dms ]| 4.5500 dms
E=]=3| .

Figure 8-33. Stakeout

e EDM: selects distance measurement mode: Coarse, Fine, or
Coarse Tracking.

¢ Stop: instructs the Robotic Total Station to stop tracking and go
into “Stand By mode.

* Search: instructs the Robotic Total Station to start searching for
the prism.

. : advances the station by the specified Station Interval
for staking out points at the Next station.

* Store: takes a measurement and opens the Store Point screen to
store the current position as a point (see “Store Point” on
page 8-10).

* Cur Pos: causes a measurement to be made and displays the
result on the screen.

* Close: saves the changes and closes the screen.

floating information screen to display the station
number and the offset value of the current point.
(Figure 8-34 on page 8-33).

Tapping in the current station string enables the
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Stakeuut '.
0+00.000... [ EDM @8
— Point 100_stk1
Hz DIl hote 100 skt b
Station 0+00.000 m  ay From TS
Offset 0.000 m Right P96 m
- FIr
+ 1.000 m
Turn Right
Dsan HA.
5.0000 dms [Z]| 4.5500 dms
==

Figure 8-34. General Stakeout information

Offsets

* The bitmap at the upper-left corner displays the following pop-up

menu:

— Rod Height: opens the Enter Rod Height screen to change the

rod height during stakeout.

— Remote Control (for Robotic mode only): opens the Remote

Control screen (see “Remote Control” on page 6-56).

— Config Link (for Robotic mode only): opens the Configure

Link screen.

— Auto Advance Pt: if checked, after storing a staked point
opens automatically the Stakeout screen for the next point.

— Design Offsets: opens the Design Ell ht screen, which allows
changing the design point elevation height, road and DTM

offsets (identical to “Design Elevation” on page 8-31).

— Store Design Pt/ Layer: opens the Design Pt /Layer screen to
select options to store the points.

— Display Coords: if checked, coordinates are displayed instead
of directions (Figure 8-7 on page 8-7).

— Help: accesses the Help files.
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Intersection & Offsets

To stakeout Intersection & Offsets, select Stake » Offsets »
Intersection & Offsets.

Intersection & Offsets

The Intersection & Offsets screen stakeouts out the intersection point
of two lines parallel to two other lines at specified offsets. The first
screen defines one line (Line 1) and the offset of the first parallel line.
The second screen field defines another line (Line 2) and the offset of
the second parallel line. The intersection point of these two parallel
lines defines the stakeout point.

The first screen contains parameters for the first line.

iER 4 Intersection & Offsets

Line 1
From Point [T51 | |
& [aztopt__|[60 =20 |

= |Right Offsetl |5.000 m

Figure 8-35. Intersection & Offsets — Line 1

* From Point: starting point of the Line 1.

* Az to Pt/Azimuth: the direction of the line set through the
azimuth of the line, azimuth from the start point to the point
selected.

* Right Offset/Left Offset: the right or left offset of the stakeout
point with respect to the line.

¢ Next: opens the second Intersection&Offsets screen.

 Settings: opens the Stakeout Parameters screen (see
“Configuration” on page 2-11).

* The bitmap on the upper-left corner displays the same pop-up
menu as the Points in Direction screen (see “Point in Direction”
on page 8-14).
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The second screen contains the parameters of the second line.

Intersel:til:ln & Offsets

Line 2

From Point [DO2 E2IED

& |Azimuth __|[280.0000 dms

& |Right Offset|[2l000 m
Intersect Ht IW m

Store Point (100
Ant Ht |2.000 m  |Verti| |

Figure 8-36. Intersection & Offsets — Line 2

» From Point: starting point of the Line 2.

* Az to Pt/Azimuth: the direction of the line; set through the
azimuth of the line, azimuth from the start point to the point
selected.

» Right Offset/Left Offset: the right or left offset of the stakeout
point with respect to the corresponding line.

* Intersect Ht: the height of the intersection point.

* Store Point: the name of the intersection point.
Ant Ht (for GPS mode): the height of the antenna.
HR (for TS mode): the height of the rod (target).

* Stakeout: opens the Stakeout screen.

* Settings: opens the Stakeout Parameters screen. See
“Configuration” on page 2-11.
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GPS+ Stakeout

The Stakeout screen reflects the progress of the stakeout, displaying
the current point name (in the upper-left corner of the screen), the
layout of the target and current position, the desired direction, and the
values of the distances to the target.

Stakel:lut
Point 1 ¢ Ao H Vo ggh
TaAd3 4218 8+0
Hz Dist N/t
79.248 m 63.737 m
North
44.231 ' m
Cut
35.406 m
Height
0.318 m
Azimuth
56.0425 dms

Figure 8-37. Stakeout

* Store: saves the location. Check the parameters of the stored
point in the Add/Edit point screen.
* Close: closes the screen and returns to the Stakeout Line screen.
* The bitmap at the upper-left corner displays the following pop-up
menu:
— Status: opens the Status screen (see “Status” on page 5-2).

— Rover Antenna Setup: opens the Antenna Setup screen (see
“Config: Rover Antenna” on page 2-42).

— Config Radio: opens the Configure Radio screen (see
“Configure Radio” on page 8-5).

— mmGPS+ Options: available if mmGPS is used, opens the
mmGPS+ Options screen (see “mmGPS+ Options” on
page 5-11).

— Store Design Pt/ Layer: opens the Design Pt /Layer screen to
select options to store the points (see “Design Pt/Layer” on
page 8-8).

— Display Coords: if checked, coordinates are displayed instead
of directions.
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Offsets

The Stakeout screen reflects the progress of the stakeout, displaying

the current station (in the upper-left corner of the screen), the

necessary direction, and the values of the distances to the target.

Stakeuut "
Point  100_stkl 108%
Hz Dist Right
0.127 m 0.126 m
Towards TS
. 0.012 m
B Fill
1.000 m
Dsan HA. Turn Right
296.4117 dms 0.0117 dms

Figure 8-38. Stakeout

« EDM: selects distance measurement mode: Coarse, Fine, or

Coarse Tracking.

 Store: opens the Store Point screen to store the current position
as a point (see “Store Point” on page 8-10).

e Cur Pos: causes a measurement to be made and displays the

result on the screen.

* Close: saves the changes and closes the screen.

* The bitmap at the upper-left corner displays the following pop-up

menu:

— Rod Height: opens the Enter Rod Height screen to change the
rod height during stakeout.

— Remote Control (Robotic mode only): opens the Remote

Control screen (see “Remote Control” on page 6-56).

— Config Link (Robotic mode only): opens the Configure Link

screen.

— Store Design Pt/ Layer: opens the Design Pt /Layer screen to
select options to store the points.

— Display Coords: if checked, coordinates are displayed instead
of directions (Figure 8-7 on page 8-7).
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Three Point Curve & Offset
To stakeout Three Point Curve & Offset, select Stake » Offsets » 3Pt

Curve & Offsets.

3 Pt Curve

The 3 Pt Curve screen creates a curve by selecting three points: PC
point, any curve point and PT point; or the RP, PC and PT points.

iEA4d 3 Pt Curve |
~ T o =
[@] curve Pt 0002 (5] & [RP Point | [DRAN
PT Point IIZIIZIIZIB (] PC Point ICT
PT Point  [DRBN1
S5 IU+UU-UUU m Curve SET.
Next »> ss [0+00.000 m
—

Figure 8-39. Three Point Curve

The screen changes its appearance depending on the first point
chosen. Manually enter, or select from the list or map, the following

sets of points:

* PC Point, Curve Point, PT Point — the starting PC (Point of
Curvature) and ending PT (Point of Tangency) points on the
circle, and a third point on the curve.

* RP Point, PC Point, PT Point — the starting PC (Point of
Curvature) and ending PT (Point of Tangency) points on the
circle, and the center point (also called as Radius Point).

For this set of points, the distance between the RP and PC should
be equal to the distance between the RP and PT. The radius, and
the PC and PT points, define two curves: one with delta less than
or equal to180° (small curve), the other with delta greater than or
equal to 180° (large curve). Values of Small or Large can be
selected from the Curve drop-down box to indicate which of
these two curves should be used for staking.
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* S§: The starting station (chainage) of the line.

* Next: opens the Station and Offsets screen (see “Station &
Offsets” on page 8-28).

Settings: opens the Stakeout Parameters screen (see
“Configuration” on page 2-11).

The bitmap on the upper-left corner displays the same pop-up
menu as for the Line & Offsets screen (see “Line & Offset” on
page 8-26).

Stakeout (GPS and TS)

GPS and TS stakeouts are performed in the same way described in
“Line & Offset” on page 8-26.

Curve & Offsets

To stakeout Curve & Offsets, select Stake » Offsets » Curve &
Offsets.

Curve & Offsets

The Curve & Offsets screen function performs a stakeout of a curve
(section of an arc) at a specified horizontal and vertical offset from
the curve.

§EA 4 Stakeout Curve & Offset
PC Point  [DD3 E2IED
Tangent Azi IW dms

# [Radius | [o.000 m

# [Length | [25.000] m

Turn IR ight : I
Mv ss [0+0.000 |m
—

Figure 8-40. Stakeout Curve & Offset

* PC Point: the Point of Curve, the starting point of the arc.

* Tangent Azi: the azimuth of the Tangent of the curve (arc) at the
PC point.
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¢ Radius/ Deg Curve/ Deg Chord: the radius parameters of the
curve.

* Length/Chord/Tangent/Mid Ord/Extern/Delta: the length
parameter of the curve. For the description of the curve (arc)
parameters, see “Curve Solution” on page 9-17.

* S§: The starting station (chainage) of the line.

¢ Next: opens the Station and Offsets screen (see “Station &
Offsets” on page 8-28).

* Settings: opens the Stakeout Parameters screen (see
“Configuration” on page 2-11).

* The bitmap on the upper-left corner displays the same pop-up
menu as for the Line & Offsets screen (see “Line & Offset” on
page 8-26).

Stakeout (GPS and TS)

GPS and TS stakeouts are performed in the same way described in
“Line & Offset” on page 8-26.
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Spiral & Offset

To stakeout Spiral & Offset, select Stake » Offsets » Spiral &
Offset.

Stakeout Spiral & Offset

The Stakeout Spiral & Offset screen is used to stakeout points at
specified Horizontal and Vertical offsets with respect to a specified
spiral.

TS Point  [DD4 E2IED
Tangent Azi IW dms

# [Radius | [2.000 m

# [Length | [o.000 m

Turn IRight :I
Dir ITS To 5C :I

ﬂ ss [0+0.000 |m
o

Figure 8-41. Stakeout Spiral & Offset

TS Point: Tangent to Spiral point. This is the starting point of the
spiral.

Tangent Azi: the azimuth of the tangent to the spiral at the point
TS.

* Radius/Deg Chord/Deg Curve: the radius parameter of the
spiral at the ending point.

* Length/Sp Const: the length of the spiral at the ending point, or
the Spiral Constant, the constant of the spiral.

. . . 2 .
For any spiral point R x Length = (SpiralConst)”, where R is the

Radius, and Length is the length of the spiral, both at the same
specified point.

 Turn: specifies whether the spiral turns right or left:

* Dir: the direction of “moving”:
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TS -> SC = Tangent Spiral->Spiral Circle. This is the
incoming spiral to the internal circle.

CS -> ST = Circle Spiral->Spiral Tangent. The outgoing
spiral from the circle to the Tangent.

* SS: the starting station (chainage) of the line.

¢ Next: opens the Station & Offsets screen (see “Station &
Offsets” on page 8-28).

» Settings: opens the Stakeout Parameters screen (see
“Configuration” on page 2-11).

* The bitmap on the upper-left corner displays the same pop-up
menu as for the Line & Offsets screen (see “Line & Offset” on
page 8-20).

Stakeout (GPS and TS)

GPS and TS stakeouts are performed in the same way described in
“Line & Offset” on page 8-26.

Roads

The Roads submenu contains three items:
* Road
* Slope
* Real Time Road

The same menu can display in the Main View to enable the stakeout
from the graphics interface (see Figure 4-2 on page 4-2 in Chapter 4).
To open the menu, press Alt on the controller’s keyboard and tap the
road to be staked.

Stakeout Road

To start the Road stakeout, select Stake » Roads » Road.

The Stakeout Road screen selects the road for stakeout and displays
the plan of the chosen road (Figure 8-42 on page 8-43).
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The bitmap in the upper-left corner displays the same pop-up menu as

the Line & Offsets screen (see “Line & Offset” on page 8-26).

Road: the road to be staked-out. Can be entered manually or
chosen from the list.

* Antenna (for GPS+): the antenna height.

HR (for TS): the rod (target) height.

Include transition point: set a check mark if the transition point
should be included in spite of the station distance.

Road [r1
ss [o+00.000 m

AN | o——

=100 m ==100m

HR Il].l]l]l] m

Include Transition Point

Figure 8-42. Stakeout Road

* Next: opens the second Stakeout Road screen.

P/N 7010-0492

Start Stn: the starting point of the stakeout, the distance from the
beginning of the road.

Settings: opens the Stakeout Parameters screen (see “Config:
Stakeout Parameters” on page 2-48).

Stakeout Road . Settings
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The second Stakeout Road screen is used to set the offsets from CL
for the stakeout points and to select staking of Curb/Ditch with the

desired offsets.

Stakeuut Road
CL Offsets
Right | [ioooo K, ooo
teft  j fioooo A4 ooo
[7] Stake Curbfpitch [Hzfvert v | T}
Hoffset [BN v Offset [1.500

e | e CURE

Figure 8-43. Stakeout Road

¢ Next: opens the third Stakeout Road screen.

The third Stakeout Road screen displays the properties of the cross
section on the stakeout station and performs the stakeout of all the

desired points.

Stakeout Road

Station 0+00.000
Sta Interval |10.000 m
Segment Pt ICL Fg =l

& Right Offset] [0.300 m
& [ Up Offset | [0.500 m
——EC Qe

|Centerline - <<« Back | | Stakeout

Figure 8-44. Stakeout Road

* Station: the station where the stakeout is performed. The arrow
buttons change the station number by the value of Station

Interval.

. : decreases / increases the distance by the station
staking interval.
e Stn Interval: the interval of the station increment.
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* Segment Pt: the point code of the current segment. The arrow
buttons in this field move the current segment point along the
cross section. This will reflect on the scheme in the bottom of this
screen.

* Right/Left Offset: the horizontal offset from the current segment
point.

* Up/Down Offset: the vertical offset from the current segment
point.

* Centerline/Segment/Surface: sets the type of template offsets:

— Centerline: the horizontal offset starts at the centerline; the
vertical offset also starts at the centerline.

— Segment: the horizontal offset starts at the beginning of the
segment; the vertical offset starts at the centerline.

— Surface: the horizontal offset starts at the beginning of the
segment; the vertical offset starts at the point on the surface of
the segment that corresponds with the horizontal offset.

. : switches on/off the keyboard arrow keys. The upper

button stands for the station increment/decrement, the lower
button for the current segment point location. Only one button
can be enabled at a time.

e Back: returns to the first Stakeout Road screen.
» Stakeout: opens the Initial Point Name screen.

* Settings: opens the Stakeout Parameters screen (see “Config:
Stakeout Parameters” on page 2-48).
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Initial Point Name

The Initial Point Name screen specifies the starting name for the
points calculated for the stakeout task.

[EEZnitial Point Name [ ok |

Initial Design Point
First Point [2]|
£ code I :I

Figure 8-45. Initial Point Name

* OK: opens the Stakeout screen.

GPS+ Stakeout

The graphics on the Stakeout screen show the relative position of the
antenna and target. The panel on the right displays the parameters of
the target.

Stakeout

64+00.00... il Fived H v g
100% 0009 0020 742

Hz Dist Left
713.426 m 57.806 m
Forward
711.080 m
Fill
14.067 m
Ellipsoidal bt
167.311' m
Azirnuth
355.2109 dms

==

Figure 8-46. Stakeout

« E= and B3 : advances the station by the specified Station
Interval for staking out points at the Next station.

* Store: saves the location. Check the parameters of the stored
point in the Add/Edit Point screen.
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¢ Close: closes the screen and returns to the Stakeout Roads
screen.

» For GPS stakeouts, the bitmap at the upper-left corner displays
the following pop-up menu:

— Status: opens the Status screen (see “Status’” on page 5-2).

— Rover Antenna Setup: opens the Antenna Setup Screen (see
“Config: Rover Antenna” on page 2-42).

— Config Radio: opens the Configure Radio screen (see
“Config: Rover Radio” on page 2-34).

— Auto Advance Sta: if checked, after storing a staked point,
automatically opens the Stakeout screen for the next point.

— Design Offsets: opens the Design Ell ht screen, to change the
design point elevation height, road and DTM offsets
(identical to “Design Elevation” on page 8-31).

— Store Design Pt/ Layer: opens the Design Pt /Layer screen to
select options to store the points (see “Design Pt/Layer” on
page 8-8).

— Display Coords: if checked, coordinates are displayed instead
of directions (Figure 8-7 on page 8-7).

— Help: accesses the Help files.

TS Stakeout

The Stakeout screen reflects the progress of the stakeout, displaying
the current station (in the upper-left corner of the screen), the layout
of the target and current position, the necessary direction, and the
values of the distances to the target (Figure 8-47 on page 8-48).

Tapping in the current station string enables the floating information
screen to display the station number and the offset value of the current
point.

e EDM: selects distance measurement mode: Coarse, Fine, or
Coarse Tracking.

« E= and B3 : advances the station by the specified Station
Interval for staking out points at the Next station.
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* Store: takes a measurement and opens the Store Point screen (see
“Store Point” on page 8-10) to store the current position as a
point.

* Cur Pos: causes a measurement to be made and displays the
result on the screen.

* Close: saves the changes and closes the screen.

Stakeuut "
0+420.000... et
Hz Dist Right
20.491 m 19.602 m
Towards TS
5.970 m
Fill
0.019 m
Dsan HA. Turn Right
146.2652 dms 101.2652 dms
==

Figure 8-47. Stakeout Road — Stakeout

* The bitmap at the upper-left corner displays the following pop-up
menu:

— Rod Height: opens the Enter Rod Height screen to change the
rod height during stakeout.

— Remote Control (Robotic mode only): opens the Remote
Control screen (see “Remote Control” on page 6-56).

— Config Link (Robotic mode only): opens the Configure Link
screen.

— Auto Advance Sta: if checked, after storing a staked point,
automatically opens the Stakeout screen for the next point.

— Design Offsets: opens the Design Ell ht screen to change the
design point elevation height, road and DTM offsets
(identical to “Design Elevation” on page 8-31).

— Store Design Pt/ Layer: opens the Design Pt /Layer screen to
select options to store the points.

— Display Coords: if checked, coordinates are displayed instead
of directions (Figure 8-7 on page 8-7).
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Stakeout Slope

To start the slope stakeout, select Stake » Roads » Slope.

The Stakeout Slope screen selects a road, which slope should be
staked-out (Figure 8-48 on page 8-49).

The bitmap on the upper-left corner displays the same pop-up menu
as for the Line & Offsets screen (see “Line & Offset” on page 8-26).

* Road: the road to be staked-out. Can me entered manually, or
chosen from the list.

* Start Stn: the starting point of the stakeout, the distance from the
beginning of the road.

* Antenna (for GPS+): the antenna height.
HR (for TS): the rod height.

* Include transition point: set the check mark if the transition point
should be included in spite of the station distance.

* Settings: opens the Stakeout Parameters screen (see
“Configuration” on page 2-11).

* Next: opens another Stakeout Slope screen.

Stakeout Slope . Settings

Road |m|
ss [o+00.000 m

S —

=100 m ==100m

HR Il].l]l]l] m

Include Transition Point

Figure 8-48. Stakeout Slope

This screen displays the properties of the cross section at the stakeout
station and helps to perform the stakeout of the catch point (the point
where the slope crosses the surface of the terrain) and/or the offset of
the catch point.
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Stakeuut Slope

Station oo B

Stalnterval 10000 m
Hinge Point Ipd— E il

Offset from P 5.000 m
R Slope cut [10.000 Fil |2.332
P

(=]
Sl L et —

Figure 8-49. Stakeout Alignment

* Station: the station where the stakeout is performed. The arrow
buttons change the station number on the value of Station
Interval.

 Stn Interval: the interval of the station increment.
* Hinge Point: the hinge point code. The hinge point is a point of
rotation of the Cut/Fill Slopes. The arrow buttons in this field

move the hinge point along the cross section. This will reflect on
the scheme in the bottom of this screen.

* Offset from CP: the offset from the catch point.

* Right/Left Slope Cut/Fill: the values of the Cut and Fill Slope
parameters, applied to the hinge point.

. : switches on/off the keyboard arrow keys. The upper

button stands for the station increment/decrement, the lower
button stands for the current hinge point location. Only one
button can be enabled at a time.

¢ Back: returns to the Slope Stakeout screen.
* Stakeout: opens the Stakeout screen.

* Settings: opens the Stakeout Parameters screen (see
“Configuration” on page 2-11).
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The graphics on the Stakeout Catch Point screen shows the direction
to target. The panel on the right displays the parameters of the target.

[EB4 stakeout catch Point

Sta 0+1.000,... ¢ Auto

Station 0+1.000 m

Hs Dae) Offset 0.000 m Rigrt
FOI'w
FCp

Away

Along
Elev
FHP

H

v
347 4952 g+ 0
84.4949 dms
0.833 m
0.000 m
1.711 m
0.833 m
0.000 m

Figure 8-50. Stakeout Catch Point

Roads

» NextSta: advances the station by the specified Station Interval for
staking out points at the Next station.

* Store: saves the location. Check the parameters of the stored
point in the Add/Edit Point screen.

¢ Close: closes the screen and returns to the Stakeout Roads

screen.

» For GPS stakeouts, the bitmap at the upper-left corner displays
the following pop-up menu:

— Status: opens the Status screen (see “Status” on page 5-2).

— Rover Antenna Setup: opens the Antenna Setup Screen (see
“Config: Rover Antenna” on page 2-42).

— Config Radio: opens the Configure Radio screen (see

“Config: Rover Radio” on page 2-34).

— Auto Advance Sta: if checked, after storing a staked point,
automatically opens the Stakeout screen for the next point.

— Design Offsets: opens the Design EIl ht screen to change the

design point elevation height, road and DTM offsets
(identical to “Design Elevation” on page 8-31).
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— Store Design Pt/ Layer: opens the Design Pt /Layer screen to
select options to store the points (see “Design Pt/Layer” on
page 8-8).

— Display Coords: if checked, coordinates are displayed instead
of directions (Figure 8-7 on page 8-7).

— Help: accesses the Help files.

TS Stakeout

The Stakeout screen reflects the progress of the stakeout, displaying
the current station (in the upper-left corner of the screen), the layout
of the target and current position, and the parameters of the stakeout.

Stakeuut Catch Point ..

0+00.000... 188

Turn
To TS5
p 1 P CfF Cp
\/_Wv_ Away CL
Along CL -0.707 m
—10m Elexy 150.101 m

n F HP 5.899 m
E=j=s)

Figure 8-51. Stakeout Slope — Stakeout Catch Point

Tapping in the current station field enables the floating information
screen to display the station number and the offset value and side
(right or left) of the current point.

* Turn: the horizontal angle on which to turn the total station.
* To TS: the direction of movement.

* C/F CP: Cut/Fill with respect to the Catch Point.

* Away CL: distance away from the center line.

» Along CL: distance along the center line.

* F HP: Fill with respect to the Hinge Point.

e EDM: selects distance measurement mode: Coarse, Fine or
Coarse Tracking.
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« E= and B3 : advances the station by the specified Station
Interval for staking out points at the Next station.

* Store: takes a measurement and opens the Store Point screen (see
“Store Point” on page 8-10) to store the current position as a
point.

* Cur Pos: causes a measurement to be made and displays the
result on the screen.

* Close: saves the changes and closes the screen.

* The bitmap at the upper-left corner displays the following pop-up
menu:

— Rod Height: opens the Enter Rod Height screen to change the
rod height during stakeout.

— Remote Control (Robotic mode only): opens the Remote
Control screen (see “Remote Control” on page 6-56).

— Config Link (Robotic mode only): opens the Configure Link
screen.

— Auto Advance Sta: if checked, after storing a staked point,
automatically opens the Stakeout screen for the next point.

— Design Offsets: opens the Design Ell ht screen to change the
design point elevation height, road and DTM offsets
(identical to “Design Elevation” on page 8-31).

— Store Design Pt/ Layer: opens the Design Pt /Layer screen to
select options to store the points.

— Display Coords: if checked, coordinates are displayed instead
of directions (Figure 8-7 on page 8-7).

— Help: accesses the Help files.
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Stakeout Real Time Road

To start the road stakeout in real time, select Stake » Roads » Real
Time Road.

The Stakeout Road screen selects a road for stakeout and displays the
plan of the chosen road.

The bitmap on the upper-left corner displays the same pop-up menu
as for the Line & Offsets screen (see “Line & Offset” on page 8-26).

- o [ o |
Road [a
Start Sta [o+00.000 m

AN

=100 =100
Ant Ht |o.000 mo [vertic[~]

Include Transition Paint

Figure 8-52. Stakeout Road

* Road: the road to be staked-out. Can be entered manually or
chosen from the list.

* Start Stn: the starting point of the stakeout, the distance from the
beginning of the road.

» Antenna (for GPS+): the antenna height.
* HR (for TS): the rod (target) height.

* Include transition point: set a check mark if the transition point
should be included in spite of the station distance.

* Settings: opens the Stakeout Parameters screen (see “Config:
Stakeout Parameters” on page 2-48).
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* Next: opens the second Stakeout Road screen to set the offsets
from CL for the stakeout points and to select staking of Curb/

Ditch with the desired offsets

Stake CurbfDitch

H Offset |E!imi]

Stakeout Road
CLoffsets @ Up | |

Right |- [10.000 I, [e.000

Left i [10.000 | [2.000

IHz,‘Vert w —E
Vv Offset |—1.5EIIJ

[

(] ey CURE,

Figure 8-53.

Stakeout Road

* Next: opens the third Stakeout Road screen to set Cut/Fill Slope

parameters.

v akeo Road

Settings | Close

Cut Slope IlD.DDD
Fill Slope

Figure 8-54. Stakeout Road — Cut/Fill

* Stakeout: opens the Initial Point Name screen.
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Initial Point Name

The Initial Point Name screen specifies the starting name for the
points calculated for the stakeout task.

First Paint [3]|
@ Code I :I

[EEZnitial Point Name

Initial Design Point

Figure 8-55. Initial Point Name

* OK: opens the Stakeout screen.

The Stakeout screen reports the cut/fill values computed tor the
current observed point. The design elevation of the road is
automatically calculated for the observed point using the

alignment and the templates.

GPS+ Stakeout

The graphics on the Stakeout screen show the relative position of CL
and antenna. The panel on the right displays the parameters of the
antenna: Northing, Easting, and Elevation until the antenna is on the
road, and a Station, an Offset, and Cut/Fill values once on the road

b 20
Point 4_stkl
—
—=500

I--ull Fixed
1003

Sta
Offset
Ell ht
Fill

Close

H v g
0015 0022 740

8+20.335 m
43275.652 L1
164.635 m
2735.891m

Figure 8-56. Stakeout
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* Store: saves the location. Check the parameters of the stored
point in the Add/Edit Point screen.

» For GPS stakeouts, the bitmap at the upper-left corner displays
the following pop-up menu:

— Status: opens the Status screen (see “Status” on page 5-2).

— Rover Antenna Setup: opens the Antenna Setup Screen (see
“Config: Rover Antenna” on page 2-42).

— Config Radio: opens the Configure Radio screen (see
“Config: Rover Radio” on page 2-34).

— Store Design Pt/ Layer: opens the Design Pt /Layer screen to
select options to store the points (see “Design Pt/Layer” on
page 8-8).

— Display Coords: if checked, coordinates are displayed instead
of directions (Figure 8-7 on page 8-7).

— Help: accesses the Help files.

TS Stakeout

The Stakeout screen reflects the relative position of CL and target.
The panel on the right displays the current point name (in the upper-
left corner of the screen) and the parameters of the target.

b 4 Stakeout
1088
Sta 0+26.418 m

Offset 32.419R m

/ Elev 9.568 m
Fill 87.096 m

+

=100

[

(s

Figure 8-57. Stakeout Real Time Road

* Cur Pos: measures the target.

* Store: stores the current position as a point.
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The bitmap at the upper-left corner displays the following pop-up
menu:

— Rod Height: opens the Enter Rod Height screen to change the
rod height during stakeout.

— Remote Control (Robotic mode only): opens the Remote
Control screen (see “Remote Control” on page 6-56).

— Config Link (Robotic mode only): opens the Configure Link
screen.

— Store Design Pt/ Layer: opens the Design Pt /Layer screen to
select options to store the points.

— Display Coords: if checked, coordinates are displayed instead
of directions (Figure 8-7 on page 8-7).

— Help: accesses the Help files.

DTM

To start the DTM (Digital Terrain Model) stakeout, select
Stake » DTM.

AntHt |1.000 m|vertic[~]
[ Use alignment

[Ccreate T [cutFil E|| Stakeout I
Figure 8-58. DTM Stakeout
e DTM name: the name of the TN3 file, which is stored at the disk.

» Ant Ht and m: for GPS+ stakeout, the antenna height and method
of height measurement.

HR: for TS stakeout, the height of reflector.

» Use Alignment: if checked, stations and offsets will be reported.
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e Create TIN: if checked, a TIN (TN3 file) cut/sheet model can be

generated.

¢ Stakeout: opens the Initial Point Name screen (see Figure 8-30
on page 8-29) and then the Stakeout screen by pressing OK.

<

If a stakeout point is located on the outside of the
DTM for the job, TopSURV will neither calculate

nor write the coordinates of this point.

Open DTM

The Open DTM screen opens the selected surface file.

Current File:

List

Created:
12{13{2005
23:57

Modified:
12{13{2005
23:57

\CF Card\TPS\TopSURVIDTM

[rowse ][ oven |

Figure 8-59. Open DTM

* Current File: displays currently open file.

controller.

¢ Browse: searches for the file on the disk.

* Open: opens the selected file in the DTM Stakeout screen.
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GPS+ Stakeout

The graphics on the Stakeout screen show the relative position of
antenna. The panel on the right displays the parameters of the
antenna.

b 4 Stakeout

Point 4 stkl s.. I--'I Fixed H v g
100% 0017 0021 g0

East
415253.485
MNorth
16175989.57¢
Ellipsoidal bt
164.643 m
CjF

Figure 8-60. Stakeout -DTM
e Store: saves the location.

» For GPS stakeouts, the bitmap at the upper-left corner displays
the following pop-up menu:

— Status: opens the Status screen (see “Status” on page 5-2).

— Rover Antenna Setup: opens the Antenna Setup Screen (see
“Config: Rover Antenna” on page 2-42).

— Config Radio: opens the Configure Radio screen (see
“Config: Rover Radio” on page 2-34).

— Auto Advance Pt: if checked, after storing a staked point,
automatically opens the Stakeout screen for the next point.

— Design Offsets: opens the Design Ell ht screen to change the
design point elevation height, road and DTM offsets
(identical to “Design Elevation™ on page 8-31).

— Store Design Pt/ Layer: opens the Design Pt /Layer screen to
select options to store the points (see “Design Pt/Layer” on
page 8-8).

— Display Coords: if checked, coordinates are displayed instead
of directions (Figure 8-7 on page 8-7).

— Help: accesses the Help files.
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TS Stakeout

The Stakeout screen reflects the relative position of the target. The
current point name and the parameters of the target display on the
right of the screen.

L 4Stakeout
Point  101_stk1l ekt
q HNorth

East

Elevation

IA ‘h

Cut

Figure 8-61. Stakeout (TS)

EDM: selects distance measurement mode: Coarse, Fine, or
Coarse Tracking.

* Cur Pos: causes a measurement to be made and displays the
result on the screen.

* Close: saves the changes and closes the screen.

* The bitmap at the upper-left corner displays the following pop-up
menu:

— Rod Height: opens the Enter Rod Height screen to change the
rod height during stakeout.

— Remote Control (Robotic mode only): opens the Remote
Control screen (see “Remote Control” on page 6-56).

— Config Link (Robotic mode only): opens the Configure Link
screen.

— Auto Advance Pt: if checked, after storing a staked point,
automatically opens the Stakeout screen for the next point.

— Design Offsets: opens the Design Ell ht screen to change the
design point elevation height, road and DTM offsets
(identical to “Design Elevation” on page 8-31).
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— Store Design Pt/ Layer: opens the Design Pt /Layer screen to
select options to store the points.

— Display Coords: if checked, coordinates are displayed instead
of directions (Figure 8-7 on page 8-7).

CodeStrings

To start a CodeString stakeout, select Stake » CodeStrings.

iER 4 CodeStrings
@ Code |1 :I
Strings
HR. Il.DDD m

Stakeout

Figure 8-62. CodeStrings

» For GPS stakeouts, the bitmap at the upper-left corner displays
the following pop-up menu:

— Status: opens the Status screen (see “Status” on page 5-2).

— Rover Antenna Setup: opens the Antenna Setup Screen (see
“Config: Rover Antenna” on page 2-42).

— Config Radio: opens the Configure Radio screen (see
“Config: Rover Radio” on page 2-34).

 For Total Station stakeouts, the bitmap on the upper-left corner
displays the following pop-up menu:

— BS Setup: opens the BS Setup screen (see “Backsight Survey”
on page 6-2).

— Config Link (for Robotic mode only): opens the Configure
Link screen.

— Remote Control (for Robotic mode only): opens the Remote
Control screen (see “Remote Control” on page 6-56).
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» Antenna Ht (for GPS mode): sets the height of the antenna
reference point (ARP) above the mark. Also, specifies the
measurement type for the height: slant or vertical.

* HR (for TS mode): the height of the rod (target).

* Settings: opens the Stakeout Parameters screen. For details see
“Config: Stakeout Parameters” on page 2-48.

» Stakeout: opens the Stakeout screen, assisting in the stakeout
process. The Stakeout screen for CodeStrings is similar to the
Stakeout screen for Points (see Figure 8-3 on page 8-3).
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Notes:
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Chapter 9

COGO

The COGO menu includes the following menu items:

Inverse

Inverse Pt to Pts List
Intersection

Inverse Pt to Line

Point in Direction (optional)
Traverse

Curve Solutions (optional)
Area

Calculator

Known Area (optional)

Transformations (optional)

m@]Bmad [My Conventional] E @
Job Edit View Survel [nwerse

Inverse Pt ta Pts List
Intersection

Inverse Pt To Line
Point in Direction
Traverse

Curve Solutions 3
Area

Calculator

Known Area 3
Transforrations 3

Figure 9-1. Cogo Menu
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COGO

Inverse

To open the Inverse screen, tap COGO » Inverse.

The Two-Point Inverse task computes the inverse between two known
points. Inverse comprises the azimuth from one point to the other, and
the distance between these points.

bEAd Two-Point Inverse

D Inverse | Results | Map

From Paint I
Topant s

Figure 9-2. Two-Point Inverse

The Inverse tab contains initial data for the task:

* From Point: the first point name; entered manually or chosen
from the map or from the list.

* To Point: the second point name; entered manually or chosen
from the map or from the list.

¢ Calc: calculates the inverse.

The menu bitmap in the upper-left corner of the screen displays a
floating menu of the following items:

* Edit Points: opens the Points screen (see “Points” on page 3-2).

* Help: accesses the Help files.
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Inverse

The thumbnail image to the left of the tabs for every COGO screen
displays the type of task being performed. Tap this image to open a
larger map (Figure 9-3). Tap the large image to hide it.

bEAd Two-Point Inverse

D Inverse | Results | Map

|

12

26

= —
La * -E

La *

Figure 9-3. Large Image of COGO Task

The Results tab shows the initial data (From Point, To Point) and
results of the calculation (Figure 9-4). The display of the results can
vary, based on whether a geodesic display system is selected or not.

When Grid or Ground is the selected display system, the results tab
has the below described fields (Figure 9-4).

Two-Point Inverse

Dlnverse Results | Map

<

From Point
To Point
Bearing

HDist

dNorth

dEast
dHeight
Grade(Slope)

12 ~

26

N42.1251E

1715.684 USft

1270.699 USft

1152.777 USft

0.000 USft

0.00 % [V
>

Figure 9-4. Two-Point Inverse — Results in Non-Geodesic Display System

* Azimuth or Bearing: to the second point from the first point.

* Horizontal Distance (HDist): from one point to another.

* Vertical distance (VDist): the “-” sign means that the height of the
second point is lower than the height of the first point.

dNorth: the increment of the North coordinate.

¢ dEast: the increment of the East coordinate.
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* dHeight: the increment of the height.
* Grade(Slope): the increment of the height in percent.
* Slope distance: the computed distance between two points.

When selecting a geodesic display system, the following fields
display (Figure 9-5):

Twu—Puint Inverse

D Irwerse | Results | Map
From Point A9
To Point 100

Forward Azim... 300.5251 dms
Backward Azi... 120.5244 dms
Geodesic Dist 173.279 m
Ground Dist 173.284 m
Delta Ell ht 8.771m

< >

Figure 9-5. Two-Point Inverse — Results in Geodesic Display System

» Forward Azimuth: the forward geodesic azimuth.

Backward Azimuth: the backward geodesic azimuth.

* Geodesic Dist: the shortest distance between two points on an
ellipsoid.

* Ground Dist From: the horizontal distance on the geodetic
horizon plane, at the height of the From Point.

* Ground Dist To: the horizontal distance on the geodetic horizon
plane, at the height of the To Point.

* Delta Ell ht: the difference in ellipsoidal heights.

9-4 TopSURYV Reference Manual



Inverse Point to Points List

The Map tab shows the illustration for the results.

Two-Point Inverse

D Irversa | Results | Map
N’Tféé % 26
B oy,
izl

27

L2lelLrl®

(T

=200 USft

Bt

I

Figure 9-6. Two-Point Inverse — Map

For a description of the buttons, see “Toolbar” on page 4-4.

Inverse Point to Points List

To perform the Inverse Point to Point List task, select COGO »
Inverse Pt to Pts List.

The Inverse Point to Point List tab calculates the inverse for all the
points in the Points list with respect to a known point.

§ER 4 Inverse Point to Point List

Inverse Pt to Pt List | Results | Map
[@] Foint [rati

[&] Paint List  [PaintListt
List of Paints COM'\,1

743 1,:

7 a4 1,:

& 85 2 I8

< > =50m |E|

Figure 9-7. Inverse Point to Point List

* Point: sets the known point name; entered manually or selected
from the map or from the list.

¢ Point List: the Point List name. Can be selected from the list of
Point Lists or entered manually.
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* List of Points: the list of currently selected points. For details see
“Point Lists” on page 3-15.

. E: closes the plot of the polygon. Only the list of points will be
available.

* Calc: calculate the inverse and displays the results on the Results
tab.

The menu bitmap in the upper-left corner of the screen displays a
floating menu of the following items:

 Edit Points: opens the Points screen to edit the points (see
“Points” on page 3-2).

* Edit Point Lists: opens the List of Point Lists screen to edit the
point lists (see “Point Lists” on page 3-15).

* Help: accesses the Help files.

The thumbnail image to the left of the tabs for every COGO screen
displays the type of task being performed. Tap this image to open a
larger map image. Tap the large image to hide it.

The Results tab shows the initial data and the results of the
calculation: closest point, azimuth, distance, height, slope and grade.

Inverse Point to Point List
[ Inverse Pt ta Pt List | Results | Map

From Point S5TAT1 ~
To Point A3

Forward Azim... 270.1604 dms
Backward Azi... 90.1600 dms
Geodesic Dist 94.211 m

Ground Dist 94.214 m

Delta Ell ht 6.624 m

To Point A4 b
< >

Figure 9-8. Inverse Point to Point List — Results Tab
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Intersection

The Map tab shows the results graphically.

=
AN
Q|
=Y

+
ﬂIz

—=50m

Figure 9-9. Inverse Point to Point List — Map Tab

Intersection

To perform the Intersection task, tap COGO » Intersection.

The Intersection screen computes the intersection point or points

when given two known points and either the directions or distances
from the known points.

Intersection
Intersection Results | Map _—
o = -
|
Point 1 [10008 =il y i
E il Intersection ResultslMap
I50+2Df m
@ o = @ Port1  [i0008
Pointz  [10001 e
# [Distance | [70.000 m [Distance ] 5,006 m
[@] coco pant [10007 O
& (pi }
B code ICQ,TI — [pistance | [r0.000 m
[@®] coGopant [10007
@ Code Icgj ab [T]

Figure 9-10. Intersection
The Intersection tab contains initial data for the intersection task.

* Point I: the first point; entered manually, chosen from the map, or
chosen from the list.
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* Azimuth/Distance/Az to Pt: rotates through selections when
tapped.

— Azimuth: sets the azimuth from the first point to the
unknown point.

— Distance: sets the distance between the first point to the
unknown point.

— Az to Pt: sets another known point to which the direction will
be calculated and input as azimuth.

* Point 2: the second point; entered manually, chosen from the map,
or chosen from the list.

* COGO Prt: sets the name and code for the resulting point of the
calculation. The code can be selected from the menu or entered
manually. Also, the Attributes can be selected through the
Attribute List bitmap. Note that the Code/String field will
remember and display the last user-saved code/string.

» Calc: starts calculation process.

entry fields to add/subtract angle and linear values

, To edit angles, azimuths, and distances etc., use the
N,
E directly or by using the Calculator.

The menu bitmap in the upper-left corner of the screen displays a
floating menu of the following items:

* Edit Points: opens the Points screen to edit the points (see
“Points” on page 3-2).

* Help: accesses the help files.

The thumbnail image to the left of the tabs for every COGO screen
displays the type of task being performed. Tap this image to open a
larger map image. Tap the large image to hide it.
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The Results tab shows the results of the calculation.

Intersection

Intersection Results | Map

E 15ection Point 1 10007

MNorth -53.840 m
East 220.646 m
Elev 0.000 m

E 1Section Point 2 10008
MNorth 41.216 m
East 199.832 m
Eley 0.000 m

< >

Figure 9-11. Intersection — Results Tab

North: the North local coordinate of the corresponding point.

* East: the East local coordinate of the corresponding point.

Height: the height of the first corresponding point.
* Save: saves the result of the calculation.

The Map tab shows the graphic solution of the task. In the example
below, there are two solutions for the Intersection calculation.

Intersection

Intersection lResuIts | Map
@% l% .12}5. 353_%28
fil} -:’:!4
i

PlElELe

0, || =—=s0m

Figure 9-12. Intersection — Map Tab

For a detailed description of the Map view, see Chapter 4.
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Inverse Point to Line

To perform the Inverse Point to Line task, select COGO » Inverse
Point to Line.

The Inverse Point to Line screen calculates the station of the known
point inverse to the known line.

Inverse Pt to Line | Results | Map
[®] Foint 7]
Start Point ISD
F (aztopt |[a
StartStn [0+00.000
[]store PTL Paint

Figure 9-13. Inverse Point to Line

* Point: sets the current point name. Can be entered manually, or
selected from the map or from the list.

* Start Point: the starting point of the reference line.

¢ Azimuth/Az to Pt: sets the azimuth of the reference line. Rotates
through selections when tapped.

— Azimuth: sets the azimuth from the starting point by value.

— Az to Pt: sets another known point to which the direction will
be calculated and input as azimuth.

* Start Stn: the starting station of the reference line.

 Store PTL Point: store the point as PTL point (see “PTL Mode”
on page 6-12).

* Calc: calculates the inverse and displays the results on the Results
tab.

The menu bitmap in the upper-left corner of the screen displays a
floating menu of the following items:

 Edit Points: opens the Points screen to edit the points (see
“Points” on page 3-2).
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* Help: accesses the Help files.

Inverse Point to Line

The thumbnail image to the left of the tabs for every COGO screen
displays the type of task being performed. Tap this image to open a

larger map image. Tap the large image to hide it.

The Results tab shows the initial data and the results of the
calculation: station, offset and height.

Inverse Point to Line

Irrverse Pt to Line | Results | Map

Close

From Point
Line
Start Point
Azimuth
Start Station
Station
Offset
Height

<

27

50

213.0641 dms
0+00.000
0+40.497
27.313 m
0.200 m

>

Figure 9-14. Inverse Point to Line — Results Tab

The Map tab shows the results graphically.

Inverse Point to Line

Close

[ Inverse Pt to Line lResuIts | Map

b’F B

E 26 27

Pl

——20m

+
[

o

i

S0 4
51

Figure 9-15. Inverse Point to Line — Map Tab
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Point in Direction

To perform the Point in Direction task, select COGO » Point in
Direction.

The Point in Direction tab calculates the coordinates of a point, using
known point, the azimuth, the angle offset from the azimuth line and
the distance offsets from the From Point.

§ER 4 Point in Direction

Point in Direction
From Point |§|

& [aztopt | |49
Angle Offset  [30.0000

Hz Dist: 20,000 m
Wert Dist 2.000 m
COGO Point (10001

@ Code

Figure 9-16. Point in Direction

* From Point: the starting point. Type the name manually or select
it from the list or from the map.

* Azimuth/Az to Pt: sets the azimuth of the line from the From
Point. Rotates through selections when tapped.

— Azimuth: sets the azimuth by value.

— Az to Pt: sets another known point to which the direction will
be calculated and input as azimuth.

* Angle Offset: the angle offset from the azimuth line.

* Hz Dist: the distance offset along the angle offset line.
* Vert Dist: the height offset.

* Cogo Pt: the computed point name.

* Code: the computed point code.

¢ Calc: calculates the coordinates and displays the results on the
Results tab.
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Point in Direction

The menu bitmap in the upper-left corner of the screen displays a
floating menu of the following items:

* Edit Points: opens the Points screen to edit the points (see
“Points” on page 3-2).

* Help: accesses the Help files.

The thumbnail image to the left of the tabs for every COGO screen
displays the type of task being performed. Tap this image to open a
larger map image. Tap the large image to hide it.

The Results tab shows the initial data and results of the calculation.

Pl:lirlt in Direction

Pairt i Direction | Results | Map

E4 point in Direc... 10001 ~
MNorth 9.000 m
East 112.321'm
Elev 6.600 m
From Point 50
Azimuth 120.0000 dms
Hz Distance 20.000 m
Vert Distance 2.000 m b
< >

Figure 9-17. Point & Direction — Results Tab
e Save: saves the results of the calculation.

The Map tab shows the results graphically.

Pl:lirlt in Direction

[ Point in Cirection lResuIts | Map
l% 4a

50 49 48

: 10001

2eleIL®

——=10m

+
[

o

i

Figure 9-18. Point & Direction — Map Tab
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Traverse

This function is used to calculate Traverse, and Sideshot points, based
Horizontal, and Vertical Offsets along a direction which is defined by
an azimuth, or right, left or deflection angles. To start a Traverse task,
select COGO » Traverse.

The Traverse Calc tab displays the initial data for the traverse task.

Traverse Calc |Results | Map
From Point [100
@& [Azmuth  |[45.0000 dms

% |Hz Grd Dist |[1000.000 m

vert Dist [0.500  m
ToPoint [1000 |5
@ Code I bt

I BS Point ] ISide Shut] I Traverse ]

Figure 9-19. Traverse Calc

» From Point: indicates the occupation (the traverse point), and can
be manually entered, or chosen from the map or list.

* Azimuth/Angle Right/Angle Left/Deflection: determines the
azimuth from the known point to the calculated point (To Point).
The azimuth can be entered as is, or can be computed from the
right or left angles, or deflection entered in this field and
Backsight information.

— Azimuth: sets the azimuth by value.

— Angle Right: angle to the right is the angle at the known
point from the backsight point to the calculated point in a
clockwise direction.

— Angle Left: angle to the left is the angle at the known point
from the backsight point to the calculated point in an counter
clockwise direction.

— Deflection: the angle at the known point between the
prolongation of the line from the backsight point and the line
to the calculated point

* Hz Dist: the Horizontal Distance along the azimuth line.
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Traverse

* Vert Dist: the Vertical Distance along the azimuth line.

* To Point: the name of the calculated point. The button
opens the Add Photo Notes screen to enter a photo note for the
point.

* Code: the code associated with the calculated point.

* BS Point: displays the BS Point screen for entering the Backsight
Point or Backsight Azimuth (Figure 9-21 on page 9-16). If a BS
point has not been entered, an Azimuth is required. In this case, if
an angle value is entered as Angle Right, Angle Left, or
Deflection, this value will be considered as azimuth.

* SideShot: if pressed, the coordinates of the To Point will be
calculated based on the entered values for Azimuth/Angle Right/
Angle Left/Deflection, Horizontal and Vertical distances. The
From Point does not change, and To Point is incremented to the
next new Point in the database.

» Traverse: if pressed, the coordinates of the To Point will be
calculated based on the entered values for (Azimuth/Angle Right/
Angle Left/Deflection), Horizontal and Vertical distances. The
From Point changes to the To Point, and the To Point changes to
the next new name in the database.

The menu bitmap in the upper-left corner of the screen displays a
floating menu of the following items:

* Edit Points: opens the Points screen to edit the points (see
“Points” on page 3-2).

* Help: accesses the Help files.

The thumbnail image to the left of the tabs for every COGO screen
displays the type of task being performed. Tap this image to open a
larger map image. Tap the large image to hide it.
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The Results tab shows the initial data and results of the calculation.

Traverse Calc Close

Traverse Calc | Results | Map

Ed save sideshot 10001 ~
MNorth 26.383 m
East 63.528 m
Elev 5.600 m
From Point 51
To Point 10001
Azimuth 325.0000 dms
Bearing N35.0000W dm: ¥
< >

Figure 9-20. Traverse Calc — Results Tab

The Map tab shows the results graphically.

BS Point

The BS Point screen enters the parameters for the Backsight Point or
Backsight Azimuth. Tapping the BS Point/BS Azimuth button
determines which parameters will display.

Hoe [ EdEe

Figure 9-21. BS Point
* In BS Azimuth mode, the azimuth is set directly.

* In BS Point mode, a point can be chosen from the list or map,
then the azimuth to this point will be calculated and input as the
BS Azimuth.

* The point code is not available for changing.

9-16 TopSURYV Reference Manual



Curve Solutions

¢ Press OK to return to the Traverse Calc screen.

The menu bitmap in the upper-left corner of the screen displays a
floating menu of the following items:

* Edit Points: opens the Points screen to edit the points (see
“Points” on page 3-2).

* Help: accesses the Help files.

Curve Solutions

A Curve is a part of a circle and thus can be described through the
center point (also called as Radius Point), the radius value and the
starting and ending points on the circle, also called as PC (Point of
Curvature) and PT (Point of Tangency). Using these values, the Curve
Solutions find other Curve parameters.

Curve Solution

The Curve Solution COGO task calculates the full set of parameters
for any curve, given one of each of the curvature parameter and the
length parameter of the curve. To start the Curve Solution task, select
COGO » Curve Solutions » Curve Solution.

The Curve Solution tab screen contains the initial data and a window
for the curve plan.

§=h 4 Curve Solution

I:l Curve Solution | Rasults | Map

& (Radics__J] [20.000 m
& |Length | [20.000

Turn |R|ght
Call:

Figure 9-22. Curve Solution

* Radius/Deg Chord/Deg Curve: the curvature parameter of the
curve.
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* Length/Chord/Tangent/Mid Ord: the length parameter of the
curve.

* Turn: the direction of turn relative to the starting point.
» Calc: press to calculate the parameters of the curve.

The menu bitmap in the upper-left corner of the screen displays a
floating menu of the Help item to open the help files.

The thumbnail image to the left of the tabs for every COGO screen
displays the type of task being performed. Tap this image to open a
larger map image. Tap the large image to hide it.

The Results tab shows the calculated parameters.

Cunre Solution

I:l Curve Solution | Results | map
Radius 20.000 m A~
Length 20.000 m
Chord 19.177 m

Degree Curve 286.2844 dms
Degree Chord Not available

Delta 57.1745 dms

Tangent 10.926 m

External 2.790 m v
< >

Figure 9-23. Curve Solution — Results Tab

The first three parameters displayed are the radius and length of the
curve and the length of the chord connecting the PC and PT points.

* Chord: PC-PT length. If the Chord is defined, then taking into
account, that

Delta _ Chord

sin > T/(R)

the Length can be calculated as Length = RxDelta (note that
delta is the angle subtended at the center).

The Degree Curve defines the angle in degrees which is used to
compute the radius of a curve with a length of 100 units:

DegreeCurve xn _ 100
180 R

where R is Radius.
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The Degree Chord defines the angle in degrees which is used to
compute the radius of curve whose chord is 100 units long. So

SinDegreeChord X1y ( 100)/
180 ~\2xR

where R is Radius.
* Delta: internal angle from center to tangent points (PC-RP-PT).

 Tangent: the PI-PT length, where PI is the Point of Intersection. If
the Tangent is defined, then taking into account, that:

tan Dezlta _ TanRgent

where R is Radius, the Length is Length = R xDelta |

Mid Ord: mid ordinate, the piece of PI-RP section from the curve
to the chord. If the Mid Ord is known, then assuming that:

COS'Delta _ R- MidOrd
2 R

where R is Radius, the Length is Length = RxDelta

* External: the piece of PI-RP section from PI to the curve. If the
External is defined, then assuming that:

COSDeIta _ R+ External
2 R

where R is Radius, the Length is Length = R x Delta

* Sector: the area of a circle bounded by two radii and the minor arc
they determine.

* Segment: the area of a circle bounded by a chord and the minor
arc that it cuts off.

* Fillet: the area between the arc of a circle and the two tangents at
the end points of the arc.
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The Map tab shows graphically the results of the calculation.

Curve Solution

I:l Curva Solution lResuIts | Map

i

Pl

(T

—5m

Bt

I

Figure 9-24. Curve Solution — Map Tab

Pl & Tangents

The PI & Tangents task computes the PC point, the PT point, and the
center (Radius Point) of a Curve, given the Point of Intersection (PI),
the radius, and the azimuths from the PI point to the PC, and PT
points respectively. To start the PI & Tangents task, select

COGO » Curve Solutions » PT & Tangents.
The PI & Tangents tab contains the initial data.

@ PI & Tangents -

PI & Tangents

PI Point 7]
AzPIToPRC  [90.0000 dimis
4zPIToPT  [300.0000 dms

% [Radius | [100.000 m
PCPot  JCogal EY MIEE
PT Pont  [Cogoz EY MIEE
RPPaint  [Cogo3 EY MIEE

* PI Point: the Point of Intersection. Can be manually entered, or

Figure 9-25. Pl & Tangents

chosen from the map or from the list.

* Az Pl to PC: the azimuth from the PI point to the starting curve

point.
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* Az PI to PT: the azimuth from the PI point to the ending curve
point.

* Radius/ Deg Curve/Deg Chord/Tangent: the radius parameter
of the curve.

* PC Point: the name and the code for the calculated starting curve
point.

* PT Point: the name and the code for the calculated ending curve
point.

* RP Point: the name and the code for the calculated radius point.

* Calc: calculates the parameters of the curve and the coordinates
of the PC, PT and RP points.

The menu bitmap in the upper-left corner of the screen displays a
floating menu of the following items:

* Edit Points: opens the Points screen to edit the points (see
“Points” on page 3-2).

* Help: accesses the Help files.

The thumbnail image to the left of the tabs for every COGO screen
displays the type of task being performed. Tap this image to open a
larger map image. Tap the large image to hide it.

The Results tab shows the results of the calculation.

PI & Tangents
@ PI & Tangents | Results | Map

M save PC point Cogol ~
MNorth 0.000 m
East 76.795 m
Elev 0.000 m
M save PT point Cogo2
MNorth 13.397 m
East 26.795 m
Eley 0.000 m v
< >

Figure 9-26. Pl & Tangents — Results Tab

Check the points that are needed to be saved and press the Save
button.
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The Map tab shows graphically the results of the calculation.

PI & Tangents ..
[@ PI & Tangents lResuIts | Map

Pl

| —

Bt

Figure 9-27. Pl & Tangents — Map Tab

Three Pt Curve

The Three Pt Curve task defines the curve using three points: PC
point, any curve point and PT point; or the RP, PC and PT points. To
start the Three PT curve task, select COGO » Curve Solutions »
Three Pt Curve.

The Three Points Curve tab displays the initial data.

iEA 4 Three Pt Curve
@ Three Paoints Curve | Results | Map

& |10003 | @ Three Paoints Curve | Results | Map

Three Pt Curve

Close

@ cmerant [woor  [2=][fEl] & [re Point | [iooos
PTRont 10002 PCPont  [iooor
RPPont 0004 PTPont OO0
B [ ~[EE s v

Calc

Calc

Figure 9-28. Three Pt Curve

The screen changes its appearance depending upon the first point
chosen. Manually enter, or select from the list or from the map, the
following sets of points.

* PC Point, Curve Point, PT Point — for this sets of points, the
coordinates for the RP Point will be calculated along with curve
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Curve Solutions

parameters. The name and the code for this calculated point can
be set.

* RP Point, PC Point, PT Point — for this sets of points, the distance
between RP Point and PC point should be equal to distance
between RP Point and PT point. The radius, and the PC and PT
points define two curves, one with delta less than or equal to 180
degrees (Small curve), and the other with delta greater than or
equal to 180 degrees (Large curve). Values of Small or Large can
be selected from the Curve drop-down box to indicate which of
these two curves should be used for computations.

» Calc: press to calculate the curve parameters.

The menu bitmap in the upper-left corner of the screen displays a
floating menu of the following items:

 Edit Points: opens the Points screen to edit the points (see
“Points” on page 3-2).

* Help: accesses the Help files.

The thumbnail image to the left of the tabs for every COGO screen
displays the type of task being performed. Tap this image to open a
larger map image. Tap the large image to hide it.

The Results tab displays the results of the calculation.

Three Pt Curve ..

@ Three Points Curve | Results | Map v Three Pt Curve "
Ed save RP point 10004 - @ Three Points Curve | Results | pMap
MNorth 50.000 m
East 63.397 m Radius 100.000 m -
Eley 0.000 m Length 52.360 m
Radius 51.764 m Chord 51.764 m
Length 189.724 m Degree Curve 57.1745 dms
Chord 100.000 m Degree Chord 60.0000 dms
Degree Curve  110.4113 dms Delta 30.0000 dms
< ¥ Tangent 26.795 m
External 3.528 m v
< >

Figure 9-29. Three Pt Curve — Results Tab

For the description of curve parameters, see “Curve Solution” on
page 9-17.

 Save: press to store the point being found.
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The Map tab displays the results of the calculation graphically.

Three Pt Curve
[@ Three Paints Curve lResuIts | Map

'31 10002

|10002

B

| —

Bt

Figure 9-30. Three Pt Curve — Map Tab

Radius & Points

The Radius & Points task defines a curve using the PC and PT points,
and a radius parameter. To start the Radius & Points task, select
COGO » Curve Solutions » Radius & Points.

The Radius & Point tab contains the initial data for the task.

Radius Point | Results | Map
PCPoint  [1000L
PTPont  [10002

% |Radius |1odooo m

Turhn IRight w | Curye ISmaII v
RP Paint  [10005 B v [zE

Calc

Figure 9-31. Radius & Points

* PC Point: the Point of Curvature. Can be manually entered, or
selected from the map or from the list of points.

* PT Point: the Point of Tangency. Can be manually entered, or
selected from the map or from the list of points.

¢ Radius/Deg Curve/Deg Chord: the radius parameter of the
curve.

e Turn: the direction of turn, relative to the PC Point.
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* Curve: defines the curve in circle that should be considered. The
radius, and the PC and PT points define two curves, one with
delta less than or equal to 180 degrees (Small curve), and the
other with delta greater than or equal to 180 degrees (Large

curve).

* RP Point: the point to be defined. Type the name and select the

code, if necessary.

* Calc: press to calculate the curve parameters.

The menu bitmap in the upper-left corner of the screen displays a

floating menu of the following items:

* Edit Points: opens the Points screen to edit the points (see
“Points” on page 3-2).

* Help: accesses the Help files.

The thumbnail image to the left of the tabs for every COGO screen
displays the type of task being performed. Tap this image to open a
larger map image. Tap the large image to hide it.

The Results tab displays the results of the calculation.

Radius & Points

Radius Paint | Results | mMap

<

K save RP point
MNorth

East

Elev

Radius
Length

Chord

Degree Curve

10005 ~

100.000 m

76.795 m

0.000 m

100.000 m

52.360 m

51.764 m

57.1745dms ¥
>

Figure 9-32. Radius & Points — Results Tab

For the description of curve parameters, see “Curve Solution” on

page 9-17.

* Save: press to store the point being found.
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The Map tab displays the results of the calculation graphically.

Radius & Points

Radius Paint lResuIts | Map

B

+
[

o

i

i

10005

| 10001

——50m

Figure 9-33. Radius & Points — Map Tab

Area

To calculate the area of a polygon, select COGO » Area.

The Area tab contains the list of points, vertices of the polygon, and

the plot of the polygon.
iER 4 Comp Area ..
IE‘ Area | Results | Map
B point List  [PaintListt
m List of Paints Coder: '%
a1 1
Ba0 1
#143 1,2
&84 1,2
m < *l=2m E

Calc

Figure 9-34. Area

e Point List: the Point List name. Can be selected from the list of
Point Lists or entered manually.

* List of Points: the list of currently selected vertices of the

polygon.

* Up and down arrows move the highlighted point up and down in

the order of the points.
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For the correct operation of the application, the
sides of the polygon should not cross each other.

. : switches on/off the keyboard arrow keys that duplicate

the operation of the arrows on the screen.

. E: closes the plot of the polygon. Only the list of points will be
available.

* Calc: calculates the area of the polygon and displays it on the
Results tab.

The menu bitmap in the upper-left corner of the screen displays a
floating menu of the following items:

 Edit Point Lists: opens the List of Point Lists screen to edit the
point lists (see “Point Lists” on page 3-15).

* Help: accesses the Help files.

The thumbnail image to the left of the tabs for every COGO screen
displays the type of task being performed. Tap this image to open a
larger map image. Tap the large image to hide it.

The Results tab shows the results of the calculation.

k=R Comp Area
IE‘ area | Results | Map
Area ~
{m~2) 63.357 m~2
(Acres) 0.01566 Acres
Perimeter 31.854806 m
Point List
Al
AZ v
< >

Figure 9-35. Area — Results Tab
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The Map tab shows a view of the polygon.

iER 4 Comp Area
IE‘ Area | Results | Map

Figure 9-36. Area — Map Tab

e

————i0m

+
[

o

i

Calculator

A built-in calculator in TopSURYV performs calculations and
conversions.

To start the calculator, select COGO » Calculator.

b d Calculator

Figure 9-37. Calculator

To enter a calculated value to any entry field in
$ . TopSURYV, start the calculator from this field by
pressing the F1 button on the controller keyboard,

or by tapping the E button on the pop-up

keyboard for controllers with the soft input panels.
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* [Input field: enter the entire equation here, and press the equals
[=] button to calculate the result.

* Result field: shows calculation results. This field is also used as
the ‘y’ or ‘theta’ values for rectangular / polar conversions.

* Previous Result field: once equals is pressed, the previous result
is moved up to this field. This field is also used as the ‘x’ or ‘r’
values for rectangular / polar conversions.

* MC: clears the memory.

* MR: recalls the memory value, indicated by M in the Input field.
* MS: saves the already computed result into memory.

* M+: adds the already computed result to the value in memory.

* C: clears all the fields.

* <-: backspace, removes the last entry.

* copy: if the calculator was started from a field in TopSURV,
copies calculation results to that field; closes the calculator in
case it was started from the COGO menu.

* sci: brings up the scientific calculator.

b 4 Calculator Cluse
Rad |Deg
I— M
TR Deq |Grad
i B
DMS | Deg | Pol | Rec

s T ES N
1 o v 100 o]+ [

Figure 9-38. Scientific Calculator
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Known Area

The Known Area task calculates the coordinate of a point/points that
after being added to Point List form a polygon of known area. There
are two methods: Hinge and Line.

Hinge
The Hinge method calculates the coordinates of a point, that meets

the following conditions:

e it is located on a known azimuth taken from the first point of
Point List;

* being added to the Point List between the first and the last points,
forms a polygon of a known area.

To start the Hinge task, select COGO » Known Area » Hinge.

Known Area - Hinge
The Area tab contains the initial data of the Hinge task.

B Point List fLis
m List of Paints Coder: '%
a1 1
182 1
#1483 1,2
F 84 1,2

m < *ll=2m E
Next ==

Figure 9-39. Known Area - Hinge — Area Tab 1

e Point List: the Point List name. Can be selected from the list of
Point Lists or entered manually.

e List of Points: the list of currently selected vertices of the
polygon.

* Up and down arrows move the highlighted point up and down in
the order of the points.
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For the correct operation of the application, the
sides of the polygon should not cross each other.

. : switches on/off the keyboard arrow keys that duplicate
the arrows on the screen.

. E: closes the plot of the polygon. Only the list of points will be
available.

» Next: opens the second screen under Area tab.

Knuwn Area - Hinge

Area |Results | Map

Azimuth 50,0000 dms

Area |so.oo0 & | sa.m
[®] oGO Paint

@ Code I v &

[ <<Back || caic |

Figure 9-40. Known Area - Hinge — Area Tab 2

* Azimuth: the known azimuth from the first point in the list, where
the hinge point is located.

* Area: the known area.

* Sq. (Job Units)/Acres: press to set the area units.

* Cogo Point: the name of the new point.

* Code: select the code from the drop-down menu, or press the

¥ button to open the list of available attributes.

Back: returns to the first Area tab.

Calc: calculates the coordinates of the hinge point and displays it
on the Results tab.
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The menu bitmap in the upper-left corner of the screen displays a
floating menu of the following items:

 FEdit Point Lists: opens the List of Point Lists screen to edit the
point lists (see “Point Lists” on page 3-15).

* Help: accesses the Help files.

The thumbnail image to the left of the tabs for every COGO screen
displays the type of task being performed. Tap this image to open a
larger map image. Tap the large image to hide it.

The Results tab shows the results of the calculation.

Knuwn Area - Hinge

Area Results | Map

<

M coGo pt1
MNorth

East

Elev

Total Area:
(m~2)
(Acres)
Plot Area:

10007 ~
4063.566 m
9229.593 m
0.000 m

50.000 m~2

0.01236 Acres
v

>

Figure 9-41. Known Area - Hinge — Results Tab

The Map tab shows the view of the polygon.

Known Area - Hinge

Area | Results | Map

i

P

+
[

o

i

N

————om

Figure 9-42. Known Area - Hinge — Map Tab
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Line

The Line method computes the coordinates of two points that along
with two other known points form a quadrilateral of known area.

To start the Line task, select COGO » Known Area » Line.

Known Area - Line

The Area tab contains the initial data of the Line task.

EEA dKnown Area - Line

Area | Results | Map

[@] startpt [ )

[@®] Endrt |4 e

Az 1200000 422 |t3s.0000  dms
Area 5001915 & [ sam |

& Azimuth |45 0000 drris

[®] cogo pt1 [10005 @ A

[®] cosorte [iooos B v

Calc

Figure 9-43. Known Area - Line — Area Tab

e Start Pt, End Pt: the known starting and the ending points of the
quadrilateral.

* Azl, Az 2: the azimuths of the lines emanating from the Start and
the End points (Line 1 and Line 2), to the calculated points,
COGO Pt I and COGO Pt 2, respectively.

* Area: the known area.
* Sq. (Job Units)/Acres: press to set the area units.

¢ Azimuth/Parallel: the azimuth of a line that will intersect Linel
at COGO Pt I and Line2 at COGO Pt 2 with an area of the
quadrilateral equal to the known area. If Parallel is set, the line
COGO Pt I->COGO Pt 2 will be parallel to the line defined by
the Start and End Points.

* COGO Ptl, COGO Pt2: the names of the points.
. : the Code field. Select the code from the drop-down menu,

or press the || button to open the list of available attributes.
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* Calc: calculates the coordinates of the line points and displays it
on the Results tab.

The menu bitmap in the upper-left corner of the screen displays a
floating menu of the following items:

 Edit Points: opens the Points screen to edit the points (see
“Points” on page 3-2).
* Help: accesses the Help files.
The thumbnail image to the left of the tabs for every COGO screen

displays the type of task being performed. Tap this image to open a
larger map image. Tap the large image to hide it.

The Results tab shows the results of the calculation.

Knuwn Area - Line

Area Results | Map

M save COGO Pt1 10005 ~
MNorth -78.606 m
East 99.548 m
Elev 0.000 m
M save COGO Pt2 10006
MNorth -17.077 m
East 161.077 m
Eley 0.000 m v
< >

Figure 9-44. Known Area - Line — Results Tab

The Map tab shows the view of the quadrilateral.

Known Area - Line

. Area | Results | Map

%MQD s

B}2 28?

FLEEPEE

——50m

+
[

o

i

Figure 9-45. Known Area - Line — Map Tab
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Transformations

The transformations include the three tasks: Rotate, Translate and
Scale.

The menu bitmap in the upper-left corner of the screens displays a
floating menu of the following items:

* Edit Points: opens the Points screen to edit the points (see
“Points” on page 3-2).

* Help: accesses the Help files.

The thumbnail image to the left of the tabs for every COGO screen
displays the type of task being performed. Tap this image to open a
larger map image. Tap the large image to hide it.

Rotate

To rotate points, tap COGO » Transformations » Rotate.

The Rotate task rotates the selected points around a specific point.

Rotate

4 points selected
Select Points By Range
) ' =] [
Rotation Point  [10006 P -—

Rotation Method IRDt. Angle w
Rotation Point 10006
Rotation Angle |4 dms
e o Rotation Method IAzimuth v

Cld Azirmuth |45 dms
Mew Azimuth IEl dms

Figure 9-46. Rotate

* Select points: select points for Rotation from the map or the list,
or by setting the point range. The point range can be set in the
Select Points by Range screen opened by the By Range button.
For a description of the Select Points by Range screen, see
“Select Points by Range” on page 9-38.

¢ Rotation Point: sets the center of rotation.

P/N 7010-0492 9-35



COGO

* Rotation Method: sets if the rotation angle will be input directly
(the Rot. Angle entry), or as a difference between the new and old

azimuths/bearings.

* Rotation Angle: sets the value of the rotation right angle.

e Old Azimuth: sets the value of the old azimuth.

e New Azimuth: sets the value of the new azimuth.

» Calc: press to rotate the selected points.

Translate

To translate a set of points, tap COGO » Transformations »

Translate.

The Translate screen moves a group of points.

L d Translate Close
l

Select Points

4 points selected

Translate By IAz,Dist,Ht v

Azirnuth 00.0000 dms
Hz Dist [100.000 m
wert Dist b.z00] m

Select Points

4 points selected

Translate By ICoords,‘Pts v
% [From pt | [10005

Calc  |@g[tocad |n|17077 B [161077

Height ID.E‘I m

Figure 9-47. Translate

* Select points: select points for the translation from the map or the
list or by setting the point range. The point range can be set in the
Select Points by Range screen, opened by the By Range button.
Description of the Select Points by Range screen see “Select
Points by Range” on page 9-38.

* Translate By: sets the method of translating, either Coords/Pts or

Az/Brg, Dist, Ht.

* Coords/Pts: all the selected points will be moved in the same
direction and distance as between the points (locations), set by
the next two fields: From Pt (From Crd) and To Pt (To Crd).
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In the first case, define only the point name; in the second case,
the local coordinates and the height of the location.

* Az/Brg, Dist, Ht: all the selected points will be moved in the
specified direction by a specified distance. These parameters are
set through the Azimuth(Bearing) field, Hz Dist and Vert Dist
fields.

* Calc: press to translate the selected points.

@ The limit for translation of points is 20,000 meters.

Scale

To scale a set of points, tap COGO » Transformations » Scale.

The Scale screen scales the distances of a range of points relative to a
Base Point.

Select Points
4 points selected

Base Point W

Scale Factor lll—

[ 5cale Heights

Figure 9-48. Scale

* Select points: select points for scaling from the map or the list, or
by setting the point range. The point range can be set in the Select
Points by Range screen opened by the By Range button.
Description of the Select Points by Range screen see “Select
Points by Range” on page 9-38.

* Base Point: sets the reference point for the scale transformation.
Can be manually entered or, chosen from the map or from the list.

e Scale Factor: the scale factor for the coordinate transformation.
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* Scale Heights: check this field if the height values should be
scaled also.

» Calc: press to scale the selected points.

Select Points by Range

In the Range of Points field, the range can be set by enumeration of
the points separated by commas, or by specifying the first and the last
included point in the range. Press the OK button to save the specified
range. The number of the selected points display on the
corresponding task screen under the Select Points field.

Select Points by Range m

Range of Points:

10001-10004

Mame Separatar I- v

Usg -' for Range Separator

Figure 9-49. Select Points
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Chapter 10

The Help menu includes the following menu items:

¢ Activate Modules
* About TopSURV

Il 1100 [My RTK] B ®

Job Edit View Survey Stake Cogo

Contents

Contents
Activate Modules
About TopSURY

Figure 10-1. Help Menu

To open the TopSURYV Help Contents screen, tap Help » Contents.

Conterts @21l Topics *®

TopSURV Help

b
i
Wigw

TS Survey
GPS+ Survey
TS Stakeout
GPS Stakeout

Cogo v

-
]

Py
=3

=

Figure 10-2. TopSURV Help Contents

All Topics opens the contents of help for other software embedded in

the controller.
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Activate Modules

To view or to add the ID’s for activating the main features in
TopSURYV, tap Help » Activate Modules.

The Security screen displays the device’s numbers and the IDs which
had been entered.

L d Security

Key ¥alue |154 1799583

Activation IDs

TS5 864984947
Contractor 3862888443
Robotic 3862167035

GP5+ IBBGDBSE 187
GIS I3364 199162

Roads 3868393342
mmGPS 3867082623

Figure 10-3. Security
* Key Value 1,2: the default key values of the controller

e Activation IDs: the codes needed to enable observation modes
and usage of roads in TopSURV.

* OK: saves the ID values, and if allowed, provides access to the
observation modes and creating and using roads (through the
following submenus: Edit » X-Sect Templates, Edit » Roads,
Stakeout » Roads, and Stakeout » Slope).

10-2 TopSURYV Reference Manual



About TopSURV

About TopSURV

To view basic information about TopSURYV, click Help » About
TopSURYV. The About TopSURYV screen displays the software name,
version, copyright and build date.

About TopSURV [ ok |

MDA TooSURY

Wersion oL
TOPCON Copyright (C) 2001-77 .

Figure 10-4. About TopSURV
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Notes:
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Appendix A

File Formats

The following sections describe the formats used in the import/export
of files.

Point Coordinate Formats

The files used to import/export point data can be in different formats:
text formats such as DXF, MOSS and many others, or binary formats
such as DWG and CRS.

FC-4
The FC-4 format is as follows:

Name, Northing, Easting, Elevation, Code

Example:
101
12.32000
45.10000
23.12000
a
102
34.20000
9.40000
3.22000

103
2.33400
8.45000
45.00000
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b

104
78.60000
45.00000
56.60000

FC-5
Example:

OutPut

_+BS_ f+012500000m_ g+011500000m_ h+000050000m_+PJ1_
f+012000000m_ g+011002106m_ h+000049970m_+PJ11_ f+012000000m_
g+011002106m_0063

h+000049970m_+PJ12_ £+011994478m_ g+011004703m_
h+000050025m_+PJ13_ f+011990588m_ g+011003698m_
h+000049863m_+PJ2_ f+011994476m1051

InPut

_+BS_ x+012500000m_ y+011500000m_ z+000050000m_+PJ1_
f+012000000m_ g+011002106m_ h+000049970m_+PJ11_ f+012000000m_
g+011002106m_0063

h+000049970m_+PJ12_ f+011994478m_ g+011004703m_
h+000050025m_+PJ13_ £+011990588m_ g+011003698m_
h+000049863m_+PJ2_ f+011994476m1051

GTS-6

GTS-6 coordinate input and output is the same format. Refer to the
GTS-6 interface manual to confirm details.

The format of GTS-6 is the same as FC-5 coordinate input.
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FC-6/GTS-7

The format of FC-6 is the same as GTS-7 coordinate format. The
GTS-7 format is as follows:

ptno, X(easting), Y (northing), Z(elevation)

Example:
1,1000.0000,1000.0000,100.0000
2,990.0000,1010.0000,100.0000
101,994.8159,1000.9684,100.1130
102,993.9304,1007.7991,100.8000
103,998.5150,1009.6329,100.4026
104,1002.0648,1002.5682,100.3421
1001,1004.7210,997.6496,100.1153
1002,1003.7027,990.8382,100.7989
1003,998.7911,990.3286,100.4033
1004,997.3111,998.0951,100.3421

GTS-7 with strings

The GTS-7 with strings format is as follows:
ptno, X(easting), Y (northing), Z(elevation), pt code, string

Example:
1,1000.0000,1000.0000,100.0000,STN,001
2,990.0000,1010.0000,100.0000,STN,001
101,994.8159,1000.9684,100.1130,STN,002
102,993.9304,1007.7991,100.8000,STN,001
103,998.5150,1009.6329,100.4026,STN,002
104,1002.0648,1002.5682,100.3421,STN,001
1001,1004.7210,997.6496,100.1153,PT,09
1002,1003.7027,990.8382,100.7989,PT,05
1003,998.7911,990.3286,100.4033,PT,09
1004,997.3111,998.0951,100.3421,PT,05
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GT

The GT Format is as follows:

0 Code Name North East Elev 0

Example:
0 a 101 12.320
0 102 34.200
0 b 103 2.334
0 104 78.600

GT-FIN

0

45.100
9.400
8.450
45.000

The File Extension for this format is *.GT

Format is 8,8,8,8,14,14,14:
1: Surface (Eight marks)
2: Line (Eight marks)
3: Code (Eight Marks)
4: Point (Eight marks)

5: X-coordinate (N) (fourteen marks)
6: Y-Coordinate (E) (fourteen marks)
7: Z-Coordinate (H) (fourteen marks)

Example:
9 1 0 1 44318.541
where
9 = Surface Code (ctrl code)
1 = Line Code (String code)
0 =Code
1 = Point number
44318.541 = North
72090.844 = East

0.000 = Height

A-4

72090.844

23.120 00
3220 00
45.000 00

56.600 00

0.000
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MMH360

The File Extension for this format is *.360
MMH360-format is as follows:

: Empty (Four marks)

: Control Code (three marks)

: String (Four Marks)

: Point (pointnumber: seven marks)

: Empty (four marks)

: Code (Three marks)

: Control Code 2 (two marks)

: Empty mark (One mark)

O 0 3 O L B~ W N =

: X-coordinate (N) (11 marks, three after comma)
10: Empty mark (One mark)
11: Y-coordinate (E) (11 marks, three after comma)
12: Empty (Eight marks)
13: Z-coordinate (H)(8 marks, three after comma)
Example:

25 4 10 60101 7062800.100 3513639.300 17.800

where
25 = Control code
4 = String
10 = Point Number
601 = Code

01 = Control Code 2
7062800.100 = North
3513639.300 = East
17.800 = Height
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DXF

AutoCAD® DXF (Drawing eXchange Format) is the native vector
file format of Autodesk's AutoCAD application.

KOF

KOF is a Norwegian format that consists of a set of data blocks.
Example:

00 Starting off with total station:

02 P10 1.690 31

09 40

03 100 45 100.1230 100.1230 100.123 1.670
03 101 45 200.3210 100.3210 200.321 1.670

03 101 45 3215 299.6786 200.322 1.670
03 100 45 300.1236 299.8770 100.134 1.670
09 40

03 100 45 200.1260 299.8770 100.126 1.670
03 101 45 300.3350299.6791 200.345 1.670
03 101 45 100.3206 100.3215 200.256 1.670
03 100 45 .1247 100.1234 100.139 1.670
09 39

032 7002  110.0000 101.3955 50.002 1.350
033 7002 125.3600 100.2500 48.369 1.350
034 7002 136.2300 100.2500 48.369 1.350
0991

035 7002 148.0000 100.2500 48.369 1.350
036 7002 150.0000 100.2500 48.369 1.350
037 7002 158.0000 100.2500 48.369 1.350
038 7002 168.0000 100.2500 48.369 1.350
039 7002 170.0000 100.2500 48.369 1.350
0310 7002 180.0000 100.2500 48.369 1.350
0999

00 Then a couple of coordinates:
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05100 1000 134721.459 9867.343 21.633
05101 1000 134741.349 9881.834 21.514
00 And some GNSS-vectors:

42 Bauta 2210658.5530 618726.6390 5930812.0680 1.341

43 D1 45619 230.4119 -47.0982 2.054

44 1.4314 0.6481 4.5640 1.0000 0.4382 0.8757 1.0000 0.4811 1.0000
42 Bauta 2210658.5530 618726.6390 5930812.0680 1.341

43 D2 -0.6466 176.7444  -33.8989 2.054

44 0.2134 0.1012 0.5657 1.0000-0.0395 0.8015 1.0000 -0.1045 1.0000

The examples shown are not complete blocks, but show typical use of
the blocks. Several of the blocks have a two-digit code that describes
the kind of measurement being done.
The relevant values are:
30 =TS, Traverse
31 =TS, Free station / eccentric station
32 =TS, Known station
33 = TS,Other
91 = GPS, code differential (DGPS)
92 = GPS, autonomous
96 = GPS, RTK fixed
97 = GPS, RTK float
Block 00 - Header
DB FreeText
A2 A A64
Example:
00 This is just a comment!!
Block 02 - Station
DB Station Feat.Code NR Press Templh Type Comm
A2 AA10 NAS ANBAI8 NIBAFO6.3NI2 ANAT
Example:
02 P100 1000 1.723
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DB is the data bloc-number (02), Station is name of station (point
where total station is situated), Feat. Code is feature code, NR
could be left blank. Pressure in mmHg and temperature in C.
Ih=instrument height, Type is type of measurement, and Comm is
comment.

Block 03 - Total Station observations 1
DB AimPoint Feat.Code Hor Vert Dist Ph  Type Comm
AM2ANAI0 MNAS NF8.4/F8.4 "F83/"F6.3" 12 "AT
Example:
03 PP230 7002 100.1230 100.1230 100.123 1.670

DB is data block-number (03). Aim Point is point name of point
at which the total station is aimed. Feature code is feature code of
Aim Point. Hor is horizontal angle (gon). Vert is vertical angle
(gon). Dist is slope distance. Ph is pole height / prism height.
Type is type of observation, and Comm is comment.

Block 04 - Total Station observations 2
DB AimPoint Feat.Code Hor Dh DistH Ph Type Comm
AM2AMAI0 MNAS NF8.4NF8.3/2F83 NF6.3/M2 NAT
Example:
04 PP231 7002  100.1230 2.113 144.341 1.670
DB is data block (04). Aim Point is the point at which the total
station is aimed. Feat.Code is feature code for Aim.Point. Hor is
horizontal angle (gon). Dh is height difference. DistH is
horizontal distance. Ph is pole height / prism height. Type is type
of observation, and comm is comment.

Block 05 - Coordinates
DB Pointname Feat.Code North East Height Type Comment
AM2ANAT0 MNAS8 AF1237F11.32F83 ~I2 ~A7
Example:
05 P101 1000 134741.349 9881.834 21.514
DB is datablock (05). Pointname is occupation name (point
name). Feat.Code is feature code. North, East, Height is
coordinate in selected system. Type is type of calculation/
measurement, and comment is a free-text comment.
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Block 09 - Program information
DB PI Connection Free text
A2 AT2 M A10 N AS0
Example (line coding):
0991
05 P100 1000 134654.123  9800.123 21.000
05 P101 1000 134741.349 9881.834 21.514
09 99
DB is datablock (09). PI is program information, which is a code
that can give extra information to the program reading the KOF
file, and can be used to start/end lines in a coordinate export.
Connection is sometimes used and is a point number of an
existing point.

Block 41 - GNSS base, no coordinate
DB BaseName Feat.Code Bk Spaces Ant.H. Type Comm.
A2AMA10 MA8 A8 x31 F6.3 M2 ~NA7T
Example::
41 Bauta 1.341
This block brings on base point name and antenna height. It has
the same layout as block 42 (fields are described there), except
that the coordinates are replaced by spaces.

Block 42 - GNSS base, with coordinate
DB BaseName Feat.Code X Y Z NrAnt.H.Bk Comm.
A2 AA10 NAS "F12.4"F12.4"F12.4M"8"F6.3 "2 ~ A7
Example:
42 Bauta 2210658.5530 618726.6390 5930812.0680 1.341
DB is data-block (42). BaseName is the point name of the base.
Feat.Code is feature code. X, Y, and Z is coordinate of base in
WGS84 geocentric coordinates. Nr should be left blank. Ant.H is
antenna height. Bk should be left blank, and Comm. is a freetext
comment.

Block 43 - GNSS vector
DB PointName Feat.Code dX dY dZ Ant.H Bk Comm
M2 ANAI0 MNAS8 "F12.4"F12.4"F12.4" F6.3 "2 ~A7
Example:
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43 P1 45619 230.4119 -47.0982 2.054

This is the vector. DB is data-block (43). PointName is the (rover)
occupation name (point name). Feat.Code is feature code. dX, dY,
and dZ is the vector components in WGS84 geocentric
coordinates. Ant.H is antenna height of the rover. Bk is not used,
and Comm. is a freetext comment.

Block 44 - GNSS RMS and correlation coefficients, geocentric
DB sX sY sZ XX XY rXZ rYY rYZ 1ZZ Comm
A2 A F8.4 AF8.4"N F8.4N F7.4N F.4N F7.4N F7.4N F7.4M F7.4M A7
Example:
44 1.4314 0.6481 4.5640 1.0000 0.4382 0.8757 1.0000 0.4811 1.0000
This block follows block 43 with additional data on the vector.
DB is data-block (44). sX, sY, sZ is the vector components
standard deviation (or RMS-values). The r-fields are correlation
coefficients between the vector components. rXX, rYY, rZZ are
all equal to 1.

Block 45 - Coordinates in geocentric system (WGS84)
DB PointName Feat.CodeX Y Z Ant.H.Bk Comm.
A2 2A10 N A8 AF12.4"F12.4"F12.4"F6.3 "2 " A7
Example:
42 P1048 1234  2210658.5530 618726.6390 5930812.0680
DB is data-block (45), PointName is occupation name
(pointname), and Feat.Code is feature code. X, Y, and Z is the
coordinate in WGS84 geocentric coordinates. Ant.H is antenna
height. NB be left blank if coordinate is already adjusted for
antenna height. Bk is left blank, and Comm. is a freetext
comment.

Block 46 - Additional GNSS information
DB Date Time(UTC) #SVs PDOP Ant.Height Epochs Type
AM2AI8 A2:2:12712 AF527F6.3 A3 AI3
Example:
46 31122004 23:59:59 13 1.45 001 96

DB is data-block (46), Date is date in format DDMMYYYY,
Time is UTC-time in format HH:MM:SS (24h notation), #SVs is
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number of satellites included in position calculation, PDOP is
PDOP, Ant height is antenna height. NB should be left blank if
coordinate (or vector) is already adjusted for antenna height.
Epochs is number of epochs measured, and type is type of
solution, from this list:

Block 50 - coordinate in selected system, with ellipsoidal height
DB Pointname Feat.Code North East EILH Type Comm.
AM2AAI0 NAS AF1237AF11.372F83 A2 ~AT
Example:
50 Point2345 1000 134741.349 9881.834 62.643
DB is data-block (50), PointName is the name of the occupation
(point), and Feat.Code is feature code. North, East is coordinate
from the measurement in selected system. Ell.H is ellipsoidal
height in WGS84. Type is left blank. Comm. is a free text
comment.

Block 51 - GNSS RMS and correlation coefficients, NEU
(North,East,Up)
DB sN sE sU NN rNE rNU rEE rEU rUU Comm
A2 A F8.4 AF8.41N F8.4N F7.4N F1.4N F1.4N F7.4N F7.4N F7.4M A7

Example:
50 Point2345 1000 134741.349 9881.834 21.514 62.643 2.054

This block follows block 05 or 50 (coordinate) with additional
data on the measurement. DB is data-block (51). sN, sE, sU is the
coordinate components’ standard deviation (RMS-values), and
the r-fields are correlation coefficients between the coordinate
components. tNN, rEE, rUU are all equal to 1.

SHP

SHP is an ArcView® GIS data format used to represent a set of
geographic features.

Refer to the following website for details:

http://dl1.maptools.org/dl/shapelib/shapefile.pdf
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Cut Sheet Standard

Cut Sheet Standard format is as follows:

Header:

Date

Time

Job Name

Dist Units (Meter, US. Feet, Int. Feet, US. Inches, Int. Inches)

Design Point Record:

Point Name

Code

North East Elev

Stakeout Station Record:

Station Name

North East Elev

deltaNorth deltaEast deltaElev Cut

Cut Sheet User Defined

This format contains a set of user-defined fields in the user-defined

order.

The following fields are available:

A-12

Design Point
Code

Staked Point
Cut

Fill

Cut(Fill)
Time Stamp

Station
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Offset Direction
Offset Distance
Design North
Design East
Design Elevation
Station North
Station East
Station Elevation
Delta North
Delta East

Delta Elevation

Check Sheet

Check Sheet format is as follows:

Header:

Date

Time

Job Name

Dist Units (Meter, US. Feet, Int. Feet, US. Inches, Int. Inches)
Observed Point Record:

Point Name

Code

North East Elev

Check Station Record:

Station Name

North East Elev

deltaNorth deltaEast deltaElev
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PTL Sheet

PTL Sheet format is as follows:
Header:
Date
Time
Job Name
Dist Units (Meter, US. Feet, Int. Feet, US. Inches, Int. Inches)
Point Record:

PointName North East Elev Code FirstReferencePointName
SecondReferencePointName

CMM

The ASCII format file that consists of two files with extentions *.cor
and *.lev containing coordinates and heights, respectively.

Land XML

LandXML is a standard data exchange format.

Refer to LandXML Website for details:
http://www.landxml.org/schema/landxml-1.0/Documentation/LandXMLDoc.htm

CR5

This is a file format of TDS-48 Coordinate file. The TDS Coordinate
File is a binary file consisting of a 38 byte header,

followed by coordinate point records 45 bytes in length.
CR-5 format is as follows:
Header:
Bytes 1- 10 is the file name in ASCII
Bytes 11- 20 are not used

Bytes 21- 34 is the starting point number in MS long integer
format. This record is -1 if the file is non-sequential
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Bytes 35- 38 is the last point number in MS long integer
format

Coordinate Point Records:

Bytes 1- 4 is the point number in MS long integer format.
This record is -1 if the point is unused (sequential files only)

Bytes 5- 12 is the northing of the point in MS double
precision real

Bytes 13- 20 is the easting of the point in MS double
precision real

Bytes 21- 28 is the elevation of the point in MS double
precision real

Bytes 29- 45 is the point descriptor in ASCII

MOSS GENIO

Example:
GENIO D:\JO119A
001,FORMAT(3F14.4)
003,0RDR.4=1,1,2,3
080,PT01,7=3
1002.6092  1013.9337 2.3165
1007.5266  992.8522 1.9564
0.0000 0.0000 0.0000
080,PT02,7=3
991.2378  1002.7609 1.5545
993.2974  1014.3845 2.3475
0.0000 0.0000 0.0000
080,CD02,7=3
1002.6079  1013.9361 2.3148
0.0000 0.0000 0.0000
080,CD03,7=3
1007.5318  992.8488 1.9562
0.0000 0.0000 0.0000
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080,0CC,7=3
1000.0000  1000.0000 0.0000
0.0000 0.0000 0.0000
080,PTO01,7=3
1002.6079 1013.9361 2.3148
1007.5318  992.8488 1.9562
991.2376  1002.7602 1.5557
993.2994  1014.3841 2.3509
0.0000 0.0000 0.0000
999
FINISH

NEZ

NEZ format is as follows:
Name, North, East, Elev, Code

Example:
101,12.3200,45.1000,23.1200,a
102,34.2000,9.4000,3.2200,
103,2.3340,8.4500,45.0000,b
104,78.6000,45.0000,56.6000,

This format is also used for PTL coordinate system. In this case the
NEZ format is:

Name, North, East, Elev, Code, First Reference Point Name, Second
Reference Point Name

NEZ with strings

The NEZ with strings coordinate format is as follows:
Name, North, East, Elev, Code, String

Example:
101,12.3200,45.1000,23.1200,a,123
102,34.2000,9.4000,3.2200,,
103,2.3340,8.4500,45.0000,b,

A-16 TopSURYV Reference Manual



Point Coordinate Formats

104,78.6000,45.0000,56.6000,,
This format is also used for PTL coordinate system. In this case the
format is:

Name, North, East, Elev, Code, String, First Reference Point Name,
Second Reference Point Name

Custom Format with Quality Control
information

This format contains a set of user-defined fields in the user-defined
order.
The following fields are available:
Name
E(Lon)
N(Lat)
Ell ht
Elevation
Notes
Codes
Codes&Strings
Codes&Attributes
FullCodes
Date
Solution Type
VRMS
HRMS
Time
PDOP
HDOP
VDOP
Num. of GPS
Num. of GLONASS
Design Elevation

Station North
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Station East
Station Elevation
Delta North
Delta East

Delta Elevation

Code Libraries

The following sections describe the code formats used in the import/
export code libraries.

Topcon Data Dictionary Format (TDD)

Topcon's Data Dictionary Format supports String, Integer, Float and
List types as fields of the codes. The Draw properties is also
supported. All exported codes are stored in the one file. Each code is
placed on a new line.
The format is as follows:
CodeName#1<Point?R*G*B ?MStylelLine’R*G*B ?DashStyle?
Width> (field#1(FIELD_TYPE),... field#N(FIELD_TYPE))
CodeName#2<Point?R*G*B ?MStylelLine’R*G*B ?DashStyle?
Width> (field#1(FIELD_TYPE),... field#N(FIELD_TYPE))
Comments:
Point, Line — types of the supported objects
R,G,B - color of the objects with such code
MStyle — mark style of the points with such code:
0 =Dot
1 = Filled Rectangle
2 = Filled Diamond
3 = Filled Circle
4 =Filled Triangle
5 = Rectangle

6 = Diamond
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7 = Circle
8 = Triangle
9 = Cross
DashStyle — dash style of the lines with such code:
0 = Solid
1 = Dash
2 =Dot
3 = Dash Dot
4 = Dash Dot Dot
Width — width of the lines with such code
FIELD_TYPE can be: String, Integer, Float, List.
For FIELD_TYPE List we use next format:
List(item#1,. . .,item#N).
Example:

test_code(menu_item<Point?255%128%*255?3|Line?255%255%128?371>(List(blue,
green,red)), text_item(String), int_item(Integer), real_item(Float))

XML File as Storage of the Code
Library (XML)

The XML Code Library format supports String, Integer, Float and
List types as fields of the codes. The format also supports Layers
dictionary and draw information for each code. All exported codes are
stored in one file. The format uses the XML syntax and is as follows:
Example:

<?xml version="1.0"7>

<CodeDictionary version="1.1">
<Layers>

<Layer name="lay1" active="1" plot="1" notes="first">
<Params type="Line">

<DrawParams colorRValue="87" colorGValue="65" colorBValue="189"
dashStyle="1" width="2"/>

</Params>

</Layer>

P/N 7010-0492 A-19



File Formats

<Layer name="lay2" active="1" plot="1" notes="second">
<Params type="Line">

<DrawParams colorRValue="153" colorGValue="98" colorBValue="156"
dashStyle="2" width="3"/>

</Params>

</Layer>

<Layer name="0" active="1" plot="1">
<Params type="Line">

<DrawParamscolorRValue="128"colorGValue="128"colorBValue="128"
dashStyle="0" width="1"/>

</Params>

</Layer>
</Layers>
<Code name="codel" layer="0">

<Params type="Point">

<DrawParamscolorRValue="255"colorGValue="255"colorBValue="255"
markStyle="-1"/>

</Params>
<Params type="Line">

<DrawParamscolorRValue="255"colorGValue="255"colorBValue="255"
dashStyle="-1" width="1"/>

</Params>

<Attributes/>
</Code>
<Code name="code2" layer="0">

<Params type="Point">

<DrawParamscolorRValue="255"colorGValue="255"colorBValue="255"
markStyle="-1"/>

</Params>
<Params type="Line">

<DrawParamscolorRValue="255"colorGValue="255"colorBValue="255"
dashStyle="-1" width="1"/>

</Params>

<Attributes/>
</Code>
<Code name="code3" layer="0">
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<Params type="Point">

<DrawParamscolorRValue="255"colorGValue="255" colorBValue="255"
markStyle="-1"/>

</Params>
<Params type="Line">

<DrawParamscolorRValue="255"colorGValue="255"colorBValue="255"
dashStyle="-1" width="1"/>

</Params>

<Attributes/>
</Code>

</CodeDictionary>

Data Base Format as Storage of the
Code Library (DBF)

This format supports String, Integer, Float types as fields of the codes.
The List type is unsupported. Each exported code is stored in a
separate file. The format uses DBF syntax. This is a binary format.

Roads Formats

The following sections describe the road formats used in the import/
export of road data.

SSS Road

Alignments are uploaded as elements, and start with the START
definition which includes the starting chainage and a coordinate. The
elements are: PT, STRAIGHT, ARC or TRANSITION.

The general format for each record is:
KEYWORD nnnn, nnnn [,nnnn]
where:
START chainage, easting, northing
STRAIGHT  bearing, distance
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ARC radius, length

SPIRAL radius, length

PT easting, northing[, radius[, A1, A2: clothoid length]]
Example 1:

START 1000.000, 8.8888, 199.1200
STRAIGHT 25.0000, 48.420
SPIRAL 20.000, 20.000

ARC 20.000, 23.141

SPIRAL 20.000, 20.000
STRAIGHT 148.3000, 54.678

Example 2:
START 1000, 1050, 1100
PT 1750, 1300, 100, 80, 80
PT 1400, 1750, 200
PT 1800, 2000

TDS Road

TDS road file has a file extension of “.RD5”. This format is divided
into eight sections. Each section is started with a line that has a two
letter code and is followed by exactly 50 '+' characters. These section
header lines have to be included in the file even if there is no
definition under them. For example, super-elevation and widening are
not required, but their header lines must exist. Each header line may
be followed by component definitions of that section.

Section codes:
HR : Start Horizontal alignment
VR : Start Vertical alignment
XR : Start Right Template
XL : Start Left Template
SR : Start Right Super Elevation
SL : Start Left Super Elevation
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WR : Start Right Widening
WL : Start Left Widening

Example:
HR+++++++++++++++H++
HL,25.49380,630.000
HS,-1.000000,1000.000,200.000,R, T
HC,-1.000000,1000.000,895.900,R
HS,-1.000000,1000.000,200.000,R,C
HL,-1.00000,250.000
VR+++++++++++++++++++++
VG,271.840,-2.000
V(C,500.000,-2.000,1.800
VG,1254.060,1.800
VG,150.000,1.800
XR+++++++++++++++++++++
RT,100,0.000,LNORMAL
XL+ ++++++++++++++++++
LT,100,0.000,NORMAL
SR++++++++++++++++++++++++
RS,106,30.000,108,30.000,-2.000,-6.000,0,0,0.000,0.000
RS,117,25.900,119,25.900,-6.000,-2.000,0,0,0.000,0.000
SL+++++++++++++++++++HH+
LS,104,30.000,108,30.000,-2.000,6.000,0,0,0.000,0.000
LS,117,25.900,121,25.900,6.000,-2.000,0,0,0.000,0.000
WR+++++++++++++++++++++H+++H
RW,104,35.000,105,35.000,22.000,14.000,0
RW,106,35.000,107,35.000,14.000,22.000,0
WLA++++++++++++++++ -+
LW,104,35.000,105,35.000,22.000,14.000,0
LW,106,35.000,107,35.000,14.000,22.000,0

Component definitions:

Horizontal Alignments
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HL,% .51f, % .3f Horizontal Line
Azimuth of line (DMS) % .51f
(-1 if tangent to previous segment)
Horiz distance of line (ft or meter) %.3f
HC,%]1f, % .3f,%.3f,%c Horizontal Curve
Tangent azimuth olf
(-1 if tangent to previous segment)
Radius %.3f
Arc length % .3t
Turn ( R-Right or L-Left ) %c
HS,%]1f,%.3f,%.3f,%c,%c  Horizontal Spiral
Tangent azimuth Dolf

(-1 if tangent to previous segment)

Radius % .3t

Arc length %.3f

Turn %c  (R-Right or L-Left)
Direction 9%c (T-Tangent or C-Curve)

Vertical Alignments

VG,%.3f,%.3f Vertical Grade
Horiz distance % .3t
Grade % .3t
VC,%.3f,%.3f,%.3f Vertical Parabolic Curv
Horiz distance % .3f
Begin grade 9% .3f
End grade % .3t
Cross section Templates
RT,%d,%.3f,%s Right or Left Cross Section Template

LT,%d,%.3f,%s
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Station number %d
Station offset % .3f
Template name Yos

Super Elevation

Right or Left Super Elevation
RS,%d,%.3f,%d,%.3f,%.3f,%.3f,%c,%c,%.3f,%.3f or
LS, %d,%.3f,%d,%.3f,%.3f,%.3f,%c,%c,%.3f,%.3f

Start Station number 9od

Start Station offset % .3f

End Station number Yod

End Station offset % .3t
Start slope % .3t
End slope % .3t
End of SE flag Joc

(0-End station number and End station offset are
in fields 3 and 4

1-length of SE interval is in field 4)
Hinge on center or edge  %c
of road (0-center,1-edge)
Parabolic transition length %.3f
at start of SE
Parabolic transition length %.3f
atend of SE
Widening
Right or Left Widening
RW,%d,%.3f,%d,%.3f,%.3f,%.3f,%c or
LW, %d,%.3f,%d,%.3f,%.3f,%.3f,%c

Start Station number %d
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Start Station offset % .3f
End Station number %d
End Station offset % .3f

Width at start of widening %.3f
Width at end of widening  %.3f
End of widening flag Yoc

(0-End station number and End station offset are
in fields 3 and 4 1-length of widening interval
is in field 4)

MC Road

MC road file has a file extension of “.RD3” and is a binary file.

LandXML Road

LandXML is a standard data exchange format.

Refer to LandXML website for details:
http://www.landxml.org/schema/landxml-1.0/Documentation/LandXMLDoc.htm

TopSURYV Road

TopSURY road format consists of three files:

1. *.thl: contains horizontal elements of the road and must start with
the START definition which includes the starting chainage and a
coordinate.

The elements are: PT, STRAIGHT, ARC or TRANSITION.
The general format for each record is:

KEYWORD nnnn, nnnn [,nnnn]

where:

START chainage, easting, northing

STRAIGHT bearing, distance
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ARC radius, length
SPIRAL radius, length
PT easting, northing[, radius[, A1, A2]]

(A1, A2 : clothoid length)

Examplel:
START 1000.000, 8.8888, 199.1200
STRAIGHT 25.0000, 48.420
SPIRAL 20.000, 20.000
ARC 20.000, 23.141
SPIRAL 20.000, 20.000
STRAIGHT 148.3000, 54.678

Example 2:
START 1000, 1050, 1100
PT 1750, 1300, 100, 80, 80
PT 1400, 1750, 200
PT 1800, 2000

2. *.tvl: contains vertical elements of the road (vertical curves) and
require chainage, level and curve length.

Starting and ending curve lengths should be zero.
The format is:
chainage, level, length

Example:
1000.000, 100.000, 0.000
1100.000, 125.000, 50.000
1250.000, 100.000, 60.000

3. *.trd: contains cross sections:
The format is:

Chainage, Template name, Turn (Left or Right), Cut, Fill,
Segment name, Horizontal Offset, Vertical Offset
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CLIP

The CLIP file fiormat is a europe road format.

Example:

*ALZ]1

Calzada Derecha Ajustada
16512.029, 699.021C, 0.000T
18374.058, 749.296C, 10000.000R
19101.891, 785.687C,-15000.000R
19693.957, 807.105C,-25000.000R
20010.319, 815.960C, 25000.000R
20322.145, 829.250C, 22500.000R
21305.065, 878.500C,-12750.000R
21629.230, 888.160C, 14500.000R
21770.000, 894.966C, 0.000R
22000.000, 906.790C, 0.000T
22100.000, 911.900C, 25000.000R
22230.000, 918.790C,-10000.000R
22380.000, 4.975P, 50000.000R
22500.000, 932.525C,-20000.000R
22800.000, 947.100C, 50000.000R
22970.000, 955.547C,-25000.000R
23100.000, 961.800C,-10000.000R
23200.000, 966.370C, 22500.000R
23320.000, 972.200C, 45000.000R
23600.000, 986.660C,-100000.000R
23786.000, 5.000P,-10000.000R
23982.080, 1002.100C, -8250.000R
24258.306, 1005.121C, -9250.000R
24693.967, 991.888C, 15000.000R
25903.863, 985.839C, 9894.424R
27440.115, 997.484C, -0.968F
28690.632, 991.237C, -1.995F

A-28

TopSURYV Reference Manual



Roads Formats

ISPOL

The ISPOL file fiormat is a europe road format.

Example:

H

# Flchero :EJE1.RAS

# FOrmato :ispol-V.7.04 29 Abr 2001 22:39 773

# PRoyecto : PRUEBAS PARA EJEMPLOS :

#Ele : 1 : Eje con todas las clotoides. Al final una de vert
# COmentario:

# COmentario:

# VERTICE | TG. ENTRADA | TG. SALIDA |
# Pk Cota | Pk Cota | Pk Cota | Pendiente (%) K.V.
#H

-19.4700 1070.9622  0.0000  0.0000  0.0000  0.0000  0.000000
0.0000

236.4537 1085.3733  146.4537 1080.3054 326.4537 1083.2497
5.631030 2252.6586

504.7339 1079.0432 452.9464 1080.2651 556.5214 1081.3971 -
2.359528 1500.0000

649.1019 1085.6054 649.1019 1085.6054 649.1019 1085.6054
4.545471 0.0000

705.1867 1082.4506  0.0000  0.0000  0.0000 0.0000 -5.625043
0.0000

# fin de fichero

MX GENIO

MX GENIO format is a GENeralized Input/Output format that is used
to import and export model information to and from Infrasoft’s MX
Professional. MX is a roadway design CADD application that uses a
string-based modeling concept rather than a template-based approach
used by civil design applications developed by other vendors.
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MX GENIO format can be used to import a wide variety of string
types into MX, including master alignment strings and geometry
strings created from horizontal and vertical alignment definitions.

This is an example of a GENIO file that will create a 3D feature string
in MX.

MOSS

GENIO,DESIGN

017,NORM

001FORMAT(3D23.17)

003,0RDR 4=1,1,2,3,

080,CECI,7=3
0.86278740486024506D+060.23557974062420847D+060.51777335135235114D+03
0.86278725732131349D+060.23558072925923113D+060.51778031070319832D+03
0.86278720921827410D+060.23558172768451227D+060.51778404785966120D+03
0.86278726103175664D+060.23558272592411647D+060.51778561243843410D+03
0.86278741224405798D+060.23558371400396363D+060.51778605405621181D+03
0.86278766134431469D+060.23558468205148648D+060.51778642232968866D+03
0.86279182182447857D+060.23559013383718926D+060.51787511440594790D+03
0.86281114482140180D+060.23559653051477592D+060.52051708265943284D+03
0.86281131684491527D+060.23559658416659472D+060.52054181820995780D+03
0.86281591805419116D+060.23559801922184543D+060.52113322369797083D+03
0.86281609007772699D+060.23559807287367119D+060.52115270941608628D+03
0.86281706168931420D+060.23559837590624942D+060.52126223300564516D+03
0.00000000000000000D+000.00000000000000000D+000.52126223300564516D+03
999

A detailed explanation of each of the lines in this file follow.

MOSS
MX files begin with this line to clear any previous errors
GENIO,DESIGN
Begin the GENIO option. Include the model name that the string(s) will be
created in.
017,NORM

This command changes the Angular Input format for the file. 017, NORM will
use the system default format for MX which is typically radians. Other
alternatives for this are:

DEGR - Decimal Degrees
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DMS - Degrees - Minutes - Seconds (in the format D23.17)
RADI - Radians
GRAD - Grads
QUAD - Quads
To specify angles in one of these other formats, substitute the appropriate
Keyword for “NORM”.
001FORMAT(3D23.17)
Formats The INPUT Information in the Data Block.
The format is described by a number of field descriptors separated by commas
and is contained within parentheses.
A field descriptor in a format specification has the form:
[r]Cwl[.d]
where
r represents a repeat count which specifies the field descriptor is to be applied
for ‘r’ successive fields. The default is 1 if omitted.
C is a format code: I - Integer, A - Alpha character, X - Space, F - Real number,
D and E - Double precision.
w specifies the width of the field.
d specifies the number of decimal places.
Example: 3D23.17 specifies that each data line will consist of 3 double-

precision records representing the X, Y, and Z coordinates of each point. Each
field will be 23 columns wide, and each number will have 17 decimal places.
003,0RDR,4=1,1,2,3,
Change Order - This command changes the order of the items of information in
a string element. The first two dimensions of a point on a string are always
Cartesian Coordinates, but the other dimensions may describe different
properties of the point. In this example, the first part of the line “003,0RDR”
will always remain the same. The last part of the command line indicates how
the data block is organized.

4=1 indicates that 1 row of data in the data block is used to define each point.
(for 3D features this is pretty straight-forward, but MX had more complex string
types such as Geometry Strings that have 12-dimensional points that may be
described over a number of lines.)

,1,2,3, indicates the string point dimensions the data should be assigned to.
(X,Y,Z for a 3D string.)

080,CECL7=3

String Input - This command indicates what type of string is being created. The
MX string label

being created in this example is CECI, and each point on this string will have 3
dimensions (7=3).
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0.86278740486024506D+060.23557974062420847D+060.51777335135235114D+03

0.00000000000000000D+000.00000000000000000D+000.52126223300564516D+03

999

Data Block - These lines define the points for string CECI as defined in the 080
line above. Each is in the format specified in the 001Format line, 3D23.17,
which is 3 fields of 23 columns in double-precision format, and 17 places to the
right of the decimal point.

To end the data block defining this string’s points, a final data line is added with
the X and Y coordinates set to 0.000. The data in the 3rd column of this row is of
no concern other than the fact an appropriate value of the specified type must be
provided. In most cases, it will suffice to provide the same Z coordinate as the
preceding line (the last actual point on the string.)

In the example above, a string was created that consisted of a continuous series
of points. In many cases, you may want to create strings that have gaps in them
(i.e. discontinuities). To represent the point on the beginning of a discontinuity
(gap), set the X value of that point to a negative value. The point representing the
end of a discontinuity (gap) should have the Y value set to a negative value.

Add a new “080” command to specify the new string.

999 - Tell MX to end the GENIO command.

Tekla XRoad & XStreet (VGP)

This format has the extension *.vgp.

Horizontal Elements

Every line starts with feature information with element information
following. Line’s mark combines from three characters: Road's
badge, alternative's badge, line's badge. KEYWORD is on every line

and

after that the parameters.

Parameters are: ¢ = text, inf = integer, f = decimal number; with
coordinates 4 decimals. Parameters are separated with spaces.

ROAD
Road's badge

TIE

badge
cl10

ROAD ALTERNATIVE
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Alternative's badge
TIEVE badge

cl0
LINE
Line's badge, description code (survey line, road's side etc), start sta
LINJA badge description start sta
cl0 int f
ELEMENT

Element's informations are: Element's number; description code (for drawing) if
different than line's description code (if not, then 0), geometry (1 = straight, 2 =
circle, 3 = circular arch, 13 = circular arch over half circle, 4 = clothoid), start radius,
end radius, clothoid's parameter (a)

ELEM number description geometry rl 2 a

int int int f f f
ELEMENT P1
Element's start sta information: Element's number, start sta, x1, y1
ELEMP1 number  start sta x1 yl

int f f f
ELEMENT P2
Element's end sta information: Element's number, end sta, x1, y1
ELEMP2 number  endsta  x1 yl

int f f f

ELEMENT CP

Circle's centre point's information: Element's number, X, y
ELEMCP  number X y
int f f

Vertical Elements

ROAD

Road's badge

TIE badge
cl0

ROAD ALTERNATIVE
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Alternative's badge
TIEVE badge

c10
LINEZ
CL's badge, horiz line badge (stations)
LINJAZ badge hl badge
cl0 cl0
ELEMENTZ

Tangents intersections informations: point number, sta, z and radius between
tangents. With first and last the radius = 0.

ELEMZ number sta z radius
int f f f

Example:
Horizontal Elements:
TIE V9aito
TIEVE h
LIHJA ml 6101005 0.000
ELEM 1 0 3 135.000 135,000 0.000
ELEMP1 1 0:000 6825003.0699 2497735.2184
ELEMP2 1 1.073,,.6825003.8022 2497734.5289
ELEMCP 1 6825090.2157 2497838.3233

12345678901234567859012534567590125345675901253456759012345678901254567890123

Wertical Elements:

TIE V9aito

TIEVE b

LINJAZ ml ml

ELEMZ 1 20.0000 111.4300 0.000
ELEMZ 2 47.0000 110.4000 500.000
ELEMZ 3 120.0000 112.4000 0.000

12345678901234567859012534567590125345675901253456759012345678901254567890123

X-sect Templates Formats

Cross section is defined by templates. Each template is stored in a
file. A template file consists of a series of segments and each segment
has a horizontal and a vertical component. The following sections
describe the formats used in the import/export of X-section Template
data.
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SSS Template

SSS Template format is as follows:

Template Record:
Template Name, 0, Cut, Fill

Segment Record:
Template Name, 1, Offset, Height[, Code]

Example:
SIMP,0,6.000,6.000
SIMP,1,1.000,0.000,1
NAME,0,4.000,4.000
NAME,1,1.000,-0.250,EP
NAME, 1,0.000,0.150,1
NAME,1,0.500,0.000,2
NAME, 1,0.200,-1.000,3
NAME,1,0.300,0.000,4

TDS X-section Template

The following sample template file describes a cross section in two
segments.

Number of segments: 2, Cut slope: 0.500 %, Fill slope: 1.000 %
First segment: ~ hd: 22.000 ft slope: -2.000 %
Second segment: hd: 2.000 ft  vd: -2.000 ft

Example:
TH,2,0.500,1.000
TS,22.000,-2.000,0,roadbed
TS,2.000,-2.000,1,ditch

Definition of components in template file:
TH : Template Header = format: TH,%d,%.3f,%.3f
Number of segments 9d

Slope cut % .3t
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Slope fill % .3f
TS : Template Segment  format: TS,%.3f,%.3f,%c,%s
Segment length % .3f
Vertical dist or %.3f
Slope %
Vertical flag %c  (0-Slope % is in

field 2
1-Vertical dist is in field 2)

Segment name Yos

TopSurv Template

TopSURYV Template format is as follows:

Template Name, Code, Offset, Height
Example:

SIMP, 1, 1.000, 0.000

NAME, EP, 1.000, -0.250

NAME, 1, 0.000, 0.150

NAME, 2, 0.500, 0.000

NAME, 3, 0.200, -1.000

NAME, 4, 0.300, 0.000

Localization Format

GC3

This is a binary file containing localization data.
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Roads Survey Formats

The following sections describe the data formats used in the export of
road raw data.

X-Section Surveys

The format is as follows:
chainage, offset, level [,code]

Example:
0.000,-4.501,18.527
0.000,-3.500,18.553
0.000,0.000,18.658,CLO1
0.000,3.500,18.553
0.000,5.501,18.493
12.669,-4.501,18.029
12.669,-3.500,18.059
12.669,-0.000,18.164,CLO1
12.669,3.500,18.059
12.669,5.501,17.999

Find Station Report

The format is as follows:
FindChainageReport:
Reference road
FindChainage:
PointName Chainage Offset North East Elev [Cut]
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Raw Data Formats

The following sections describe the formats used in the export of raw
data.

FC-5

Refer to the FC-5 interface manual to confirm details on FC-5 data
format.
Example:

_ISAMPLE_"SOMEONE_#GX0021_$06/01/
95_%24C_&990HP_"X1000_(_)1.200_+A001_ a+2755858d_ b0881003d
¢+00010942m_*NS001_,1.200_+A002_ a+0006

3265752d_ b0952330d c+00003366m_*NS001_,1.200_+A003_ a+0420820d_
b0894549d c+00006913m_*NS001_,1.200_

1002

GTS-6
The data is GTS-6 and FC-5 unformatted data.

Refer to the GTS-6 interface manual to confirm details.

Example:

_ISAMPLE_"SOMEONE_#GX0021_$06/01/
95_%24C_&990HP_"X1000_(_)1.200_+A001_
7+00010942m0881003+2755858d+00010936***+**4*%054_*NS001_,0064

1.200_+A002_
7+00003366m0952330+3265752d+00003351 *#***4*%063_*NS001_,1.200_
+A003_ 7+00006913m0894549+0420820d+00006912#**4**4*%1039

055_*NS001_,1.200_
2037
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FC-6/GTS-7
The format of the GTS-7 data is the same as the FC-6 data format.
The general format of each record is as follows:
CONTROL WORD fieldl . ... fieldn
Where:
CONTROL WORD is terminated by a space.
Fields 1 to n-1 are terminated by commas.
Field n is terminated by the end-of-line.

Each field may be preceded by a number of space characters
which should be ignored but may contain spaces after the first
non-space character.

GTS-600 v3.1

JOB job name, description

DATE date, time

NAME surveyors name

INST instrument id

UNITS Meter/Feet, Degree/Gon

SCALE grid factor, scale factor, elevation
ATMOS temp, press

STN ptno, ins ht, stn id

XYZ X(easting), Y (northing), Z(elevation)
BKB ptno, backsight bearing, backsight angle
BS ptnol, target height]

FS ptno, target height, pt code[,string number]
SS ptno, target height, pt code[,string number]
CTL control code[,pt code 2[,string no 2]](optional)
HV HA, VA

SD HA, VA, SD
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OFFSET radial offset, tangential offset, vertical offset

PTL_OFF offset along ref. line, offset perpendicular to line,
vertical offset

NOTE comments
MLM from point, to point, delta HD, delta VD, delta SD
RES_OBS ptno, target height, observation count

XYZ if present follows the STN record

BKB if present follows the BKB record or STN record
if no BKB.

CTL if present follows the FS or SS header record.

HV, SD or HD must follow a BS, FS or SS header and follows
the CTL if present.

OFFSET may follow any SD or HD record.
Example:

GTS-600 v3.1

JOB TEST1,TOPO COLLECTION

NAME FRED
INST GTS-7
UNITS M,D

STN 1,1.500,STN

SS 1001,1.500,BLDG,01
SD 0.0000,84.4650,9.746
SS 1002,1.500,BLDG,01
SD 0.0000,84.4650,9.746
SS 1003,1.500,BLDG,01
SD 0.0000,84.4650,9.747
SS 1004,1.500,BLDG,01
CTL CL

SD 359.1740,84.4650,9.747
SS 1005,1.500,NS

SD 359.1740,84.4650,9.747
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SS 1006,1.500,NS

SD 359.1740,84.4650,9.747
FS 2,1.500,NS

SD 179.1740,84.4650,9.747

STN 2,1.500,STN

GTS-600 v3.1

JOB TEST2, SET COLLECTION
NAME FRED

INST  GTS-7

UNITS M,D

STN 1,1.500,STN

XYZ 1000.000,1000.000,100.000
BKB 2,315.0000,0.0000

BS 2,1.500

HV 344.0620,86.3810

FS 101,1.500,STN

SD 325.3420,88.4750,5.275
FS 102,1.500,STN

SD 7.0610,85.2210,9.914

FS 103,1.500,STN

SD 36.1350,87.3800,9.755
FS 104,1.500,STN

SD 83.4730,84.0410,3.313
FS 104,1.500,STN

SD 263.4820,275.5530,3.313
FS 103,1.500,STN

SD 216.1430,272.2150,9.755
FS 102,1.500,STN

SD 187.0650,274.3730,9.916
FS 101,1.500,STN

SD 145.3520,271.1510,5.27
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BS 2,1.500
HV 164.0640,273.2340

Land XML

LandXML is a standard data exchange format.

Refer to LandXML Website for details:
http://www.landxml.org/schema/landxml-1.0/Documentation/LandXMLDoc.htm

TDS RawData

Example:
JB,NMA_meas,DT03-15-02,TM15:17:53
MO,ADO0,UN1,SF1.000000,EC0,EO00.0000
SP,PN1,N 90.0000,E 200.0000,EL 50.0000,--man
OC,0OP1,N 90.0000,E 200.0000,EL 50.0000,--man
LS,HI1.0100,HR0.0000
--user has entered the following Azimuth
BK,OP1,BP2,BS0.0000,BC65.4618
--SS,0P1,FP2,AR65.4618,ZE102.0935,SD4.7720,--DOOR
LS,HI1.0100,HR2.5600
SS,0P1,FP3,AR61.1834,ZE84.2723,SD6.5740,--BEN

from/to this file and can only export GPS and TS

@ TopSURYV can import/export localization data
observations.

MOSS Survey

Both traverse and detail raw data formats can be exported.

Example:
SURVEY D:\J0119A
017,.DMS
190,,,DECR,0900000
180,,,9000,,1000.000,1000.000,0.000
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200,9000,9001,SDVA,3595958,,,1.600,,1.000000
201,,,PT01,0103620,14.194,0870623,0.000,,,1001
201,,,PT01,1333115,10.386,0880200,0.000,,,1002
201,,,PT02,2872920,9.187,0901702,0.000,,,1003
201,,,PT02,3350057,15.887,0871812,0.000,,,1004
201,CD2,02,PP01,0103555,14.196,0870649,0.000,,,1005
201,CD2,03,PP01,1333053,10.392,0880209,0.000,,,1006
201,,,P101,2872902,9.187,0901634,0.000,,,1007
201,,,P101,3350118,15.886,0871727,0.000,,,1008

999

FINISH

Berlin GNSS

This format is a German format that consists of two separate files of

quality report: GNSS-Messprotokoll and GNSS-Mittelwerte.

Scanning Data Format

Scanning data includes an orientation file, control points for
orientation and Camera calibration file for DI-3000.

DI-3000

Project:
Header(FIELD_SCAN_FSC_FILEVER1.0)

*Text Format

Orientation Information File:
Name of Image
Size of Image Width[pixel] Height[pixel]

Number of Image Coordinates of Orientation Points
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Image coordinates of Orientation point:

: Point Name,X,Y

*Text Format

Control Point(Terrain) For Orientation File:

Point Name, X,Y,Z
*CSV Text Format

Results of Orientation Calculation(Single Orientation):
ERR MAX,X Maximum Error,Y Maximum Error, 0.000000
ERR RMS, X Standard Dev[Pixel],Y Standard Deviation[Pixel], 0.000000

Discrepancy of each orientation point[Pixel]

*Text Format

Camera Calibration For Digital Camera:

7.955772 // focal length [mm]

1.866217 // x of principal point [m]
1.375943 //'y of principal point [m]

2 // distortion model

4 // number of distortion parameters
3.596956e-003 // distortion parameter 1
-1.414950e-004 // distortion parameter 2
-1.786501e-004 // distortion parameter 3
4.303863e-004 // distortion parameter 4
0.005600 // x resolution [mm/pixel]
0.005600 //'y resolution [mm/pixel]

0  // number of fiducial marks

0  // number of radial distortion values
*Text Format

Setting Information:

Instrument Point,X,Y,Z

Backsight Point,X,Y,Z

mh 0.0000 0.0000 IH(Instrument Height)
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*Text Format

Point Clouds(Scanning Data):
Header(SFILE_VERO1)
point name,X,Y,Z,Wide Image name,Tele Image Name,,Layer Name,Point Attribute

*Binary Format(Fix)

Point Clouds(Scanning Data):
point name,X,Y,Z,Layer Name
*CSV Format

Job History

Job history can be exported to the CSV file or text report.

CSV

All job history data are represented in text format with comma
separated values.

Report

In the current version only resection data are output.

The completed resection measurements prints out or writes to a file in
the order of measuring. Also, all changes made when editing raw data
are visible in the report file.

Example:

+++ TopSURYV Version 5.04 +++ Date, Time

Resection

Job : Job-Name

Occ-point name : PPPPPPPPPP (E: EEEEEEE.EEEE[m], N:
NNNNNNN.NNNN[m], Z: ZZZZ.ZZZZ[m])

Instr. height  : ii.iiii[m]
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Surveyor : name
Temperature : TT.T[°C]

Pressure : xxx (mmHg)
Date/Time : JJJIJ-MM-DD HH:MM:SS
Dim-Type :2D or 3D

Orientation : ggg.gggg[gon] (Standarddev.: dg.gggg[mgon])
OCC.Std.deviation : dE: dE[mm] dN: dN[mm] dZ: dZ[mm]
Scale : fix/calculated 1.00000000
Backbearing-Name Hz [gon] V [gon] SD[m] dHz[mgon] dV[mgon]dS[m]
tH[m]
East [m] North [m] Height [m] dE[m] dN[m] dZ[m]
USE(HVSD)

BKB 1pppppppppppp HHHHHHH VVV.VVVV  DDDD.DDDD dH.HHHH
dV.VVVV dS.SSS t.tit

EEEEEEE.EEEE NNNNNNN.NNNN 72777.7777 dE.EEE dN.NNN
d2.ZZZ HVSD

BKB2pppppppppppp HHHHHHH VVV.VVVV DDDD.DDDD dH.HHHH
dV.VVVV dS.SSS t.ttt

EEEEEEE.EEEE NNNNNNN.NNNN 7777.7777 dE.EEE dN.NNN
dZ2.ZZZ HV-

BKB3pppppppppppp HHH.HHHH  VVV.VVVV  DDDD.DDDD dH.HHHH
dV.VVVV dS.SSS t.ttt

EEEEEEE.EEEE NNNNNNN.NNNN 72777.7777 dE.EEE dN.NNN
d2.Z2Z7Z HVSD

BKB4pppppppppppp HHHHHHH VVV.VVVV  DDDD.DDDD dH.HHHH
dV.VVVV dS.SSS t.it

EEEEEEE.EEEE NNNNNNN.NNNN 72777.7777 dE.EEE dN.NNN
dZ2.ZZZ HVSD
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A

Alarms 2-9
Alignment 3-24
Antenna 2-26, 2-42
Attribute 3-12

C

Code 3-12
COGO
intersection 9-7
rotate 9-35
scale 9-37
translate 9-36
two point inverse 9-2
Configuration
GPS+ configuration 2-13
survey configuration 2-4, 2-12
TS configuration 2-53
Control code 3-10, 5-25
Co-Op tracking 2-52
Coordinate system 2-5, 2-71, 2-100

Datum 2-6, 2-72
Degree of chord 3-33
Degree of curve 3-33
Distance averaging 2-64

Elevation mask 2-18, 5-4
Export

to device 2-120

to job 2-105
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Index

F

Feature 3-12
Find station 6-33

G

GPS+
GPS+ status 5-2
start base 5-12

HAL 3-29
circular arc 3-33

intersection point 3-24, 3-36

line 3-32
spiral 3-34
|
Import

from file 2-94
from job 2-85

Job
delete job 2-10
job list 2-2
new job 2-3
open job 2-2
select job 2-85, 2-105

L

Localization 5-47

Index



Index

M

Missing line 6-37

mmGPS 2-14, 2-43

Modem
GSM 2-21
internal HiPer Lite 2-22
Satel 2-24

Multipath reduction 2-52

o

Observation mode 2-123
Offset

hidden point 6-20
Offsets

sideshots 6-14

topo survey 5-32

P

Pattern 2-61
Point guide 2-65
Points 3-2
Post processing
kinematic 2-15
static 2-15
Prism constant 2-65
Projection 2-5, 2-71, 2-73
PTL 6-12

Raw data 3-55
Receiver
base receiver 2-17, 2-18
rover receiver 2-27
Reference direction 2-48
Road 3-24
Rover known point 5-44
RTK 2-14

S

Scan range 2-62
Sensitivity 2-62

Index

Sideshot 6-10
Signal-to-noise ratio 5-7
Slope 3-22
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